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INTRODUCTION

Thank you for choosing this lcom product. This product is designed and built with lcom’ s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This product combines traditional analog technologies with the new digital technology, Digital Smart Technologies for
Amateur Radio (D-STAR), for a balanced package.

ABOUT THE CONSTRUCTION OF THE MANUAL (As of April 2017)

You can use the following manuals to understand and operate this transceiver.
® If necessary, you can download a glossary of HAM radio terms from the Icom website.

Basic manual (Comes with the transceiver) Advanced manual (This manual)
Instructions for the basic operations, precautions, Instructions for advanced operations, as shown below.
installation, and connections. * Memory operation <Advanced>*
» Scan operation <Advanced>*
D-STAR Guide (Comes with the transceiver) * Priority watch operation

* D-STAR operation <Advanced>*

* GPS operation

* Using a microSD card

» VVoice memory operation

About the DV Gateway function (PDF type) . Repeater and dup|ex operations

* Menu screen <Advanced>*

* Other functions

* Options <Advanced>*

* Bluetooth operation

® This manual can be downloaded from the lcom
website.

*The basic instructions are described on the Basic manual.

Instructions for registering your call sign on a gateway
repeater, and the basic operations of D-STAR.

Instructions on the system requirements or operations

needed to use the DV Gateway function.

® The guide “About the DV Gateway function” can be
downloaded from the Icom website.

Icom, Icom Inc. and the Icom logo are registered trademarks of lcom Incorporated (Japan) in Japan, the United States, the United Kingdom,
Germany, France, Spain, Russia, Australia, New Zealand, and/or other countries.

Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

The Bluetooth word mark and logos are registered trademarks owned by the Bluetooth SIG, Inc. and any use of such marks by Ilcom Inc. is
under license. Other trademarks and trade names are those of their respective owners.

Android and the Android logo are trademarks of Google, Inc.

10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

Apple, iPad, and iPhone are trademarks of Apple Inc., registered in the U.S. and other countries.

App Store is a service mark of Apple Inc.

The iPhone trademark is used under license from AiPhone Co., Ltd.

Galaxy and Galaxy S are registered trademarks of Samsung Electronics Co., Ltd.

Google, the Google Logo, Google Play, the Google Play logo,

All other products or brands are registered trademarks or trademarks of their respective holders.
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Functions and features of Adobe® Acrobat® Reader®

The following functions and features can be used with Adobe® Acrobat® Reader®.

* Keyword search
Click “Find” (Ctrl+F) or “Advanced File BT view Window Help * Find screen
Search” (Shift+Ctrl+F) in the Edit ¢

menu to open the search screen. _

This is convenient when search-

ing for a particular word or phrase Frevious et
in this manual. 1
*The menu screen may differ, * Advanced search screen
depending on the Adobe® Acrobat® N B seerh = o=
Reader® version. @ Amange Windows
Select All Ctri+A Where would you like to search?
@ In the current document
Deselect All Shift+Ctri+A ©) All PDF Documents in
| () My Documents -
Click to open the find or search Copy File to Clipboard What word or phrase wold you ke tosearch for?

screen or advanced search screen.

i Take a Snapshot . 53 Whole words only
[T Case-Sensitive
[C]Include Bockmarks

Check Spelling » [include Comments
Search
Q Find Ctri+F
Advanced Search Shift+Ctrl+F
Protection 4
Accessibility »
* Printing out the desired pages. * Read Out Loud feature.
Click “Print” in the File menu, and then select the The Read Out Loud feature reads aloud the text in
paper size and page numbers you want to print. this PDF.
*The printing setup may differ, depending on the Refer to the Adobe® Acrobat® Reader® Help for the
printer. Refer to your printer's instruction manual details.
for details. (This feature may not be usable, depending on your
*Select "A4" size to print out the page in the original PC environment including the operating system.)
manual size.
Rotate View J
Edit Vi Wind Hel
Ii! it View indow elp 3age Ma\:igation .
B Open... Ctrl+0
Create PDF Online... Page Display »
Zoom b
Save As... Shift+Ctrl+5 Tools »
Save as Other 3
Show/Hide 3
Send File 3
Display Theme 4
Close S [¥] Read Mode Cirl+H
Properties... Ctrl+D |:_| Full Screen Mode Ctrl+L
= Pint.. Ctrl+P EP tracker..
L Read Out Loud [

*The screen may differ, depending on the Adobe® Acrobat® Reader®
version.
iii
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Entering and editing text

Controls used for text entry

[QUICK]

[MENU] —[DIAL] (Rotate) Selects the
Cancels /> Selects character type

\ o/ [ Tras v s
/ﬁ/ & LA
S / Al vou
oo

S \

= = CLR B s

VM@ MODE

MW RX+CS _ MONI qu\cxm‘

~ ~ WA —
—[RX—CS]
(] Clears
Cancels IMW]
[MODE] Moves the
Moves the cursor to the

cursor to the left fight

* To insert a text, move the cursor to a place to
enter, then rotate [DIAL].

* To clear a character, push [RX—CS].

* To consecutively clear characters, continuously
hold down [RX—CS].

* When the character type is “AB” or “ab,” and while
entering a character, push [QUICK] to convert
between upper case and lower case letters.

To change the character type

1. When not selecting text, or an entered text is
selected, push [QUICK].

2. Rotate [DIAL] to select the character type, then
push [J].

EMNAME =y
m !u#
. ah
12 S
i— g [STEEY 4B
Character Selectable characters Character
type and symbols conversion
AB A to Z, (space) Ala
ab a to z, (space) Ala

12 0 to 9, (space) -

I"#$%& ()*+,-./:1;<= -

"R s2@10 0 (1) (space)

TIP: When the character type is “AB” or “ab,” and
while entering a character, push [QUICK] to convert
between upper case and lower case letters.

Push
[QUICK]
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Entering and editing text (Continued)

< Usable characters
The usable characters and symbols, and the maximum characters differ, depending on the item.
See the following list for details.

® The usable characters and symbols for each character type are described at the bottom of the page.

Maximum .
Category Item Character type e Information Reference
Memory name | [AB] [ab] [12] ["#] 16 - p. 1-10
Manage Memory
Bank name [AB] [ab] [12] ['"#] 16 - p. 1-11
Program scan Scan name [AB] [ab] [12] ["#] 16 - p. 2-9
P-LINK Scan Link name | [AB] [ab] [12] [!"#] 16 - p. 9-20
My Station TX Message [AB] [ab] [12] ["#] 20 - p. 4-17
p. 5-15
Normally 12 characters
1" -
Unproto Address |[AB] [ab] [12] [I"#] 56 (API410,DSTAR®) p. 5-17
p. 5-21
The number of characters you
can enter differs, depending on p.5-16
P ) )
GPS TX Mode Comment [AB] [ab] [12] ["#] 43 the data extension and altitude p.5-18
. p. 5-22
settings.
Object Name P
ltem Name [AB] [ab] [12] ['"#] 9 - p. 5-17
GPS Message |[AB][ab] [12] ["#] 20 - p. 5-26
Save Setting | [AB] [ab] [12] ["#] 20 }”_e_gfLC:araCterS: p. 6-4
SD Card III. - Ccharacters.
Export [AB] [ab] [12] [I"#] 20 p oo characters: p. 6-9
Bluetooth Set Device name [AB] [ab] [12] ['"#] 8 Except for “ICOM BT-" p.9-72
Group name [AB] [ab] [12] ['"#] 16 - p. 4-41
Repeater name | [AB] [ab] [12] ["#] 16 - p. 4-34
Repeater List Sub name [AB] [ab] [12] ['"#] 8 - p. 4-34
Call sign AtoZ,0t09,/, space 8 - p. 4-34
GW Call sign AtoZ,0t09,/, space 8 - p. 4-34
UR AtoZ,0t09,/, space 8 - p. 9-41
CS screen R1 AtoZ,0t09,/, space 8 - p. 9-41
R2 AtoZ,0t09,/, space 8 - p. 9-41
. . Includes “/” between the Call
My Call Sign Call sign AtoZ,0to9,/, space 12 (+1) sign and Memo field. p. 9-47
. Name [AB] [ab] [12] ["#] 16 - p. 4-43
Your Call sign -
Call sign AtoZ,0t09,/, space 8 p. 4-43
Memory name  |[AB] [ab] [12] [I"#] 16 - p. 5-27
GPS Memory
Group name [AB] [ab] [12] [I"#] 16 - p. 5-30
Direct Input (UR) [AtoZ,01t09,/, space 8 - p. 4-11
DR screen -
Direct Input (RPT) [Ato Z,01t0 9, /, space 8 - p. 4-12
DTMF Memory DTMF code 0t09,A,B,C,D, " # 24 - p. 10-8

[AB]: Ato Z, (space)

[ab]: a to z, (space)
[12]: 0 to 9, (space)

H N "#$%& () +,-./:;<=>2@[\]"_"{|} (space)
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Entering and editing text (Continued)

< How to enter

(Example: Entering “Calling” as a Memory name.)

1. Push [MW].

2. Rotate [DIAL] to select “Manage Memory,” then
push [J].

il Write to Mew CH
1 4 Arite to Selected CH

Manage Memaory

FERIF

* Displays the MANAGE MEMORY screen.
3. Select “Memory CH,” then push [J].

Az (Blank)k
E: (Blank)k
* Displays the ALL screen.
5. Rotate [DIAL] to select the Memory channel to
enter a name, then push [QUICK].

BEE: 146,010 FM
@E1: 440,000  FM 3
@E2: 146.030  FM 3

6. Select “Edit,” then push [J].

[EE: 146
@E1 2 440,

BE2: 146,
7.
MAME . M
FREQUENCY  :146.010.00  »
MODE  FI R

= MAME

= — CLR 4B

* Enters the name entry mode.

Vi

8. Push [QUICK].
9. Select the character type, then push [J].
EMAME ey S
!”#
_ ah
12 S—
= - [STEIT 4B

10. Rotate [DIAL] to select a character, then push [J].
(Example: C)

= NAME

= — CLR 4B

® Information

» To move the cursor forward, push [MW].

» To move the cursor backward, push [MODE].

* To insert a text, move the cursor to a place to enter,
then rotate [DIAL].

* To clear a character, push [RX—CS].

« To consecutively clear characters, continuously hold
down [RX—CS].

* When the character type is “AB” or “ab,” and while
entering a character, push [QUICK] to convert
between upper case and lower case letters.

11. Repeat step 8 ~ 10 to enter a name.

(Example: Calling)

= MNAME

Calling_

= — CLR ab

12. After entering, push [J].

FREQILIENCY
MODE ; FM

BANE P

<= vepwrite=x

TONE tOFF »u
3

 The confirmation dialog “Overwrite?” is displayed.
14. Select <YES>, then push [J].

m Dverwrite? E

» Beeps sound, and writes the entered name to the
channel.
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General description

The transceiver has a total of 1000 Memory channels
(100 channels in each of 26 memory banks, A ~ Z)
and two Call channels (C0/C1) each for the 144 and
430 MHz bands.

The Memory mode is useful to quickly select often-
used frequencies.

< The number of the Memory channel

Memory Channels Descriptions
000 ~ 999 (Total of 1000) | Regular Memory channels.

Two Call channels (C0/C1) each for the 144 and 430 MHz bands.
Instantly recalls a specified frequency.

Co/C1

< Memory channel content
The following information can be entered into the
Memory channels:

* Operating frequency

* Duplex direction (DUP+ or DUP-) and frequency
offset

* Memory name

* Scan skip setting

* Tuning step

* Operating mode

» Subaudible tone encoder, tone squelch or DTCS
squelch ON/OFF

» Subaudible tone frequency, tone squelch frequency
or DTCS code with polarity

* UR station call sign

* R1/R2 call signs

« Digital Call sign squelch or Digital code squelch ON/
OFF

* Digital code

* Memory bank

NOTE: Memory content may be accidentally

cleared by static electricity, electric transients,

and other causes. In addition, it may be cleared

by a malfunction, or during repairs. Therefore, we

recommend that you backup the memory content or

save it to a microSD card* or to a PC.

*User supplied

® The CS-4100 cloning software can also be used to
backup your memory data.

1-2
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Manage Memory screen description

The MANAGE MEMORY screen enables you to easily

manage the Memory or Call channel content.

* Displays the Memory or Call channel content.

 Easy to assign to a bank, and displays the bank
content.

 Easy to add, edit, copy, or clear the Memory
channels.

< Tree view of the Manage Memory screen

— Memory CH ALL |

Manage
Memory

] Call CH H{co 144 |

1-3

< Displaying the Manage Memory screen
Manage Memory > Memory CH

1. Push [MENU].
Rotate [DIAL] to select “Manage Memory,” then

push [J].

By DUPSTOME. . 3

B Manage Memory

& Scan 3

* Displays the MANAGE MEMORY screen.
® You can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.
3. Select “Memory CH,” then push [J].

El

Al 1/

Call CH

4. Select “ALL,” then push [J].

B (Blank)®
E: (Blank)®

* Displays the ALL screen.
5. Select a channel, then push [J].

S ALL
BEE: 146.010  FM b
@E1 = 440, 000 FH |]
SEMEMORY CH (@&1 CH)

MAME 2

FREQLEMCY D440 00000

MODE : FId

* Displays the Memory content.

® Rotate [DIAL] to select the page.
6. Push [MENU].

* Returns to the standby screen.

TIP: To edit, copy or clear the memory content.
1. Push [QUICK] in step 5.
2. Select “Edit,” “Copy” or “Clear,” then push [J].

2440 000 .00
: FiA

FREQUEMNCY
MODE

(Example: When selecting “Edit.”)
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Selecting a Memory channel

In the Memory mode, you can select the Memory
channels by rotating [DIAL].

1. Push [V/M] several times until you enter the
Memory mode.

146.010
'1EB

® Pushing [V/M] toggles between the VFO and Memory
modes.

2. Rotate [DIAL].
* Selects a Memory channel.

440000 |

® Blank channels are not selectable.

[DIAL]

[V/IM]

1-4

Selecting a Call channel

Two Call channels (C0/C1) are selectable in each of
the 144 and 430 MHz bands.

Factory default frequencies and operating modes are
entered into the Call channels. Change these to suit
your operating needs.

1. Hold down [CALL] for 1 second.
« Enters the Call channel mode.

146010

® Pushing [CALL] again cancels the Call channel
mode.

2. Rotate [DIAL].
« Selects a Call channel.

146010 |

[DIAL]

[CALL]
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Writing to a Memory channel

After setting a frequency in the VFO mode, you can
write it to a selected channel or an automatically
selected blank channel.

Memory channels 002 to 999 are blank as the default.

< Writing to the selected channel < Writing to a blank channel

Example: Writing 146.030 MHz into Memory channel 18. Example: Writing 146.030 MHz into a blank channel.

1. Push [V/M] several times until you enter the VFO 1. Push [V/M] several times until you enter the VFO
mode. mode.

2. Rotate [DIAL] to select 146.030 MHz.

146.030

2. Rotate [DIAL] to set 146.030 MHz.
3. Hold down [MW] for 1 second.

FM [ E3
146.030
E1 L] FSKIF
841
3. Push [MW]. v
4. Rotate [DIAL] to select “Write to New CH.”
I o = P eam pleted.
Write to Mew CH CH SRRz
1 4 Write to Selected CH FRECQ : 146 .020
Manage Memory . MAIME: —- ﬁ“‘
Ba1
» Beeps sound, and automatically writes into a blank
5. Rotate [DIAL] to select the Memory channel “018.” channel.
* Returns to the standby screen (VFO mode).
146030 & Elami:
Pais
EDIT WRITE EEEL

TAND/BANK G
e |2 ¥ ePs

vou

@ If you select a pre-entered channel, the previous
channel content will be overwritten.
® The Call channels are also selectable.
6. Push [MW].
* The confirmation dialog “Write to a blank channel?” is
displayed.
7. Select <YES>, then push [J].

SPCH

saL
MW RX+CS _ MONI__QUICKIVIB

VM@

MODE

/ | I
[«]1< [DIAL] [VIM]  [MW]

Write to a blank channel?

u
=
-

=]
—
|us]

=
2]
o

* Beeps sound, and writes into the selected Memory
channel.
* Returns to the standby screen (VFO mode).

1-5
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Writing to a Memory channel (Continued)

< Overwriting to the selected channel

You can write a frequency into a pre-entered channel.

Example: Writing 147.030 MHz into Memory channel

“018.”
1. Push [V/M] several times until you enter the
Memory mode.
2. Rotate [DIAL] to select the channel 18.

146.030_

Destination channel

w

Push [V/M] to enter the VFO mode.
4. Rotate [DIAL] to set 147.030 MHz.

147.030 |

SHIF

o ]

5. Push [MW].
6. Rotate [DIAL] to select “Write to Selected CH,”
then push [J].

Write to Mew CH

SEIF

v
147030 &
P ais

EDIT MWRITE BAME

7. Push [MW].
* The confirmation dialog “Overwrite?” is displayed.
8. Select <YES>, then push [J].

FM
1 4 Write to Selected CH
Manage Memory

1 ]

Civerwrite?

(=]
—
0a

o
2
-

* Beeps sound, and writes into the selected Memory
channel.
* Returns to the standby screen (VFO mode).

1-6

< Copying Memory content to the VFO
It is convenient when you want to operate on a
channel frequency near a Memory or Call channel.

Example: Copying Memory channel “001” to the VFO.

1. Push [V/M] several times until you enter the
Memory mode.

2. Rotate [DIAL] to select the channel 1.

440.000

Push [MW].
Rotate [DIAL] to select “Copy to VFO,” then push
[J].

il Edit

4 4 |:|:| oy to "-.-"Fl:l
Manage Memory
@maa1

* The confirmation dialog “Copy to VFO?” is displayed.
5. Select <YES>, then push [J].

FM [y to WFO?

4

* Beeps sound, and copies the selected Memory
content to the VFO.
* Returns to the standby screen (VFO mode).

o3 ba1 1

> w

SANDIEANK
S | e

)|

VM

MODE

/ | |
[«]- [DIAL] [VIM]  [MW]
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Writing to a Memory channel (Continued)

< Copying Memory content to another Memory channel

You can copy the memory content to another Memory

channel.

Example: Copying Memory channel “018” to Memory
channel “019”.

Manage Memory > Memory CH

1. Push [MENUI.
2. Rotate [DIAL] to select “Manage Memory,” then
push [].

% DUP/TOME. . b

B Manage Memory
M Scan 3

* Displays the MANAGE MEMORY screen.
® You can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.
3. Select “Memory CH,” then push [J].

I 14

Memar Vv CH
Call CH

4. Select “ALL,” then push [J].
EMEMIORY CH

h: (Elanki®
B: (Elanki®

* Displays the ALL screen.

5. Rotate [DIAL] to select the Memory channel “018,”
then push [QUICK].

1_111 2= 147,030 FM B
@149: »
B20: »

6. Select “Copy,” then push [J].

Edit JEETE
o18: 47 Copy ¥
#19: Clear »

» “DESTINATION?” blinks at the top left of the screen.

1-7

7. Select the destination channel, then push [J].

NN
= DESTIMNATION 2
NS

@78: 147,030 © FH

B2a:

Caompleted.
MBCH @13
FREDQ 1147020
@zmE:|MAME: -

» Beeps sound, and copies to the destination channel.
@ If you select a pre-entered channel, the previous
channel content will be overwritten.

[MENU]
|

EANDIEANK
S | O aem

I I
[.J]/ [DIAL] [QUICK]
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Memory bank setting

The transceiver has a total of 26 banks (A ~ Z).
Regular memory channels 0 ~ 999 can be assigned

to any bank for easy memory management. Up to 100

channels can be assigned to a bank.

NOTE: The memory banks are only used to hold
memory channels. Therefore, if the original memory
channel content have been changed, the memory
bank content are also changed at the same time.

< Assigning a memory channel to a memory bank

Example: Assigning Memory channel “000” to the

bank “A”.

Manage Memory > Memory CH

1.

Push [MENU].
Rotate [DIAL] to select “Manage Memory,” then
push [J].

* Displays the MANAGE MEMORY screen.

® You can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.

Select “Memory CH,” then push [J].

EMAMAGE MEMORY

Viernory 2
Call CH >|]

Select “ALL,” then push [J].
EMEMIORY CH

A (Blank)®
B: (Blank)®

* Displays the ALL screen.
Rotate [DIAL] to select the Memory channel to be
aSS|gned to a bank, then push [QUICK].

FH
BE1: 440,000  FM 3
BE2: 146.030 M 3

Select “Edit,” then push [J].

@@ = 440 Clear 4
B2z 146, 3

7.

Select “BANK,” then push [J].
EMEMORY CH EDIT (@@@CH)

TONE : OFF
]

<<y riters

Select a bank to be assigned, then push [J].

TOME SOFF
: 3

TOME tOFF
BANK s b

< vere rites=

* The confirmation dialog “Overwrite?” is displayed.

. Select <YES>, then push [J].

m Civerwrite? E

» Beeps sound, and assigns the selected memory
channel to the bank.

WK
{

[d]/ [DIAL]

[MENU]

[QUIICK]
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Memory bank setting (Continued)

< Directly writing into a memory bank
You can also write the memory content directly into
a memory bank channel. This way is a short cut to
creating a memory channel, and then assigning it to
a bank. In that case, the transceiver automatically
selects the lowest blank memory channel, to write.

Example: Writing 146.030 MHz into Bank A.

1. Push [V/M] several times until you enter the VFO
mode.

2. Rotate [DIAL] to set 146.030 MHz.

3. Push [MW].

4. Rotate [DIAL] to select “Write to New CH,” then
push [d]

1 4 erte tu Selected CH
Manage Memory .
4
146030 & el
P aos
EDIT WRITE BAMNEK

* Displays the WRITE screen.

5. Push [QUICK].
6. Select a bank, then push [J].
B (Blank)
146030 Fwm Eliarls
P aos
EDNT WRITE BAMNE
7. Push [MW].
* The confirmation dialog “Write to a blank channel?” is
displayed.
8. Select <YES>, then push [J].
Write to a blank channel? E
ank
185
LMK

* Beeps sound, and writes the memory content to the
bank channel.

¢ Selecting the Memory Bank mode
When you select the Memory Bank mode, rotating
[DIAL] selects only the entered bank channels in the
selected bank.

1. Push [V/M] several times until you enter the
Memory mode.

2. Push [QUICK].

3. Rotate [DIAL] to select “Bank Select,” then push
[J].

14

4. Select a bank, then push [J].

1 4 {Blank)

(Blank) [ ABE

5. Rotate [DIAL] to select a bank channel.

146.010

o ABE

® Only assigned bank channels are selectable.
® To return to the Memory mode, select “OFF” in step
4

Bank Select

-

TIP: After step 5, you can write the displayed content

to the bank channel.

1. After step 5, push [V/M] to enter the VFO mode.

2. Set the frequency, then push [MW].

3. Rotate [DIAL] to select “Write to New CH,” then
push [<J]

14

'.-"‘-.'rlte to Selected CH
Manage Memary

4

146070 & Blank
P ap2

EDIT WRITE BAME

TIP: On the WRITE screen, you can select other

channel by rotating [DIAL].

@ If you select a pre-entered channel, the previous
channel content will be overwritten.

Writing destination E
1 Blank

B06
EDIT WRITE BANK

BAND/BANK ! GPs
P sCan} 7

saL
V/M@N®  MODE MW ___ RX+CS _ MONI _QUICKOIVD
1

O =i

I I I
[«] / [DIAL] [VIM]  [MW] [QUICK]
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Entering a Memory or Bank name

You can enter an alphanumeric name for each
Memory, including Call channels, and Banks.
Names can be a maximum of 16 characters.

< Entering a Memory name
Manage Memory > Memory CH

1. Push [MENU].
Rotate [DIAL] to select “Manage Memory,” then
push [J]. Calling_
/2 — — CLR ab
Dy DUPSTOMNE. . »
B Manage Memary Selectable characters and symbols
48 Sean C AtoZ,atoz, 0to 9, !"#$%& ()*+
« Displays the MANAGE MEMORY screen. ol <=>?2@ [\ {[}" (space)
® You can display the MANAGE MEMORY screen by ® See “Entering and editing text” for details. (p. iv)
pushing [MW] on other than the DR screen. 9. After entering, push [J].
3. Select “Memory CH,” then push [J]. ¥ -
- EMEMORY CH EDIT (@@ EH
MAMNAGE MEMDRY f12 M ARME : Calling b
C FREQUEMNCY $146.010.00 r
Call CH b MODE : FM 8
4. Select “ALL,” then push [J].
EMEMORY CH TOME OFF
BAME th 2
i (Blank)® P ——————
E: (Blank)k .
) * The confirmation dialog “Overwrite?” is displayed.
* Displays the ALL screen. 11. Select <YES>, then push [«J].
5. Rotate [DIAL] to select the Memory channel to
enter a name, then push [QUICK]. Bl Cverwrite? /3|
A5.010  FM
E’IE11 440.000  FM 3
BE2: 146.030  FM 3 » Beeps sound, and writes the entered name to the
channel.
6. Select “Edit,” then push [J].
[MENU]
|
T
7.

FF{EQUEH Y
MO DE L FM

CLR AB

* Enters the name entry mode.

8. Enter a name of up to 16 characters.
(Example: Calling)

I I
[4J]/ [DIAL] [QUICK]
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Entering a Memory or Bank name (Continued)

< Entering a Bank name
Manage Memory > Memory CH [MENU]
1. Push [MENU]. '

Rotate [DIAL] to select “Manage Memory,” then
push [J].

SAND AN =3
® |0 F

)|

V/MX_MODE

Mw

%y DUR/TOME. . 3

Wanaoe Memory I%l
r:4=1_ Iermory “ [‘J]/ [DIAL] [QUICK]

* Displays the MANAGE MEMORY screen.
® You can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.
3. Select “Memory CH,” then push [J].

SMANAGE MEMORY

Memuory CH

Call CH 3

4. Select a bank group to enter a name, then push
[QUICK].

EMEMIORY CH

= BANE NAME

= — CLR AB

* Enters the bank name entry mode.
6. Enter a bank name of up to 16 characters.
(Example: Contest)

= BaMk MaME

Contest

— — CLR ab

Selectable characters and symbols
AtoZ,atoz,0t0 9, !"#$%& ()*+
- l<=>?2@ [\ {]}" (space)
® See “Entering and editing text” for details. (p. iv)
7. After entering, push [J].

= WMEMORY CH

A Contest

B: (Elank)»

* Beeps sound, and writes the entered name to the
bank.
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Selecting a Memory name display

MEMORY OPERATION

The transceiver has two Memory name display types.

1.

w N

&

Push [V/M] several times until you enter the
Memory mode.

Push [QUICK].

Rotate [DIAL] to select “Display Type,” then push
[JI.

L Home CH Set 3

Calling/[MEErRRN=3
Clock

1 4Evoitaqe RB0E

Select the display type, then push [J].
FMl

Freg
Ca"ing Mame

14E Y55 1

* Freq:
Displays the large font sized frequency and small
font sized memory name.

146.010

Calling (1 1555 1

* Name:
Displays large font sized memory name and a
small font sized frequency.
FIA | &3

Calling

146.010 umB60 1

[MENU]
|

¥ GPs

VMENS MODE MW ___ RX+CS __MONI _QUICKEIVD
—eo
]l

[«] / [DIAL] [VIM] [QUIICK]

Clearing a Memory channel

Entered memory content can be cleared.

Manage Memory > Memory CH

1. Push [MENU].
Rotate [DIAL] to select “Manage Memory,” then

push [J].

By DUP/TOME. . 3

B Manage Memory
& Scan 3

* Displays the MANAGE MEMORY screen.
® You can display the MANAGE MEMORY screen by
pushing [MW] on other than the DR screen.
3. Select “Memory CH,” then push [J].

%GE MER ORY

ME
Mermory CH v
Call CH 3
4.
LL
CH (Blank)k
B: (Blank)k

* Displays the ALL screen.
5. Rotate [DIAL] to select the Memory channel to be
cleared, then push [QUICK].

FH
Wil 440,000 FM 3
W2 146,030 FM 3

6. Select “Clear,” then push [J].

o]
BE1: 440, (=T r
A2z 146,

* The confirmation dialog “Clear?” is displayed.
7. Select <YES>, then push [J].

B :

WEz

* Beeps sound, and clears the memory content.
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2  SCAN OPERATION

Scanning is a versatile function that can automatically
search for signals. A scan makes it easier to locate
stations to contact or listen to, or to skip unwanted
channels or frequencies.

< About the scan function

In the VFO mode In the Memory mode
The frequencies that are set as “PSKIP” are skipped Repeatedly scans all entered Memory channels.
during a scan. (p. 2-5, 9-18) The frequencies that are set as skip channels “PSKIP”

and “SKIP” are not scanned. (p. 2-8)
® Two or more Memory channels must be entered to start a
memory scan.

¢ VFO scan <& Memory scan
ALL (Full scan) ALL (Memory full scan)
Repeatedly scans the entire band. Scans all Memory channels.
118 Mz 550 MHz BAND (Selected band memory scan)
! PSKIP_Scan P SKiP ! Scans all Memory channels on the same frequency
N i band as the selected channel.
J
o MODE (Mode memory scan)
BAND (Selected band scan) Scans Memory channels which are entered with
Scans all frequencies over the entire selected band. the same receiving mode as the currently selected
Bandledge Bandledge mode.
P S.KIP Scan P.SKIP
Yo v < Memory bank scan
Jump ALL (Full bank scan)

PROG 0 ~ 24 (Program scan) Scans all banks.

Scans the Program scan edge ranges. BANK-LINK (Bank link scan)
(Scan > Program Scan Edge) (p. 2-9, 9-18) Sequentially scans the banks which are set to link
Band  Lower Higher Band on the MENU screen. (p 9'18)
edge e~ SCRNEUOR8 ~Jreq  ede (Scan > Bank Link)
smp_ " Scan o BANK-A-Z (Bank scan)
L G A Scans the Memory channels in the selected bank.

® At least one Program scan edge range must be

entered to start a Program scan. Duplex (DUP) scan

The Duplex scan searches for both TX and RX
P-LINKO0-9 (Program link scan) frequencies which are used in duplex operation.
Sequentially scans the Program scan edge ranges (p. 8-4) o '
which are set to link on the MENU screen. ® “D-" or “D+" is displayed in the Duplex mode.
(p. 9-19) ® A Duplex scan does not start when the frequency
(Scan > Program Link) offset is set to “0.000 MHz.”

Tone scan

The Tone scan searches for tone frequencies or

DTCS codes that are used by stations using the

Tone Squelch function.

® A Tone scan is usable in any VFO, Memory, or
Call channel mode.

® During a scan, rotate [DIAL] to change the scan
direction.
See “Tone Squelch function” or “DTCS code
Squelch function” for details. (pp. 10-11, 10-12)

2-2
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Scan (Continued)

< [DIAL] operation during a scan

* Rotate [DIAL] to change the scan direction during a
scan.

* When the scan is paused, rotate [DIAL] to resume
the scan.

< Squelch setting for a scan

You can change the squelch level to suit your
operating needs. Set the squelch level to open the
squelch, according to the received signal strength.
During a scan, rotate [SQL] to adjust the squelch
level.

< Tuning step for a VFO scan

The selected tuning step is applied to the scan.
For a Program scan or Program Link scan, set the
tuning step in the Program Scan Edge ranges.

(p. 2-9)

< Skip function
The skip function speeds up scanning by not scanning
those frequencies set as skip channels. (pp. 2-5, 2-8)

TIP: When “Program Skip” is set to OFF, you cannot
use the Scan Skip function. (p. 9-18)
(Scan > Program skip)

< Temporary Skip timer
The Temporary Skip function temporarily skips
unwanted frequencies during a scan, for the set
period of time.
* These settings can be changed on the MENU
screen. (p. 9-18)
(Scan > Temporary Skip Timer)

< Receive mode during a scan
* The VFO scan uses the selected receive mode.
® For a Program scan or Program Link scan, set the
tuning step in the Program Scan Edge ranges. (p. 2-9)
» During a Memory or Bank scan, the mode entered
into the channel is used.

Scanning in the FM mode

1 4€, 775

Displays the scan type

2-3

<& When a signal is received
When a signal is received, the scan pauses for
approximately 10 seconds (default), then resumes.
The scan resumes approximately 2 seconds (default)
after the signal disappears.
To manually resume the scan, rotate [DIAL].
® These settings can be changed on the MENU

screen. (p. 9-18)

(Scan > Pause Timer)

(Scan > Resume Timer)

BLISY

146,775 %W

\ﬁLL/

The S-meter dlsplays the
received signal strength.

< Scan Stop Beep function

The Scan Stop Beep function sounds a beep when a
signal is received.

This function can be turned ON or OFF on the MENU
screen. (p. 9-66)

(Sounds > Scan Stop Beep)

When receiving a signal

146.775

BUSY

- /% Beeps

CALL=
/ N\
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VFO mode scan

1. Push [V/M] several times until you enter the VFO < Scan type
mode. The VFO mode scan has 6 scan types.
2. Hold down [SCAN] for 1 second. e ALL: Full scan
* Opens the Scan Type Select window. « BAND: Band scan
@ If you hold down [SCAN] for 3 seconds, the last « P-LINKO ~ 9: Program link scan
selected scan starts. « POO ~ 24: Program scan
3. Rotate [DIAL] to select a scan type, then push « DUP: ' Duplex scan
[J]. ' ; i
S he scan starts. . (Displayed only when duplex is set.)
- : * TONE: Tone scan
(For the Tone Squelch scanning)
1 4 BAND
P-LINKO FKIF ® The frequencies that are set as a Skip channel (PSKIP)

Po0: T8, 009 - 550, 000 are skipped during a scan. (p. 2-8)
v ® When “Program Skip” is set to “OFF,” the Skip channel

EM B frequencies are not skipped. (p. 9-18)
1 E\ / 5
4 3 :; ;
A

(Scan > Program Skip)

N7

== TIP:
® The decimal point and the selected scan type icon * During a scan, rotating [DIAL] changes the
blink. scanning direction.
® When receiving a signal, the S-meter displays the * During a scan, you can change the operating
received signal strength. band, scan edge, and so on, in the Quick Menu
4. Push [SCAN]. window.
* Cancels the scan. » The scan continuously runs, even if you push

[MENU] or [QUICK] during a scan.

* You can set the tuning step and the operating
mode used for a Program scan or Program Link
scan. (p. 2-9)

* The transceiver can receive on the AIR, 144 MHz,
230 MHz, 300 MHz, and 430 MHz bands.*
*Selectable band differs, depending on the transceiver’s

version.
® You can transmit on only the amateur band
frequencies.

MR,

S5 | PADEANK
<
[

oo

oo

,—“0 ooo
[SCAN] k I
[« S

[DIAL] [V/IM] [QUICK]

*The key operation may differ,
depending on the operating status.

2-4
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VFO mode scan (Continued)

< About a Scan name < Setting the skip frequencies

When a Scan name is assigned, the name is You can set unnecessary frequencies as Skip
displayed in the Scan Type Select window. (p. 2-4) channels (PSKIP) to be skipped during a scan. The
® The Scan name is not displayed during a scan. Skip function speeds up a scan.

® See page 2-9 to enter the scan name.
1. Start the VFO scan.
When the Scan name is assigned « When a signal is received, the scan pauses.
2. Push [QUICK].
3. Rotate [DIAL] to select “SKIP.”

sk FM MHz BLISY

o= | Scan name 1 s N %

— = Asrc'/x/

When the Scan name is not assigned DTMF T - J}LI\.:J
Fl

« Sets the frequency as a Skip channel into empty
Memory channel 999.

. ; ARE * The entered Memory channel number blinks.

P 175, OO0~ 550, 0 <=ooo— Scan edges ® If channel 999 already has content, the transceiver
automatically searches for another blank channel to
use. If there is no blank channel, a beep sounds, and
the frequency is not set as a Skip channel.

4. After setting, the scan resumes.

< About a Program Link name

When a Program Link name is assigned, the name is
displayed in the Scan Type Select window. (p. 2-4)
® The Program Link name is not displayed during a scan.
® See page 2-9 to enter the program link name.

TIP: Once frequencies are set as a Skip channel,
these frequencies are skipped until clearing the skip
setting. To clear the skip setting, see page 2-8 for

When the Program Link name is assignhed details.

FI
m ® The skip setting is also cleared when the Memory
1 4 BAMD _ ] channel set as a Skip channel is cleared. (p. 1-12)
P-L0O: Scan link & < — Program
FOO: 118, 000 - 550. 000 || @AY I Link name

When the Program Link name is not assigned

BAMD
Program link
POz 118, 000 - 550, 000 | | l

P-LIMKD <

FSKIF

2-5
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Memory scan

NOTE: Two or more Memory channels, which are
not set as Skip channels, must be entered to start a
Memory scan.

1. Push [V/M] several times until you enter the
Memory mode.

2. Hold down [SCAN] for 1 second.
* Opens the Scan Type Select window.
® If you hold down [SCAN] for 3 seconds, the last

selected scan starts.

3. Rotate [DIAL] to select a scan type, then push
[J].
* The scan starts.
F

14

@B[a5

v

146030

— m@a5
/ \

® The decimal point and [N blink.
® When receiving a signal, the S-meter displays the
received signal strength.
4. Push [SCAN].
+ Cancels the scan.

& | *5 ¥ GPs
@
[SCAN] > T
[T &%L ST

[DIAL] [ViM]

*The key operation may differ,
depending on the operating status.

2-6

< Scan type
The Memory mode scan has 5 scan types.
*ALL:  Full scan
* BAND: Band Memory scan
* MODE: Mode Memory scan
* DUP: Duplex scan
(Displayed only when duplex is set.)
* TONE: Tone scan
(For the Tone squelch scanning)

® When two or more Memory channels, which are not
set as Skip channels, are entered, the Memory scan is
usable.

® The channels that are set as a Skip channel (PSKIP or
SKIP) are skipped during a scan. (p. 2-8)

TIP:

» During a scan, rotating [DIAL] changes the
scanning direction.

» The scan continuously runs, even if you push
[MENU] or [QUICK] during a scan.
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Memory Bank scan

A Memory Bank scan searches through the Memory

channels in the selected bank.

® Two or more Memory channels, which are not set as skip
channels, must be entered to start a Memory Bank scan.

(p. 1-8)

1. Push [V/M] several times until you enter the
Memory mode.

Push [QUICK].

Rotate [DIAL] to select “Bank Select,” then push
[J].
Fli

1 4 F.15]518)

4, Select a bank to be scanned, then push [J].
(Blank)

1 4 OFF
(Elank) | |mBEE

5. Hold down [SCAN] for 1 second.
* Opens the Scan Type Select window.
@ If you hold down [SCAN] for 3 seconds, the last
selected scan starts.
6. Rotate [DIAL] to select a scan type, then push

RIS

Bank Select

[J].
* The scan starts.
i ALL

AL
1 4 BANK-LINE

BAMK-A

TOME

146,030

® The decimal point and T blink.
® When receiving a signal, the S-meter displays the
received signal strength.
7. Push [SCAN].
+ Cancels the scan.

@A

lm]BuﬂE 1

saL
RX+CS __MONI _QUICKQV

[SCAN]
[T

Mw

> .
[DIAL] J [ViM]

*The key operation may differ,
depending on the operating status.

[QUICK]

2-7

< Scan type

* ALL: Full bank scan

* BANK-LINK: Bank link scan

* BANK-A ~ Z: Bank scan
(Displays only banks which contain a
Memory channel.)

* DUP: Duplex scan
(Displayed only when duplex is set on
the channel.)

* TONE: Tone scan (For tone scanning)

® When all channels are set as “SKIP” or “PSKIP,” the bank
is skipped during a Bank Link scan. (p. 2-8)

® When all channels in the selected bank are set as “SKIP”
or “PSKIP,” the scan does not start.

® When two or more Memory channels, which are not set
as Skip channels, are entered in a bank, the Memory
bank scan is usable. (p. 2-7)

TIP:

* During a scan, rotating [DIAL] changes the
scanning direction.

» The scan continuously runs, even if you push
[MENU] or [QUICK] during a scan.

+ During a scan, you can change the bank to be
scanned on the Quick Menu window.

< About a Bank name

When a Bank name is assigned, the name is
displayed on the Scan Type Select window.
® The scan name is not displayed during a scan.
® See page 1-11 to enter the Bank name.

When the Bank name is assigned

1 43:% LINK J—]

TONE -Lummala |

Bank name

When the Bank name is not assigned

1 43:% LINK J—]

TONE -Lummala |

Bank initial
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Setting and clearing the skip channel

You can set or clear a Skip channel setting.
The channels that are set as a Skip channel are
skipped during a scan.

1. Push [V/M] several times until you enter the
Memory mode.
2. Rotate [DIAL] to select the Memory channel.

146.030

o B83

3. Push [QUICK].
4. Rotate [DIAL] to select “SKIP,” then push [J].

B TS ,
1 4 : l
DTMF T 2
Yoice TH HmBER3

5. Select the option, then push [J].
* OFF: Cancel the skip setting.
» SKIP: Skipped during a memory scan.
» PSKIP: Skipped during both VFO and memory

FM1 4 :SFKFIP 8683 1
Frd vl-i- .
146.035 _

* When a Skip channel is set, “SKIP” or “PSKIP” is
displayed.

TIP: To clear the skip channel setting
To clear the skip channel setting, select “OFF” in
step 5, then push [J].

[DIAL] [V/IM] [QUICK]

2-8
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Entering scan edges

You can enter the upper and lower frequency edges to

the Program scan edge ranges for Program scans.
Each Program scan edge range has its own tuning
step and the receive mode.

The default setting is differ, depending on the
transceiver version.

You can enter a total of up to 25 Program scan edge

ranges.

Scan > Program Scan Edge

1. Push [MENU].
Rotate [DIAL] to select “Scan,” then push [J].

Ty DUPYTOME. »
B Manage Memory 3

* Displays the SCAN screen.
3. Select “Program Scan Edge,” then push [J].

F' ragram Skip
Bank Link »
Prograrm Scan Edge »

4.

5. Push [QUICK].

6. Select “Edlt ” then push [J].

7.
E PROGRAM SCAN EDGE e

3

FREQUEMCY: - 3
TS HE »

= MAME

= — LR 4B

* Enter the name entry mode.

8.

10.

1.

12.

13.

2-9

Enter a name of up to 16 characters, then push
[J]. (Example: Air)
E MAME

DAr 3
FREQUENCY = 3
T3 3

Selectable characters and symbols
AtoZ,atoz,0t0 9, !"#$%& ()*+
ol <=>?2@ V] {1} (space)
® See “Entering and editing text” for details. (p. iv)

Select “FREQUENCY,” then push [4J]
£ PROGRAM SCAN EDGE :
MAME DALY i—ﬂ

FRECIUEMNCY:
TS 3 == 4

Rotate [DIAL] to set a lower frequency, then push
[«J]. (Example: 118000)

EFRECILEMNCY

112,000

— —

® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

Set a higher frequency, then push [J].

(Example: 136000)

EFREQLEMNCY

112,000 -136.000

— —

Select “TS,” then push [J].

= PROGRAM SCAN EDGE

MAME DAIr

b
FREQLIENCY: 118,000 - 136, 000 3
. - b

« Displays the selectable tuning step.
Select the tuning step to be used during a scan.

® When you select “---,” the tuning step set in the VFO
mode is used during a scan.

= Continued on the next page



Previous view

2  SCAN OPERATION

Entering scan edges (Continued)

14. Select “MODE,” then push [J].
E PROGRAM SCAN EDGE

<zl itex> M

* Displays the selectable mode.
15. Select the receive mode to be used during a scan.

AM-M

® When you select “---,” the receive mode set in the
VFO mode is used during a scan.
16. Select “<<Write>>,” then push [J].
EPROGRAM SC i,z
MODE L AN 3

* The confirmation dialog “Write?” is displayed.
17. Select <YES>, then push [J].

» Beeps sound, and automatically writes into the
selected scan edge channel.
* Returns to the PROGRAM SCAN EDGE screen.

2-10
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3 PRIORITY WATCH

Priority watch

While operating on a VFO frequency, using the DR
function or while scanning, Priority watch checks for
signals on a selected frequency every 5 seconds.

< Starting the Priority watch

To start the Priority watch, select “ON” or “Bell,” as

described below.

1. Push [QUICK].

2. Rotate [DIAL] to select “PRIO Watch,” then push
[J].

GPS Infarmatian

FM
1 d GPS Position
Weather Information

3. Select an option, then push [J].

* ON: Starts Priority Watch.
When a signal is received on the Priority
channel, the channel is automatically
selected.

* Bell: Starts Priority Watch.
When a signal is received on the Priority
channel, the “((+)) ” icon blinks.

FEEIF

866

FM‘I d Bell »
F ® vm |
146.010 »

* “P” is displayed, and the Priority watch starts.

3-2

< Canceling the Priority watch

1. Push [QUICK].

2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [J].

GPS Infarmatian

FM
1 d GPS Position
Weather Information

PRID Watch OFF

FEEIF

886

 “P” disappears, and the Priority watch is canceled.
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3 PRIORITY WATCH

VFO frequency and a Priority channel

Checks the selected Priority channel every 5 seconds,
while receiving on a VFO frequency.

Step 1. Set the VFO frequency
(See Basic manual section 3)

1. Push [V/M] several times until you enter the VFO
mode.

2. Set the receive frequency and mode you want to
monitor.

Step 2. Set the Priority channel

To select a Memory channel (p. 1-4)

1. Push [V/M] to enter the Memory mode.

2. Rotate [DIAL] to select the Memory channel you
want to monitor.

To select a Bank channel (p. 1-9)

1. Push [V/M] to enter the Memory mode.

2. Push [QUICK].

3. Rotate [DIAL] to select “Bank Select,” then push [J].

4. Rotate [DIAL] to select the Bank channel you want
to monitor.

To select a Call channel (p. 1-4)

1. Hold down [CALL] for 1 second to enter the Call
channel mode.

2. Rotate [DIAL] to select the Call channel you want
to monitor.

Step 3. Starts the Priority watch (p. 3-2)

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch,” then push

[J].
3. Select the Priority watch option, then push [J].
» “P” is displayed, and the Priority watch starts.

Example: Checks Memory channel “002” while
receiving on 146.010 MHz.

146010

() Priority channel

146.030 |

Checks Memory channel “002”
every 5 seconds.

3-3

VFO Priority
frequency channel

Receiving
(5 seconds)

Step 4. Canceling the Priority watch (p. 3-2)

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then

push [J].
« “P” disappears, and the Priority watch is canceled.

<& When a signal is received

When “ON” is selected.

When a signal is received on the Priority channel, the

channel is automatically selected.

* The “P” icon blinks.

® The scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

146,030

()

BLISY

NP2

/ —_—
B2 =
\
Automatically selects
the Priority channel.

When “Bell” is selected.

When a signal is received on the Priority channel, the
display remains in the VFO mode.

* A beep sounds and the “((+)) ” icon blinks.

148010

Remains in the VFO mode.

FSEIF

|
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3 PRIORITY WATCH

VFO frequency and a Memory/Bank scan

Sequentially checks the Memory or Bank channels
every 5 seconds, while receiving on a VFO frequency.

Step 1. Set the VFO frequency
(See Basic manual section 3)

1. Push [V/M] several times until you enter the VFO
mode.

2. Set the receive frequency and mode you want to
monitor.

Step 2. Start a Memory or Bank scan

To start a Memory scan (p. 2-6)

1. Push [V/M] to enter the Memory mode.

2. Hold down [SCAN] for 1 second.
* Opens the Scan Type Select window.

3. Rotate [DIAL] to select a scan type, then push
[J].

* The scan starts.

To start a Bank scan (p. 2-7)
Push [V/M] to enter the Memory mode.
Push [QUICK].

Select a bank to be scanned, then push [J].
Hold down [SCAN] for 1 second.

* Opens the Scan Type Select window.

Rotate [DIAL] to select a scan type, then push
[J].

* The scan starts.

aoroN=

o

Step 3. Starts the Priority watch (p. 3-2)

Rotate [DIAL] to select “Bank Select,” then push [J].

1. Push [QUICK].

2. Rotate [DIAL] to select “PRIO Watch,” then push [J].

3. Select the Priority watch option, then push [J].
* “P” is displayed, and the Priority watch starts.

Example: Sequentially checks the Memory channels
while receiving on 146.010 MHz.

146.010

()
440.000

Checks the Memory channels every 5 seconds.

The Memory channels
are sequentially checked.

3-4

N0

M-CH

Receiving
(5 seconds)

Receiving

(5 seconds) sl

When using a
Memory scan

When using a
Bank scan

Step 4. Canceling the Priority watch (p. 3-2)

1. Push [QUICK].

2. Rotate [DIAL] to select “PRIO Watch OFF,” then
push [J].
« “P” disappears, and the Priority watch is canceled.
® The Memory or Bank scan is also canceled.

< When a signal is received

When “ON” is selected.

When a signal is received on the Priority channel, the

channel is automatically selected.

* The “P” icon blinks.

® The scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

440,000

Automatically selects
the Priority channel.

EUSY

\ 7/
= -
ABE1 =

/ \

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains in the VFO mode.
« A beep sounds and the “((+)) " icon blinks.
\/
@z

146.010

Remains in the VFO mode.

iTif 1
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3 PRIORITY WATCH

VFO scan and a Priority channel

Checks the selected Priority channel every 5 seconds,
during a VFO mode scan.

Step 1. Set the Priority channel

Priority
channel
Scan

(5 seconds)

Step 4. Canceling the Priority watch (p. 3-2)

To select a Memory channel (p. 1-4)

1. Push [V/M] to enter the Memory mode.

2. Rotate [DIAL] to select the Memory channel you
want to monitor.

To select a Bank channel (p. 1-9)

1. Push [V/M] to enter the Memory mode.

2. Push [QUICK].

3. Rotate [DIAL] to select “Bank Select,” then push
[J].

4. Rotate [DIAL] to select the Bank channel you want
to monitor.

To select a Call channel (p. 1-4)

1. Hold down [CALL] for 1 second to enter the Call
channel mode.

2. Rotate [DIAL] to select the Call channel you want
to monitor.

Step 2. Starts the Priority watch (p. 3-2)

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch,” then push [J].

3. Select the Priority watch option, then push [J].
* “P” is displayed, and the Priority watch starts.

Step 3. Starts the VFO scan (p. 2-4)

1. In the VFO mode, hold down [SCAN] for 1 second.
* Opens the Scan Type Select window.
2. Rotate [DIAL] to select a scan type, then push

[].

* The scan starts.

Example: Checks Memory channel “002” during a VFO
mode scan.

1468775

()

146.030 |

Checks Memory channel “002”
every 5 seconds.

AN

ZEL

N T
[
.

3-5

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then

push [J].
 “P” disappears, and the Priority watch is canceled.

<& When a signal is received

When “ON” is selected.

When a signal is received on the Priority channel, the

channel is automatically selected.

» The “P” icon blinks.

® The scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

\\I/
Fu > < | L2
/a\
146.030 .1
o B8 |
/ \

Automatically selects the Priority channel.

BLISY

When “Bell” is selected.

When a signal is received on the Priority channel, the
display remains in the VFO mode.

« A beep sounds and the “((+)) ” icon blinks.

\ 7/
F S [ L3
/a\
1 E\ I/ 5
I > 1 \; :
1\ ~

Remains in the VFO mode.

AN

skt 1

1
—

N -
[
-
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3 PRIORITY WATCH

VFO scan and a Memory/Bank scan

Sequentially checks the Memory or Bank channels
every 5 seconds during a VFO mode scan.
A Memory scan or Bank scan can be selected.

Step 1. Start a Memory or Bank scan

Scan
(5 seconds) Bank CH

Scan
(5 seconds)

When using VFO scan
and a Memory scan

When using VFO scan
and a Bank scan

Step 4. Canceling the Priority watch (p. 3-2)

To start a Memory scan (p. 2-6)

1. Push [V/M] to enter the Memory mode.

2. Hold down [SCAN] for 1 second.
* Opens the Scan Type Select window.

3. Rotate [DIAL] to select a scan type, then push
[J].

* The scan starts.

To start a Bank scan (p. 2-7)

Push [V/M] to enter the Memory mode.

Push [QUICK].

Rotate [DIAL] to select “Bank Select,” then push [J].
Select a bank to be scanned, then push [J].

Hold down [SCAN] for 1 second.

* Opens the Scan Type Select window.

Rotate [DIAL] to select a scan type, then push [J].
* The scan starts.

aoroN-=

o

Step 2. Starts the Priority watch (p. 3-2)

1. Push [QUICK].

2. Rotate [DIAL] to select “PRIO Watch,” then push [J].

3. Select the Priority watch option, then push [J].
« “P” is displayed, and the Priority watch starts.

Step 3. Starts the VFO scan (p. 2-4)

1. In the VFO mode, hold down [SCAN] for 1 second.
* Opens the Scan Type Select window.
2. Rotate [DIAL] to select a scan type, then push

[J].

* The scan starts.
Example: Sequentially checks the Memory channels
while VFO scanning.

146,775

()

146.030 |

Sequentially checks the Memory
channels every 5 seconds.

SN

SKY

N e
[ -
e

3-6

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then

push [J].
« “P” disappears, and the Priority watch is canceled.

<& When a signal is received

When “ON” is selected.

When a signal is received on the Priority channel, the

channel is automatically selected.

* The “P” icon blinks.

® The scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

146030

Automatically selects the Priority channel.

BLSY
\ 7/

— Gl
/ N\

When “Bell” is selected.
When a signal is received on the Priority channel, the
display remains in the VFO mode.
+ A beep sounds and the “((+)) " icon blinks.
St
\

148,775

Remains in the VFO mode.

-/
AN

ske 1

1
-~

N
—
.



Previous view

3 PRIORITY WATCH

Scanning “FROM” on the DR screen and a Priority channel

Checks the selected Priority channel every 5 seconds,
while receiving a repeater or simplex frequency in
“FROM” of the DR screen.

Step 1. Set the Priority channel

To set the VFO frequency

(See Basic manual section 3)

1. Push [V/M] several times until you enter the VFO
mode.

2. Set the receive frequency and mode you want to
monitor.

To select a Memory channel (p. 1-4)

1. Push [V/M] several times until you enter the
Memory mode.

2. Rotate [DIAL] to select the Memory channel you
want to monitor.

To select a Bank channel (p. 1-9)

1. Push [V/M] several times until you enter the
Memory mode.

2. Push [QUICK].

3. Rotate [DIAL] to select “Bank Select,” then push
[J].

4. Rotate [DIAL] to select the Bank channel you want
to monitor.

To select a Call channel (p. 1-4)

1. Hold down [CALL] for 1 second to enter the Call
channel mode.

2. Rotate [DIAL] to select the Call channel you want
to monitor.

Step 2. Select the repeater or simplex frequency in
the DR screen (p. 4-3, D-STAR guide)

1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “FROM,” then push [J].
* Displays the FROM SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select a repeater or a simplex
frequency.

Step 3. Starts the Priority watch (p. 3-2)

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch,” then push [J].
3. Select the Priority watch option, then push [J].

* “P” is displayed, and the Priority watch starts.

3-7

“From” Priority
(DR screen) channel
Receiving (Frequency/
(5 seconds) Channel)

Example: Checks Memory channel “002” every 5
seconds while receiving on a repeater

frequency.
DY [ (T3
TOAM Ha malgln
g Hirano
439.390 JPEYHH &

()

146.030 |

Checks Memory channel “002”
every 5 seconds.

Step 4. Canceling the Priority watch (p. 3-2)

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then

push [J].
« “P” disappears, and the Priority watch is canceled.

< When a signal is received

When “ON” is selected.

When a signal is received on the Priority channel, the

channel is automatically selected.

* The “P” icon blinks.

® The scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

N/
Fhl SIEE | T3
/a\
146.030 .1
o B8 |
/ \

Automatically selects the Priority channel.

BLISY

When “Bell” is selected.

When a signal is received on the Priority channel, the
display remains on the DR screen.

* A beep sounds and the “((+)) " icon blinks.

\/
DY D- S -

TOARE Hamdlho

Hirano
439,390

Remains on the DR screen.

JPEYHH &
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DR scan and a Priority channel

Checks the selected Priority channel every 5 seconds,
during a DR scan.

Step 1. Set the Priority channel

To set the VFO frequency

(See Basic manual section 3)

1. Push [V/M] several times until you enter the VFO
mode.

2. Set the receive frequency and mode you want to
monitor.

To select a Memory channel (p. 1-4)

1. Push [V/M] several times until you enter the
Memory mode.

2. Rotate [DIAL] to select the Memory channel you
want to monitor.

To select a Bank channel (p. 1-9)

1. Push [V/M] several times until you enter the
Memory mode.

2. Push [QUICK].

3. Rotate [DIAL] to select “Bank Select,” then push
[J].

4. Rotate [DIAL] to select the Bank channel you want
to monitor.

To select a Call channel (p. 1-4)

1. Hold down [CALL] for 1 second to enter the Call
channel mode.

2. Rotate [DIAL] to select the Call channel you want
to monitor.

Step 2. Start the DR scan (p. 4-5)

1. Hold down [DR] for 1 second to display the DR
screen.

2. Hold down [SCAN] for 1 second.
* Displays the DR scan setting window.

3. Rotate [DIAL] to select the scan type, then push
[J].

* The selected scan starts.

Step 3. Starts the Priority watch (p. 3-2)

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch,” then push [J].
3. Select the Priority watch option, then push [J].

* “P” is displayed, and the Priority watch starts.

3-8

Priority
channel
Scan
(5 seconds)

Example: Checks Memory channel “002” every 5
seconds during a DR scan.

D¥F - (7] [ B2
T{?'EE/’B Hamacho

sHirano
% 2 \\439.390 JPSYHH &

()

146.030

Checks Memory channel “002”
every 5 seconds.

Step 4. Canceling the Priority watch (p. 3-2)

1. Push [QUICK].
2. Rotate [DIAL] to select “PRIO Watch OFF,” then

push [J].
« “P” disappears, and the Priority watch is canceled.

< When a signal is received

When “ON” is selected.

When a signal is received on the Priority channel, the

channel is automatically selected.

* The “P” icon blinks.

® The scan pause timer and resume settings are the same
as those for a normal scan. (p. 9-18)

N/
Fhl SIEE | T3
/a\
146.030 .1
o B8 |
/ \

Automatically selects the Priority channel.

BLISY

When “Bell” is selected.

When a signal is received on the Priority channel, the
display remains on the DR screen.

* A beep sounds and the “((+)) " icon blinks.

\\ I/
{1

DY [-— | T3
Tili-?é}% Hamd4dtho
S Hirano

155,590 IPSYHH &

e
/N
Remains on the DR screen.
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= Continued on the next page

4-1



Previous view

(Continued)
Skip setting for the DR scan.........ccccooiiiiiie 4-40
< Individual skip setting.........ccoocieiiiiiin 4-40
<O Group skip setting......ccoevieeeiiiiii 4-40
Entering the repeater group name............coooociiiiiieneneeennn. 4-41
Repeater detail screen ..., 4-42
Entering Your (destination) call sign............ccccccvvviveereneeennn. 4-43
Deleting Your (destination) call Sign ..........cccccceveviiieeeeennnen. 4-44
Rearranging the display order of Your (destination) call signs . 4-45
Your setting is COMect? ..o, 4-46
IMPORTANT!

* The repeater list, described in this manual, may differ from your transceiver’s preloaded contents.
* Although Japanese repeaters are used in the setting examples, the Japanese repeater node (port) letters are
different from other country’s.
Be sure to add the repeater node letter in the 8th digit of the call sign, according to the frequency band shown
below.
1200 MHz : A (B in Japan)
430 MHz : B (Ain Japan)
144 MHz : C (no D-STAR repeaters in Japan)

To begin digital mode communication using other than the D-STAR Repeater (DR) function

To begin the digital mode communication using other For a Local area call or Gateway call:

than the DR function, you can use the VFO mode, 1. Set the access repeater’s frequency. (p. 8-2)
Memory mode or Call channel mode. 2. Set the Duplex direction. (p. 8-4)

This manual description focuses on the DR function 3. Set the frequency offset for the Duplex operation.
operation which can be set up easily. If you want to (p. 8-4)

use other than the DR function, see the procedures 4. Set the call signs (UR/R1/R2). (p. 9-41)

as described to the right, or select the repeater in a

memory channel. For a Simplex call:

1. Set the operating frequency.
2. Set the UR call sign (for call sign squelch).
(p. 9-41)
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4 D-STAR OPERATION

“FROM” (Access repeater) setting

Your access repeater must be set in “FROM” when
you make a call on the DR screen.
You have five ways to set the access repeater.

Setting by [DIAL]
i oY D-
Select the preset repeater by rotating [DIAL] on the DR screen. e cacac:
FROM Hirano
435.350 JPEYHH &

-
<—Displayed
while rotating
[DIAL]

i

* When you know your access repeater

From the repeater list (p. 4-4)
You can select your access repeater from the repeater list by
selecting the repeater area and name, if entered, or call sign. Repeater List

Mear Repeater
TX History

* When you do not know which repeater you can access.

Search for a repeater using the DR scan (p. 4-5) oY Do
The Normal DR scan searches for output repeater frequencies of TOARE O
nearby repeaters. The scan will stop when a signal is detected.
» The scan will also stop on simplex signals.

Marmal
Mear Repeater (ALL)
Hi[MNear Repeater (DW)
45 Mear Repeater (FM)

|

Scan items

The Near Repeater scan searches for output repeater frequencies of nearby repeaters that are within 160
kilometer (99.4 miles) from your location and the repeater’s location that is entered in the Repeater List. The
DR scan starts scanning and will stop when a signal is detected.

You can also find only FM repeaters using the Near Repeater (FM) scan.

Search for near repeaters (p. 4-6)

Searches for near repeaters that are within 160 kilometer S FROM SELECT
(99.4 miles) from your location using your GPS location and the Reneater | it »
repeater’s location that is entered in the Repeater List. Mear Repeater

The nearest repeaters in your transceiver’'s Repeater List are I# History r

displayed as selectable choices.

You can select the nearby DV only, FM only, or both repeater types.

* When the “FROM?” data is saved in the TX History.

Setting from the TX History (p. 4-7) I
Select a repeater that you have accessed before from the TX = FROM SELECT
History record. Repeater List

Mear Repeater

4-3
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“FROM” (Access repeater) setting (Continued)

< Using your transceiver’s repeater list
When your access repeater is in your transceiver’s
repeater list, you can select it from the list. By only
selecting the repeater from the list, the call sign,
frequency, duplex and offset frequency settings are
automatically set for easy operation.

Example: Selecting the “Hirano” repeater in Japan
from the repeater list.

1. Hold down [DR] for 1 second to display the DR
screen.

2. Select “FROM,” then push [J].
* Displays the FROM SELECT screen.
® On the DR screen, pushing [DR] toggles between

“FROM” and “TO.”
3. Rotate [DIAL] to select “Repeater List,” then push

Fepeater Lizt
Mear Repeater r
Tx History r

+ Displays the REPEATER GROUP screen.

4. Select the repeater group where your access
repeater is listed, then push [J].
(Example: “11: Japan”)

E REFPEATER GROUP

10z ltaly

12: Latin America

5. Select your access repeater, then push [J].
(Example: “Hirano”)

Osaka
Sugamo JF2YHH A

* Returns to the DR screen, and the selected repeater
name is displayed in “FROM.”

DY D-— B

TOSRE COCOCO

Hirano 1

439,390

JFSYHH &

® The repeater list, described in this manual, may
differ from your transceiver’s preloaded contents.
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TIP:

When you select an FM repeater:

When an FM repeater is in your transceiver’s
repeater list, you can select it from the list.

When selecting an FM repeater, the “TO” setting is
not necessary and a “---” is displayed in “TO.”

When selecting an FM repeater.
- TOME B-#

FrA

Icom repeater
439,520 IR3VE

(Sample)

How to change the repeater group:
To change the repeater

Group Select

grOUp on the DR screen, Repeater Dietail
push [QUICK], then select T Power 3
DTMF T *

“Group Select.”
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D-STAR OPERATION

“‘FROM?” (Access repeater) setting (Continued)
< Using the DR scan

The DR scan scans frequencies to find a signal on a
repeater or a simplex frequency.

You can use two kinds of DR scans, Normal scan and
Near Repeater scan.

Normal scan
To quickly find a repeater, the Normal scan skips

repeaters that are not specified as an access repeater.

(The “USE (FROM)” setting is set to “NO” (SKIP is
set) on the repeater list.)

Near Repeater scan

The Near Repeater scan searches for up to 20 nearby

repeaters by using your location and the repeater’s

entered location, and then lists the repeaters.

® The Near Repeater scan will continue, even if you
turn OFF the power, and then turn it ON again
during the scan.

® If your own position is not being received, the last
received position is used.

NOTE: Even if your transceiver receives a repeater
signal, the repeater may not receive your signal,
because the repeater’s output power is higher than
your transceiver’s, and your signal doesn't reach the
repeater.

TIP: The DR scan scans the simplex frequencies in
the repeater list, in addition to a D-STAR repeaters.
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Example: Selecting the “HamFair” repeater in Japan

1.

2.

using the DR scan.
Hold down [DR] for 1 second to display the DR
screen.

Hold down [SCAN] for 1 second.
* Displays the DR scan setting window.
[')I'I‘:) 28,5 _':( Moarrnal ]
MNear Repeater (ALL) DR scan
RO Hi| Mear Repeater (D) setting window
43| Mear Repeater [FRA) %
Rotate [DIAL] to select the scan type.
* Normal:
Searches for repeaters whose “USE (FROM)”
setting is set to “YES.”
* Near Repeater (ALL):
Searches for up to 20 nearby DV or FM
repeaters. (Total 40 repeaters)
* Near Repeater (DV):
Searches for up to 20 nearby DV repeaters.
* Near Repeater (FM):
Searches for up to 20 nearby FM repeaters.
Push [J].
* The selected scan starts.
D D | £
TOERR COCOCO |
— HamFair < The repeaters
WA\ #4250 JR1vI) A are sequentially
. . displayed.
While DR scanning
® While DR scanning, the repeaters are sequentially
displayed.
® The scan resumes the same as other scans.
(p. 9-18)
When the transceiver receives a signal from a
repeater, the scan stops.
LY D- - BLISY
TOAR COCQCT
HamFair %
439250 JP1vIL &
Push [SCAN].

» The DR scan is canceled, and the repeater is set to
“FROM.”
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“FROM” (Access repeater) setting (Continued)

< Using the Near Repeater Search function

The transceiver searches for the nearest repeater
by using your location and the repeater’s entered

Step 2: Selecting the access repeater from the

Near Repeater list

position. 1.
The nearest repeater in your transceiver’s repeater list

is displayed as the available choices. 2.
NOTE:

» When using the Repeater Search function, be sure

to first receive your own position data, or manually 3.

enter your position data.

* If no repeater is found within a 160 kilometer range,
“No Repeater Found” will be displayed.

« If the last received position can be used, “GPS
is invalid. Search by last valid position” will be
displayed.

Example: Selecting the “lcom Repeater” in Japan
from the Near Repeater list.

Step 1: Receiving your own position from the GPS
satellite

® When it is difficult to receive signals indoors, even
if you are near a window, try going outdoors for
better reception.

Confirm the GPS receiver is receiving your position.
» The GPS icon blinks when searching for satellites.

T Y T

* The GPS icon stops blinking when the minimum needed
number of satellites is found.

o

@ It may take only a few seconds to receive, or it may take
a few minutes, depending on your operating environment.

@ If your own position is not being received, the last
received position is used.
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Hold down [DR] for 1 second to display the DR

screen.

Select “FROM,” then push [J].

* Displays the FROM SELECT screen.

® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

Select “Near Repeater,” then push [J].

EFROM SELECT

12
Repeater List 4
Mear Repeater 4

3

TH History

* Displays the NEAR REPEATER screen.

Select the type of nearby repeater to display, then
push [J].

E MEAFR REFPEATER

1
Mear Repeater (ALL) »
MNear Repeater (D) k
MNear Repeater (FI) »

* Near Repeater (ALL):
Displays up to 20 nearby DV and FM repeaters.
(A total 40 repeaters)

* Near Repeater (DV):
Displays up to 20 nearby DV repeaters.

* Near Repeater (FM):

Displays up to 20 nearby FM repeaters.
Select the repeater to select it as your access
repeater, considering the distance from your
position to the repeater, then push [J].
(Example: “Icom Repeater”)

= NEAR REPEATER iALL)

JRZYE «— Repeater

@ call sign.

Displayed for Distance and direction
FM repeaters from your position to
the repeater*

Hirana

lcorn Repeater ﬂ Dszaka

* Returns to the DR screen, and the selected repeater is
set in “FROM.”

*When the position data accuracy level is set to
“Approximate,” the direction data is not displayed if the
distance to the repeater is less than 5 kilometers.

(p. 4-36)



Previous view

4 D-STAR OPERATION

“‘FROM?” (Access repeater) setting (Continued)

< Using the TX History

Repeaters you transmitted on before are saved in
the TX History. You can select a repeater from the TX
History as your access repeater.

The TX History saves up to 10 of the latest “FROM”
(Access) repeaters.

Example: Selecting the “Hirano” repeater in Japan
from the TX History.

1. Hold down [DR] for 1 second to display the DR
screen.

2. Select “FROM,” then push [J].
* Displays the FROM SELECT screen.
® On the DR screen, pushing [DR] toggles between

“FROM” and “TO.”
3. Rotate [DIAL] to select “TX History,” then push

[F].

EFROM SELECT

Repeater Lizt r
MNear Repeater r

* Displays the TX HISTORY screen.
4. Select the TX history, then push [J].

: STORY 141 E
T Histary (D0
T Histary (FR) y

» TX History (DV): Displays the TX history of the
DV repeaters.
» TX History (FM): Displays the TX history of the
FM repeaters.
5. Select the repeater to use as your access
repeater, then push [J]. (Example: “Hirano”)

ETH HISTORY (DV)

Hamacho Czaka
IP3YHH A
oY D- -

TOERE COCOCO

Hirano
439.390 JPEYHH &

* Returns to the DR screen, and the selected repeater is
set in “FROM.”

TIP: When you push [QU|CK]

in step 5, you can display Delete
the REPEATER DETAIL Delete All
screen, or delete the repeater
information from the TX
HISTORY screen.
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4 D-STAR OPERATION

“TO” (Destination) setting

The destination repeater or station must be set in “TO” TIP: After you receive the individual station or

when you make a call in the DV mode. repeater’s signal, the call sign can be captured by

You have eight ways to set the destination. holding down the Call Sign Capture key ([RX—CS]),
and you can quickly and easily reply to a call.

Setting by rotating [DIAL]
Rotate [DIAL] to select the repeater or Your Call

Sign that is displayed on the DR screen. (This
operation is disabled when “CQCQCQ" is set.)

:I'o make a Local Area CQ call TO SELECT screen

“Local CQ” setting (p. 4-9)
Set “CQCAQCQ" in “TO” (Destination).

Gateway CO k
Your Call Sign k

To make a Gateway CQ call

“Gateway CQ” setting (p. 4-9)
Select a repeater from the repeater list, if you want
to make a Gateway call.

TIP: How to change the
repeater group:

When “Local CQ” or “Gateway
CQ’ is selected, you can change
the repeater group.

To change the repeater group on
the DR screen, push [QUICK],
To make a call through a reflector then select “Group Select.”

-

To make a call to a specific station

“Your Call Sign” setting (p. 4-10)
Select the station call sign in the Your Call Sign
memory.

“Reflector” setting (p. 4-12)
Select a reflector you want to call through.

To select from RX History

Setting from RX History (p. 4-10)
When you receive a call, the repeater or caller
station data is saved in RX History.
You can select the destination from the record.

@R History »
TH History r

To select from TX History

Setting from TX History (p. 4-11)
When you make a call, the destination repeater or
called station data is saved in TX History.

You can select the destination from the record.

To directly enter the destination station call sign

Direct Input (UR) (p. 4-11)
Directly enter the destination station’s call sign.

Direct Input (LUR)
Direct Input (RFET)

To directly enter the destination repeater call sign

Direct Input (RPT) (p. 4-12)
Directly enter the destination repeater’s call sign.

4-8
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“TO” (Destination) setting (Continued)

< Using the “Local CQ” (Local Area call)
When “Local CQ” is selected on the TO SELECT
screen, “CQCQCAQ” is set in “TO.”

Example: Making a Local area call by accessing the
“Hirano” repeater.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [J].

[ L

FROM Hirano 1

* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”
3. Select “Local CQ,” then push [J].

Local CO
Gateway CO N
Your Call Sign -

FROM Hirano

» Returns to the DR screen, and “CQCQCQ” is
displayed in “TO.”
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< Using the “Gateway CQ” (Gateway call)
When “Gateway CQ” is selected on the TO SELECT
screen, you can select the repeater to make a
gateway call on the repeater list.

Example: Making a Gateway CQ call to the
“Hamacho” (Japan) repeater from the
“Hirano” repeater.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [J].
[ £

FROM Hirano 1

* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”
3. Select “Gateway CQ,” then push [J].

ETO SELECT

Local CQ

Gateway CO

Your Call Sign 4

* Displays the REPEATER GROUP screen.

4. Select the repeater group where your destination
repeater is listed, then push [J].
(Example: “11: Japan”)

5. Select the destination repeater, then push [J].
(Example: “Hamacho”)

H: 0
HamFair TP A
Inage

FROM Hirano

* Returns to the DR screen, and “Hamacho” is displayed
in “TO.”

TIP: After selecting a destination repeater, you can
select another repeater preset in your repeater list
by rotating [DIAL].

bV D- | L

JR1YIL &
FROM Hirano JIe182 1
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“TO” (Destination) setting (Continued)

< Using “Your Call Sign”

The “Your Call Sign” memory saves the “UR”
(destination) call signs. When you select an individual
station call sign for the “TO” (Destination) setting using
“Your Call Sign,” you can make a Gateway call. When
you call the destination through a gateway, the signal
is automatically sent to the last repeater that the
station accessed. So, even if you do not know where
the station is, you can make a call.

NOTE: If the repeater, set in “FROM” (Access
Repeater) has no Gateway call sign, you cannot
make a gateway call.

Example: Selecting “Station1” from the “Your Call

Sign.”
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [J].
[ £
FROM Hirano 1

* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”
3. Select “Your Call Sign,” then push [J].

ETO SELECT

Local CQ -
Gateway CO »

Yaur Call Sign

* Displays the YOUR CALL SIGN screen.
4. Select the destination name or call sign, then
push [J]. (Example: Station1)

Stationz JAZYLLA
Station3 JE2ZME F
[— [ T3
o8 Station1
JH1ZLE
FROM Hirano

* Returns to the DR screen, and “Station1” is displayed
in “TO.”

TIP: After selecting a destination, you can select
another station preset in your transceiver by rotating
[DIAL].

FROM Hirano

4-10

< Using the RX History

When a call is received in the DV mode, the call data
is saved in the RX History.

Up to 50 Callers, and only the last Called call signs
can be saved.

Example: Selecting “Station1” in the RX History.

1. Hold down [DR] for 1 second to display the DR
screen.

2. Select “TO,” then push [J].

[ L.J

D

-

S COCQCC 1
FROM Hirano
* Displays the TO SELECT screen.

® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “RX History,” then push [J].

ETO SELECT

Reflectar

T Histary

* Displays the RX HISTORY screen.

4. Select the destination name or call sign, then

push [J]. (Example: Station1)

= R¥ HISTORY

Station
Stationz IM1ZLE A
StationZ

- | T3

JM1ZLE
FROM Hirano

S tation 1

* Returns to the DR screen, and “Station1” is displayed
in “TO.”

TIP: To add the RX HISTORY data to memory, push
[QUICK], then select “Add To Your Memory.”
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“TO” (Destination) setting (Continued)

< Using the TX History

The TX History saves the name and/or call sign of up
to 20 “TO” (Destination) settings that were used when
you made the calls.

NOTE: Until you make a call in the DV mode, you
cannot select “TO” (destination) from the TX History.

Example: Selecting the “Hamacho” repeater in the TX

History.
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [J].

-

FROM Hirano 1

* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Select “TX History,” then push [J].

ETO SELECT

Reflectaor
R Histary 4
3

TH Histary

* Displays the TX HISTORY screen.
4. Select the destination name or call sign, then
push [J]. (Example: “Hamacho”)

ETH HISTORY 141

HamFair Tokyo €«<—The Sub
Station FIPTYILLA, name is
Hamacho displayed.

* Returns to the DR screen, and “Hamacho” is displayed
in “TO.”
(T3

FROM Hirano 1

TIP: You can add the TX HISTORY data to memory,
or delete it from the TX HISTORY screen, push

< Directly entering (UR)
The destination station call sign can be directly
entered.

Example: Directly entering the call sign “IM1ZLK.”

1. Hold down [DR] for 1 second to display the DR
screen.

2. Select “TO,” then push [J].

-

FROM Hirano 1

* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”
3. Select “Direct Input (UR),” then push [J].
STO SELECT
Direct lnput (LUR)
Direct Input (RFT)

* Displays the DIRECT INPUT (UR) screen.

4. Enter a call sign of up to 8 characters, including
spaces.
EDIRECT IMPUT{UR)

IM1ZLE_

— —

CLR

® See “Entering and editing text” for details. (p. iv)
5. After entering, push [J].
* Returns to the DR screen, and “UM1ZLK” is displayed
in “TO.”

® After entry, you can correct the call sign in the
DIRECT INPUT (UR) screen.

® The entered call sign remains on the DIRECT INPUT
(UR) screen, until you enter a new call sign.

TIP: If the entered call sign is duplicated in “Your
Call Sign” memory, the name is displayed. (Only
when the name has been entered.)

[— B+
S tation
I ZLK
FROM Hirano

Dy
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“TO” (Destination) setting (Continued)

< Directly entering (RPT)
The destination repeater call sign can be directly
entered.

Example: Directly entering the call sign “JP1YIU”

1. Hold down [DR] for 1 second to display the DR
screen.

2. Select “TO,” then push [J].

-

FROM Hirano 1

* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”
3. Select “Direct Input (RPT),” then push [J].

ETO SELECT

Direct Input (LIR) -
Direct Input (RPT) *

* Displays the DIRECT INPUT (RPT) screen.

4. Enter a call sign of up to 8 characters, including
spaces.
EDIRECT INPUTIRPT)

JPTYIU

= — CLR

® See “Entering and editing text” for details. (p. iv)
5. After entering, push [J].
* Returns to the DR screen, and “JP1YIU” is displayed
in “TO.”

® After entry, you can correct the call sign in the
DIRECT INPUT (RPT) screen.

® The entered call sign remains on the DIRECT INPUT
(RPT) screen, until you enter a new call sign.

TIP:

« If the entered call sign is duplicated in the repeater
list, the name is displayed. (Only when the name
has been entered.)

| £

FROM Hirano

* When “/” is entered, the repeater call sign can be
used for a Gateway call.

FIP1YIU
A

= —+ CLR

“I” is entered.
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4 D-STAR OPERATION

Connecting to a Reflector

< What is the reflector?

A reflector is a special server connected to the
Internet and running a version of dplus software. If the
dplus software is installed on your access repeater,

it provides various functions including gateway

and reflector linking capabilities (It is known as the
D-STAR reflector system). The D-STAR reflector
system enables a number of D-STAR repeaters
anywhere to link to a reflector. This means that when
you transmit through a D-STAR repeater linked to a
reflector, your voice can be heard on other repeaters
linked to the reflector, and you can hear other stations
that are connected to the reflector.

D-STAR reflector system

|NJEBN/€T mw :: n

Access {ipeater W

= )
INTERNET mm N n

oo
AUS

< Using a reflector

1. Hold down [DR] for 1 second to display the DR 4. Select “Use Reflector,” then push [J].
screen. S REFLECTOR 2 E
2. Select “TO,” then push [J]. Use Reflectar
* Displays the TO SELECT screen. Link to Reflector ]
® On the DR screen, pushing [DR] toggles between Unlink Reflectar
“FROM” and “TO.” v
3. Rotate [DIAL] to select “Reflector,” then push [J]. — -
* Displays the REFLECTOR screen.
Use Reflector
CEMCRCE
FR2M Hirano

» Returns to the DR screen, and “Use Reflector” and
“CQCQCQ” are displayed in “TO.”
5. Hold down [PTT] to transmit.
« Displays while transmitting.
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D-STAR OPERATION

Connecting to a Reflector (Continued)

< Linking to a reflector
If your repeater is not currently linked to a reflector, or

you want to change to another reflector, you can do so

following the steps below. Before linking to a reflector,
be sure to unlink any current reflector. (p. 4-15)

Direct entering a reflector

Using the TX History

Example: Directly entering “REF010BL.”

1.

2.

© ~N

10.

Hold down [DR] for 1 second to display the DR

screen.

Select “TO,” then push [J].

* Displays the TO SELECT screen.

® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

Rotate [DIAL] to select “Reflector,” then push [J].

* Displays the REFLECTOR screen.

Select “Link to Reflector,” then push [J].

* Displays the “Link to Reflector” screen.

Select “Direct Input,” then push [J].

Rotate [DIAL] to select the reflector number.

(Example: 010)

E Link to Reflectar

REFEEIEAL

— —

Push [MW](—) to move the cursor to the right box.
Rotate [DIAL] to select the module letter.
(Example: B)

S Link to Reflector

REFO10[E L

— —

Push [J].

* Returns to the DR screen, and “Link to Reflector” and
“REF010BL” are displayed in “TO.”

LY D- (£

g Link to Reflector
REFE1AEL
FROM Hirano

Hold down [PTT] to link to the reflector.
* Displays while transmitting.
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The TX History saves the up to 5 reflectors that your
access repeater linked before.

Example: Selecting the “REF010BL” in the TX History.

1.

2.

Hold down [DR] for 1 second to display the DR

screen.

Select “TO,” then push [J].

* Displays the TO SELECT screen.

® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

Rotate [DIAL] to select “Reflector,” then push [J].

* Displays the REFLECTOR screen.

Select “Link to Reflector,” then push [J].

* Displays the “Link to Reflector” screen.

Select the reflector that you want to link to.

(Example: “REF010BL”")

E Link to Reflector i1

Direct Input 3

REFO10BL

* Returns to the DR screen, and “Link to Reflector” and
“REFO010BL” are displayed in “TO.”

Hold down [PTT] to link to the reflector.

« Displays while transmitting.
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Connecting to a Reflector (Continued)

< Reflector Echo Testing

You can transmit a short message, and after releasing
[PTT], your message will be played back. Itis a

useful check of how well your signal is getting into

the repeater, and you can use it to verify that your
repeater is operating normally.

< Unlinking a reflector
Before trying to link to another reflector, be sure to
unlink the current connected reflector.

1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [J].
* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

3. Rotate [DIAL] to select “Reflector,” then push [J].

* Displays the REFLECTOR screen.

4. Select “Unlink Reflector,” then push [J].
EREFLECTOR
IJze Reflector W

Link to Reflector »
IInlink Feflector

DY D- B-#

ToQE Unlinlﬁ Reflector

FROM Hirano

* Returns to the DR screen, and “Unlink Reflector” and
“U” are displayed in “TO.”
5. Hold down [PTT] to unlink the reflector.
* Displays while transmitting.
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1.

2.

Hold down [DR] for 1 second to display the DR

screen.

Select “TO,” then push [J].

* Displays the TO SELECT screen.

® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”

Rotate [DIAL] to select “Reflector,” then push [J].

* Displays the REFLECTOR screen.

Select “Echo Test,” then push [J].

EREFLECTOR

Echo Test T
Repeater Information

v

oY D B

Echo !est

FROM Hirano

* Returns to the DR screen, and “Echo Test” and “E” are
displayed in “TO.”

Hold down [PTT] and speak into the microphone.

* Displays while transmitting.

Release [PTT] to hear your message.



Previous view

4 D-STAR OPERATION

Connecting to a Reflector (Continued)

< Requesting repeater information
When you send the repeater information command,
an ID message is sent back.

1. Hold down [DR] for 1 second to display the DR
screen.

2. Select “TO,” then push [J].
* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between

“FROM” and “TO.”

3. Rotate [DIAL] to select “Reflector,” then push [J].
* Displays the REFLECTOR screen.

4. Select “Repeater Information,” then push [J].

= REFLECTOR.

Fepeater Information

Echo Test M

by D (L

TooE Repee:ter Information
FROM Hirano

* Returns to the DR screen, and “Repeater Information”
and “I” are displayed in “TO.”
5. Hold down [PTT] to send the repeater information
command.
* Displays while transmitting.
6. Release [PTT] to hear the repeater ID message.
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4 D-STAR OPERATION

Message operation

You can save up to 5 short messages in memory, to
transmit in the DV mode.
Each message can be up to 20 characters long.

< Entering a TX message
Example: Entering “JAPAN TOM” into message
memory number 1.

My Station > TX Message

1. Push [MENU].
Rotate [DIAL] to select “My Station,” then push

[F].

off O Set

& My Station
P SFEECH

3. Select “TX Message,” then push [J].

EMY STATIOHN 14
My Call Sign

* Displays the TX MESSAGE screen.

4. Select a message memory number, then push
[QUICK].

5. Select “Edit,” then push [J].

* Enters the TX Message entry mode.
6. Enter a message of up to 20 characters.
(Example: JAPAN TOM)

LAPAN TOM_

— —

CLR AB

Selectable characters and symbols
AtoZ,atoz,0t0 9, !"#$%& ()*+
-l <=>?2@ VN {1} (space)

® See “Entering and editing text” for details. (p. iv)
7. After entering, push [J].

* Returns to the TX MESSAGE screen.

S T MESSAGE

OFF
1o IAPAMN TOM

2

8. Push [MENUI.
* Returns to the standby screen.”

< Transmitting a message

You can transmit a pre-entered text message by
pushing [PTT]. First, select a TX message which also
turns ON the Message Transmission function.

My Station > TX Message

1. Push [MENU].
Rotate [DIAL] to select “My Station,” then push
[J].

3. Select “TX Message,” then push [J].
* Displays the TX MESSAGE screen.

4. Select a message memory, then push [J].
(Example: 1: JAPAN TOM)

= T MESSAGE
OFF
1: JAPAN TOM

s

® To not transmit any message, select “OFF.”
5. Push [MENUI.
* Returns to the standby screen.”

® Information

* The message is transmitted each time you push
[PTT].

* The message is transmitted along with your voice
signal.

TIP: RX call sign and message display

As the default, the received call sign and message
are automatically displayed and scrolled on the LCD.
To not display and scroll them, set “RX Call Sign” to
“OFF.”

(Display > RX Call Sign)

432.875
MSG: JAPAN TOM

A 4
432.875 .

(MSG:N TOM |
Scrolls

-

0]
=~
Rl =5

=
fi]
k]

]




Previous view

4 D-STAR OPERATION

Message operation (Continued)

< Deleting a TX message

You can delete the entered TX message.

Example: Deleting the entered TX message “JAPAN
TOM” from message memory number 1.

My Station > TX Message

1. Push [MENU]I.
Rotate [DIAL] to select “My Station,” then push
[J].

Wy Station
off DV Set ¢

P SFEECH 3

3. Select “TX Message,” then push [J].

EMY STATICOHN 1/
My Call Sign

TH Mezzage

* Displays the TX MESSAGE screen.

4. Select a message memory number to delete, then
push [QUICK].

5. Select “Clear,” then push [J].

-

* The confirmation dialog “Clear?” is displayed.
6. Select <YES>, then push [J].

* Clears the entered message.
7. Push [MENU]I.
* Returns to the standby screen.”
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Viewing the received call signs

When you receive a DV call, the calling station and
the repeater’s call signs are saved. Up to 50 calls can
be saved. Even if the transceiver is turned OFF, the
RX record is not deleted. When you receive the 51th
call, the oldest history will be deleted.

< View the call signs in the RX History screen
1. Push [QUICK].
2. Rotate [DIAL] to select “RX History,” then push

[J].

DY¥ D- 2
ToARA He Woice TH *

Hil GPS Information
43 GPS Position

* Displays the RX HISTORY screen.
3. Rotate [DIAL] to select an RX history memory.

® Information

» The RX history number, the caller’s name (or call
sign), destination, RX message, RX date and time,
“GW,” and “GPS” are displayed on the screen.

« “GW” is displayed when the Gateway call is received.

* “GPS” is displayed when the received call includes the
position data.

* “UP” is displayed when the repeater uplink signal is
received.

* Hold down [RX—CS] for 1 second to temporary set
the received call sign to the “TO” field (destination).

4. Push[J].
* Displays the RX history detail screen.

RX HISTORY screen (RX01)

Displayed when a
Gateway call is received.

Received D-PRS TX
date and time format icon*!

History SR RO 17102
number—Ril1: 2017/03/20 7:27 4 |i|
Station] —=CQCQCO First

+2 HELLD CQ D-5TAR
f page

Caller station
® A note may be
displayed after /. RX message Called station
(“cQcacQ’is
displayed if you
received a CQ call.)

*1 The displayed icon differs, depending on the D-PRS TX
format.
GPS: Position  OBJ: Object
ITEM: Item WX: Weather

*2 \When a name is not entered in the memory, call sign
is displayed. You can change the display type between
“Name Display” and “Call Sign Display” in the Quick menu
window. (Default: Name Display)

4-19

5. Rotate [DIAL].
* Selects the page.

<First page>

« CALLER: Displays the caller station’s name*?
and any note entered after the call
sign.

« CALLED: Displays the called station’s name*2.

S RX HISTORY 01 1200 1/6S

CALLER: Station1
CALLED: CQCQCO

<Second page>
« RXRPT1: Displays the repeater's name*? that
was accessed by the caller station. If
it was a call through a gateway and
the internet, this item displays the
gateway call sign of the repeater you
received the call from.
* Rx RPT2: Displays the repeater's name*? you
received the call from.
® “FREQUENCY” is displayed instead of above
items when the call was not through a repeater
(Simplex call), to show the frequency that was
used.

E R¥ HISTORY 01

R#FFT1: Hirano G
R#RFTZ: Hirano
439,390

<Third page>
* RX MESSAGE: Displays any message included in
the received call, if entered.
* RXTIME: Displays the date and time the
call was received.
ERX HISTORY 01
R MESSAGE:

HELLO CQ D-3TAR
R TIME: 2017 02/20(Mon) 07:27:51

= Continued on the next page
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Viewing the received call signs

< View the call signs in the RX History screen (Continued)

<Fourth page>, <Fifth page>, <Sixth page>
Displays the position data of the caller station. If a
received signal has no data, then no position data
is displayed.

E R¥ HISTORY 01

B o130°25.28'E  DST: 330m|

. 33°35.55'W  ALT:1050ft
=
B‘E’/ GL: PH53FO

ER¥ HISTORY 01 12:00  GSsEE
COURSE : 199° JH1ZLE-4
SPEED: 29. 9mph &=
7:01)
ERX HISTORY 01 12:00  E/EE
GPS MESSAGE:
HELLC!

6. Push [MENU].
* Returns to the standby screen.

TIP: To delete the RX HISTORY data
On the RX HISTORY or the detail screen, push
[QUICK], then select “Delete.”

ERRERIE 51| Sign Display
CALLEF Add Ta Your Memoar

CALLET

TIP: “RX RPT1” setting may differ, depending on the way the call was made.

Example: When a Local area call is received. Example: When a Gateway call is received.
4 N 4 N
(rRxrPT2) (RXRPT1) (RxRPT2)

GW (RX RPT1
A

5 / e P
5 e

22 &
CALLED

YOUR STATION |

9 (YOUR STATION )
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BK mode communication

The BK (Break-in) function enables you to break

into a conversation, where the two other stations

are communicating with call sign squelch enabled.

(Default: OFF)

® The BK function is automatically turned OFF when
transceiver is turned OFF.

DV Set > BK

1. While two other stations are communicating in the

DV mode, hold down [RX—CS] for 1 second.

* The calling station’s call sign is set to “TO”

(Destination).

® When a call sign is not received correctly, error
beeps sound, and no call sign is set.

@ After releasing, beeps sound and the calling station’s
call sign is announced. (RX—CS Speech function)

Push [MENU].

Rotate [DIAL] to select “DV Set,” then push [J].

wn

P SPEECH >H

4. Select “BK,” then push [J].

4
O Auto Detect »
F¥ Record (RPT) »

p b

How to use Break-in?

6. Push [MENU].

* Returns to the standby screen, and “BK” is displayed.

DY B

TOARE COCOCO

e 70cm Calling-UK
438.612s0

7. When both stations are in standby, push [PTT] to

transmit.

* Displays while transmitting.

® “BK” blinks when receiving the Break-in call.

® To cancel the BK mode, select “OFF” in step 5, or
turn OFF the transceiver.

While using digital call sign squelch, the squelch never opens (no audio is heard) even if a call is received, unless

your own call sign is specified.

However, when a call including the “BK ON” signal (break-in call) is received, the squelch will open and audio is

heard even if the call is specified for another station.

Station C calling to Station A with “BK OFF”

Station A

and B are —
communicating

usmg. digital Station A Station B
call sign

squelch. Station C

Station B never hears that
Station C is calling Station A.

Station C calling to Station A with “BK ON”

Station A

and B are T
communicating \ /

using digital . .

call sign Station A Station B
squelch. Station C

Station B also hears that
Station C is calling Station A.



Previous view

4 D-STAR OPERATION

EMR communication

The EMR (Enhanced Monitor Request)
communication function can be used in only the DV
mode. Using the EMR function, no call sign setting is
necessary.
All transceivers that receive an EMR signal
automatically open their squelch to receive the signal.
When an EMR signal is received, the audio (voice)
will be heard at the specified level, even if the volume
setting level is set to the minimum level, or the digital
call sign/digital code squelch is used. (Default: OFF)
® The EMR communication function is automatically
turned OFF when the transceiver is turned OFF.

Example: Transmitting from the “Hirano” repeater
using the EMR function.

DV Set > EMR

1. Push [MENU].
Rotate [DIAL] to select “DV Set,” then push [J].

P SPEECH >H

3. Select “EMR,” then push [J].

EMPE AF Level »

4. Select “ON,” then push [J].

OFF

5. Push [MENUI.
* Returns to the standby screen, and “EMR” is
displayed.
oV D- @ [£3
TOSRE CQCO CQ‘
Hirano
439,390 JF3YHH A

6. Push [PTT] to transmit.

« Displays while transmitting.

® “EMR” blinks on a station that receives the EMR
signal. The audio (voice) will be heard at the
specified level, or the [VOL] control level, whichever
is higher.

® To cancel the EMR mode, select “OFF” in step 4, or
turn OFF the transceiver.

< Adjusting the EMR AF level

The audio output level when an EMR signal is
received is adjustable between 0 and 32.

When an EMR signal is received, the audio will be
heard at the preset level, or the [VOL] control level,
whichever is higher.

To disable the setting, set it to “0.”

DV Set > EMR AF Level

1. Push [MENU].
2. Rotate [DIAL] to select “DV Set,” then push [J].
3. Select “EMR AF Level,” then push [J].

£d
EME. »
3

EMP. AF Level

&

Rotate [DIAL] to adjust the EMR audio output level
between 0 (minimum) and 32 (maximum) in single
digit steps. (Default: 19)

S EMPE AF Level

5. Push [MENU]I.
* Returns to the standby screen.
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Automatic DV detection

If you receive an FM signal while in the DV mode, the

“‘DV” and “FM” icons alternately blink to indicate the

received signal is FM.

When the DV Auto Detect function is turned ON, the

transceiver automatically selects the FM mode to

temporarily monitor the signal. (Default: OFF)

® Regardless of this setting, the “DV” and “FM” icons
alternately blink if you receive an FM signal while in
the DV mode.

TIP: When digital call sign squelch (DSQL) or digital
code squelch (CSQL) is set, the transceiver does not
receive FM signals, even if this function is ON. You
can silently wait for calls from others.

When an FM signal is received while in the DV mode

DV Set > DV Auto Detect

1. Push [MENU].
Rotate [DIAL] to select “DV Set,” then push [J].

R Record [(RPT)

_I:Zl"-.-" Auto Detect .
BE 3

4. Select “ON,” then push [J].

E DV Auto Detect

OFF

5. Push [MENU]I.
* Returns to the standby screen.
® When an FM signal is received while in the DV
mode, the “DV” and “FM” icons sequentially blink,
and the transceiver receives the signal in the FM
mode.

DV Auto Detect function: OFF
The “DV” and “FM” icons alternately blink, but the
audio cannot be heard.

DV Auto Detect function: ON
The “DV” and “FM” icons alternately blink, and the
audio can be heard.

I (T3 BUSY
-’38’3 cCocacao
438.030MHz DV % /
435.050
These icons

alternately blink

{

%-’38’3 CQCOCcq

438.036MHz DV
455.030

[ L

o o o

N

BLISY \

The audio
cannot be heard.
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(3 BUSY
'1'.0.’38’3 CaCaCa
N 135 .030MHZz DV %
438,030

These icons Thanks for the
altirnately blink nice QSOs « «

oV B pust N

saa COCQCo % \

The audio
can be heard.
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Automatic Reply function

When a call addressed to your own call sign is DV Set > Auto Reply
received, the Automatic Reply function automatically 1. Push [MENU].

replies V.V'th your call sign. (Default: OFF) . Rotate [DIAL] to select “DV Set,” then push [J].
Depending on the setting, a recorded message may 3. Select “Auto Reply,” then push [J]

be transmitted with the call sign.

/4 S
Tone Contral b
NOTE: The Automatic Reply function temporary sets Auto Reply 3
the received call sign to the destination call sign. DY Data TX b

4. Select an option.
TIP: To record the Auto Reply message

You can record the Auto Reply message. See page = Auto Reply
9-22 for details.
(Voice Memo > DV Auto Reply)

* ON: Automatically replies with your own call
sign. (No audio reply is sent)

*Voice: Automatically replies with your call
sign and an Auto Reply message
recorded on the microSD card (up to 10
seconds).

@ If no card is inserted, or no message is
recorded, replies with your own call sign.
(No audio reply is sent)

* Position: Automatically replies with your own call
sign and your position data using the
internal or external GPS receiver.
® When “GPS Select” is set to “OFF” or

“Manual,” the internal GPS receiver is
temporarily turned ON.
When “GPS Select” is set to “External
GPS,” but if the external GPS receiver is
not connected, the internal GPS receiver
is temporarily turned ON.
5. Push [MENU]I.
* Returns to the standby screen, and displays “#7.”
Yedcacacd® ™
FROM Hirano
439.390 JFSTHH &

® When “ON” or “Voice” is selected, the Automatic
Reply function is automatically turned OFF, when you
push [PTT].
When “Position” is selected, the Automatic Reply
function remains ON, when you push [PTT].

Example: After receiving a call from “UM1ZLK,” the
transceiver automatically sends a reply call.

oY Db- A (T3
TOSHRR CQCQCO
Hirano %
434,390 JFEYHH &
UR: IM1ZLK(Station1]

The “TO” setting does not change, but “UR:
JM1ZLK (Caller’s call sign)” is displayed.
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Automatic Reply function (Continued)

< Recording an Auto Reply message
You can record the Auto Reply message and saved on
a microSD card to reply to the call with your voice.

|TIP: Be sure a microSD card is in the card slot. |

Voice Memo > DV Auto Reply

1. Push [MENU].
2. Rotate [DIAL] to select “Voice Memo,” then push

& Yoice Memo
b, Yoice TH 3
-# GFS 3

3. Select “DV Auto Reply,” then push [J].

=EVOICE MEMOD e
Q50 Recorder >|]

O Auto Reply

4. Push [MW].
« Starts recording.

S0 ALUTO REPLY

O Auto Reply  ——
REC e
Leval - S °
MIC SEL  GAIN . » ]

® Maximum record time is 10 second
® Hold the microphone 5 to 10 cm (2 to 4 inches) from
your mouth, then speak at a normal voice level.
® Only one message can be recorded. The current
contents will be overwritten if you record again.
5. Push [MENU].
* Returns to the standby screen.

TIP:
* To delete the recorded message, push [QUICK] on
the DV AUTO REPLY screen, then select “Clear.”

—
REC o
Level - 0:10
MIC SEL

* To record message with the optional VS-3
Bluetooth HEADSET, push [V/M] on the DV AUTO
REPLY screen, then select “Bluetooth MIC.”

Hand MIC I
O At Bluetooth 1T 1
REC 0:10
Level - "
MIC SEL

4-25

DV AUTO REPLY screen operation

[MENU]
Returns to the standby screen

[o] [QUICK]

Returns to the Clears the

VOICE MEMO recorded message
screen [MONI]

[VIM] Stops recording
Selects the [RX—CS]

microphone Starts the playback
[MODE] [MwW]

Adjusts the Starts recording

microphone gain

* Push [MONI] to stop recording.

* Push [RX—CS] to start the playback.

» Push [MODE] to display the microphone gain
adjustment bar.

S0V ALTO REPLY

O Auto Reply

REC —o
rLevel [Hmmmmnm——n—,—"mnmn, {1 .

GaIN _$_ 4

Audio level
is displayed

Adjust the Mic gain so
that the REC Level does
not reach to this range
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Automatic Reply function (Continued)

< Auto Position Reply function

When you receive a call addressed to your own call
sign, but are in a situation that makes it difficult to
operate the transceiver, this function automatically
replies with your own call sign and transmits your
position data.

After receiving the Auto Position Reply call, the caller’s

position data is displayed in a window.

® Only the Icom transceivers, ID-4100A/E, ID-
5100A/E, ID-51A/E PLUS, or ID-51A/E PLUS2,
displays the position after receiving a call. (As of
April 2017)

® You can turn OFF the caller’s position indication.
(Display > RX Position Display) (p. 9-63)

When no valid position data is received

2. Your position data is

automatically transmitted.
||II"""""'"""""""

‘ éji\.\\
! IIIIIIIIIIIIII @
Him —o=

1. A call addressed to (ID_41 OOA/E)
your own call sign.

Your station

3. After receiving,
the position data
is displayed in the
destination’s window.

D' ] o 3 15
\ ITFLZFN GPS
To‘u’f;-:l 136°34, 20°E TAZYOA
N %
RO| 146ft  Ri: JASYUA 7

A

Scrolls your call sign or the TX

message.

® Your status message may be
displayed.

After receiving a call addressed to your own call sign,
the internal GPS receiver is temporarily turned ON for
approximately 5 minutes to receive your position data,
even if “GPS Select” is set to “OFF,” “External GPS,”
or “Manual.” Then, the transceiver automatically
replies with a message, as described below.
® When the internal GPS receiver is temporarily ON, and
valid position data is received, the transceiver transmits
your position data if a call addressed to your own call
sign is received again.

Reply message list when no valid position data is
received

Message Status
No Position When no position is received.
2 minutes or more has
Old Position passed since receiving

position data.

The internal GPS receiver is
temporarily turned ON, but
has not received your position
data yet.

The internal GPS receiver is
temporarily turned ON, and 2
minutes or more have passed
since receiving the position
data.

No Posi & GPS Start

Old Posi & GPS Start
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433580 ..

MSG: No Posi & GPS Start

A

Scrolls your message

TIP:

* The position data is transmitted according to the
GPS TX mode. (p. 9-24)

* When the GPS TX mode settings are incorrect
for the Automatic Reply function, the transceiver
automatically corrects them to reply to a call.

* When the GPS transmission mode is OFF,
“D-PRS” is automatically selected.
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Data communication

In addition to digital voice communication, you can
send and receive data. And you can use the DV Fast
Data function for data communication.

The DV Fast Data function uses the data and the
audio frames to send data approximately 3.5 times
faster than the normal speed. So, no audio can be
sent. To send and receive data, the optional OPC-
2350LU and a data communication software (user
supplied) are required.

NOTE: Before staring data communication

“‘DV Data TX” is set to “Auto” as the default setting.
So, when you enter text data into your
communication software, the transceiver may
automatically transmit it, depending on the software
and the software settings.

< Connection
Connect the transceiver to your PC using the optional
OPC-2350LU, as shown below.

Transceiver
((?
E;’]@ PC
To the To the
[DATA] jack USB port
= |~eEm=ID—=—<am
OPC-2350LU

NOTE: Before you start sending data, be sure to
set the following items. (p. 9-24)
* Set “GPS SELECT” to other than “External GPS.”
(GPS > GPS Set > GPS Select)
+ Set “GPS OUT (To DATA Jack)” to “OFF.”
(GPS > GPS Set > GPS Out (To DATA Jack))
* When “GPS TX Mode” is “D-PRS,” set “TX Format”
to other than “Weather.”
(GPS > GPS TX Mode > D-PRS > TX Format)

< Data communication application setting

Set the communication software, as shown below.

* Port: The COM port number that is used by
the ID-4100A/E.*!

» Baud rate:  4800/9600 bps*2
* Data: 8 bit
* Parity: none
* Stop: 1 bit

* Flow control: Xon/Xoff

*1 Depending on the PC environment, the COM port number
used by the ID-4100A/E may be higher than 5. In that
case, use an application that can set it to higher than 5.

*2 Set the baud rate in “Data Speed.” (p. 9-60)
(Function > Data Speed)

<> Sendlng data
Set your own call sign, the UR call sign and the
repeater call sign.
2. Follow the instructions of your data
communication application software.
3. When you enter text data into your communication
software, the transceiver may automatically
transmit it, depending on the software and the
software settings.
® When “DV Data TX” is set to “PTT,” pushing [PTT]
transmits the text data and a voice signal. (p. 9-48)
(DV Set > DV Data TX)

® Before transmission, the transceiver sends
approximately 500 milliseconds of carrier sense.

NOTE:

* Only the ASCII code can be used for data
communication.

» The standard Message Transmission function also
transmits up to 20 characters. (pp. 4-17, 4-18)

* Depending on the combination of your PC and your
communication software, some data may be lost.

» While receiving voice or data through the internet,
some packets may be lost due to network error
(poor data throughput performance). In such a
case, an “L” is displayed on the screen to indicate
that packet loss has occurred.
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Data communication (Continued)

< DV Fast Data function

To send data using the DV Fast Data function, do the

following.

® The DV Fast Data communication can be made by
only the following Icom transceivers: ID-4100A/E,
ID-5100A/E*, or ID-51A/E (PLUS, PLUS2, 50th
Anniversary model). (As of April 2017)
*Usable only when firmware versions CPU M 1.10, S

1.00, C 1.10, and DSP 1.10 or later are installed.

NOTE: When using DV Fast Data function, if you
want to send GPS data to other transceivers that can
receive only slow speed data, set “GPS Data Speed”
to “Slow.” (p. 9-49)

(DV Set > DV Fast Data > GPS Data Speed)

TIP: The DV Fast Data function can also be used
when you operating the transceiver through the RS-
MS1A or RS-MS1] REMOTE CONTROL SOFTWARE.

® The optional UT-137 Bluetooth UNIT is required.

Android
orioS
device

Transceiver with
the Bluetooth unit
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DV Set > DV Fast Data > Fast Data

1. Push [MENU].
Rotate [DIAL] to select “DV Set,” then push [J].

Digital Monitor
Digital Repeater Set

4. Select “Fast Data,” then push [J].

= % Fast Data

Fazt Data
GPS Data Speed
T¥ Delay (PTT)

5. Select “ON,” then push [J].

= Fast Data

OFF

6. Push [MENU].

* Returns to the standby screen.
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Digital squelch functions

The digital squelch opens only when you receive a
signal addressed to your own call sign, or a signal that
includes a matching digital code.

You can silently wait for calls from others.

You can independently set the Digital squelch function
in the VFO mode, Memory mode, CALL channel
mode, or DR function.

< The digital call sign squelch setting
1. Push [QUICK].
2. Rotate [DIAL] to select “DSQL,” then push [J].

[ElS

PRIO Watch

JeEs X Hu:ue CH Set
3. Select “DSQL ((*)” or “DSQL,” then push [J].
LTS

QL
TOERE O

3
3
3
3

OFF

[ ] R{S0]

DEcL
| CSOLEn

+ DSQL ((») : Turns ON the digital call sign squelch
function with the Pocket beep.
® “DSQL (") " is displayed.

+ DSQL: Turns ON the digital call sign squelch
function.
® “DSQL” is displayed.

D (T2

TOSRE COCUCD

438.036MHz DV
455.030

FRi0

When the received signal includes a matching call

sign, the squelch opens and you can hear the audio.

® When the received signal does not include a matching
call sign, the digital call sign squelch does not open.
However, the S/RF meter displays the received signal
level.
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< Digital call sign squelch function with a

Pocket beep
When a received signal is addressed to your own call
sign, the beeps sound for 30 seconds and an “((+))”
blinks. Within 30 seconds, push [PTT] to answer, or
operate the transceiver to stop the beeps and turn
OFF the Pocket beep function.

+ “((+))” disappears.
® If you make no operation for 30 seconds, the beeps
automatically stop, but “((+)) ” continues to blink to

indicate that you received a call.

NOTE:

* DO NOT use the digital call sign squelch function
when communicating with two or more stations,
because the digital call sign squelch function
opens only when receiving a signal addressed
to your own call sign. Thus the digital call sign
squelch function can be used when communicating
with only one station.

* Even if the squelch closes by the digital call sign
squelch function, you can receive data in the DV
mode.
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Digital squelch functions (Continued)

<>The digital code squelch setting
Push [QUICK].
2. Rotate [DIAL] to select “DSQL,” then push [J].

Dy
rotas o PRIO Watch

Home CH Set
1 LB DS0L
43 SKIP

3
3
3
3

3. Select “CSQL ()" or “CSQL,” then push [J].
+ CSQL((») : Turns ON the digital code squelch
function with the Pocket beep.
® “CSQL((»)” is displayed.
+ CSQL: Turns ON the digital code squelch
function.
® “CSQL" is displayed.

| OFF
DSQLi)

D [ L
TOARE COCUCD 1

w438.030MHz DV
455.030

B

Push [MENU].
5. Select “DUP/TONE...,” then push [«J].

E'.:.- DUPR/TOME. ..

B Manage Memory »
& Scan >

6. Select “Digital Code,” then push [J].

E Digital Code

8. Push [MENU].
* Returns to the standby screen.

When the received signal includes a matching code,

the squelch opens and you can hear the audio.

® When the received signal does not include a matching
code, the digital code squelch does not open. However,
the S/RF meter displays the signal level.

NOTE: Even if the squelch closes by the digital code
squelch function, you can receive data in the DV
mode.

< Digital code squelch function with a

Pocket beep
When a received signal matches your digital code,
beeps sound for 30 seconds and an “((+)) ” blinks.
Within 30 seconds, push [PTT] to answer, or operate
the transceiver to stop the beeps and turn OFF the
Pocket beep function.
* “((+))” disappears.
® If you make no operation for 30 seconds, the beeps
automatically stop, but “((+)) ” continues to blink to
indicate that you received a call.
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Viewing call signs

While in the DV mode, you can display the CALL
SIGN screen.

1. Push [MENU].
2. Rotate [DIAL] to select “Call Sign,” then push [J].

e Call Sign
= RX History 3
D% Memory 3

* Displays the CALL SIGN screen.
3. Push [MENU].
* Returns to the standby screen.

CALL SIGN screen

ECALL 5IGMN
Destination call sign— il R{I9FY Hamacho
Access repeater call sign—=>R1: IF2YHH A Hirano
Gateway repeater call sign— RB2: IPE%¥HH G Hirano G
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Repeater list

You can save repeater information for quick and
simple communication in up to 1500 repeater memory
channels (Repeater list) in up to 50 Groups.
Entering data into the repeater list is required to use
the DR function.

You can enter four types of frequencies into the
repeater list, as shown below:

* DV repeater

* DV simplex

* FM repeater

* FM simplex

TIP:

* For easy operation, the repeater list is preloaded
into your transceiver. However, if you do an All
Reset, the CPU clears all the setting data, the
memory channels, and the repeater list. We
recommend that you back up the memory data to
a microSD card or save it to a PC using the CS-
4100 cloning software.

» The repeater list can be downloaded from the Icom
website.
http://www.icom.co.jp/world/support/download/firm/
index.html
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< Repeater list contents
The following contents are included in the repeater

list:

* TYPE:
* NAME:
+ SUB NAME:
* CALL SIGN:

* GW CALL SIGN:

« GROUP:
« USE(FROM):
« FREQUENCY:

* DUP:

* OFFSET FREQ:

* MODE:

* TONE:

* REPEATER TONE:
* POSITION:

* LATITUDE:
* LONGITUDE:

* UTC OFFSET:

Example: “Hamacho”

= REPEATER LIST

Frequency type (p. 4-34)
Repeater name (p. 4-34)
Repeater sub name (p. 4-34)
Repeater call sign and port letter
(p. 4-34)

Gateway repeater’s call sign and
port “G” (p. 4-34)

Repeater group (p. 4-35)
Access repeater use (p. 4-35)
Access repeater’s frequency

(p. 4-35)

Duplex direction (p. 4-35)
Frequency offset (p. 4-35)
Operating mode (p. 4-35)

Tone setting (p. 4-35)

Repeater tone (p. 4-35)

Position data accuracy level

(p. 4-36)

Latitude of the repeater (p. 4-36)
Longitude of the repeater

(p. 4-36)

UTC Offset (p. 4-36)

repeater information

TYPE
MAME
SUB MAME

= REPEATER LIST

CaALL SIEM DIPTYIL A |
G CALL SIGH  JRP1YIU G
GROUP 111 Jlapan

E REFEATER LIST

: D% Repeater M
: Hamacho
: Tokyo

USE(FROM)
FREQUENCY
DUP

S REPEATER LIST

CYES B
£ 434.400.00

: DUP+

OFFSET FREQ 1 5.000.00

FOSITICMN » Approximate
LATITUDE 3BT 19N

£ REFPEATER LIST /2
LONGITLDE $139°47 46'F

LUTC OFFSET T+ 900
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Entering new information into the Repeater List

This section describes how to manually enter new
repeater information into the repeater list. DR screen
The required setting items differ, depending on your
communication usage. Confirm the required items, as
shown below.

B

FR2M Hirano

NOTE: To enter repeater information into the
repeater list, the repeater’s call sign MUST be
entered first.

< Required items for the communication cases

Repeater list Used as an dliss(ta;:tsioan Use_d for DV Used as an FM Use_d for FM
contents access repeater simplex repeater simplex
repeater
TYPE DV Repeater DV Repeater DV Simplex FM Repeater FM Simplex
NAME O O O O O
SUB NAME O O O O O
CALL SIGN o [ ] N/A O N/A
GW CALL (]
SIGN (For a Gateway call) o N/A N/A N/A
GROUP O O O O O
USE(FROM) o O o (] [ J
FREQUENCY ® ©) [ ] (] [ J
DUP o O N/A o N/A
OFFSET
FREQ { O N/A ] N/A
MODE N/A N/A N/A O O
TONE N/A N/A N/A O O
REPEATER
TONE N/A N/A N/A O O
POSITION O O O O O
LATITUDE O O O O O
LONGITUDE O O O O O
UTC OFFSET O O O O O

®: Must be entered
O: Possible to enter
N/A: Not Applicable

4-33



Previous view

4 D-STAR OPERATION

Entering new information into the Repeater List (Continued)

< Entering new information into the repeater list

Step 1. Selecting the repeater group

Step 4. Entering the repeater sub name

DV Memory > Repeater List

1. Push [MENU].
Rotate [DIAL] to select “DV Memory,” then push

[J].

e Call Sign

= R History
O Memory

3. Select “Repeater List,” then push [J].

Om SELECT 1715
FRepeater List |]

MNear Repeater

T History 4
4. Select a repeater group to add a repeater to, then
push [J].

E REFEATER GROUF 7
10 [taly 3
11: lapan 4

3

12: Latin America

(Example: 11: Japan)
+ Displays the repeater list of the selected repeater
group.

5. Push [QUICK].
6. Select “Add,” then push [J].
: |12
HamFai|Edit 1A

lnage |[SKIP All ORN

» The REPEATER LIST EDIT screen is displayed.

Step 2. Selecting the communication type

1. Select “TYPE,” then push [J].

2. Select the communication type, then push [J].
* DV Repeater: Repeater operation in the DV mode.
* DV Simplex: Simplex operation in the DV mode.
* FM Repeater: Repeater operation in the FM mode.
* FM Simplex: Simplex operation in the FM mode.

Step 3. Entering the repeater name

1. Select “NAME,” then push [J].
* Enters the repeater name entry mode.
2. Enter a name of up to 16 characters.
Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()*+
-l <=>?2@ [V {]}" (space)
® See “Entering and editing text” for details. (p. iv)
3. After entering, push [J].

1. Select “SUB NAME,” then push [J].

* Enters the repeater sub name entry mode.
2. Enter a sub name of up to 8 characters.
3. After entering, push [J].

Step 5. Entering the repeater call sign

® When ‘Step 2. Selecting the communication type’ is
set to “DV Simplex” or “FM Simplex,” go to ‘Step 7.
Changing the repeater group.’

1. Select “CALL SIGN,” then push [J].
* Enters the repeater call sign entry mode.

2. Enter the repeater call sign of up to 8 characters,
including spaces.

3. After entering, push [J].

TIP: Be sure to add the repeater node letter in the
8th digit of the call sign, according to the frequency
band shown below. Note that there are almost
always different node letters between Japanese
D-STAR repeaters and repeaters in other countries.
Cross band operation between different nodes at the
same repeater site can be made.

* 1200 MHz: A (B in Japan)

* 430 MHz: B (Ain Japan)

* 144 MHz: C (no D-STAR repeaters in Japan)

Step 6. Entering the gateway repeater call sign

® This item is displayed when ‘Step 2. Selecting the
communication type’ is set to “DV Repeater.”

® The 8th digit in the call sign, entered in ‘Step 5.
Entering the repeater call sign,’ is automatically
set to “G” as the gateway port, so you can skip this
setting and go to the next item. To change it, follow
the steps, described below.

1. Select “GW CALL SIGN,” then push [J].

* Enters the gateway repeater call sign entry mode.
2. Enter a gateway repeater call sign of up to 8

characters, including spaces.

® A space or “G” can be entered in the 8th digit.
3. After entering, push [J].
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Entering new information into the Repeater List

< Entering new information into the repeater list (Continued)

Step 7. Changing the repeater group

Step 11. Entering the frequency offset

® The repeater group that is selected in ‘Step 1.
Selecting the repeater group’ is displayed. You can
skip this setting and go to the next item. To change
the group, follow the steps, described below.

1. Select “"GROUP,” then push [J].
* Enters the repeater group selection mode.

2. Select the repeater group, 01 to 50, then push
[J].

Step 8. Setting “USE(FROM)” to be used as an
Access repeater

® You can use the entered repeaters as an access
repeater when using the DR function. When not
using as an access repeater, select “NO,” and go to
‘15. Selecting the position data accuracy level.’ In
that case, the entered repeater is not displayed in
the “FROM” field.

1. Select “USE(FROM),” then push [J].

2. Select “YES” to use the repeater as an access
repeater, then push [J].

Step 9. Entering the access repeater frequency

1. Select “FREQUENCY,” then push [J].
* Enters the frequency entry mode.
2. Rotate [DIAL] to enter the repeater frequency,
then push [J].
® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

Step 10. Selecting the duplex direction

® When ‘Step 2. Selecting the communication type’
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.

® “DUP-"is automatically set when the access
repeater frequency is entered in ‘Step 9. Entering
the access repeater frequency.’

® If necessary, you can change the duplex direction.

1. Select “DUP,” then push [J].
Select a duplex direction, then push [J].
* OFF: Turn the duplex function OFF.
* DUP-: The transmit frequency shifts down from the
receive frequency by the offset amount.
* DUP+: The transmit frequency shifts up from the
receive frequency by the offset amount.
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® When ‘Step 2. Selecting the communication type’
is set to “DV Simplex” or “FM Simplex,” this item is
not displayed.

® The offset value* is automatically set when the
access repeater frequency is entered in ‘Step 9.
Entering the access repeater frequency.’
*The default value differs, depending on the transceiver
version.

® If necessary, you can change the frequency offset.

1. Select “OFFSET FREQ,” then push [J].
« Enters the frequency offset entry mode.

2. Rotate [DIAL] to enter the frequency offset
between 0.000.00 ~ 59.995.00 MHz, then push
[J].
® Push [MW] to move the cursor forwards, or push

[MODE] to move the cursor backwards to select a
digit to enter.

Step 12. Setting the FM mode

® When ‘Step 2. Selecting the communication type’ is
set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

1. Select “MODE,” then push [J].
* Enters the operating mode setting mode.
2. Select “FM” or “FM-N,” then push [J].

Step 13. Setting the tone

® When ‘Step 2. Selecting the communication type’ is
set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

1. Select “TONE,” then push [J].
* Enters the tone setting mode.
2. Select the option, then push [J].
* OFF: Turn the tone function OFF.
» TONE: Select when the repeater requires an access
tone.
* TSQL: Select when you want to use the tone squelch
operation in simplex.

Step 14. Selecting the repeater tone frequency

® When ‘Step 2. Selecting the communication type’ is
set to “DV Repeater” or “DV Simplex,” this item is
not displayed.

® This setting is required when ‘Step 13. Setting the
tone’ is set to “TONE” or “TSQL.”

1. Select “REPEATER TONE,” then push [J].
* Enters the repeater tone setting mode.

2. Rotate [DIAL] to select the repeater tone

frequency, then push [J].
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Entering new information into the Repeater List

< Entering new information into the repeater list (Continued)

Step 15. Selecting the position data accuracy level

Step 18. Setting the UTC offset

® When the Near Repeater Search function is not
used, or the distance between your position and a
repeater is not displayed, select “OFF,” and go to
‘Step 18. Setting the UTC offset.’

1. Select “POSITION,” then push [J].
2. Select the position data accuracy level, then push
[J].
* None: Select when the repeater has no position
data.
» Approximate: Select when the entered position data is
approximate.
» Exact: Select when the entered position data is

exactly correct.

Step 16. Entering the latitude

® This item is displayed only when ‘Step 15.
Selecting the position data accuracy level is set to
“Approximate” or “Exact.”

1. Select “LATITUDE,” then push [J].
* Enters the latitude data entry mode.
2. Rotate [DIAL] to enter the latitude.
® Push [MW] to move the cursor forwards, or push

[MODE] to move the cursor backwards to select a
digit to enter.

® To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

3. After entering, push [J].

Step 17. Entering the longitude

® This item is displayed only when ‘Step 15.
Selecting the position data accuracy level is set to
“Approximate” or “Exact.”

1. Select “LONGITUDE,” then push [J].
* Enters the longitude data entry mode.
2. Rotate [DIAL] to enter the longitude.
® Push [MW] to move the cursor forwards, or push

[MODE] to move the cursor backwards to select a
digit to enter.
® To enter an east latitude longitude, select “E,” and to
enter a west longitude, select “W.”
3. After entering, push [J].
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® UTC (Universal Time Coordinated) offset is the

time difference between UTC and repeater local
time. This is a useful function to know the local time

of the destination repeater before you make a call.
(p. 4-42)

Select “UTC OFFSET,” then push [J].

* Enters the UTC offset entry mode.

Rotate [DIAL] to set the time difference between
UTC and the local time, then push [J].

Step 19. Saving the repeater list

1.

2.

Select “<<Add Write>>,” then push [J].

* The confirmation dialog “Add Write?” is displayed.
Select <YES>, then push [J].

* The entered contents are saved to the repeater list,

and the display returns to the selected repeater group
screen.

TIP: To cancel the entered data
1.
2.

Push [9] to display “Cancel edit?” window.
Select <YES>, then push [J] to cancel entry
and return to the selected repeater group
screen.

Cancel edit?
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D-STAR OPERATION

This function edits a repeater’s data. This is useful
when already-entered data is incorrect, has changed,
or some data needs to be added to the list.

DV Memory > Repeater List

1.

10.

Push [MENU].

Rotate [DIAL] to select “DV Memory,” then push
[J].

Select “Repeater List,” then push [J].

Select a repeater group where the repeater you
want to edit is listed, then push [J].

E REFEATER GROLUP

100 [taly 3

11: lapan
12: Latin America 4

(Example: 11: Japan)

* Displays the repeater list of the selected repeater
group.

Select a repeater you want to edit, then push

[QUICK].

Select “Edit,” then push [J].

= REFEAETAE —Im

Hamach| Add |

(Y T — -

lnage |[SEIP All ON

Select an item, then edit it.
E REPEATER LIST EDIT

1 OV Repeater »
MAME : HamFair *
SUB MNAME : Takwo 3

® See pages 4-34 ~ 4-36 for details.
After editing, select “<<Overwrite>>."

PEATER LIST EDIT

== CIverwrites=

* The confirmation dialog “OverWrite?” is displayed.
Select <YES>, then push [J].

BG

Civerwrite?

MO

» The edited contents are saved to the repeater list, and
returns to the selected repeater group screen.

Push [MENU].
* Returns to the standby screen.
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Deleting a repeater list

The entered repeater contents can be deleted from
the repeater list.

DV Memory > Repeater List

1. Push [MENUI.

Rotate [DIAL] to select “DV Memory,” then push
[J].

Select “Repeater List,” then push [J].

Select a repeater group where the repeater you
want to delete is listed, then push [J].

E REFEATER GROLUP £

10z [taly »

o

12: Latin America k

(Example: 11: Japan)
* Displays the repeater list of the selected repeater
group.
5. Select the repeater to be deleted, then push
[QUICK].
6. Select “Delete,” then push [J].

= REPE ARG ENEE
Harmach|ove
A

lnage

* The confirmation dialog “Delete?” is displayed.
7. Select <YES>, then push [J].

Han

Han

lnat

Delete?

» The selected repeater contents are deleted from the
repeater list, and returns to the selected repeater
group screen.

8. Push [MENU].
* Returns to the standby screen.
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Rearranging the display order of the repeater

You can move the entered repeaters to rearrange their
display order in the selected repeater group.

The entered repeater cannot be moved out of their
assigned repeater group.

Example: Moving "Hamacho" above “Inage.”
DV Memory > Repeater List

1. Push [MENU].

2. Rotate [DIAL] to select “DV Memory,” then push
[J].

3. Select “Repeater List,” then push [J].

4. Select a repeater group where the repeater you

want to move is listed, then push [J].
E REFEATER GROLUP

100 [taly 3

12: Latin America 4

(Example: 11: Japan)
5. Select the repeater to be moved, then push

[QUICK].
6. Select “Move,” then push [J].
: RE
) A

Inage

» “DESTINATION?” blinks at the top left of the screen.
7. Select the location to insert the repeater you want
to move, then push [J].

< N\ N\ \ / / 4

k= OF <
Hamacfo = = Chiba
HamFair IPTYIQ A

HamFair k[l Tokyo
Hamacho 4P A
Inage 3

* The selected repeater is inserted above the
destination repeater name.
® If “<<Move End>>" is selected, the repeater is moved
to the bottom of the group.
E DESTIMNATION

<<Nlove End>>

Hirana
Sugarmo

8. Push [MENU].
* Returns to the standby screen.
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Adding the Repeater information using the RX History

This section describes how to add new repeater
information to the repeater list using the RX history.

1.

oo

Push [QUICK].
Rotate [DIAL] to select “RX History,” then push
[J].

Oy D+ 2
TORRA ¢ Vmce}{
istary

Hi GFS Information
45| GPS Position

* Displays the RX HISTORY screen.
Rotate [DIAL] to display the repeater you want to
add to the repeater list, then push [J].

ER¥ HISTORY 1200 1408

Station1 —CQCQCO

R¥01: 2017 05420 TF:27
HELLD COQ D-STAR

* Displays the RX history detail screen.
Rotate [DIAL] to display “RXRPT1” and
‘RXRPT2.”

SR HISTORY Q1

RARPTZ: IP2YHH A

RARPT1:IP2YHH A T
4359.390

Push [QUICK].

Select “Add To RPT List,” then push [J].
BRI 11 Sign Display b 2/3 5|
BROER| .0l To RPT List H

RHERPTZ Delete

Select the repeater call sign that you want to add
to the repeater list, then push [J].

H

* Displays the REPEATER LIST EDIT screen. The

selected repeater call sign is automatically entered.
® See pages 4-34 ~ 4-36 to edit the contents.
Select “<<Add Write>>,” then push [J].

* The confirmation dialog “Add Write?” is displayed.
Select <YES>, then push [J].

Add write?

* The repeater contents are added to the repeater list,
and the display returns to the RX HISTORY screen.
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TIP: How to select the display type

The RX HISTORY screen has two display types,
Name Display and Call Sign Display.

(Default: Name Display)

1. On the RX HISTORY screen, push [QUICK].
Select “Name Display” or “Call Sign Display,”
then push [J].

Call Sign Dizplay
Station 1| Delete
HELLD 1| Delete All

® Even if “Name Display” is selected, the call sign is
displayed when a name is not entered in the DV
memory.
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Skip setting for the DR scan

You can set repeaters as scan skip repeaters. The

selected repeaters are skipped for faster scanning.

You can set the skip setting to all repeaters in the

selected repeater group, or to individual repeaters.

® When a repeater is specified as a skip repeater, its
“USE (FROM)” setting is automatically set to “NO.”
In that case, the repeater cannot be selected in
“FROM?” field (Access repeater).

< Individual skip setting
DV Memory > Repeater List

1. Push [MENU].

Rotate [DIAL] to select “DV Memory,” then push
[J].

Select “Repeater List,” then push [J].

Select a repeater group where the repeater you
set the skip setting is listed, then push [J].

= AEPEATER GROLUP

1D [taly 3

B w

12: Latin America »

(Example: 11: Japan)
« Displays the repeater list of the selected repeater
group.
5. Select the repeater to be skipped, then push
[QUICK].
6. Select “SKIP,” then push [J].

HamFai|Edit 1A
lnage |[SKIP All ORN

Harmacho

HamFair r IR ILL A

lnage r

* Displays “SKIP” on the selected repeater’s information
window.
® Select “SKIP” again to cancel the skip setting.
® Select “SKIP All ON” to set the skip setting to all
repeaters in the group.

<> Group skip setting
On the REPEATER GROUP screen, select a
repeater group, as described above.

2. Push [QUICK], then select “SKIP All ON” to skip
the repeaters in the group during the DR scan.

11: .Iar:--: SKIP Al OFF
12: Latir r

TIP:

* When you select “Repeater List” on the FROM
SELECT screen, you can set the skip setting as
described to the left.

* When “FROM?” is selected, push [QUICK] to set
the skip setting, as shown below.

] Clock
Waltage
| ==REC Start=>

v

Dy D-—
Toaga cf OFF

v

(s v B
TOSRE COCOCO

Hirano
439,390 JFEYHH &

@ Displays “SKIP” in the “FROM” field.
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Entering the repeater group name

DV Memory > Repeater List > Repeater Group

Push [MENU].

Rotate [DIAL] to select “DV Memory,” then push
[J].

3. Select “Repeater List,” then push [J].

4. Select a repeater group that you edit the name.
E REPEATER GROLIP

N -~

23: 3
24: r

(Example: 22:)
Push [QUICK].
Select “Edit Name,” then push [J].

oo

7. Enter a group name of up to 16 characters.
E GROUP MAME

Kaorea_

= — CLR ab

Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()*+
- l<=>?2@ [\ " {]}" (space)
® See “Entering and editing text” for details. (p. iv)

8. After entering, push [J].
E REPEATER GROUP

areq

23:
24:

9. Push [MENU].
* Returns to the standby screen.
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Repeater detail screen

According to the content, such as position data, UTC
offset, and so on, the distance between your position
and the repeater or the repeater time can be displayed
on the REPEATER DETAIL screen.

The detail screen can also be entered from the FROM
SELECT screen.

Example: Displaying the “Hamacho” repeater detail

screen
1. Hold down [DR] for 1 second to display the DR
screen.
2. Select “TO,” then push [J].
oW D— [ T3

FROM Hirano 1

* Displays the TO SELECT screen.
® On the DR screen, pushing [DR] toggles between
“FROM” and “TO.”
3. Select “Gateway CQ,” then push [J].
=ETO SELECT ==
Local C0) ﬂ

Gateway C0

Your Call Sign 3

4. Select “11: Japan,” then push [J].
EREFEATER GROUF 447

10z ltaly 3
11: lapan 3
12: Latin America 3

5. Select “Hamacho,” then push [QUICK].

Hamacho
HamFair JP1YILL A
lnage
6. Select “Detail,” then push [J].

* Displays the REPEATER DETAIL screen.

= REPE.

HamFai|Edit 1A
lnage |Delete

E REFEATER DETAIL
;"‘N“\‘ Hamacho
?E Tokyn

S2em  SRR1T 434400 DUP+

JPTYIL A 2325

@ If there is no position data, the distance and direction
from your position are not displayed.
(p. 5-3)
® When selecting the FM repeater, either of “FM” or
“FM-N” and the tone setting are displayed.
7. Push [J].
* Returns to the previous screen.

The REPEATER DETAIL screen

Sub name Call sign
Repeater name Repeater time

+—F
H

anti Hamache

Direction from _;, m \
your position* gl Tokyo JETYIL A 2325

sse  GREUT 434,400 DUP+

Distance T * .
from your Group number Duplex setting
s Repeater
position
frequency

* When the position data accuracy level is set to
“Approximate,” direction data is not displayed if the
distance to the repeater is less than 5 kilometers.

TIP: You can display the repeater details screen
when the DR screen is displayed:
When you set the repeater as shown below, push
[QUICK], then select “Repeater Detail.”
Dy D— | £
TOSAE COQCOCO

Hirano
439,390 JEEYHH &

v

[:'\:}.:35’[3)_12( Group Select 3

] Fepeater Detail
Hi| T Power *
43 DTMF T r

* Displays the REPEATER DETAIL screen.
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Entering Your (destination) call sign

You can manually enter a Your (destination) call sign.
When a Your (destination) call sign is set to “TO,” you
can make a call to a station, even if you do not know

where the station is currently located.

Up to 300 Your call signs can be entered.

Example: Entering “Station 1/JM1ZLK” to the Your
Call Sign memory.

DV Memory > Your Call Sign 12. Select “<<Add Write>>" then push [J].

EYOUR CALL SIGN EDIT

1. Push [MENU].

Rotate [DIAL] to select “DV Memory,” then push MNAME ~ :Station |

CALL SIGM: IM1TZLE

v v b

[J]. <A Write=>
3. Select “Your Call Sign,” then push [J].
4. Push [QUICK]. « The confirmation dialog “Add Write?” is displayed.
5. Select “Add,” then push [J]. 13. Select <YES>, then push [J].
= VYOUR]Ac B2 dd write?
I

* Displays the YOUR CALL SIGN EDIT screen.

6. Select “NAME,” then push [J]. L CALLSIGN

= VOUR CALL SIGN EDIT 5 LN
MNAME H
CALL SIGM: »
seAdd rites= « “Station 1 JM1ZLK” is entered into the Your Call Sign
* Enters the name entry mode. memory.
7. Enter a name of up to 16 characters. 14. Push [MENU].

(Example: Station 1) * Returns to the standby screen.
= MAME

_ TIP:
Station 1_ To cancel the entered data

—  — CLR 12 1. Push [9] to display “Cancel edit?.”
2. Select “YES” to cancel the entry and the display

Selectable characters and symbols returns the YOUR CALL SIGN screen.
AtoZ,atoz,0to 9, !"#$% & ()*+ BB Cancel edit? £
- /::<=>2@[\]"_"{|}" (space)

® See “Entering and editing text” for details. (p. iv)
8. After entering, push [J].
9. Select “CALL SIGN,” then push [J]. To edit the entered data:

= TOUR [:'ﬂ'LL SIGHEDIT To edit the entered data, select “Edit” in step 5.
NAME —:>tation | . This is useful when already-entered data is incorrect,
has changed or some data needs to be added to the
list.

CALL SIGH:
<<hddd Writex>=

« Enters Your call sign entry mode.
10. Enter Your call sign of up to 8 characters,
including spaces. (Example: JM1ZLK)

IMAZLE,

= — CLR

11. After entering, push [J].
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4 D-STAR OPERATION

Deleting Your (destination) call sign

You can delete Your (destination) call signs from the
Your Call Sign memory.

DV Memory > Your Call Sign

1. Push [MENU].

Rotate [DIAL] to select “DV Memory,” then push
[J].

Select “Your Call Sign,” then push [J].

Push [QUICK].

Select “Delete,” then push [J].

I

ok

* The confirmation dialog “Delete?” is displayed.
6. Select <YES>, then push [J].

* The selected call sign contents are deleted from the
Your call sign list, and the display returns to the YOUR
CALL SIGN screen.

7. Push [MENULI.
* Returns to the standby screen.

TIP: You cannot delete the Your (destination) call
sign if it is selected on the DR screen. In that case,
the following screen is displayed.

Memory iz used in DR

ELEL | function. n
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4 D-STAR OPERATION

Rearranging the display order of Your (destination) call signs

You can move Your call signs to rearrange their
display order.

It is easy to find stations that you often communicate
with if the stations are moved to the top of the list.

Example: Moving “Station 1” above “Station 3.”
DV Memory > Your Call Sign

1. Push [MENU].

2. Rotate [DIAL] to select “DV Memory,” then push
[J].

3. Select “Your Call Sign,” then push [J].

4. Select a Your (destination) call sign to be moved,

then push [QUICK].
5. Select “Move,” then push [J].

/4 \
Station 1
Station 2 JAZYLLA
Station 2 IKZZMEB F

» “DESTINATION?” blinks at the top left of the screen.
6. Select the location to insert the call sign you want
to move, then push [J].

NN\ \ / U4
—

B= DESTIMNATION

“Stationd © > IMIZLE |
St 2 JAZYUA
Station 3 IK3ZNE F

YOUR CALL SIGH ME
Station 2 1AZY U A 3
Station 1 1M1 ZLEK 3
Station 3 IKZZME F b

* The selected call sign is inserted to above the
destination.
® If “<<Move End>>" is selected, the call sign is moved
to the bottom of the list.

EDESTINATION

<<Move End=>

7. Push [MENU].
* Returns to the standby screen.
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4 D-STAR OPERATION

Your setting is correct?

If you make a local area call with a gateway setting
still selected in “TO,” the destination repeater will be
busy while you transmit.

So the stations that use that repeater as their Access
repeater cannot access it, as shown below.

BE SURE to set CQCQCQ in “TO” when you intend to
make a local call, or after you finish a Gateway call.

Example: JM1ZLK wants to make a Local area call.

Hamacho repeater Hirano repeater

His setting is!
| cannot acces
‘,epea‘teﬂ

o

|ETE\R NET IIIIIIIIITT]

Caller 3
(JM1ZLK) —

Called
Hirano area

Hamacho area

JM1ZLK’s setting
DVF D+ | B3

T62R8 Hirano NOTE: With this setting, the Local area call can be
P Hamacho % made, but the destination repeater, selected in “TO,”

il 439.400 JRTYIL & is also busy while you transmit.
UR: /JP3YHHA So the station that uses the destination repeater as
The destination (“TO”) setting is incorrect.  their Access repeater cannot access it.

Correct setting

LW [+ B

TOERE COCOCO

FR.OM Hamacho %
439.400 JR1YIU &

UR: CQCQCQ

To make a Local area call, set the
destination (“TO”) to “CQCQCQ.”
See page 4-9 for details.
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5  GPS OPERATION

GPS operation

NOTE: The built-in GPS receiver cannot calculate
its position data if it cannot receive signals from the
GPS satellites.

The transceiver has a built-in internal GPS receiver.
The GPS receiver’s position data can be received in
any mode. Also, a NMEA format compatible external
GPS receiver can be connected to the transceiver
through the [DATA] jack.

To receive signals from an external GPS source,
connect an external NMEA format compatible receiver
to the transceiver according to the instructions, shown
to the right.

Position data can be transmitted in only the DV mode.

< Confirming the GPS signal receiving
Confirm the GPS receiver is receiving your position
data.

The GPS icon blinks when searching for satellites.

r D D

The GPS icon stops blinking when the minimum
needed number of satellites is found.

R

® It may take only a few seconds to receive, or it may take

a few minutes, depending on your operating environment.

If you have difficulties receiving, we recommend that you
try a different location.

® When the “GPS Select” item is set to “Manual,” the icon
is not displayed.
(GPS > GPS Set > GPS Select) (p. 9-24)

GPS
- | Receiver

To the
RS-232C port

Connection

Terminal information

® Tip: RXD

v 9
25mm TGEE[:I]]]]ij @ Ring: TXD
(0.1in) (d) @ ® Sleeve: GND

<& When a received signal contains

position data
When a received signal contains position data, the
caller’s position data is displayed in the RX position
window.
See page 5-3 for details.

Example: When the signal from JM1ZLK contains
position data.

[l ) W o ] 15
ML 3TN GPE
‘ m* 135" 34, 33°F IMIZLE=-A]
bgrt A
Ry 77 8ml  Re: IM1ZLE AlStation?] fl

When you receive the signal, the RX
position data is displayed in the RX
position window.

v

After a few seconds, the window disappears.

b | B3
432.875 .
MSG: HELLO CQ D-STAR

When the received signal contains
position data, the RX position icon is
displayed as shown above.

® You can turn OFF the caller’s position data
indication. (p. 9-63)
(Display > RX Position Display)

® You can turn OFF the RX position icon indication.
(p. 9-63)
(Display > RX Position Indicator)
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5  GPS OPERATION

Checking your location

You can check your current location.
This section is described using received position data.

< Displaying Position Data
1. Push [QUICK].
2. Select “GPS Position,” then push [J].
* Displays the GPS POSITION screen.
3. Rotate [DIAL] to select the screen.

* My screen (MY), the received screen (RX), the GPS
Memory channel screen (MEM), and the GPS Alarm
channel screen (ALM) are selectable.

*« MY: Displays your location in latitude and longitude,
grid locator, altitude, speed*, time, compass
heading* and course direction*.

* Does not displayed when “GPS Select” is set
to “Manual.” (p. 9-24)
(GPS > GPS Set > GPS Select)

*« RX: Displays the caller station’s location in latitude
and longitude, grid locator, altitude, distance/
direction from your location, SSID, course,
speed, TX power level, height, antenna gain,
antenna direction, temperature, rainfall, wind
direction, wind speed, barometric pressure,
humidity, Time stamp, D-PRS symbol, and call
sign.

Depending on the received signal, some data
may not be displayed. (p. 5-5)

* MEM: Displays the GPS memory channel’s location
in latitude and longitude, grid locator, and
distance/direction from your location.

* ALM: Displays the GPS alarm memory channel
location in latitude and longitude, grid locator,
and distance/direction from your location.

4. Push[9].
* Returns to the standby screen.

TIP: If you transmit with the GPS POSITION screen
open, the screen is temporarily canceled. To check
the position data while transmitting, push [QUICK],
then select “GPS Position” while transmitting.

NOTE: Latitude, longitude, and altitude data may
differ, depending on your GPS.

GPS memory:
GPS alarm:
) Tokyo Skytree Tokyo Big Sight
Your station 236 ml

Course: 90 degrees
Speed: 21.2 mph

236 ml £
) This is an
78.0ml I Caller station (D-PRS: mobile) example for
Q¢ Course: 95 degrees the GPS data
Speed: 7.8 mph screens

5-3

[About the GPS Position screen]
<MY>  Compass direction Longitude
top is North. Latitude | Altitude Speed

5 POSITIO r-. -im E |
POL T 35 s 00N/ ALT: 45Ft
Your.coulrse*[ "‘?":f 135°36. O0'E  SPEED: 21. Zmph
heading is @Sgﬂ. GL: PMZETS  TIME: 18:15:30

East.
Displays/ T T T

Your course  Grid Time
direction is locator
90° degrees.

My location

<RX>
When the caller’s TX format is D-PRS Position (Mobile

station
) S GPS POSITION

GL: PHP450

o N WIRIFN ALT:10BFt ]
Direction from "‘Lv,,f 15°30.20F  DST: 78. Onl
your location s

Calleris

south of you. . ) .
Displays received Distance from

position screen your location

Caller’s call sign with SSID

EGPS FOSITION /S E
The course —> COURSE: 95° JaUA-4
heading of the = SPEED: 7. Snph o
caller is 95 (13 08)
degrees. D-PRS symbol |

Displays the time the caller
acquired the position data

<MEM>

o e 35A259'N  GLIPMISVR |
Direction from —> 4 =% 13g°45, 65’ DST: 236m|

: A
your location Tokyo Skytree
The location is @ .
East of you. . .
Displays the GPS Distance from
Memory position screen  your location
<ALM> = GPS POSITION

your location iy

)  Tokyo Bigsite
The location is S

East of you. )

o N 35°37.7FN GLiPHSYP ]
Direction ffom»[‘”)'“ 130747, 80°F DST: 236m|

Displays the GPS Distance from
alarm position screen  your location

*When a name is not entered in the Memory channel, date
and time are displayed instead of the name.
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Checking your location (Continued)

GPS position data has two transmit modes, D-PRS
and NMEA. Moreover, with the D-PRS mode data,
five position formats, Position (Mobile station/Base
station), Object, ltem and Weather, are selectable.

| D-PRS | NMEA

— Position (Mobile) |

—| Position (Base) |
—| Object |
—| ltem |

|

L' Weather

* D-PRS:

D-PRS is a function which simultaneously
sends position data received from the
internal or external GPS receiver, using the
slow speed data packet space, along with
voice.

A station operating from a vehicle, a
vessel, or other location, away from it's
normal base location.

A station operating at home or in any
building.

Transmitting Object data such as an
earthquake information, satellite track
information, and so on.

An Object contains a time stamp.
Transmitting Item data such as a traffic
accident, lighthouse, antenna, or DV
access point location, and so on.

An Item does not contain a time stamp.

A station transmitting a weather information
received from the weather device.

A station transmitting position data
(NMEAO183) received from the internal or
an external GPS receiver.

* Mobile:

* Base:

* Object:

¢ [tem:

* Weather:

* NMEA:

5-4

le' POSITION

ALT: 10BFt

24" 37, 23° N
J PREEN: OST: 78, Onil
6Lz PH7AS0
£ GPS POSITION 35 E
COURSE ; 95° 1A3UA—b
SPEED: 7. Bph vy
(132080

Example: When the caller’s TX format is D-PRS
Position (Mobile)

TIP: For users who have a D-STAR transceiver
model prior to the ID-4100A/E:

The GPS TX mode, “GPS (DV-G)” and “GPS-A (DV-
A),” are now called “NMEA” and “D-PRS.”

- GPS (DV-G) » NMEA
« GPS-A (DV-A) - D-PRS
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Checking your location (Continued)

< Displayed items
Depending on the caller’s transmit mode or transmit format, the displayed items differ.

D-PRS
Position Object ltem
= =
= =
8 8
a &)
- £ - £
1 S 2 S
Q = o =
0|5 Q| 5
o) © o) ©
2] T 2 L
L S = L S =
[TH o [ [TH o [
o | O 2| O o g
c c o c c o
i) ie) c iel iel c
%) %) Ke] %) 7 o
C C (2] C C [72]
2 2 S 2 2 S .
< | o s | 3| x| | | F| &
g '-g ? 8 8 ol 8 e S ®
Zz s a| 38|88/ 8]8| 8] =
Compass v v v v v v v v v v
Latitude v v v v v v Ve v v v
Longitude v v v v v v v v v v
Grid locator v v Ve Ve v v v v v v
Altitude v v v Ve v v v v v
Distance v v v v v v v v v v
Course v v v v
Speed v v v v
Power v v v
Height v v v
Gain v Ve v
Directivity v v v
Temperature v
Rainfall v
Wind direction v
Wind speed v
Barometric pressure v
Humidity v
Symbol v v v v v v v v v
Time stamp v v v v v v v
Call sign v v v v v v v v v v
v Displayed
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5  GPS OPERATION

Checking your location (Continued)

< TX format: D-PRS Position (Mobile)

Displays the following items when the caller’'s TX
format is D-PRS Position (Mobile).

= GPS

FOSITION

v‘“ﬁl IR TN ALT: -E5ft
135°34. 29°E DET: 77, 9l
X\“ ~ GL: PHZ450

= GPS

FOSITION

COURSE: &°
SPEED: 0. Omph

IZLK4
s
3:33)

= GPS

< TX format: D-PRS Position (Base)

Displays the following items when the caller’s TX
format is D-PRS Position (Base).

FOSITION

77 3T AN
”\g':f 128°47. 30°E
i 6L PHOBIO

_|-,F'

POSITION

ALT: O19Ft [)
DST: 170n |

FOMER: OW

HE [GHT: 10f t
Ga W 0dB  DIRECT: Omn i

IW1ZLK
A
3z 447

Displays the caller’s direction

Displays the caller’s direction

5-6

Compass f . Compass .
rom your location from your location
Latitude Displays the caller’s latitude Latitude Displays the caller’s latitude
Longitude Displays the caller’s longitude Longitude Displays the caller’s longitude
Displays the grid locator based Displays the grid locator based
GL on the caller’s latitude and GL on the caller’s latitude and
longitude. longitude.
ALT Displays the caller’s altitude ALT Displays the caller’s altitude
DST Displays the caller’s distance DST Displays the caller’s distance
from your location from your location
COURSE Displays the caller’s course over POWER Displays the caller’s TX power
ground level
SPEED Displays the caller’s speed HEIGHT Displays the height of the caller’s
Svmbol Displays the caller’s D-PRS ar)tenna :
ymbo symbol GAIN Displays the gain of the caller’s
GPS Time Stamp Displays the time that the caller aptenna _ :
acquired the position data. DIRECT Displays the dlre.zctllon the caller’s
Call sign Displays the caller’s call sign ar_1tenna was p0|nt!nq
(with SSID) Symbol Displays the caller’'s D-PRS

symbol

GPS Time Stamp

Displays the time that the caller
acquired the position data.

Call sign

Displays the caller’s call sign
(with SSID)
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Checking your location (Continued)

< TX format: D-PRS Object < TX format: D-PRS Item
Displays the following items when the caller’'s TX Displays the following items when the caller’s TX
format is D-PRS Object. format is D-PRS Item.

GPS POSITION GPS POSITION

J 333N ALT: 1050ft JUG 3TN ALT: B6f
”i:‘j 120°25.28'E  DST: 330m ”#:ff 132°37.28'E  DST: 170
o= GL:PMG3FD e = GL: PMGEHG

PS POSITION = PS POSITION =
JM1 ZLE-
POWER: 81W  HE IGHT: BOf t ﬁ POWER: 81  HE [GHT: 160f t EEJ]
GAIN: YdB DIRECT: O i (B:23) GAIN: OdB  DIRECT: O
Displays the Object’s direction Displays the Item’s direction from
Compass . Compass .
from your location your location
Latitude Displays the Object’s latitude Latitude Displays the Iltem’s latitude
Longitude Displays the Object’s longitude Longitude Displays the Item’s longitude
GL Displays the grid locator based on Displays the grid locator based
the Object’s latitude and longitude GL on the ltem’s latitude and
ALT Displays the Object’s altitude longitude
Displays the Object’s distance ALT Displays the Item’s altitude
DST ) . —
from your location DST Displays the ltem’s distance from
Displays the Object’s course your location
COURSE . PTRY
over ground COURSE Displays the Item’s direction over
SPEED Displays the Object’s speed ground
Displays the Object’'s TX power SPEED Displays the Item’s speed
POWER : ;
level Displays the ltem’s TX power
- - — POWER
Displays the height of Object’s level
HEIGHT i i '
antenna HEIGHT Displays the height of Item’s
GAIN Displays the gain of Object’s antenna
antenna GAIN Displays the gain of ltem’s
Displays the direction that the antenna
DIRECT s o : —
Object’s antenna was pointing DIRECT Displays the direction that the
Displays the Object’s D-PRS Item’s antenna was pointing
Symbol - ;
symbol Svmbol Displays the ltem’s D-PRS
. Displays the time that the caller y symbol
GPS Time Stamp L : ; -
sent the Object’s data. Call sian Displays the caller’s call sign
Call sign Displays the caller’s call sign 9 (with SSID)
(with SSID) ® When the Item’s status is finished, “KILLED" is
® When the Object’s status is finished, “KILLED” is displayed.
displayed.
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Checking your location (Continued)

O TX format: D-PRS Weather

Displays the following items when the caller’'s TX
format is D-PRS Weather.

S GPS POSITION

DET: 179m |

7 35737, 40° N '

”\g':f 128°47. 30°E
o 6L: PHOSJD

= GPS

FOSITION

¢ TX mode: NMEA
Displays the following items when the caller’s TX
mode is NMEA.

FOSITION

= GPS

v‘\ 3°37.38'N ALT: 5Bf
135°34. 27°E DET: 7. Bml
\\ + GL: PHZ450

_|-,F'

POSITION

TEHP: 72°F WO IR: 220° 1M1 EL}{ COURSE: 342° I ZLE ”
RAIM: 0.00inh WSPD: dmph @ SPEED: 1. Omph
BARD: 28. 2inHg  HUMI: 50% (6z47] (72471 25)
Displays the caller’s direction Displays the caller’s direction
Compass . Compass .
from your location from your location
Latitude Displays the caller’s latitude Latitude Displays the caller’s latitude
Longitude Displays the caller’s longitude Longitude Displays the caller’s longitude
Displays the grid locator based Displays the grid locator based
GL on the caller’s latitude and GL on the caller’s latitude and
longitude longitude
Displays the caller’s distance ALT Displays the caller’s altitude
DST . . —
from your location DST Displays the caller’s distance
TEMP Displays the temperature of the from your location
caller’s area COURSE Displays the caller’s direction
RAIN Displays the rainfall of the over ground
caller’s area SPEED Displays the caller’s speed
Displays the wind direction of the Displays the time that the caller
WDIR ; i piay
caller's area GPS Time Stamp acquired the position data.
WSPD Displays the wind speed of the Call sign Displays the caller’s call sign
caller’s area
BARO Displays the: barometric pressure
of the caller’s area
HUMI Dlspla'ys the humidity of the
caller’s area
Displays the caller station’s
Symbol D-PRS symbol
) Displays the time that the caller
GPS Time Stamp acquired the weather data.
. Displays the caller’s call sign
Call sign (with SSID)
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5

Checking your location (Continued)

GPS OPERATION

< Changing the GPS memory or alarm
You can change the GPS memory or GPS alarm in
the GPS POSITION screen.

1.

Push [QUICK].

Rotate [DIAL] to select “GPS Position,” then push

[J].
* Displays the GPS POSITION screen.

Rotate [DIAL] to display the MEM screen or ALM

screen.
Push [QUICK].

When the MEM screen is displayed in step 3,
select “GPS Memory Select,” or when the ALM
screen is displayed in step 3, select “Alarm
Select.”

MEM screen

S GPs POSITICN 4/5 S
f?“ﬂ 24737, 557N GL: PM7ASP

i F 135" 34.15°E DET: 77, Pml
r:.)q;ﬁj lcom Osaka HC

ALM screen
S GPs POSITICN

f’”“‘ﬂl 35" 78N GL = PHASYP
[Ty o ’ .

Sl 139°47.66° E DST: 235m |
att . Tokyo Bigsite

Select the GPS memory or GPS alarm to display

on the GPS POSITION screen.

® See “Adding or editing GPS memory” or “Setting the

GPS alarm” for details. (pp. 5-27, 5-32)

< About the Grid Locator

Grid Locator (GL) is a location compressed into a 6
character code, calculated by the longitude and the

latitude.

The locator is simply calculated by dividing the earth

surface into squares.
It is used to find the area of a radio station.

PSS POSITION

N MR 2N
W& qa5°3g 17 E

GL: PHA4s0

SPEED: 21. Zmph

ALT: a5ft 1
TIME: 17:22:46

=
Py EZTE"

Field

——
PM74S0O

| Square ‘

|
Subsquare

* The grid locator map of Japan

oy 0
@ »
[0} d
H =
HHE‘
QR
oo ies)
!H

NN
— |0
® || m
=W
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Checking your location (Continued)

< Changing the Compass Direction
You can change the compass direction between
Heading Up, North Up, and South Up.

o Wen
A

Heading Up South Up

Iy

Push [QUICK].
Rotate [DIAL] to select “GPS Position,” then push

[J].
* Displays the GPS POSITION screen.

3. Push [QUICK].
4. Select “Compass Direction,” then push [J].

| 1/5E]
t

2mph

a0: 44

5. Select the compass direction.

N —

Compass Direction #

* Heading Up: The compass always points to your

heading course direction.
The top is always north.
The top is always south.

e
t

Zmph

* North Up:
» South Up:

Heading Up
Marth Up
South Up

SFL2IN ALT: 4BFt
S 35°30. 17 SPEED: 21. Zuph
v oce  GLIPMZASO  TIME:17:51:36

When you select “South Up.”
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< Saving your own or a received position

data
You can save the position data of your station from
wherever you are, and also the position data of the
caller station.
The GPS Memory has a total of 300 channels, and
the channels can be assigned into one of 27 banks, A
~ Z, and (No Group).

1. Push [QUICK].

2. Rotate [DIAL] to select “GPS Position,” then push
[J].
* Displays the GPS POSITION screen.

3. Select the screen that you want to save.

5 POSITION /5
f’ﬁNH\‘»‘ AT 2N ALT: 45f
e o . .
N 135°34.17°E  SPEED: 21. Zmph
v ooee Gl PH7AS0 TIME: 17:22: 46

® To save your own position data: MY screen

® To save a received position data: RX screen
Push [QUICK].

5. Select “Add To GPS Memory,” then push [J].

&

LATITUDE : 3 3 '
LONGITUDE: 135°34 .17'F
ALTITUDE :45ft v

® See pages 5-27 ~ 5-29 for entering details.
6. Select “<<Add Wr|te>> ” then push [J].

=chdd Writes= u

* The confirmation dialog “Add write?” is displayed.
® To select the destination group to be saved, select
“GROUP.”
7. Select <YES>, then push [J].

A write?
GRu

» Saves the data in the GPS memory, then returns to
the GPS POSITION screen.
8. Push [D].
* Returns to the standby screen.

TIP: The position data is saved in the selected
group with the "GROUP" item.
(GPS > GPS memory)
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Checking GPS information (Sky view screen)

This screen is used to view GPS satellite information
when the GPS icon does not stop blinking for a long
time.

GPS Information displays the quantity, signal power
and location of the GPS satellites.

The sky view screen displays the location of GPS
satellites. The screen also displays the direction,
elevation angle, satellite numbers, and their receiving
signal strength status.

1. Push [QUICK].
Rotate [DIAL] to select “GPS Information,” then

push [J].
* Displays the GPS INFORMATION screen.

FORMATION

[Tl
|| Fel o
hifriull 3 01 25 16 01 18 22 26 30 -- -- -- --
'I‘u-.*,. SAT: 4 34°37. 23N
] 26ft 13573417 E

Meaning of each icon

* (O): Untracking satellite.

* (01): Tracking satellite with a weak signal,
shown by the satellite number.

(01)E Tracking satellite with a strong signal,
shown by the satellite number.

* (SAT): The quantity of tracking satellites.

* Altitude:  The altitude of your station.

The altitude is only displayed when 4
or more satellites are tracked. When 3
or less satellites are tracked, “------ ft”
is displayed.
* Longitude/Latitude:
Longitude and Latitude of your
station.
« Signal strength graph:
Signal strength of the satellites
[l Tracking satellite with a strong
signal
E# Tracking satellite with a weak
signal
[J: Untracking satellite
3. Push[9D].
* Returns to the standby screen.
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Signal strength graph

S INFORMATION =2
N

el rrrl
Sky .F‘rﬁ lu Tt om oW __]
view 1‘% SAT 4 3437, 237N

screen 26t 4_‘ 135°34, 17 4_‘

Altitude Tracking Longitude Latitude
satellite
quantity

North

Untracking

@'_4— satellite
' < Satellite

number 16’s
signal is weak.

. p
Satellite —> "
|
o

number 7’s =) ol
signal is ..."-.__ || -
strong.

Elevation angle
0 degree line
Elevation angle
30 degree line
Elevation angle
60 degree line
Elevation angle
90 degree line
(Zenith)

* The image of the satellite number 7
Elevation angle 90
degree line (Zenith) Elevation angle
60 degree line
Elevation angle
30 degree line

E

Elevation angle
0 degree line
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Transmitting GPS data (D-PRS and NMEA)

< Type of position data

GPS position data has two types of TX mode, D-PRS
and NMEA. Moreover, in the D-PRS mode, you can
select a TX format from Position (Mobile station/Base
station), Object, Iltem and Weather.

Type of position data for transmission
[D-PRS (p. 5-13) | [NMEA (p. 5-25) |
— Position (Mobile) (p. 5-15) |

— Position (Base) (p. 5-15) |

— Object (p. 5-17)

|
— Item (p. 5-17) |
|

L{ weather (p. 5-21)

* D-PRS: D-PRS is a function that simultaneously
sends position data received from the
internal or external GPS receiver, using the
slow speed data packet space, along with
voice.

» Mobile: A station operating from a vehicle, a vessel,
or other location, away from it's normal
base location.

You can transmit direction and speed
information.

*Base: A station operating at home or in a building.
You can transmit the TX power level,
height, antenna gain and antenna direction
information.

* Object: Transmitting Object data such as an
earthquake information, satellite track
information, and so on.

An Object contains a time stamp.

* ltem: Transmitting Item data such as a traffic
accident, lighthouse, antenna, or DV
access point location, and so on.

An Item does not contain a time stamp. For users who have a D-STAR transceiver model
» Weather: A station transmitting weather information prior to the ID-4100A/E:

received from a weather device. The GPS TX mode, “GPS (DV-G)” and “GPS-A (DV-
* NMEA: A station transmitting position data A),” are now called as “NMEA” and “D-PRS.”

(NMEAO0183) received from the internal or * GPS (DV-G) » NMEA

external GPS receiver. * GPS-A (DV-A) = D-PRS

For users who have one of the following models:
(ID-800H, IC-91AD/E91, I1C-U82, IC-V82, IC-7100,
ID-51A/E, ID-31A/E, I1C-9100, IC-80AD/E8OD, ID-
880H/E880, IC-92AD/E92D, 1C-2820H/E2820)
When you receive a D-PRS position (Base),

Object, Iltem or Weather signal, position data is not
displayed.

5-12
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Transmitting D-PRS data

When D-PRS is selected as GPS TX mode, you can
transmit D-PRS data.

When operating in the D-PRS mode, the following
codes are transmitted to the PC.

D-PRS code is based on APRS® code.

(APRS®: Automatic Packet Reporting System).

¢ D-PRS

D-PRS is a mode that simultaneously sends position
data received from the internal or external GPS
receiver, using the slow speed data packet space,
along with voice in the DV mode.

In an analog mode, you can transmit or receive

only voice or data at one time. However a D-PRS
capable radio can transmit or receive message data
or GPS position data at the same time voice is being
transmitted or received.

I-GATE is required to send position data to the APRS

NOTE:

* If “GPS select” is set to “Manual,” the manually
entered position data in “Manual Position” is
change to the D-PRS data format to transmit.
(p. 9-24)

(GPS > GPS Set > Manual Position)

* Please note that if “GPS Auto TX” is set to any
other setting than “OFF,” the data is transmitted
according to the set time. (p. 9-40)

(GPS > GPS Auto TX)

The image of D-PRS
<Using a repeater>

Voice, Messages and
D-PRS positions

server.
P D-STAR

repeater

O

N I-GATE
Voice, Messages and

D-PRS positions

<Simplex> Voice, Messages and

D-PRS positions

/[ \
I-GATE

Voice, Messages and
D-PRS positions

=0
I(l\—lTE\R NET <¢—»
N

Information from an APRS network

D-PRS positions

D-PRS
positions

You can check the
location on a map site.

APRS server

D-PRS positions

< Operating in the D-PRS mode

To transmit in D-PRS, follow the steps below, and
for more details, see the pages listed along with the
steps.

1. “MY” (Your own call sign) entering (p. 9-47)
. Receiving GPS data (p. 5-2)
3. Set“GPS TX mode” to “D-PRS.” (p. 5-15)
® Set transceivers prior to the ID-4100A/E to “GPS-A
(DV-A).”
4. Set TX information (pp. 5-15 ~ 5-22)
® You must set SSID and symbol.
(GPS > GPS TX Mode > D-PRS > TX Format >
Position, Object, item or Weather > SSID, Symbol)
\)
Complete (You can transmit in the D-PRS mode.)

TIP: In the D-PRS mode, you can transmit
earthquake or weather information, in addition to
position data.

(GPS > GPS TX mode > TX format)

TX format of D-PRS
* Position (Mobile/Base):
Used to transmit position data.

* Object: Used to transmit specific position data.
(Contains a time stamp.)
* Item: Used to transmit specific position data.

(Does not contain a time stamp.)
» Weather: Used to transmit weather information.
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Transmitting D-PRS data (Continued)

< Displayed items
Depending on the TX format, the setting items and displayed order of the items differ.

D-PRS
Position Object ltem
2 =
= =
© °
o o
g g
- £ o £
| S S| &
Q = Qo =
Q5 Q| B
@ @ @ IS
2] T £ L
L S = L S =
[T 1) T o
c| 8| || 8] z
c c o c c o
iel Re) c Re) Re) c
7] » K] 7 7] e}
5| 5|2 5| 5| ¢
- - (5] -— -— (&) —
o S| | F| 8| 8| F| 2
AN IEIE IR IR IR IR IR
s | a|a| 8| 8| 8| a| 8| =
Unproto Address v v v v v v v v v
Comment v v v v v v v v v
Altitude v v
Object Name/ltem v v v v v v
Name
Data Type v v v v v v
Position information v v v v v v
(Latitude/Longitude/
Altitude)
Data Extension v v v v v v v v
Course v v
Speed v v
Power v v v
Height v v v
Gain v v v
Directivity v v v
Symbol v v v v v v v v v
SSID v v v v v v v v v
Time stamp v v v v v v
v: Displayed
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Transmitting D-PRS data (Continued)

<© Setting D-PRS Position (Mobile/Base)

Set to transmit as a D-PRS Position.

1. Setting the GPS TX Mode to D-PRS

5. Setting the SSID

GPS > GPS TX Mode

1. Push [MENU].

2. Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS TX Mode,” then push [J].

4. Select “D-PRS,” then push [J].

TIP: If the TX information setting has been done, you
can easily turn ON the GPS TX mode by pushing
[MENU] after step 4.

* Returns to the standby screen, then displays “T#.”

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.
1. Select “Unproto Address,” then push [J].
® The default setting is “AP1410,DSTAR*.”
2. Push [9].
* Returns to the previous screen.

3. Setting the TX format to “Position”

1. Select “TX Format,” then push [J].
2. Select “Position,” then push [J].
* Displays the POSITION screen.

4, Setting the Symbol

Select the symbol that indicates your operating
situation. The selected symbol channel’'s symbols
(1~4) are transmitted along with the position data.
Select “Symbol,” then push [J].
Select the symbol channel, then push [QUICK].
Select “Edit Symbol,” then push [J].
Select the symbol, then push [J].
® 1:Car, 2: Van, 3: Truck, and 4:House QTH (VHF) are
set as defaults.

® See page 9-24 to directly edit a symbol.
5. Select the symbol channel, then push [J].

* Returns to the POSITION screen.

PO

5-15

To assist in identifying a station’s type, the displayed
APRS® (Automatic Packet Reporting System) based
SSID is added after the D-PRS data call sign.

The way to add SSID'’s differs, depending on whether
you enter a space in your call signs or not.

1. Select “SSID,” then push [J].

Select the SSID, then push [J].
The space in call sign is converted
to “-.” If no text is entered after the
space, the space will be deleted, and
the space is not converted to “-.”
Example: JA3YUA A > JA3YUA-A
No SSID is added. If a call sign
includes a space, any text or digit

after the space will be deleted.

*-1~-15:  Adds an SSID of -1 to -15 to your call
sign.
Example: SSID is “-9.”
JA3YUAA — JA3YUA-9
o -A~-Z: Adds an SSID of -A to -Z to your call

sign.
Example: SSID is “-Z.”
JA3YUAA — JA3YUA-Z

About the SSID

To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

1= Continued on the next page.
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Transmitting D-PRS data

< Setting D-PRS Position (Mobile/Base) (Continued)
6. Entering a comment

8. Setting the Altitude

Enter a comment, and transmit it with the D-PRS
position data.

The number of characters you can enter differs,
depending on the data extension and altitude settings.
(See to the right.)

Data Extension Altitude erﬁzzs?tl\ﬁ;i.)
OFF OFF 43 (Default)
OFF ON 35
Course/Speed OFF 36
Course/Speed ON 28
Power/Height/Gain/Directivity OFF 36
Power/Height/Gain/Directivity ON 28

Select “Comment,” then push [J].
Select the comment number 1 ~ 4, then push
[QUICK].
3. Select “Edit,” then push [J].

* Enters the Comment entry mode.
4. Enter a comment.

Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()*+
-l <=>?2@ [V {]} (space)

® See “Entering and editing text” for details. (p. iv)

® The symbol “4” shows the transmittable comment
range. Please note that the characters that exceed
the range will not be transmitted.

After entering, push [J].

Select the entered comment number, then push

[J].

N —

oo

7. Setting the Time Stamp

Set the time stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
1. Select “Time Stamp,” then push [J].
2. Select the time stamp, then push [J].

* OFF: Does not transmit the time information.

* DHM: Transmits the time stamp in the Day, Hour,
and Minute format.
Transmits the time stamp in the Hour,
Minute, and Second format.

* HMS:

5-16

Set the altitude data transmission.
1. Select “Altitude,” then push [J].
2. Select “ON,” then push [J].

NOTE: If you transmit with the altitude setting ON,
the character string is included in a comment on the
products that cannot display the altitude. (IC-9100,
IC-80AD, IC-E80D, ID-880H, ID-E880, IC-92AD, IC-
E92D, IC-U82, IC-V82)

9. Setting the Data Extension

Set the data extension of your station’s information.
1. Select “Data Extension,” then push [J].
2. Select the option to transmit, then push [J].
* OFF: Does not transmit any
information.
» Course/Speed: Transmits the course and speed
data along with the position data.
» Power/Height/Gain/Directivity:
Transmits the TX power level,
height, antenna gain and antenna
direction, along with the position
data.

10. Setting the TX power

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the TX power level of the base station, to
transmit along with the position data.
1. Select “Power,” then push [J].
2. Select the option, then push [J].
* Options: Set to between 0, 1, 4, 9, 16, 25, 36,
49, 64, and 81W.

11. Setting the antenna height

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the height of the base station’s antenna, to
transmit along with the position data.
1. Select “Height,” then push [J].
2. Select the option, then push [J].
* Options: Set to between 10, 20, 40, 80, 160,
320, 640, 1280, 2560, and 5120 feet.
® You can change the unit to “meter.” (p. 9-64)

iz Continued on the next page.
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Transmitting D-PRS data

< Setting D-PRS Position (Mobile/Base) (Continued)
12. Setting the antenna gain

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the gain of the base station’s antenna, to
transmit along with the position data.
1. Select “Gain,” then push [J].
2. Select the option, then push [J].
* Options: Set to between 0 and 9 dB.

13. Setting the antenna directivity

< Setting D-PRS Object/Item
Set to transmit as a D-PRS Object or ltem.

1. Setting the GPS TX Mode to D-PRS

GPS > GPS TX Mode

1. Push [MENU]I.
Rotate [DIAL] to select “GPS,” then push [J].
* Displays the GPS screen.

3. Select “GPS TX Mode,” then push [J].

4. Select “D-PRS,” then push [J].

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the direction the base station’s antenna was
pointing, to transmit along with the position data.
1. Select “Directivity,” then push [J].
2. Select the option, then push [J].
* Options: Set to between Omni, 45°NE, 90°E,
135°SE, 180°S, 225°SW, 270°W,
315°NW and 360°N.

14. Exiting the MENU screen

TIP: If the TX information setting has been done, you
can easily turn ON the GPS TX mode by pushing
[MENU] after step 4.

* Returns to the standby screen, then displays ‘T%+#.”

Push [MENU].
* Returns to the standby screen, then displays “T&#.”

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.
1. Select “Unproto Address,” then push [J].
® The default setting is “AP1410,DSTAR*.”
2. Push [9].
* Returns to the previous screen.

3. Setting the TX format to “Object” or “ltem”

1. Select “TX Format,” then push [J].
2. Select “Object” or “ltem,” then push [J].
* Displays the OBJECT or ITEM screen.

4. Entering Object name or ltem name

Enter an Object or ltem name, such as an event
information or location.
1. Select “Object Name” or “ltem Name,” then push

[J].

* Displays the “Object Name” or “ltem Name” screen.
2. Enter an Object or Item name of up to 9

characters.

Selectable characters and symbols
AtoZ,atoz,0to 9, !"#$% & ()*+
ol <=>2@ VN {]} (space)
® See “Entering and editing text” for details. (p. iv)
3. After entering, push [J].

&z Continued on the next page.



Previous view

5

GPS OPERATION

Transmitting D-PRS data

< Setting D-PRS Object/ltem (Continued)
5. Setting Data type

Set the Object or ltem’s status.
1. Select “Data Type,” then push [J].
2. Select the option, then push [J].
(For an Object)
* Live Object: The Object is valid.
« Killed Object: The Object is invalid.
(For an Item)
* Live Item: The Item is valid.
* Killed Iltem: The Item is invalid.

6. Setting Symbol

Select a symbol that indicates an Object or Item.
1. Select “Symbol,” then push [J].
2. Select the symbol, then push [J].

® “Radio” is set as the default.

® See page 9-24 for directly editing a symbol.

7. Entering a Comment

Enter a comment to transmit as an Object or Item.
The number of characters you can enter differs,

depending on the data extension and altitude settings.

(p. 5-19)
Data Extension Altitude erﬁzz:itl\:;i.)

OFF No data | 43 (Default)
OFF Set 35
Course/Speed No data 36
Course/Speed Set 28
Power/Height/Gain/Directivity | No data 36
Power/Height/Gain/Directivity Set 28

Select “Comment,” then push [J].
. Push [QUICK].
3. Select “Edit,” then push [J].
* Enters the Comment entry mode.
4. Enter a comment.
Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()*+
- l<=>?2@ [\ " {]}" (space)
® See “Entering and editing text” for details. (p. iv)
® The symbol “J1” shows the transmittable comment
range. Please note that the characters that exceed
the range will not be transmitted.
5. After entering, push [J].
* Displays the entered Comment.
6. Push[9].
* Returns to the OBJECT or ITEM screen.

N —
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8. Setting the Position

Set the position data of an Object or Item.

For example, if you want to transmit traffic accident
information as an Item, set the location where the
accident has happened.

If the position data is entered in the GPS memory, you
can easily set the position data from the memory.

1. Select “Position,” then push [J].
2. Push [QUICK].
3. Select “Edit,” then push [J].

* Displays the POSITION EDIT screen.

TIP: When you select “Capture From GPS” or “Set
From GPS Memory” in step 3, you can capture the
position data from the GPS, or set the Object or
Item’s position data from the GPS memory.

Entering the latitude

4. Select “LATITUDE,” then push [J].
* Displays the LATITUDE screen.

5. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

6. Rotate [DIAL] to enter the latitude.

* Range: Set to between 0°00.00' to 90°00.00'.
® You can change the unit to “ddd°mm'ss".” (p. 9-64)
® To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”
7. Repeat steps 5 and 6 to enter the latitude.
8. After entering, push [J].

Entering the longitude

9. Select “LONGITUDE,” then push [J].

* Displays the LONGITUDE screen.

Push [MW] to move the cursor forwards, or push

[MODE] to move the cursor backwards to select a

digit to enter.

11. Rotate [DIAL] to enter the longitude.

* Range: Set to between 0°00.00' to 180°00.00".

® You can change the unit to “ddd°’mm'ss".” (p. 9-64)

® To enter an east longitude, select “E,” and to enter a
west longitude, select “W.”

Repeat steps 10 and 11 to enter the longitude.

After entering, push [J].

10.

12.
13.

i Continued on the next page.
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< Setting D-PRS Object/ltem
8. Setting the Position (Continued)

Entering the altitude

14. Select “ALTITUDE,” then push [J].

* Displays the ALTITUDE screen.

Rotate [DIAL] to select between plus and minus.
Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

Rotate [DIAL] to enter the altitude.

* Range: Set to between —32808 and +32808 feet.
Repeat steps 16 and 17 to enter the altitude.

After entering, push [J].

Select “<<Write>>" then push [J].

* The confirmation dialog “Write?” is displayed.

Select <YES>, then push [J].

» Writes the entered position data.

Push [9].

* Returns to the OBJECT or ITEM screen.

15.
16.
17.
18.
19.
20.
21.

22.

9. Setting the Data Extension

Set the data extension of an Object or Iltem’s
information.
1. Select “Data Extension,” then push [J].
2. Select the option to transmit, then push [J].
* OFF: Does not transmit any
information.
» Course/Speed: Transmits the course and speed
data along with the position data.
» Power/Height/Gain/Directivity:
Transmits the TX power level,
height, antenna gain and antenna
direction, along with the position
data.

10. Setting the Course

® This item is displayed when “9. Setting Data
Extension” is set to “Course/Speed.”

Set the Object or Item’s course when the station

moves.

1. Select “Course,” then push [J].

2. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

3. Rotate [DIAL] to enter the Object or Item’s course.

* Range: Set to between 0° and 360°.

Repeat steps 2 and 3 to enter the course.

5. After entering, push [J].

B
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11. Setting the Speed

® This item is displayed when “9. Setting Data
Extension” is set to “Course/Speed.”

Set the Object or Item’s speed.

1. Select “Speed,” then push [J].

2. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

3. Rotate [DIAL] to enter the Object or Item’s speed.
» Range: Set to between 0 and 1150 mph.
® You can change the unit to “km/h” or “knots.”

(p. 9-64)
4. After entering, push [J].

12. Setting the TX power

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the TX power level of the Object or ltem if the
station is a repeater, node, access point, and so on
and an antenna is installed.
1. Select “Power,” then push [J].
2. Select the option, then push [J].
* Options: Set to between 0, 1, 4, 9, 16, 25, 36,
49, 64, and 81W.

13. Setting the antenna height

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the height of the Object or ltem’s antenna if the
station is a repeater, node, access point, and so on
and an antenna is installed.
1. Select “Height,” then push [J].
2. Select the option, then push [J].
* Options: Set to between 10, 20, 40, 80, 160,
320, 640, 1280, 2560, and 5120 feet.
® You can change the unit to “meter.” (p. 9-64)

14. Setting the antenna gain

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the gain of the Object or Item antenna.
1. Select “Gain,” then push [J].
2. Select the option, then push [J].

* Options: Set to between 0 and 9 dB.

iz Continued on the next page.
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Transmitting D-PRS data

< Setting D-PRS Object/ltem (Continued)
15. Setting the antenna directivity

17. Setting Time Stamp

® This item is displayed when “9. Setting Data
Extension” is set to “Power/Height/Gain/Directivity.”

Select the direction the base Object or Item’s antenna
was pointing.
1. Select “Directivity,” then push [J].
2. Select the option, then push [J].
* Options: Set to between Omni, 45°NE, 90°E,
135°SE, 180°S, 225°SW, 270°W,
315°NW and 360°N.

16. Setting the SSID

To assist in identifying a station’s type, the displayed
APRS® (Automatic Packet Reporting System) based
SSID is added after the D-PRS data call sign.

The way to add SSID’s differs, depending on whether
you enter a space in your call signs or not.

1. Select “SSID,” then push [J].
Select the SSID to set, then push [J].

The space in call sign is converted
to “-.” If no text is entered after the
space, the space will be deleted, and
the space is not converted to “-.”
Example: JASYUAA > JAYUA-A
No SSID is added. If a call sign
includes a space, any text or digit
after the space will be deleted.
Adds an SSID of -1 to -15 to your call
sign.
Example: SSID is “-9.”

JA3BYUAA — JA3YUA-9
Adds an SSID of -A to -Z to your call
sign.
Example: SSID is “-Z.”

JA3YUAA — JA3YUA-Z

o -A~-Z:

About the SSID

To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

5-20

® This item is displayed when the TX format is
“Object.”

Set the time stamp function to transmit the Object’s
time data in UTC (Universal Time Coordinated) time.
1. Select “Time Stamp,” then push [J].
2. Select the time stamp,” then push [J].
* DHM: Transmits the time stamp in the Day, Hour,
and Minute format.
* HMS: Transmits the time stamp in the Hour,
Minute, and Second format.

18. Exiting the MENU screen

Push [MENU].
* Returns to the standby screen, then displays “I%+.”
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Transmitting D-PRS data (Continued)

< Setting D-PRS Weather

Set to transmit as a D-PRS Weather station.

1. Setting the GPS TX Mode to D-PRS

GPS > GPS TX Mode

1. Push [MENU].

2. Rotate [DIAL] to select “GPS,” then push [J].
* Displays the GPS screen.

3. Select “GPS TX Mode,” then push [J].

4. Select “D-PRS,” then push [J].

TIP: If the TX information setting has been done, you
can easily turn ON the GPS TX mode by pushing
[MENU] after step 4.

* Returns to the standby screen, then displays ‘T%+#.”

2. Checking the Unproto Address

You should use the default address, and editing is not
recommended.
1. Select “Unproto Address,” then push [J].
® The default setting is “AP1410,DSTAR*.”
2. Push [9].
* Returns to the previous screen.

3. Setting the TX format to “Weather”

1. Select “TX Format,” then push [J].
2. Select “Weather,” then push [J].
* Displays the WEATHER screen.

4. Setting Symbol

Select a symbol that indicates the weather station.
1. Select “Symbol,” then push [J].
2. Select the symbol, then push [J].

® See page 9-24 for directly editing a symbol.

® “WX Station” is set as the default.
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5. Setting the SSID

To assist in identifying a station’s type, the displayed
APRS® (Automatic Packet Reporting System) based
SSID is added after the D-PRS data call sign.

The way to add SSID’s differs, depending on whether
you enter a space in your call signs or not.

1. Select “SSID,” then push [J].
2. Select the SSID to set, then push [J].
The space in call sign is converted
to “-.” If no text is entered after the
space, the space will be deleted, and
the space is not converted to “-.”
Example: JASYUAA > JA3YUA-A
No SSID is added. If a call sign
includes a space, any text or digit
after the space will be deleted.
Adds an SSID of -1 to -15 to your call
sign.
Example: SSID is “-9.”

JA3YUAA — JA3YUA-9
Adds an SSID of -A to -Z to your call
sign.
Example: SSID is “-Z.”

JA3YUAA — JA3YUA-Z

o -A~-Z:

About the SSID

To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to

D-PRS and APRS®, and correctly set.

= Continued on the next page.
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Transmitting D-PRS data

¢ Setting D-PRS Weather (Continued)
7. Entering a Comment

Enter a comment to transmit as a D-PRS Weather
station.
1. Select “Comment,” then push [J].
2. Push [QUICK].
3. Select “Edit,” then push [J].
* Displays the “Comment” screen.
4. Enter a comment of up to 43 characters.
Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()*+
-l <=>?2@ [V {]} (space)
® See “Entering and editing text” for details. (p. iv)
® The symbol “J” shows the transmittable comment
range. Please note that the characters that exceed
the range will not be transmitted.
5. After entering, push [J].
6. Push [9].
* Returns to the WEATHER screen.

8. Setting Time Stamp

Set the time stamp function to transmit the received
time data in UTC (Universal Time Coordinated) time.
1. Select “Time Stamp,” then push [J].
2. Select the time stamp,” then push [J].
* OFF: Does not transmit the time information.
* DHM: Transmits the time stamp in the Day, Hour,
and Minute format.
* HMS: Transmits the time stamp in the Hour,
Minute, and Second format.

9. Exiting the MENU screen

Push [MENU].
* Returns to the standby screen, then displays “I%#.”
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Transmitting D-PRS data (Continued)

< Weather station transmission

When you transmit as a weather station, you should
set the weather station’s settings, and input the
weather data to the [DATA] terminal.

You can input the weather data from a third party’s
weather device by converting it to the APRS weather
format in your PC or microcomputer.

After completing the weather station’s settings, and
inputting the weather data, you can transmit as a
weather station.

NOTE: If the weather data is not input to the [DATA]
terminal, you cannot transmit as a weather station.

Tr scelver

=)

To the
RS-232C
port

[DATA] ; - =7
jack i T
)~ ee{ID——<0

Cable

To the
USB port

OPC-2350LU Weather device

Microcomputer

Terminal information

O1|n (d)

@ Tip: RXD
@ Ring: TXD
(3 Sleeve: GND

< Confirming the weather data input
You can confirm whether or not the weather data is
input to the [DATA] terminal.

1. Set the “GPS TX Mode” to “D-PRS,” and the “TX

format” to “Weather.” (pp. 5-21, 5-22)

2. On the standby screen, push [QUICK].
3. Rotate [DIAL] to select “Weather Information,”

then push [J].

* Displays the weather information screen as shown
below if the weather data is input to the [DATA]
terminal.

® When the weather information is displayed, you can

transmit as a weather station. If “-” is displayed on
the screen, the weather data does not input to the
[DATA] terminal. In that case, check the input data

settings.
D
TEWP: 25.0°C WOIR: 220°
‘ RAIM: 0. Onm/h WSPD: 1. 8nfs
BARO: 990k Pa HUK | = 503 3
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< Application setting

Configure the communication software as follows.

* Port: The COM port number that is used by
the 1D-4100A/E.*!

» Baud rate:  4800/9600 bps*2

* Data: 8 bit

* Parity: none

* Start: 1 bit

* Stop: 1 bit

¢ Flow control: none

*1 Depending on the PC environment, the COM port number
used by the ID-4100A/E may be higher than 5. In that
case, use an application that can set it to higher than 5.

*2 Set the baud rate in the “Data Speed” item.

(Function > Data Speed) (p. 9-60)

< About the weather data content

The weather data should be input according to the
format (based on the APRS® Weather Data) as shown
below.

Example:
220/0049005t077r000p000P000h50b09900 End code

1 2 3 4 5 6 7 8 9
No. Item Value Unit
1 | Wind direction 000 to 360 °
2 | Wind speed 000 to 999 mph
3 |Gust speed g000 to g999 mph
4 | Temperature t-99 to t-01, F
t000 to 1999
5 |Rainfall r000 to r999*" inch
6 |Rainfall (24 Hours) |p000 to p999*" inch
7 |Rainfall (Midnight) |P000 to P999* inch
8 [Humidity h00, h01 to h99 %
(h00 indicates 100%.)
9 [Barometric pressure | b00000 to b99999*2 [hPa,
mb
*1 The last two digits indicate the two decimal place.
*2 The last digit indicates the one decimal place.
® If you have no data, enter a space or “.” (period)

instead of a number.
(Example: “.../...g...t077r000p...P...h50b.....")
® Enter <CR>, <LF> or <CR><LF> for an end code.



Previous view

5  GPS OPERATION

Transmitting D-PRS data (Continued)

< Displaying your location using a mapping software \‘ »

If you transmit to an I-GATE station, and then enter
the call sign information on the internet map website,
the set symbol is displayed.

You can check the
location at a map site.

For your reference

D-PRS data content
D-PRS data content are shown below.
< Position (Mobile)

(e.g.) JASYUA-A>API41 0,DSTAR*:_/002338h3437.38N/ 13534.29E>090/002/A=000012ID-4100 OP.SATOH
» @ ® @ @ é) é @ e W@

<Position (Base)

(e.g.) JASYUA-A>API410,DSTAR*:/002338n3437.38N/13534.29E-PHG5132/ID-4100 OP.SATOH

ONINO) ® @ @ & N @

< Object

(e.g.) JASYUA-A>API410,DSTAR*:;HAM FESTA*01234523437.38N\13534.29Eh/2017.4.1 am10-pm4
® @ ® @ ® ® 0 N

Oltem

(e.g.) JASYUA-A>API410,DSTAR™:)REPEATER!3454.00N/13536.00ErPHG5132/439.39MHz DV RPT JP3YHH A
® @ ® @ ® © & P

<OWeather

(e.g.) JASYUA-A>API410,DSTAR*:/01234523454.00N/13536.00E_220/004g005t077r000p000P000h50b09900
v @ ® @ 0 ® § © L B ©® 08 o @0 o

. (2Data Extension(PHG codes)

%gg|||§ an PHG codes definitions

(®Unproto Address 0 1 2 3 4 5 6 7 8 9

@D-PRS Data type First: Power 0 1 4 9 16 25 36 49 64 81 (W)

/ Position with time stamp

. ! 4 Second: Height| 10 20 40 80 160 [ 820 | 640 | 1280 | 2560 | 5120 | (feet)
! Position without time stamp —
. Object Third: Gain 0 1 2 3 4 5 6 7 8 9 (dB)
; ltem Fourth: Directivity] omni | 45°NE | 90°E | 135°SE | 180°S [ 225°SW | 270°W | 315°NW| 360°N [ - -
(®O0bject Name/ltem Name
®Data Type B3Altitude (9Rainfall (24 Hours)
* Live Object —99999 ~ 999999 feet 0.00 ~9.99 inch
! Live ltem @Comment @)Rainfall (Midnight)
_ Killed Object/Killed ltem @Wind direction/Wind speed 0.00 ~9.99 inch
@Time Stamp(UTC) Wind direction:0 ~ 360° @)Humidity
h Hour Minute Second Wind speed: 0 ~ 999 mph 1 ~99%, 00=100%
z Day Hour Minute @®Gust speed @2Barometric pressure
(®Latitude 0 ~ 999 mph 0.0 ~9999.9 hPa
®Symbol @Temperature
({@Longitude -99 ~ 999°F
{Data Extension(Course/Speed)  (3Rainfall
Course:0 ~ 360° 0.00 ~ 9.99 inch

Speed:0 ~ 999 knots
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Transmitting NMEA data

Set a GPS sentence to transmit GPS data in the DV
mode.

< Setting the GPS data sentence
GPS > GPS TX Mode > NMEA > GPS Sentence

Push [MENU].

Rotate [DIAL] to select “GPS,” then push [J].
Select “GPS TX Mode,” then push [J].

Select “NMEA,” then push [J].

Select “GPS Sentence,” then push [J].

« Displays the “GPS Sentence” screen.

Rotate [DIAL] to select the GPS sentence, then

aorowh =

o

[0 GLL

+ Displays “v” when the sentence is set to ON.

® The selectable GPS sentences are RMC, GGA, GLL,
VTG, GSA and GSV. The GGA sentence is set to ON
as the default GPS sentence.

Repeat step 6 to set the GPS sentence.

® A maximum of four GPS sentences can be set at a
time.

Push [MENU].

* Returns to the standby screen, then displays “‘T&+#.”

The display while transmitting NMEA data
Displayed when “GPS TX Mode” is

set to “NMEA.”
.
432.875 %
UR: CQCQCH

® When you transmit, the set GPS sentence
is also transmitted.

« Contents of GPS sentence

NOTE:

 Set the GSV sentence to OFF when sending the
GPS message to a conventional digital transceivers
(IC-2820H, IC-E2820, ID-800H, IC-91AD, IC-E91,
IC-V82, IC-U82, IC-2200H).

The GSV sentence is incompatible with them.

* If “GPS Select” is set to “Manual,” the transceiver
automatically sets the NMEA sentence, and
transmits it along with the manually entered
position data in “Manual Position.” (p. 9-24)

(GPS > GPS Set > Manual Position)

* Please note that if “GPS Auto TX” is set to any
other setting than “OFF,” the data is automatically
transmitted according to the set time. (p. 9-40)
(GPS > GPS Auto TX)

TIP: To return to the default setting:
1. Push [QUICK] in step 6.
2. Select “Default,” then push [J].

Lon Date 2D | COG | SOG
Sentence ILat Alt |UTC (UTC) Status 13D |(True)|(knot) Others
RMC | v v v v v v | Magnetic variation, Mode Indicator
Number of satellites in use, HDOP, Geoidal
GGA vViv|Y v separation, Age of Differential GPS data
GLL v v v Mode Indicator
VTG v v CO_G (Magnetic north), SOG (km/h), Mode
Indicator
ID numbers of satellites used in solution, PDOP,
GSA v |V HDOP, VDOP
Total number of sentences, Sentence number,
GSV Total number of satellites in view, Satellite
information (ID, Elevation, Azimuth, S/N)
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Transmitting NMEA data (Continued)

< Entering a GPS message
Enter a GPS message to be transmitted with the
position data.

Example: Entering “Japan TOM”
GPS > GPS TX Mode > NMEA > GPS Message

1. Push [MENU].
Rotate [DIAL] to select “GPS,” then push [J].
* Displays the GPS screen.

3. Select “GPS TX Mode,” then push [J].

4. Select “NMEA,” then push [J].

5. Select “GPS Message,” then push [J].
* Displays the “GPS Message” screen.

6. Push [QUICK].

7. Select “Edit,” then push [J].

* Enters the GPS message entry mode.
8. Enter a GPS message of up to 20 characters.

lapan TOM_

— — CLR AR
(Example: Japan TOM)

Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()*+
-l <=>?2@ [V {]} (space)
® See “Entering and editing text” for details. (p. iv)

9. After entering, push [J].
* Displays the entered message.

lapan TOM

10. Push [MENU].
* Returns to the standby screen.
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Adding or editing GPS memory

< GPS memory

You can add GPS data to GPS Memory.

You can add your own position data, other station’s
position data, or any position data that are manually
entered.

The GPS Memory is capable of storing a total of 300
channels, and conveniently saved in up to 27 groups,
from Ato Z and “(No Group).” The A to Z groups can

also be named.

< Add a GPS memory
Example: Add "HOME" into (No Group)
1. Adding GPS Memory and entering the edit mode

| GPS Memory |

Group names are just
example.

—| (No Group)

— A: ICOM

|
|7-| Icom Osaka HC |

-| lcom America |

—| B: HAM festa

I I Tokyo Bigsite |

—| C: Railroad

| -| Dayton Hamventio |

-| Friedrichshafen |

—|Z:

2. Entering the GPS Memory name

GPS > GPS Memory

1. Push [MENU]I.
. Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS Memory,” then push [J].
* The previously added GPS memories are displayed on
the GPS MEMORY screen.

Select “(No Group),” then push [J].
Push [QUICK].
Select “Add,” then push [J].

ook

* Displays the GPS MEMORY EDIT screen.

TIP: To edit the previously saved GPS memory,
select “Edit” in the step 6. You can enter the content
in the same way as described above.

Add
I ove
Delete
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1.

2.

Select “NAME,” then push [J].

* Enters the GPS Memory name entry mode.
Enter a GPS memory name of up to 16
characters.

HOME,

= — LR 4B

(Example: HOME)

Selectable characters and symbols

AtoZ,atoz Oto
-l <=>2?2@ [\ ]

9, 1"#$%& ()*+
*_ {1} (space)

® See “Entering and editing text” for details. (p. iv)

After entering, push

[J].

* Returns to the GPS MEMORY EDIT screen.

iz Continued on the next page



Previous view

5

GPS OPERATION

Adding or editing GPS memory

< Add a GPS memory (Continued)

3. Entering the GPS Memory date 6. Entering the GPS Memory longitude

1. Select “DATE,” then push [J]. 1. Select “LONGITUDE,” then push [J].
* Enters the date entry mode. * Displays the LONGITUDE screen.

2. Push [MW] to move the cursor forwards, or push 2. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a [MODE] to move the cursor backwards to select a
digit to enter. digit to enter.

3. Rotate [DIAL] to enter the date. 3. Rotate [DIAL] to enter the longitude.

* Range: Set to between 2000/01/02 and * Range: Set to between 0°00.00' to 180°00.00".
2099/12/30. ® You can change the unit to “ddd°mm'ss".” (p. 9-64)
4. Repeat steps 2 and 3 to enter the date. ® To enter an east longitude, select “E,” and to enter a
west longitude, select “W.”
4. Repeat steps 2 and 3 to enter the longitude.
20170288 Man) ELOMNGITUDE
= 12524 2 E

5. After entering, push [J]. — —

4. Entering the GPS Memory time 5. After entering, push [¢J].

1. Select "TIME," then push [J]. 7. Entering the GPS Memory altitude

(3]

* Enters the time entry mode.

Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

Rotate [DIAL] to enter the time.

* Range: Set to between 00:00:00 and 23:59:59.
Repeat steps 2 and 3 to enter the time.

1%:11

—

After entering, push [J].

—

. Entering the GPS Memory latitude

Select “LATITUDE,” then push [J].

* Displays the LATITUDE screen.

Push [MW] to move the cursor forwards, or push

[MODE] to move the cursor backwards to select a

digit to enter.

Rotate [DIAL] to enter the latitude.

* Range: Set to between 0°00.00' to 90°00.00'".

® You can change the unit to “ddd°’mm'ss".” (p. 9-64)

® To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”

Repeat steps 2 and 3 to enter the latitude.

ELATITUDE

24°27 2N

— —

After entering, push [J].

5-28

wn

©o

Select “ALTITUDE,” then push [J].

* Displays the ALTITUDE screen.

Rotate [DIAL] to select between plus and minus.
Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards to select a
digit to enter.

Rotate [DIAL] to enter the altitude.

* Range: Set to between —32808 and +32808 feet.
Repeat steps 3 and 4 to enter the altitude.
EALTITUDE

+0005fft

—

After entering, push [J].

—

. Selecting the GPS memory group

N —

Select “GROUP,” then push [J].
Select the group between (No Group) and A ~ Z.

EGROUP

149

A [COR
B: HAM festa

® A total of up to 300 memories can be saved.

= Continued on the next page
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Adding or editing GPS memory

< Add a GPS memory (Continued)
9. Writing the GPS memory
1. Select “<<Add Write>>,” then push [J].
* The confirmation dialog “Add write?” is displayed.

@ If a previously added GPS memory was edited,
select “<<Overwrite>>."

2. Select <YES>, then push [J].

Add write? /5 S|
GRI

* The data is added to the GPS memory, and then the
selected GPS Memory group screen is displayed.
3. Push [MENU]I.
* Returns to the standby screen.

To view the entered content:
To view the entered content, select the GPS
memory channel.

= GPS MEMORY EE
MNAME : HOME

DATE : 2017/02/06 (Man)

TIME 1 1%:11:00

To cancel the entered data:
To cancel the entered data, push [D] to display the
confirmation dialog, as shown below.
Select <YES> to cancel entering and the display
returns to the GPS Memory group screen.

Cancel edit? .3 5|

GR1
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Adding or editing GPS memory (Continued)

< Entering the GPS Memory group name < Deleting GPS memory
You can enter a name for each GPS Memory group. You can delete the GPS memories.

Please note that deleted GPS memories cannot be
GPS > GPS Memory restored.

There are two ways to delete the memories:
* Deletes all GPS memory in a group.
* Deletes a specific memory.

1. Push [MENU].
. Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS Memory,” then push [J].
* Displays the GPS MEMORY screen. Example: Deleting all in the Group F.
4. Select the group that the name to be entered,
then push [QUICK]. GPS > GPS Memory
5. Select “Ed|t Name,” then push [4J] 1. Push [MENU].
£, . Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS Memory,” then push [J].
* Displays the GPS MEMORY screen.
4. Select the group where the GPS memory to
delete is saved, then push [QUICK].

* Enters the Group Name entry mode. 5 Sel « »
. ect “Delete All In Group,” then push .
6. Enter a GPS group name of up to 16 characters. P P []
E GROUP MNAME
HOME AREA_
— — CLR AB
(Example: HOME AREA) * The confirmation dialog “Delete all in group?” is
displayed.
Selectable characters and symbols 6. Select <YES>, then push [J].
AtoZ,atoz, 0to 9, !"#$%& ()*+ EXE[Celcte all in groug?
-l <=>2@ V1N {1} (space)
® See “Entering and editing text” for details. (p. iv) |.|

7. After enterlng push [J].

GPS MEMORY =48
OME AREA 4

]

]

F
Gt
8. Push [MENUJ. H:

* Returns to the standby screen.

« All GPS memory in the selected group are deleted,
then returns to the GPS MEMORY screen.

® When selecting a blank group, “Blank” is displayed.

EGROUPF !

7. Push [MENU]I.
* Returns to the standby screen.

Deleting a specific GPS memory

You can delete a specific GPS memory.

1. Select the GPS memory to delete, then push
[QUICK].

2. Select “Delete,” then push [J].

3. Select <YES>, then push [J].
* The selected GPS memory channel is deleted.
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Adding or editing GPS memory (Continued)

< Rearranging the display order of the GPS data

You can move the entered GPS memories to
rearrange their display order in the selected GPS
memory group.

In order to move the GPS memory out of their
assigned memory group, edit and move, and then
save.

GPS > GPS Memory

Push [MENU].

Rotate [DIAL] to select “GPS,” then push [J].

Select “GPS Memory,” then push [J].

* Displays the GPS MEMORY screen.

4. Select the group where the GPS memory to move
is saved.

5. Select the GPS memory to move, then push
[QUICK].

6. Select “Move.”

wn =

Friedrichshafen

» “DESTINATION?” blinks at the top left of the screen.
7. Select the location to insert the memory you want
to move, then push [J].
=:|E <
Takyfu Ei/igS\ItE\ >
Dayton Hamventio

Friedrichzhafen

* The selected memory is inserted above the destination
memory name.
® If “<<Move End>>" is selected, the memory is moved
to the bottom of the group.
8. Push [MENU]I.
* Returns to the standby screen.
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Adding or editing GPS memory (Continued)

< Setting the GPS alarm

A GPS alarm can sound when a target location comes
into the alarm area.

This function can be set to the caller station, all GPS
Memory channels, a specified Memory group or a
specified Memory channel.

Alarm area 1 (Setting plural stations) Alarm area 2 (Setting specific station)
When all channels or group is selected: When a specified memory is selected:
Point A ; 025, 025 / ' Extended range
\/B ; !A/\(Approxmate 1 km,
Your i Your 1094 Y)
location ——— X —— location ———— \ \
Poi /B \ ?/ Limited range
oint T (Approximate 500 m,

547)

Point C  Beeps three times Beeps one tlmes Beeps three times

Example: Set the alarm to all GPS memory (All
Memories).

GPS > GPS Alarm

1. Push [MENU].
. Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS Alarm,” then push [J].
* Displays the GPS ALARM screen.
4. Select “Alarm Select,” then push [J].
5. Select “Group,” then push [J].

OFF

6.
EGROUP =
All Memories
(Mo Group)
Az [COM
When the GPS alarm sounds
* Returns to the GPS ALARM screen. .
® If you want to set the alarm to a GPS memory group, Bl\")ks
select‘(No Group)” or “A” to “Z.” DF n;;\:
7. Push [MENU]. 4.. B —l
« Returns to the standby screen, then displays “*)).” " GPS ALARM N
® When either one of the stations in a specified group ME1
enters the set range, the alarm sounds three times, Alarm sounds. and “GPS ALARM’
“GPS ALARM” pops up on the screen, and “*))” oDS U ’
blinks. PopS Up-

® To cancel the GPS alarm, select “OFF” in the step 5.

TIP: When “All Memories”, “A” to “Z” or “(No Group)”
is selected, the alarm sounds depending on the
“Alarm Area (Group)” setting on the MENU screen.
(GPS > GPS Alarm > Alarm Area (Group))
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Adding or editing GPS memory

< Setting the GPS alarm (Continued)
Example: Set the alarm setting to RX (RX/Memory).

GPS > GPS Alarm

1. Push [MENU].
. Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS Alarm,” then push [J].
* Displays the GPS ALARM screen.
4. Select “Alarm Select,” then push [J].
5. Select “RX,” then push [J].

E Alarm Select

OFF

R
Group 3

* Returns to the GPS ALARM screen.

@ If you want to set the alarm to a GPS memory
channel, select “Memory,” and then select “(No
Group)” or “A” to “Z.”

6. Push [MENU].
* Returns to the standby screen, then displays “*)).”

® Information

» When a station with its GPS alarm set enters within an
approximate 1 kilometer (1093 yard) range, the alarm
sounds once. When it enters within an approximate
500 meter (546 yard) range, the alarm sounds three
times.

* When the GPS alarm sounds, “GPS ALARM” pops up
on the screen, and “*))” blinks.

* To cancel the GPS alarm, select “OFF” in the step 5.

When the GPS alarm sounds
Blinks

-

N/
D [ TG
] /=\
4 U GPS ALARM —l
U FSRIF
BE1

Alarm sounds, and “GPS ALARM”
pops up.

NOTE: Even if “RX” is selected in step 5, when the
received signal has no position data, the GPS alarm
does not sound.

TIP: When “RX” or a GPS memory channel is
selected, the alarm sounds depending on the “Alarm
Area (RX/Memory)” setting on the MENU screen.
(GPS > GPS Alarm > Alarm Area (RX/Memory))
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GPS Logger function

The GPS Logger function enables you to save the
position data from a GPS receiver into a microSD card
as a log.

The GPS Logger saves Latitude, Longitude, Altitude,
Positioning state, Course, Speed and Date.

If you use this GPS Logger while driving, you can
check your driving history on a mapping software.

< GPS Logger operating outline
To use GPS Logger function, perform following
operations.
1. Insert a microSD card*.
*User supplied
2. Check whether or not the GPS receiver is
receiving your position data. (p. 5-2)
3. Turn ON the GPS Logger function.
\:
Completed! The GPS Logger function starts.

< GPS Logger operation

Select whether or not save your route as a log.

When the GPS Logger function is ON, the transceiver
saves the position data from GPS receiver into
microSD card in a specified time interval.

The saved GPS sentences are GGA, RMC, GSA and
VTG.

GPS > GPS Logger > GPS Logger

1. Push [MENU].
. Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS Logger,” then push [J].

GPS Logoger
GPS Auto TH

* Displays the GPS LOGGER screen.
4. Select “GPS Logger,” then push [J].

GP gyEr
Recard Interval »
Recaord Sentence »

5. Select “ON,” then push [J].

E GPS Logger

OFF

6. Push [MENU]I.
* Returns to the standby screen, and the GPS Logger
function starts.
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NOTE:

» The GPS logger function requires a microSD card
(User supplied).

* Once the GPS logger function is turned ON, the
transceiver continuously saves the position data
from the GPS receiver, even if the transceiver is
turned OFF, then ON again. To cancel this function,
turn OFF the function. While this function is ON,
and when the transceiver is turned OFF, the log file
will be closed. Then the transceiver is turned ON
and Positioning is carried out by the GPS receiver,
a new log file will be created.

* When the microSD card is full, this function will be
automatically paused.

< Setting the GPS record interval

For example, when you are walking and if the time
interval is set to “1sec,” a lot of position data is saved
at near place. Select the GPS Logger function record
interval to suit your travel speed.

(Default: 5sec)

GPS > GPS Logger > Record Interval

Push [MENU].

Rotate [DIAL] to select “GPS,” then push [J].
Select “GPS Logger,” then push [J].

Select “Record Interval,” then push [J].
=GRS LOG ;

GPS Logger

hPON~

Fecord Interval
Record Sentence

* Displays the “Record Interval” screen.
5. Select a record interval.
* Options: Set to between 1, 5, 10, 30 and 60
seconds.

£ Record Interval

1zec Bl
Szec
10sec

6. Push [MENU].
* Returns to the standby screen.
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GPS Logger function (Continued)

< Setting the GPS record sentence

Select the GPS sentence for the GPS Logger function.
The function records only the selected sentence, so
the data volume will be reduced.

See the contents table shown below before selecting.

GPS > GPS Logger > Record Sentence

Push [MENU].

Rotate [DIAL] to select “GPS,” then push [J].
Select “GPS Logger,” then push [J].

Select “Record Sentence,” then push [J].

pON~

EGPS LOGGER

Recard Interval »

Fecord Sentence

GPS Lagger . >

* Displays the “Record Sentence” screen.
5. Rotate [DIAL] to select the GPS sentence, then

 “v/” disappears when the sentence is set to OFF.
® The selectable GPS sentences are RMC, GGA, VTG
and GSA. All sentences are set to ON as the default.
6. Push [MENU].
* Returns to the standby screen.

« Contents of GPS sentence

Lon Date 2D [ COG | SOG
Sentence ILat Alt |UTC (UTC) Status 13D |(True)|(knot) Others

RMC v v v v v v’ | Mode Indicator
Number of satellites in use, HDOP, Geoidal

GGA viv|Y v separation, Age of Differential GPS data

VTG v v CO.G (Magnetic north), SOG (km/h), Mode
Indicator
ID numbers of satellites used in solution, PDOP,

GSA v |V HDOP, VDOP
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GPS Logger function (Continued)

< Viewing the log data on a PC Map

If you want to display the your log data, copy the log
file to your PC.

® Windows 10 is used for these instructions.

1. Turn OFF the transceiver, then remove the
microSD card from the transceiver.
® To removing the card while the transceiver power is
ON, unmount it first. (See Basic manual sction 7)
2. Insert the card into the microSD card drive or a
memory card reader* on your PC.
*User supplied.
3. Click the “Open folder to view files” option to
access the card.

Removable Disk (H:)

Choose what to do with removable drives.

' Configure this drive for backup
2 History
Configure storage settings
Settings

m Open folder to view files «—C“Ck

File Explorer

. Take no action

* Displays the ‘ID-4100’ folder.
4. Double-click the “ID-4100" folder.

DriveTools  Removable Disk (H:

Home Share  View Manage

« v 1 wm » ThisPC » Removable Disk (H:)

# Quick access Name

@ OneDrive <—— Double-click
[ This PC

s Removable Disk (H:)

1D-4100

« Eight folders are displayed.
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5. Double-click the “Gps” folder.

I & [ = | p-4100

Home Share View

< v » ThisPC » Removable Disk (H) > ID-4100
3 Quick access Mame

4@ OneDrive .
[ &= ]«———Double-click
[ This PC ooy
Repl
= Removable Disk (H:) £y
Rulog
1D-4100 Setting

v
| 4= 16Gps

Home Share View

« v P > This PC > Removable Disk (H:) > ID-4100

3 Quick access MName

[E] 20170227_163643l0g

\J 20170227 174911 4eq | —— | NE |Og files
[ This PC 5] 20170307 151519.0g are saved here

Z& OneDrive

= Removable Disk (H:)
1D-4100

* The log files are displayed.

® The files are named with the time the log was
started, in the following format:
yyyymmdd_hhmmss.log
yyyy = year, mm = month, dd = day, hh = hour,
mm = minute, ss = second

Import the log file to a mapping software.

* You can see your route on the software map.

® The file may not be compatible with all mapping
software.
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GPS Logger function (Continued)

For your information— About the recorded NMEA sentence for GPS logging

Regarding the GPS logging data of the ID-4100A/E, each sentence corresponds to the NMEA standard and
is recorded in the following format.

¢ GGA sentence

(e.g.) $GPGGA,161229.487,3723.2475,N,12158.3416,W,1,07,1.0,9.0,M,25.5,M,3,0000*18<CR><| F>
@ @ ® © oo @ © o @

(D GGA protocol header ($GPGGA) @ Horizontal Dilution of Precision (1.0) 0.0-50.0

(@ UTC of position (16:12:29.487) Altitude re: mean-sea-level (geoid), meters

(3 Latitude (North 37° 23.2475') N=North, S=South (9.0 meters)

@ Longitude (West 121° 58.3416') E=East, W=West (® Geoidal separation, meters (25.5 meters)

(® GPS quality indicator (1) Age of Differential GPS data (3 seconds)
0=Fix not available or invalid, 1=SPS mode (D Check Sum (*18) Error detection data
2=DGPS (SPS), 6=Estimated (Dead Reckoning) mode started with “*” (hex code)

® Number of satellites in use (7), 00-12 @2 End code

*Blank shows when not positioned.
< RMC sentence

(e.g.) $GPRMC,161229.487,A,3723.2475,N,12158.3416,W,0.13,309.62,010417, , ,D*10<CR><LF>
O

@ é) @ ® ® O é) @
(@ RMC protocol header ($GPRMC) UTC date of position (17 Apr 1st) ddmmyy
(@ UTC of position (16:12:29.487) (® Mode Indicator (D)
(3 Status (A) A=Data valid A=Autonomous mode, D=DGPS,
V=Data invalid/not positioned E=Estimated (dead reckoning) mode,
@ Latitude (North 37° 23.2475') N=North, S=South N=Data not valid, R=Almanac data
® Longitude (West 121° 58.3416') E=East, W=West Check Sum (*10) Error detection data
(® Speed over ground (0.13 knots) started with “*” (hex code)
@ Course Over Ground (309.62°; degrees True) (D) End code
0.00°-359.99° *Blank shows when not positioned.
<© GSA sentence
(e.g.) $GPGSA,A,3,07,02,26,27,09,04, , , , , ,15,1.8,1.0,1.5*33<CR><LF>
@ @ ® ® ®® ®

(D GSA protocol header ($GPGSA) (® Position Dilution of Precision (1.8) 0.0-50.0
@ Mode indicator 1 (A) (® Horizontal Dilution of Precision (1.0) 0.0-50.0

M=Manual, forced to operate in 2D or 3D mode (@ Vertical Dilution of Position (1.5) 0.0-50.0

A=Automatic, allowed to automatically switch 2D/3D Check Sum (*33) Error detection data
(® Mode indicator 2 (3) started with “*” (hex code)

1=Fix not available, ® End code

2=2D (using satellites; less than 3), *Blank shows when not positioned.

3=3D (using satellites; more than 4)
@ 1D numbers of satellites used in solution (07, 02, 26, 27, 09, 04...15)
01-32 *Shows up to 12 ID’s

¢ VTG sentence

(e.g.) $GPVTG,309.62,T, ,M,0.13,N,0.2,K,A*03<CR><LF>
® ® é) @ ® é @)

@ VTG protocol header ($GPVTG) (® Mode Indicator (A)
(@ Course Over Ground (309.62°; degrees True) A=Autonomous mode, D=DGPS,
0.00°-359.99° E=Estimated (dead reckoning) mode,
(3 Course over ground degrees; Magnetic north N=Data not valid, R=Almanac data
@ Speed over ground, knots (0.13 knots) (@ Check Sum (*03) Error detection data
(® Speed over ground, kilometer per hour (0.2 km/hr) started with “*” (hex code)
End code

*Blank shows when not positioned.
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GPS Auto transmission for only Simplex

In the DV mode, this function automatically transmits
the GPS receiver’s current position data at a selected
interval, and should only be used in the simplex mode.
® Your own call sign must be entered to activate the
GPS automatic transmission.
® When “GPS TX Mode” is set to “NMEA,” be sure
to set “GPS Select” to “Internal GPS” or “External
GPS.”
When “GPS TX Mode” is set to “D-PRS,” and “TX
Format” is set to “Position” or “Weather,” be sure to
set “GPS Select” to “Internal GPS,” “External GPS,”
or “Manual.”
Otherwise, you cannot use this function.
(GPS > GPS Set > GPS Select) (p. 9-24)

< Setting the GPS automatic transmission
GPS > GPS Logger > GPS Auto TX
Push [MENU].

1.
2. Rotate [DIAL] to select “GPS,” then push [J].
3. Select “GPS Auto TX,” then push [J].

GPS Lagger -
GPS Auta TH »

EGPS Auto TH
OFF
Bzec

* Options: Set to between OFF, 5, 10, 30 seconds,
or1, 3,5, 10, and 30 minutes.
(Default: OFF)

® Information

* Selecting “OFF” cancels the GPS automatic
transmission.

« If four GPS sentences are selected in “GPS
Sentence,” “5sec” cannot be selected.

» The GPS message is also transmitted, if entered.

5. Push [MENUI.
* Returns to the standby screen.

NOTE:

* Use GPS automatic transmission in only the
simplex mode.

» GPS automatic transmission through a repeater
may interfere with other communications.
When a GPS message is entered, the transceiver
transmits it along with the position data. See page
5-26 for the GPS message entry.
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Saving data onto a microSD card

You can save the following data onto the card:

* Data settings of the transceiver

Memory channel contents, repeater lists, Your (UR)
memory and GPS memories that are saved in the
transceiver.

« Communication contents
Communication audio.

* Communication log
The communication and RX history logs.

* Automatic answering voice audio for the DV
mode

Voice audio used for the Auto Reply function in the DV

mode.

* Voice audio for the Voice TX function
Voice audio for the Voice TX function to be used in
amateur radio contests, and so on.

* GPS position data
GPS position data that is saved as tracking data.
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Saving the setting data onto a microSD card

You can save the Memory channels, Menu screen
item settings, and repeater lists on a microSD card.
Saving data settings on a card enables you to easily
restore the transceiver to its previous settings, even if
you perform an All Reset.

TIP: The setting data are saved in the “icf” file
format that is used in the CS-4100 CLONING
SOFTWARE. When the saved data on a card is copied
to a PC, you can edit it with the cloning software.

You can save the setting data as a new file or to
overwrite an older file.

To save as a new file To overwrite a file

SD Card > Save Setting To overwrite a file, select the file to be overwritten in
1. Push [MENU]. ;;..-'Er-.l G 2

2. Rotate [DIAL] to select “SD Card,” then push [J]. Z<Mevw Fila>

3. Select “Save Setting,” then push [J]. Se 1201 70401_01

4. Select “<<New File>>," then push [J]. -

ESETTIMG 1/2E

* Displays the FILE NAME screen.

® The file name is automatically named in the following
manner: Setyyyymmdd_xx (yyyy: Year, mm: month,
dd: day, xx: serial number)
Example: If a second file is saved on April 1, 2017,

the file is named “Set20170401_02."

® To change the file name, see “Save with a different

file name.” (p. 6-4)
5. Push [J].
= FILE MAME

Setz@ 179491 _@1

= — CLR AB

* The confirmation dialog “Save file?” is displayed.
6. Select <YES>, then push [J].

Save file? B

Set!

* Saves the data settings.
® While saving, a progress bar is displayed, then
returns to the SD CARD screen after the saving is
completed.
7. Push [MENU]I.
* Returns to the standby screen.
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Saving with a different file name

SD Card > Save Setting

Push [MENU].

Rotate [DIAL] to select “SD Card,” then push [J].
Select “Save Setting,” then push [J].

Select “<<New File>>" then push [J].

ESANE SETTIMG 125

PON=

* Displays the FILE NAME screen.
5. Push [RX—CS].
* Deletes the entered characters.
@ If [RX—CS] is continuously held down, the
characters are continuously deleted.
6. Enter a name of up to 20 characters.
(Example: My data)

= - CLR ab

Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()+,-
=?7@[V]"_"{]}" (space)
® See “Entering and editing text” for details. (p. iv)
7. After entering, push [J].

* The confirmation dialog “Save file?” is displayed.
8. Select <YES>, then push [J].

Save file? E

My

+ Saves the data settings.
® While saving, “SAVING” and a progress bar are
displayed, then returns to the SD CARD screen after
the saving is completed.
9. Push [MENU]I.
* Returns to the standby screen.
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Loading the saved data files that are on the microSD card

Memory channels, Menu screen item settings, and
repeater lists can be copied to the transceiver.

This function is convenient when copying saved data,
such as memory channels, or repeater lists, to another
ID-4100A/E, and then operating with the same data.

TIP: Saving the current data is recommended before
loading other data into the transceiver.

(Example: Loading all the data into the
“Set20170401_01" file)

SD Card > Load Setting
Push [MENU].
Rotate [DIAL] to select “SD Card,” then push [J].

Select “Load Setting,” then push [J].
Select a file to load.

1 SETTING

Pobd=

* Displays the LOAD SETTING screen.

5. Select the loading option, then push [J].

* ALL: Loads all memory channels, Menu screen
item settings and the repeater list into the
transceiver.

» Except My Station:

Loads all memory channels, Menu screen
item settings and the repeater list except
MY call signs and TX message into the
transceiver.

* Repeater List Only:

Loads only the repeater list into the
transceiver.

Except My Station
Repeater Lizt Only

* The confirmation dialog “Keep 'SKIP' settings in the
Repeater List?” is displayed.
6. Select <YES>, <NO> or <Cancel>, then push [J].

* YES: Retains the skip settings of the repeater
list. (p. 4-40)

* NO: Does not retain the skip settings of the
repeater list.

* Cancel: Returns to the LOAD FILE screen.

Keep 'SKIF' settings in the
Repeater List? H
Exce

Rep MO CAMNCEL

* When you select <YES> or <NO>, the confirmation
dialog “Load file?” is displayed.
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Select <YES>, then push [J].
Load file?

/1 £]
.|]
« Starts the file check.

® While checking the file, displays “CHECKING FILE”
and a progress bar.

CHECKIMG FILE

/1]
Pleaze wait... .|]

Excce
Rer| m— ]

After checking, settings data loading begins.
® While loading, “LOADING” and a progress bar are
displayed.

LOADING

EH
Fleaze wait... .|]

Exce
REF: | ]

After loading ends, “COMPLETED!” is displayed.
® To complete the loading, restart the transceiver.

COMPLETED! BE
Reboot the 10-4108 .|]

Exce
Reg
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Backing up the data saved on the microSD card onto a PC

A backup file enables easy restoration, even if the _| 2 Csv 3. GpsMemory |
data on the microSD card is accidentally deleted.
@ If your PC does not have a microSD card slot, —| 6. Gps | 4. RptList |

connect a memory card reader (user supplied) to

<& About the microSD card’s folder

contents

The folder in the microSD card contains the following:

1.

2,

10.

1.

12

13.

ID-4100 folder

Contains the folders created in the ID-4100.
Csv folder

Contains the GPS Memory, Repeater List and
Your Call Sign Memory folders.

GpsMemory folder

Saves the Gps Memory in the “csv” format to
import.

RptList folder

Saves the Repeater List in the “csv” format to
import.

YourMemory folder

Saves the Your Call Sign Memory in the “csv”
format to import.

Gps folder

Saves GPS logging data in the “log” format.
QSOLog folder

Saves QSO log data in the “csv” format.
Reply folder

Saves Automatic reply data in the “wav” format.
RxLog folder

Saves RX record log data in the “csv” format.
Setting folder

Saves the transceiver’s setting data in the “icf”
format.

Voice folder

Creates the recorded QSO audio date folders.

. yyyymmdd folder

Saves the recorded audio file in the “wav” format.
The folder name is automatically created in the
following format:

yyyymmdd (yyyy:year, mm:month, dd:day)
VoiceTx folder

Saves the recorded voice audio data for the Voice
TX function in the “wav” format.
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use the microSD card. _| 7.QsoLog | L 5. YourMemory |
1. ID-4100

10. Setting

{11 Voice 12. yyyymmdd |

12. yyyymmdd |

[

13. VoiceTx

(Example: Selecting the setting data)
When the microSD card is inserted into the microSD
card slot of your PC or the microSD card reader, the
screen is displayed as shown below.

Removable Disk (H:)

Choose what to do with removable drives

! Configure this drive for backup
S History

Configure storage settings
Settings

Open folder to view files (__ H
m File Explorer C“Ck

Take na action

v

d Drive Tools Removable Disk (H:

Home Share View Manage

T = > Removable Disk (H:) »

Mame

[ o4 ]€———— Double-click

3+ Quick access

¢@ OneDrive

I B [} = | p-4100
Home Share View

« v o » Removable Disk (H) > ID-4100

# Quick access Mame

Cav
& OneDrive
Gps
[ This PC Qsolog
[ Desktop Reply

2] Documents

‘ Downloads — DOUble-C"Ck

VOICE
VoiceTx

v

[F ] = | Setting

b Music

Home Share View

< v P » Removable Disk (H:) » ID-4100 » Setting

MName

[ seamrmioronie | €———— Setting data

# Quick access

7@ OneDrive
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Backing up the data saved on the microSD card onto a PC (Continued)

< Making a backup file on your PC

Windows® 10 is used for these instructions.

1. Insert the microSD card into the microSD card
drive or a memory card reader* on your PC.
*User supplied.

2. Click the “Open folder to view files” option to
access the card.

Removable Disk (H:)

Choose what to do with removable drives

' Configure this drive for backup
£ rile History
Configure storage settings
Settings

D Open folder to view files (__Cllck

File Explorer

. Take no action

* Displays the ‘ID-4100’ folder.
3. Right-click “Removable disk.”

4. Click “Copy.”
- | Y = Drive Tools ~ Removable Disk (H
Home Share View Manage

T = » Removable Disk (H:) >

# Quick access Name
ID-4100
f@ OneDrive
3 This PC
‘v - Removabl ;—..;:,,, H nght-cllck
10-2100 N
Open AutoPlay...
¥ Network
Open in new window
4 Homegeol Pin to Quick access

Share with >
Open as Portable Device

Include in library >
Pin to Start

Format...

Eject

Cut

[ |«————Click

1item Rename
New >
Properties
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5. Open a folder to copy a backup file to, then right-

click, and then click “Paste.”
* Copies the microSD card data onto your hard disk.
(Example: Copying into the “Backup” folder on the

C drive)
| [4 [] = Bsckup
“ Home Share View

< v 4 » ThisPC » Local Disk (C) » Backup

A Name Date modified

# Quick access

& OneDrive This folder is empty.
I This PC View >
[ Deskiop Sort by >
[5] Documents Group by >
3 Downloads Refresh
B Music Customize this folder...
=] Pictures Paste l(_C“Ck
B videos Faste snorMcut
‘i, Local Disk (C:) Undo Rename Ctrl+Z
= Removable Disk Share with N
= Removable Disk (1 New >
D-4100 Properties
¥ Network

To remove the microSD card, click the removable
disk icon (“[f¥’ in the screen shot shown below) in
the task bar.

Then, click “Eject Removable Disk.”

2 Open Devices and Printers ‘

LISR3.0 Card Reader

- Eject Removable Disk (H:) | [«<—Click
v

(When a memory card reader is connected.)
When “Safe To Remove Hardware” is displayed,
remove the microSD card.

Safe To Remove Hardware

(When a memory card reader is connected.)
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Importing or Exporting a CSV format file

Please read this section before importing or exporting 20 Importing
a Comma Separated Values (CSV) format file from the NOTE:

i D .
microSD card * Before importing, make a backup file of all the

You can import or export the following data: . : .
« Your Call Sign Memory g:;slcoeslger s data to the microSD card in case of

* Repeater List . . .
- GPS Memory * The transceiver cannot display a file that has a

file name longer than 21 characters. In this case,
rename it using 20 characters or less. When you
export the data in a CSV format file using the CS-
4100, BE SURE to name it using 20 characters or
less.

Example: Importing the Your Call sign memory.
SD Card > Import/Export > Import

1. Push [MENU].
2. Rotate [DIAL] to select “SD Card,” then push [J].
3. Select “Import/Export,” then push [J].
4. Select “Import,” then push [J].
5. Select “Your Call Sign,” then push [J].
EIMPORT HE
Your Call Sign 3
Repeater Lizt r|]
GPS Memory »

6. Select the CSV file to import.

* The confirmation dialog “Import file?” is displayed.
7. Select <YES>, then push [J].

m Impart file?

« Starts to import.

® While importing, “IMPORTING” and a progress bar
are displayed.

® After importing ends, “COMPLETED!” is displayed.

® To complete the importing, restart the transceiver.

BERfi[CoMPLETED!

/1]
Rekoot the [D-410@. .|]

TIP: To import a repeater list, see the step 6 on page
6-5 for details.

6-8
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©  USING A microSD CARD

Importing or Exporting a CSV format file (Continued)

< Exporting
You can export Your Call Sign Memory, Repeater List
and GPS Memory.

To save as a new file
Example: Exporting the Your Call sign memory.

SD Card > Import/Export > Export

Push [MENU].

Rotate [DIAL] to select “SD Card,” then push [J].
Select “Import/Export,” then push [J].

Select “Export,” then push [J].

Select “Your Call Sign.”

SEXPORT

Your Call Sign
Repeater List 4

arowh =

GPS Memory 4

6. Select “<<New File>>"

SIGH

* Displays the FILE NAME screen.

® The file name is automatically named in the following
manner; Your*yyyymmdd_xx (yyyy: Year, mm: month,
dd: day, xx: serial number)
* “Rpt” is displayed for a repeater list, and “Gps” is

displayed for a GPS memory.

® To change the file name, see “Save with a different

file name.” (p. 6-4)
7. Push[J].

EFILE NAME

Mour2@170491_@1

= — CLR 4B

* The confirmation dialog “Export file?” is displayed.
8. Select <YES>, then push [J].

Export file? E

Mou

* Exports the data settings.
® While exporting, “EXPORTING” and a progress bar
are displayed.
9. Push [MENU]I.
* Returns to the standby screen.

To overwrite a file
To overwrite a file, select the file to be overwritten in
step 6 to the left.

EYVOUR CALL 5IGM

<<Mew File== 4

Your 20170331_M
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Recording a QSO audio

NOTE:

* Be sure to insert a microSD card into the
transceiver before recording the audio.

+ Once the recording has started, it will continue,
even if the transceiver is restarted.

To starting to record To stop recording

1. Push [QUICK]. 1. Push [QUICK].

2. Rotate [DIAL] to select “<<REC Start>>,” then 2. Rotate [DIAL] to select “<<REC Stop>>,” then
push [J]. push [J].

Fecording started. Fecording stopped.

l yDisplayed
(T3

146.010

Recording Standby mode

F=EIF 1
HEH

The recording starts when you transmit or the squelch
opens.

Displayed—y y—Blinks
o0+

146010

T
SKIP%
5]a]%)
® Information

* The recording pauses while no signal is received, and
resumes when a signal is received again.

* The recording continues until you manually stop
recording, or the card becomes full.

« If the recording file’s content reaches 2GB, the
transceiver automatically creates a new file, and
continues recording.

TIP: When the PTT Automatic Recording function is
set to ON, the recording automatically starts when
“<<REC Start>>" is selected. In that case, recording
continues even while no signal is received.

See page 7-4 for details.

(Voice Memo > QSO Recorder > Recorder Set >
PTT Auto REC)

7-2
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VOICE MEMORY

Playing back the recorded audio

NOTE: Insert the microSD card, which contains the
recorded audio file, into the transceiver’s slot.

Voice Memo > QSO Recorder > Play Files

1. Push [MENU].
Rotate [DIAL] to select “Voice Memo,” then push

[J].

= 3
b, Yoice TH 3
- GFS 3

3. Select “QSO Recorder,” then push [J].

= 050 RECORDER
=<REC Start=>
Flay Files

Recorder Set »

* Displays the recorded file folders.
5. Select the folder that contains the audio file to
play, then push [J].

® The folder name is automatically named in the
following manner: yyyymmdd (yyyy: year, mm:
month, dd: day)
6. Select the audio file to play.
» The VOICE PLAYER screen is displayed, and the file
starts to play.

10:46:33 146, EI1EI FM

0: 02

T Operating mode

Recorded
time Operating Total playback
frequency time

v

Current playback file and the
total number of files in the folder—\

Recorded EXEINIEFSIE i
date > 2017/04/01 10:46:30 e o——
Recording—> 146.010 FH  TA 0:00/ 0:08
information [ “ 1] " ™ T

Played back time/
Total time

7-3

The VOICE PLAYER screen description

[MENU]
Cancels

= vou

01?1'04/01 10 46 0 -
146,010 FH TH

0:00/ 0206 seau
] « n 3 ]

saL

VMG MODE MW RX+CS _ MONI__QUICKCITED

I
Cancels [QUICK]
* Displays the file
[P\ll/M]grl]H) . fil information
ays the previous tile * Deletes the file
[MODE](#)
Rewinds [MONI](MHH)
Plays the next file
[RX—CS](H)
Fast forwards
[MWI](ER)/ (M=)

Pauses or plays

Fast forward/Rewind
* Hold down [RX—CS] (M) or [MODE](#) for 1
second to continuously fast forward/rewind the file.

* The default skip time is 10 seconds. If you want to
change it, see page 7-4 for details.

* You can fast forward or rewind the file that is
playing by rotating [DIAL]. The fast forward/rewind
time is 1/20 of the total file time, regardless of the
skip time setting.

Rewind while playing

If you push [MODE](#) within the first one second
of the file, the skip time at the end of the previously
recorded file will playback.

Playing the previous file

» While the oldest file in the folder is playing back,
push [V/M](HH) to start playing the file at the
beginning.

* When the playback is paused at the beginning of
a file, push [V/M](H) to move to the beginning of
the previous file, and pause.

Playing the next file

» While the latest file in the folder is playing back,
push [MONI](MH) to stop playing.

* When the playback is paused, push [MONI](H) to
move to the beginning of the next file, and pause.

Operating information

The operating frequency, mode, and audio category
(received audio or transmitted audio) is also
recorded as the operating information.




Previous view

7  VOICE MEMORY

Changing the QSO recorder settings

You can change the recording setting on the MENU
screen.
See page 9-21 for details.

Record only the received audio Synchronize the recording to PTT
Voice Memo > QSO Recorder > Recorder Set > Voice Memo > QSO Recorder > Recorder Set >
REC Mode PTT Auto REC
EPTT Auto REC
OFF
® The default setting is “TX&RX” (Both transmitted and ® The default setting is “OFF” (Recording is not
received audio are recorded). synchronized to PTT.).

TIP: When “PTT Auto REC” is set to “ON”

Continue to record even while the squeich is  Starts recording not only when PTT is pushed,

closed but also when switched to transmit by the CI-V
Voice Memo > QSO Recorder > Recorder Set > command.
RX REC Condition * When “REC Mode” is set to “RX Only,” the transmit

audio is not recorded.
I * A signal that is received within 10 seconds after the
Srmalel At squelch is closed is recorded in same file.

andition

® The default setting is “Squelch Auto” (Records only while Change the Skip Time

the squelch is open). Voice Memo > QSO Recorder > Player Set >
Skip Time
ESkip Time
Record the QSO audio as one file Szen
Voice Memo > QSO Recorder > Recorder Set > S3EC
File Split

= File Split ® The default setting is “10sec.”

® The default setting is “ON” (transmitted and received
audio are separately recorded in different files).

® When “RX REC Condition” is set to “Squelch Auto,” an
audio file is created every time the squelch opens. The
received audio is recorded in a separated file.

7-4
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Deleting the audio folder/file

NOTE: A deleted audio file can NOT be recovered.

< Delete an Audio Folder
NOTE: All audio files in the folder are deleted.

Voice Memo > QSO Recorder > Play Files

1. Push [MENU].
Rotate [DIAL] to select “Voice Memo,” then push

[J].

& Yaice Memo )
b, Yoice TH 3
- 5F3 4
3.
4.

Fleurder Set PH

* Displays the recorded file folders.
5. Select the folder to delete.

I_:I 201704M

6. Push [QUICK].
7. Select “Delete,” then push [J].

’ Fulder Infarmation

Delete All Folders

r:. 20170

*» The confirmation dialog “Delete folder?” is displayed.

8. Select <YES>, then push [J].
Delete folder? BE

» A beep sounds, and then the folder is deleted.

9. Push [MENUI.
* Returns to the standby screen.

TIP: To delete all folders
Select ! Delete All Folders” in step 7.
|]

Delete All Folders

7-5

< Delete an Audio File
Voice Memo > QSO Recorder > Play Files

1. Push [MENU].
2. Rotate [DIAL] to select “Voice Memo,” then push [J].
3. Select “QSO Recorder,” then push [J].
4. Select “Play Files,” then push [J].

« Displays the recorded file folders.
5. Select the folder that contains the audio file to

delete then push [J].
6.

l|_|..1t....|| -14n.-||l|| FH I:I.IZ

10:46:33 146,010 FM 0:02r

Recorded T Operating mode

time )

Operating Total playback
frequency time

7. Push [QUICK].
8. Select “Delete,” then push [J].

Em F|Ie Information 118

:16:3

10:46: 37 Delete Al O:02e

* The confirmation dialog “Delete file?” is displayed.
9. Select <YES>, then push [J].

ESl[Celcte file?

EE
[3]3
]2>|]

* A beep sounds, and then the folder is deleted.

10. Push [MENU].
* Returns to the standby screen.

TIP: To delete all files
Select “Delete All” in step 8.

m File Information
10:46: 3 | 0z 016w
10:46: 35 (Al EI.E|2>|]
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Viewing the file information

The recorded audio file contains the recording data

(operating frequency, operating mode, recorded date,

and so on).

Voice Memo > QSO Recorder > Play Files
1. Push [MENU].

Rotate [DIAL] to select “Voice Memo,” then push

[J].
3. Select “QSO Recorder,” then push [J].
4. Select “Play Files,” then push [J].

* Displays the recorded file folders.

5. Select the folder that contains the file to view the

information, then push [J].

6. Select the aud|o file to view the information.

10:46: 33 146 EI1EI FH

Push [QUICK].
Select “File Information,” then push [J].

© ~N

File Information 1415

10:46: 33 Delete Al 0z 02w

ESl[Fren : 136 010 BE

[10: 4N b 11|

10z Z|PONER: HIGH 12
START: 2017/08/01 10: 46:30

* Displays the File Information window.
9. Push [MENU]I.
10. Returns to the screen selected in step 6.

TIP: To view the folder information
Push [QUICK] in step 5, and then select “Folder
Information” to view the folder information.

Delete All Folders

v

MAME: 20170403 <— Folder name
B|FILE: 7(672KB) <— Total files
DATE: 2017/04/03 (total size)
10z 46:30 |

Created date

7-6

File information examples

® Depending on the recording status, some data may not
be displayed.

® The file name is automatically named in the following
manner: yyyymmdd_hhmmss (yyyy: year, mm: month,
dd: day, hh: hour, mm: minute, ss: second)

¢ TX audio file information

EIsl[Fren ;- 433, 390 ¥FE Operating
15:1|MODE : DY TH &[] information (TX)
152 1{POYER: HIGH 13

KR [574RT: 2017/04/03 15:18:28

v

Ed
WY POSITION LAT: 35°45. 00 N ’]E MY station
|

H=

15:1 LON: 135736 00°E ([||'5* (| location
1521 GL: PH7GTS |

15: 1 ALT: 6t

BE[t0 :cacaca ¥FH DR setting
1511 15

15:1\FROM: 1PZYHH A Ii=»

m Hirano E

EIS[ene : 201 ?ma 151828 ¥FH File data

51 ZE: AOKB

—_ -
i om
—-

DATE: 2017/04,/03
15:18:32

* RX audio file information

EIs|[Fren ;- 433, 390

[15: JT N

SHET: S04+

START: 201?;’04303 15:20: 27

Operating
information (RX)

LON: 135° 36, 007 E location
GL: PH7ETS
ALT: Baf t

v

EISl[calLER: IM1ZLEK
Station
IPEYHH A
Hirano

Caller and

/3 |
Eu received

R¥RPT : repeater

v

ESl[r POSITION LAT: 33735 55 N
LON; 130725, 28°
ALT: 1050F t
DST: 230n]

¥EH RX station
=

location

EXSl[nanE : 20170403 _152027

[15: ISR

DATE : 20117/04/03
15:29: 33

¥EH File data
5 |

EISl[# PoSITION LAT: 35 45.00° N |28 MY station
15: 5|
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Viewing the microSD card memory capacity

You can check the microSD card memory capacity
and available recording time.

SD Card > SD Card Info

1. Push [MENU].
Rotate [DIAL] to select “SD Card,” then push [J].

E ard Info »
3
Farmat

S0 CARD INFO

ree space. I |
1, 917, GHEB (REC: 34h54dm)

Capacity: 1, 922 5ME

« Displays the remaining capacity and available
recording time.
4. Push [MENU]I.
* Returns to the standby screen.
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Playing back the recorded audio on the PC

You can play back the recorded QSO audio on your
PC.
® Operation data is not displayed.

Windows 10 is used for these instructions.

Example: Playing back the audio file on the microSD
card on the PC, through the memory card
reader (user supplied).

1. Insert the microSD card into a memory card
reader on your PC.

2. Click the “Open folder to view files” option to
access the card.

Removable Disk (H:)

Choose what to do with removable drives.

' Configure this drive for backup
2 History
Configure storage settings
Settings

m Open folder ta view files «—C“Ck

File Explorer

. Take no action

3. Double-click the ‘ID-4100’ folder.

=M= Drive Tools  Removable Disk (H:

Home Share  View Manage

T = » Removable Disk (H:) »

Mame

<— Double-click

# Quick access

4@ OneDrive

=

4. Double-click the ‘Voice’ folder.

I &[] =1 0-4100
Home Share View

< v 4 ||+ Removable Disk (H] > ID-4100
~ ~

# Quick access MName
Csv

@ OneDrive
Gps

[ This PC Qselog

[ Desktop Reply
Rxlog

5 Documents
J Downloads
D Music

5. Double-click the folder that contains the audio file
to play back. (Example: “20170403”)

<— Double-click

VOICEIX

M = | Voice
Home Share View
« v 4 > Removable Disk (H:) » ID-4100 > Voice »
Mame -

3t Quick access

@ OneDrive D — DOUb'e-C"Ck

3 This PC

Double-click the file to play back.
(Example: “20170403_104630.wav”)

I ¥ [ = | 20170403
Home Share View

« v » Removable Disk (H:) » ID-4100 » Voice » 2017

3t Quick access Mame

acone [ e | «———Double-click

= —
[ This PC [©] 20170403_151149.wav
[&] 20170403_151411.wav
[ 20170403_151654.wav
& 20170403_151828.wav
& Network €] 20170403_152927 wav

- Removable Disk (H:)
ID-4100

P

® Information

+ See the instruction manual of your player for operation
details.

» The audio file may not play back, depending on the
player.
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8 REPEATER AND DUPLEX OPERATIONS

FM Repeater operation

A repeater receives signals and on one frequency, and
then retransmits them on a different frequency. When
using a repeater, the transmit frequency is shifted
from the receive frequency by a frequency offset.

A repeater can be accessed using the Duplex function
by setting the transceiver’s offset to the same value as
the repeater’s offset.

See Section 4 for details on accessing a D-STAR
repeater.

Repeater
434.540 MHz

439.540 MHz

Statlon A

TX: 434.540 MHz
RX: 439.540 MHz

TX: 434.540 MHz
RX: 439.540 MHz

TIP:

* When the Repeater tone frequency or the
frequency offset is changed, the tone or offset for
Auto Repeater function is also changed.

« If the offset value will cause the transmit frequency
to be out of the band, “OFF BAND” is displayed on
the display when [PTT] is pushed, and transmit will
be inhibited. (p. 8-5)

8-2

1.

10.
11.

12.

13.

Push [V/M] several times until you enter the VFO

mode.

Push [BAND].

* Enters the Band Select mode.

Rotate [DIAL] to select the operating band.

Push [BAND] again.

* Returns to the frequency display.

Push [MODE] several times until you select the

FM mode.

Rotate [DIAL] to set the receive frequency

(Repeater output frequency).

® When the Auto Repeater function (usable in only the
USA version) is turned ON, skip steps 7 ~ 12. (p. 8-5)

Push [QUICK].

Rotate [DIAL] to select “DUP,” then push [J].

—] Band Select P|—|
4 T}{ Poweer 4
FSKIF
TONE 3

* Displays the Duplex direction setting window.
Select the offset direction, then push [J].

OFF
4 = —

EE
DUP+

o
il
il
i
=

v

439540

* Displays “D-" or “D+.”

® You can set the frequency offset in the MENU screen.
(DUP/TONE... > Offset Freq) (p. 9-16)

Push [QUICK].

Select “TONE,” then push [J].
Fm D-

— Band Select k

mm| 15 Powver 4

— DUP L FSKIF
(5]5]5]

+ Displays the Tone function setting window.
Select “TONE,” then push [J].
FZEIF 1
(5110

FM D= [ToFF
|
PSKIP

||
4 TONE
) TSQLED
TsQL

V

498540

» Turns ON the repeater tone, and “TONE” is displayed.

® You can set the tone frequency in the MENU screen.
(DUP/TONE... > Repeater Tone) (p. 9-16)

Operate in the normal way.

® Subaudible tone is superimposed on your transmit signal.
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FM Repeater operation (Continued)

< Checking the repeater input signal

You can check whether another station’s transmit
signal can be received directly or not, by listening to
the repeater input frequency.

1. Push [MONI] to listen on the repeater input
frequency.
» While monitoring, “BUSY” blinks.

® Information

» While monitoring, the displayed frequency
automatically changes to the transceiver transmit
frequency (repeater input frequency).

» When the other station’s signal can be directly

received, move to a non-repeater frequency and use

simplex. (duplex OFF)

* While monitoring, the Attenuator function is temporarily

disabled to receive a weak signal.
2. Push [MONI] again to cancel monitoring.

[— TOME

439,540

V

434540 =

While monitoring

FEEIF

8-3

<1750 Hz tone burst

A 1750 Hz tone is required to access many European
repeaters.

® This operation is only for the ID-4100E.

1. Push [MODE] several times until you select the
FM mode.

2. While holding down [PTT] on the microphone
to transmit, push [T-CALL] if assigned to a
microphone key.

» Accesses the repeater with a short tone burst.
. Displays “1750Hz TONE.”

Tx

145.410 %

1 FEOHz TOME

Sending the tone burst

3. Operate in the normal way.
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Duplex operation

The Duplex operation shifts the transmit frequency
up or down from the receive frequency by an offset

amount.

< Setting the frequency offset <> Setting the duplex direction

NOTE: The frequency offset cannot be changed Push [QUICK].

when using the DR function. 2. Rotate [DIAL] to select “DUP,” then push [J].

3. Select the offset direction, then push [J].
* OFF: For simplex operation (the receive and
DUP/TONE... > Offset Freq transmit frequencies are the same).
1. Push [MENU]. * DUP-: The transmit frequency shifts down
Rotate [DIAL] to select “DUP/TONE...,” then push ;rg]”;::te receive frequency by the offset
* DUP+: The transmit frequency shifts up from the

4. Rotate [DIAL] to set the offset.

(Example: 0.700.00 MHz)
= Offset Freg * Displays “D-" or “D+.”

i receive frequency by the offset amount.
E]Manage Memu:ur'_\.-' 3 Fi | COFF
88 Scan g 4=
3. Select “Offset Freq,” then push [J]. w—| DUP+ Gt
S DUP/TOME. .. IEE
Dffset Freg 2 v
Repeater Tone 3 Frl [ T3
’ 439540
U FSKIF

0.700.00 MHz

< Duplex operation
1. Push [MONI] to listen to the transmit frequency to
check whether another station is transmitting on

® Set to between 0.000.00 and 59.99500 MHz.
® The selected tuning step in the VFO mode is used to
set the offset.

5. Push [J] to set the offset. it, or not.
6. Push [MENU]. * The transceiver transmit frequency is displayed on the
display.

* Returns to the standby screen. ) o
2. Push [MONI] again to cancel monitoring.

3. Operate in the normal way.

TIP: If the offset value will cause the transmit
frequency to be out of the band, “OFF BAND” is

displayed on the display when [PTT] is pushed, and NOTE: When the Auto repeater is ON, and the

transmit will be inhibited. (p. 8-5) operating frequency is set out of the repeater output
frequency range, the duplex mode is automatically
cancelled.

8-4
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Off band indication

If the transmit frequency is out of the amateur band,
the off band indication, “OFF BAND,” is displayed
on the display when [PTT] is pushed. Check the
frequency offset or duplex direction in this case.

(p. 8-2)

FM D-
1

B

OFF BAND
FEEIF
T 551}

Displayed

8-5

Auto repeater function

When the operating frequency falls within the repeater
output frequency range, the Auto Repeater function
automatically sets the repeater settings (duplex ON/
OFF, duplex direction, tone encoder ON/OFF).

The Auto Repeater function uses the preset repeater
tone frequency and frequency offset.

NOTE for the USA version transceiver:

When turned ON, the Auto Repeater function has
priority over the manual duplex setting. If the transmit
frequency changes after setting, the Auto Repeater
function may have changed the duplex setting.

Function > Auto Repeater

1. Push [MENU].
2. Rotate [DIAL] to select “Function,” then push [J].
3. Select “Auto Repeater,” then push [J].
4. Select the option to turn ON the Auto Repeater
function.
* OFF: Turn OFF the function.
* ON (DUP): Turns ON only the duplex

operation. (Default)
* ON (DUP, TONE): Turns ON the duplex
operation and tone encoder.
5. Push [MENU]I.
* Returns to the standby screen.

Frequency range and offset direction

Frequency range Shift direction
145.200 ~ 145.495 MHz “DUP-"is set
146.610 ~ 146.995 MHz “‘DUP-"is set
147.000 ~ 147.395 MHz “DUP+” is set
442.000 ~ 444.995 MHz “DUP+”" is set
447.000 ~ 449.995 MHz ‘DUP-"is set
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Selecting a Menu item

You can use the MENU screen to set infrequently
changed values or function settings.

In addition to this page, see pages 9-3 through 9-15

for details of each item’s options and their default
value.

TIP: The MENU screen is constructed in a tree
structure. You may go to the next tree level, or go
back a level, depending on the selected item.

MEMLI

3
B Manage Memory 3
M Scan »

W Yaoice Memo
b, Yoice TH 3
-§ 5F3 3

EMEMNLI

Gz Call Sign

[ RX History »
O Mermary »
& My Station

ot DY Set 3
P SPEECH y
EMEMNL /S
#2EDTMF

QsS0/R¥ Log »
# Function 3

O Dizplay
$ Sounds »

& Time Set 3

EMEMNL

s DY Gateway

B S0 Card »
&3 Bluetooth Set »

Cithers
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<& MENU screen operation

[MENU]
Switches between the MENU
screen and the standby screen.

|
/l A ¥ Gps
7 v
. &)
option. K L]
* Goes to the / \\
nexttree i) [DIAL] [QUICK]
level. Goes back Selects an Returns to
tree levels. item or option. the default

setting.

Simplified description—‘Select’ operation

In this manual, user’s ‘Select’ operation is simplified,
as shown below.

Simplified description:
Select “30min.”

Operation:
Rotate [DIAL] to select “30min.”

Example: Set the “Auto Power OFF” item to “30 min.”
Time Set > Auto Power OFF

1. Push [MENU].
2. Rotate [DIAL] to select “Time Set,” then push [J].

O Dizplay H

& Sounds

O Time Set

Select

‘Auto Power OFF,” then push [J].

£ Auto Power OFF

OFF
Z0min
&0min

» Sets the option, then goes back a tree level.
(TIME SET screen is displayed.)
5. Push [MENUI.
* Returns to the standby screen.

TIP: To return to the default setting:
1. Push [QUICK] in step 4.

2. Select “Default,” then push [J].
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9  MENU SCREEN

Menu items and Default settings

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

DUP/TONE... Settings to access repeaters.

Offset Freq 0.000~0.600.00*'~59.995 MHz  Sets the frequency offset for duplex (repeater)
operation.

Repeater Tone 67.0~88.5~254.1 Hz Selects a tone frequency used to access the
repeaters.

TSQL Freq 67.0~88.5~254.1 Hz Selects a tone frequency for the Tone Squelch
or the Pocket Beep function.

Tone Burst OFF or ON Turns the Tone Burst function ON or OFF.

This function is used to suppress the RX

squelch tail noise in the FM mode, if you

transmit a signal which superimposes the
CTCSS tone or subaudible tone.

DTCS Code 023~754 Selects a DTCS (both encoder/decoder)
code for DTCS Squelch or the Pocket Beep
function.

DTCS Polarity Both N, TN-RR, TR-RN, or Selects the DTCS polarity for the DTCS

Both R Squelch or the Pocket Beep function.
Digital Code 00~99 Selects a digital code for the Digital Code
Squelch function.
Manage Memory Manages your Memory or Call channel data.
Memory CH ALL, A~Z Manages the Memory channels.
Call CH CO0/C1(144):146.010 FM*2 Manages the Call channels.
C0/C1(430):440.000 FM*?
Scan Set scan options.

Pause Timer 2sec~10sec~20sec, or HOLD Selects the Scan Pause time. When receiving
signals, the scan pauses according to this set
period of time.

Resume Timer Osec~2sec~5sec, or HOLD Selects the Scan Resume time from a pause
after the received signal disappears.

Temporary Skip Timer 5min, 10min, or 15min Selects the Temporary Skip time. When the
time is set, specified frequencies are skipped
for this set period of time during a scan.

Program Skip OFF or ON Turns the Program Skip Scan function ON or
OFF for a VFO mode scan.

Bank Link A:~Z: Selects banks to be scanned during a Bank
Link Scan.

Program Scan Edge 00~24 Sets the frequency ranges for a Program
scan.

Program Link Sets the Link function for the Program Scan

See page 9-19 for details of the preset values. Edge channels.

*1 The default value may differ, depending on the frequency band and the transceiver version.
*2 The default value may differ, depending on the transceiver version.
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9  MENU SCREEN

Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

Voice Memo

Set the TX/RX voice recording options.

QSO Recorder

Set QSO recorder options.

<<REC Start>>*

Starts recording the received signal audio.
® While recording, <<REC Stop>> is displayed.

Play Files* Plays the recorded audio.
Recorder Set
REC Mode TX&RX or RX Only Selects whether or not to record the TX audio.
RX REC Condition  Always or Squelch Auto Selects whether or not the squelch status
affects the RX voice audio recording.
File Split OFF or ON Selects whether or not to automatically create
a new file if transmission and reception, or
squelch status (open and close) is changed.
PTT Auto REC OFF or ON Turns the PTT Automatic Recording function

ON or OFF.

Player Set

Skip Time

3sec, 5sec, 10sec, or 30sec

Sets the Skip time to rewind or forward the
recorded audio when you push the fast-rewind
or fast-forward key during playback.

DV Auto Reply*

Records a voice audio to use the Auto Reply
function in the DV mode.

Voice TX Set microphone voice recording options.
Record* T1~T4 Starts recording the microphone audio.
TX Set

Repeat Time

1sec~5sec~15sec

Sets the repeat interval. The transceiver
repeatedly transmits the recorded voice audio
at this interval.

TX Monitor OFF or ON The TX Monitor function outputs the TX
voice audio from the speaker during voice
transmission.

<<TX>>* T1~T4, Repeat TX The transceiver transmits the recorded voice
audio.
GPS Set GPS options.
GPS Set
GPS Select OFF, Internal GPS, Selects either the internal or an external

External GPS, or Manual

GPS receiver that the transceiver receives its
position data from.

Manual Position

Manually enter your current position.

GPS Out (To DATA Jack)

OFF or ON

Turns the output of GPS information from the
internal GPS receiver to the [DATA] jack ON
or OFF.

* Be sure to insert the microSD card into the transceiver before selecting these items.
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9  MENU SCREEN

Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

GPS TX Mode Set the GPS TX mode.
OFF Turns OFF the GPS TX function.
D-PRS
Unproto Address API410,DSTAR* Enters an unproto address, or keeps the
default.
TX Format
Position
Symbol 1:Car, 2:Van, 3:Truck, or Selects a D-PRS Symbol to transmit.
4:House QTH (VHF)
SSID === (-0), -1~-15, or -A~-Z Selects the APRS® call sign SSID.
Comment Enters a comment to transmit.
Time Stamp OFF, DHM, or HMS Selects the format to transmit the current UTC
time as a time stamp.
Altitude OFF or ON Turns the altitude transmit option ON or OFF.
Data Extension  OFF, Course/Speed, or Selects whether to transmit the course/speed
Power/Height/Gain/Directivity data, or power/height/gain/directivity data.
Power 0w, 1W, 4W, 9W, 16W, 25W, Selects a base station’s TX power level to
36W, 49W, 64W, or 81W transmit.
Height 10ft, 20ft, 40ft, 80ft, 160ft, 320ft, Selects a base station’s height to transmit.
640ft, 1280ft, 2560ft, or 5120ft*
Gain 0dB~9dB Selects a base station’s antenna gain to
transmit.
Directivity Omni, 45°NE, 90°E, 135°SE, Selects a base station’s antenna directivity to
180°S, 225°SW, 270°W, transmit.
315°NW, or 360°N
Object Set Object data such as an earthquake information, satellite track information,

and so on, to transmit along with the position data.
An Object contains a time stamp.

Object Name Enters an Object’'s name to transmit.
Data Type Live Object, Killed Object Selects an Object’s status to transmit.
Symbol Radio Selects an Object’s symbol to transmit.
Comment Enters an Object’'s comment to transmit.
Position Sets an Object’s position data to transmit.
Data Extension = OFF, Course/Speed, or Selects whether to transmit an Object’s course/
Power/Height/Gain/Directivity speed data, or power/height/gain/directivity
data.
Course 0°~360° Sets an Object’s course to transmit.
Speed O0mph~1150mph* Sets an Object’s speed to transmit.
Power 0w, 1W, 4W, 9W, 16W, 25W, Selects an Object’s TX power level
36W, 49W, 64W, or 81W information to transmit.
Height 10ft, 20ft, 40ft, 80ft, 160ft, 320ft, Selects an Object’s height information to
640ft, 1280ft, 2560ft, or 5120ft*  transmit.
Gain 0dB~9dB Selects an Object’s antenna gain information
to transmit.

* The unit may differ, depending on the “Display Unit” settings. (p. 9-64)
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9  MENU SCREEN

Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

Directivity Omni, 45°NE, 90°E, 135°SE, Selects an Object’s antenna directivity
180°S, 225°SW, 270°W, information to transmit.
315°NW, or 360°N
SSID === (-0), -1~-15, or -A~-Z Selects the APRS® call sign SSID for the
Object.
Time Stamp DHM or HMS Selects a format to transmit the current UTC
time as a time stamp.
Item Set Item data such as a traffic accident, lighthouse, antenna, or DV access point
location, and so on, to transmit along with the position data.
An Item does not contain a time stamp.
Item Name Enters an ltem’s name to transmit.
Data Type Live Item, Killed Item Selects an Item’s status to transmit.
Symbol Radio Selects an Item’s symbol to transmit.
Comment Enters an ltem’s comment to transmit.
Position Sets an Item’s position data to transmit.

Data Extension

OFF, Course/Speed, or
Power/Height/Gain/Directivity

Selects whether to transmit an Item’s course/
speed data, or power/height/gain/directivity
data.

Course 0°~360° Sets an Item’s course to transmit.
Speed O0mph~1150mph* Sets an Iltem’s speed to transmit.
Power 0w, 1W, 4W, 9W, 16W, 25W, Selects an Item’s TX power level information
36W, 49W, 64W, or 81W to transmit.
Height 10ft, 20ft, 40ft, 80ft, 160ft, 320ft, Selects an Item’s height information to
640ft, 1280ft, 2560ft, or 5120ft*  transmit.
Gain 0dB~9dB Selects an Item’s antenna gain information to
transmit.
Directivity Omni, 45°NE, 90°E, 135°SE, Selects an Item’s antenna directivity
180°S, 225°SW, 270°W, information to transmit.
315°NW, or 360°N
SSID === (-0), -1~-15, or -A~-Z Selects the APRS® call sign SSID for the Item.
Weather
Symbol WX Station Selects a weather station’s symbol to transmit.
SSID === (-0), -1~-15, or -A~-Z Selects the APRS® call sign SSID for the
weather station.
Comment Enters a weather station’s comment to
transmit.
Time Stamp OFF, DHM, or HMS Selects a format to transmit the current UTC

time as a time stamp.

NMEA

GPS Sentence

RMC, GGA, GLL, VTG, GSA, or
GSV

Transmits position data in selected GPS
sentences.

GPS Message

Enter a GPS message to be transmitted.

GPS Information

Displays the received GPS information.

GPS Position Displays your position, RX station, GPS
memory, and Alarm positions.
GPS Memory (No Group), A~Z Displays the GPS memory contents.

* The unit may differ, depending on the “Display Unit” settings. (p. 9-64)

9-6



Previous view

9  MENU SCREEN

Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

GPS Alarm
Alarm Select OFF, RX, Group, or Memory Select the target for the GPS alarm function.
Alarm Area (Group) 0.08' ~ 0.25’ ~ 59.99*" Enter the GPS alarm active range.
Alarm Area (RX/Memory) Limited, Extended, or Both Select the GPS alarm active range.
GPS Logger*?
GPS Logger OFF or ON Turns the GPS Logger function ON or OFF, to
save your route as you move.
Record Interval 1sec, 5sec, 10sec, 30sec, or Selects the GPS Logger function record
60sec interval.
Record Sentence RMCGGTGGSA Selects the GPS Logger function record
sentences.
GPS Auto TX OFF, 5sec, 10sec, 30sec, 1min, Selects a time option for the GPS automatic
3min, 5min, 10min, or 30min transmission function.
Call Sign Set and display the DV mode call signs.
UR: CQCQCAQ, R1: -------- Displays the operating call signs.
R2: , MY: Sets the operating call signs according to the
type of call you want to make.
RX History Displays the received call history in the DV mode.
RX01: Displays the calls your transceiver received.
DV Memory Saves call signs or repeater information to use in the DV mode.
Your Call Sign Blank Saves station call signs. Add or edit call signs.
Repeater List 01:~50: Saves repeater information.

Add or edit a repeater information.

NOTE: The repeater list described in this manual may differ from your preloaded list.

My Station Sets and saves MY call sign to use in the DV mode.
My Call Sign 1:~6: Saves MY call signs.
Select or edit a MY call sign to use in the DV
mode.
TX Message 1:~5: or OFF Saves TX Messages.
Select or edit TX Message to use in the DV
mode.
DV Set Sets values for the DV mode operations.
Tone Control
RX Bass Cut, Normal, or Boost Sets the DV mode received audio bass filter
level to Cut, Normal or Boost.
RX Treble Cut, Normal, or Boost Sets the DV mode received audio treble filter
level to Cut, Normal or Boost.
RX Bass Boost OFF or ON Turns the DV mode received audio Bass

Boost function ON or OFF

*1 The unit may differ, depending on the “Display Unit” settings. (p. 9-64)
*2 Be sure to insert the microSD card into the transceiver before selecting these items.
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9  MENU SCREEN

Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

TX Bass Cut, Normal, or Boost Sets the DV mode transmit audio bass filter
level to Cut, Normal or Boost.
TX Treble Cut, Normal, or Boost Sets the DV mode transmit audio treble filter
level to Cut, Normal or Boost.
Auto Reply OFF, ON, Voice, or Position Selects the Automatic Reply function.
DV Data TX PTT or Auto Selects to manually or automatically transmit
low speed data.
DV Fast Data The DV Fast data mode sends data through

both the audio and data frames in the DV
mode. The data speed of the DV Fast data
mode (approximately 3480 bps) is 3.5 times
faster than the lowspeed data communication
mode (approximately 950 bps). In the DV Fast
data mode, no audio can be sent.

Fast Data OFF or ON Selects whether or not to use DV Fast data
mode for data communication in the DV
mode.

GPS Data Speed Slow or Fast Set the GPS data transmission speed in the
DV Fast data mode.

TX Delay (PTT) 1sec~2sec~10sec, or OFF Set the TX delay time after releasing [PTT]

when the “DV Data TX” item is set to “PTT”
and data is sent using the DV Fast data

function.

Digital Monitor Auto, Digital, or Analog Selects the DV mode RX monitoring when
[SQL] is held down.

Digital Repeater Set OFF or ON Turns the digital repeater setting function ON

or OFF. This function is usable in any DV
mode except when using the DR function.

DV Auto Detect OFF or ON Turns the DV mode automatic detect function
ON or OFF.

RX Record (RPT) ALL or Latest Only The transceiver can record the data of up to
50 individual calls.

BK OFF or ON Turns the Break-in (BK) function ON or OFF.

The BK function enables you to break into a
conversation between two stations with call
sign squelch enabled.

EMR OFF or ON Turns the Enhanced Monitor Request (EMR)
communication mode ON or OFF.
After turning OFF the transceiver, the EMR
mode will be canceled.

EMR AF Level 0~19~32 Sets the audio output level when an EMR
mode signal is received.
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Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

SPEECH

Sets the Speech functions.

RX Call Sign SPEECH

OFF, ON (Kerchunk), or
ON (All)

Selects the RX call sign speech function
option while ON, or turns it OFF.

RX>CS SPEECH OFF or ON Turns the RX>CS Speech function ON or
OFF.

DIAL SPEECH OFF or ON Turn the Dial Speech function ON or OFF.

MODE SPEECH OFF or ON Turn the Operating Mode Speech function ON

or OFF.

SPEECH Language

English or Japanese

Selects either English or Japanese as the
speech language.

Alphabet

Normal or Phonetic Code

Selects the alphabet character announcement
type.

SPEECH Speed Slow or Fast Selects Slow or Fast speech speed
SPEECH Level 0~7~9 Sets the volume level for the voice
synthesizer.
DTMF Sets the DTMF Memory functions.
DTMF Memory d0:~d9:, dA:~dD:, d*:, or d#: Displays a list of the DTMF memory channels.
The DTMF memory can save up to 24-digit
DTMF code.
DTMF Speed 100ms, 200ms, 300ms, or Selects the DTMF transmit speed.
500ms
QSO/RX Log Sets the QSO/RX History Log options.
QSO Log*! OFF or ON Selects whether or not to make a
communication log on the microSD card.
RX History Log*’ OFF or ON Selects whether or not to make a DV mode’s
receive history log on the microSD card.
CSV Format

Separator/Decimal

Sep [,] Dec [.]*,
Sep [;] Dec [.], or Sep [;] Dec [,]

Selects the separator and the decimal
character for the CSV format.

Date yyyy/mm/dd, mm/dd/yyyy*3, or  Selects the date format.
dd/mm/yyyy
Function Sets various function’s options.
Squelch/ATT Select OFF, S-Meter Squelch, or ATT  Selects to use the S-Meter Squelch or the

Attenuator function for the [SQL] control.

Squelch Delay

Short or Long

Selects to shorten or lengthen the time until
the squelch opens.

Fan Control

Slow, Mid, Fast, or Auto

Selects the cooling fan control action.

Dial Speed-UP

OFF or ON

Turns the dial speed acceleration ON or OFF.

Auto Repeater*?

OFF, ON (DUP), or
ON (DUP,TONE)

Turns the Auto Repeater function ON or OFF.

*1 Be sure to insert the microSD card into the transceiver before selecting these items.
*2 Displayed only in the USA version transceivers.
*3 The default value may differ, depending on the transceiver version.
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Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

Remote MIC Key

Selects the key function for [F-1] or [F-2] on
the supplied remote-control microphone.

During RX/Standby

[F-1]:MODE [F-2]:Monitor

Selects the key function to be used while
receiving or in the standby mode.

During TX

[F-1]: T-CALL [F-2]:-—

Selects the key function to be used while
transmitting.

Up/Down MIC Key

Selects the key function for [UP] or [DN] on
the optional hand microphone.

During RX/Standby

[UP]:UP [DN]J:DOWN

Selects the key function to be used while
receiving or in the standby mode.

During TX

[UP]:-- [DN]:--

Selects the key function to be used while
transmitting.

One-Touch PTT(Remote MIC) OFF or ON

Turns the One-Touch PTT function ON or
OFF.

PTT Lock

OFF or ON

Turns the PTT Lock function ON or OFF.

Busy Lockout

OFF or ON

Turns the Busy Lockout function ON or OFF.

Time-Out Timer

OFF, 1min, 3min, 5min, 10min,
15min, or 30min

Selects the Time-Out Timer time options.

Active Band Single or All Enables continuous frequency selection
across all bands by rotating [DIAL].

MIC Gain 1~2*~4 Sets the microphone sensitivity to suit your
preference.

Data Speed 4800bps or 9600bps Selects the data transmission speed for
low-speed communication, or between the
[DATA] jack and external modules like a GPS
receiver, and so on.

Cl-v

CI-V Address 02h~9Ah~DFh Sets the transceiver's unique CI-V

hexadecimal address code.

Cl-V Baud Rate

4800, 9600, 19200, or Auto

Sets the CI-V code transfer speed.

Cl-V Transceive

OFF or ON

Turns the CI-V Transceive function ON or
OFF.

ClI-V Bluetooth—REMOTE 00~DFh Sets the address to inhibit the external control
transceive Address with CI-V for the transceiver through the [SP]
(REMOTE) jack.
Power OFF (With No OFF or ON Selects whether or not to automatically turn

Controller)

OFF the transceiver when the controller is
disconnected from the transceiver.

Display

Sets the Display options.

LCD Backlight Brightness

1~4

Selects the LCD backlight brightness level.

LCD Backlight Color

White, Amber, Green, or Blue

Selects the LCD backlight color.

Key Backlight Brightness

1~4

Selects the key backlight brightness level.

Key Backlight Color

White, Amber, Green, or Blue

Selects the key backlight color.

* The default value may differ, depending on the transceiver version.
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Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

Backlight Night Time Setting

Night Time Setting OFF or ON Selects whether or not to turn down the
backlight brightness for nighttime operation.
Brightness 1~2~4 Selects the backlight brightness level for

nighttime operation.

Night Time Start

0:00~18:00~23:59

Sets the start time for nighttime operation.

Night Time End

0:00~6:00~23:59

Sets the end time for nighttime operation.

Auto Dimmer Setting

Auto Dimmer

OFF, Auto-OFF, or Auto 1~3

Sets the Auto Dimmer function for nighttime
operation.

Auto Dimmer Timer 5sec, 10sec Sets the period of time until the backlight turns
OFF when “Auto Dimmer” is set to “Auto-OFF”
or “Auto-1” to “Auto-3.”

Auto Dimmer Cancel (PTT) OFF or ON Select the transceiver operation when [PTT] is
pushed when the Auto Dimmer is activated.

Auto Dimmer Cancel OFF or ON Select the transceiver operation when

(DV RX) receiving a DV signal while the Auto Dimmer
is activated.

LCD Contrast 1~8~16 Sets the contrast level of the LCD.

RX Call Sign

OFF, Normal, RX Hold, or Hold

Selects the call sign and message display
option when receiving a call.

RX Position Indicator OFF or ON Selects whether or not to display the indicator
when the position data is included in the
signal received in the DV mode.

RX Position Display OFF or ON Selects whether or not to display the caller’s

position data in a dialog when the data is
included in the signal received in the DV
mode.

RX Position Display Timer

5sec, 10sec, 15sec, 30sec, or
Hold

Sets the RX position data display period of
time.

Reply Position Display

OFF or ON

Selects whether or not to display the caller’s
position data in a dialog when the data is
included in the Auto Reply signal.

TX Call Sign OFF, Your Call Sign, or Selects whether or not to display My or Your
My Call Sign call sign while transmitting.
Scroll Speed Slow or Fast Selects the scrolling speed of the message,
call sign, or other text.
Opening Message OFF or ON Selects whether or not to display the opening
message at power ON.
Voltage (Power ON) OFF or ON Selects whether or not to display the power

source voltage at power ON.

* The default value may differ, depending on the transceiver version.
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Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

Display Unit
Latitude/Longitude ddd°mm.mm’' or ddd°mm'ss" Selects position format to display the position.
Altitude/Distance m or ft/ml* Selects the units to display the distance and
altitude.
Speed km/h, mph*, or knots Selects the units to display the speed.
Temperature C or F* Selects the units to display the temperature.
Barometric hPa, mb, mmHg, or inHg* Selects the units to display the barometric
pressure.
Rainfall mm or inch* Selects the units to display the rainfall.
Wind Speed m/s, mph*, or knots Selects the units to display the wind speed.
Display Language English or Japanese Selects the display language in the DR
screen or MENU screen. When “English” is
selected in “System Language,” this item is
not displayed.
System Language English or Japanese Selects English or Japanese as the system
language of the transceiver.
Sounds Sets the Sound options.
Beep Level 0~9 Sets the beep output level.
Key-Touch Beep OFF or ON Turns the confirmation beep tones ON or OFF
when key is pushed.
Home CH Beep OFF or ON Turns the Home CH Beep ON or OFF.
Band Edge Beep OFF or ON Turns the Band Edge Beep ON or OFF.
Scan Stop Beep OFF or ON Turns the Scan Stop Beep ON or OFF.
Standby Beep OFF, ON, ON (to me:High Tone), Turns the Standby Beep function in the DV
or ON (to me:Alarm/High Tone) mode ON or OFF.
Scope AF Output OFF or ON Selects the audio output option during a
sweep.
Time Set Sets the Time options.
Date/Time
DATE 2000/01/01~2099/12/31 Sets the current date.
TIME 0:00~23:59 Sets the current time.
GPS Time Correct OFF or Auto Sets to automatically correct the time using a
GPS signal.
UTC Offset —14:00~%0:00~+14:00 Enters the time difference between UTC and
the local time.
Auto Power OFF OFF, 30min, 60min, 90min, or Turns the Auto power OFF function ON or
120min OFF.
DV Gateway Enters the Terminal mode or Access Point mode.
<<Terminal Mode>> Enters the Terminal mode.
<<Access Point Mode>> Enters the Access Point mode.

* The default value may differ, depending on the transceiver version.
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Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

SD Card*'

Sets the microSD card options.

Load Setting

File selection

ALL, Except My Station, or
Repeater List Only

Loads the settings file to the transceiver.

Save Setting

<<New File>>

Saves the settings as a new file.

File selection

Saves the settings in a selected file.

Import/Export

Import

Your Call Sign, Repeater List, or

GPS Memory

Imports the Your call sign, Repeater list, or
GPS memory data in the CSV format file.

Export

Your Call Sign, Repeater List, or

GPS Memory

Exports the Your call sign, Repeater list, or
GPS memory data in the CSV format file.

CSV Format

Separator/Decimal

Sep [,] Dec [.]*%, Sep [;] Dec [],

or Sep [;] Dec [,]

Selects the separator and the decimal
character for the CSV format.

Date

yyyy/mm/dd, mm/dd/yyyy*2, or
dd/mm/yyyy

Selects the date format.

SD Card Info

Displays the free space and remaining
recording time of the card.

Firmware Update

Enters the Firmware Update mode.

Format

Formats the card.

Unmount

Electronically unmounts the card.

Bluetooth Set*3

Sets the Bluetooth options.

Bluetooth

OFF or ON

Turns the Bluetooth function ON or OFF.

Auto Connect

OFF or ON

Selects whether or not to automatically

connect to a paired Bluetooth device when the

device is turned ON.

Pairing/Connect

Pairs or connects to a Bluetooth device.

Device Search

Search Headset

Searches for Bluetooth headsets.

Search Data Device

Searches for Bluetooth data devices.

Pairing list

Displays paired devices.

<<Pairing Reception>>

Accepts the connection request from a
Bluetooth device.

*1 Be sure to insert the microSD card into the transceiver before selecting these items.
*2 The default value may differ, depending on the transceiver version.
*3 The optional UT-137 Bluetooth unit is required.
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Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

Headset Set

AF Output

Headset Only or
Headset & Speaker

Selects the AF output option when you use a
Bluetooth headset.

Headset Function Select

Normal, Microphone, or PTT

Select the PTT and microphone combination
when either a Bluetooth headset or the radio
microphone are used.

VOX

VOX

OFF or ON

Turn the VOX function ON or OFF when you
use a Bluetooth headset.

VOX Level

OFF, 1~5~10

Set the MIC Gain level.

If the microphone input level is higher than
this set value, the transceiver starts to
transmit, and if the input level is lower than
this set value, returns to receive.

VOX Delay

0.5sec, 1.0sec, 1.5sec, 2.0sec,
2.5sec, or 3.0sec

Sets the VOX Delay time for the transmitter
stays ON after you stop speaking before the
VOX switches to receive.

VOX Time-Out Timer

OFF, 1min, 2min, 3min, 4min,
5min, 10min, or 15min

Sets the VOX Time-Out Timer to prevent an
accidental prolonged transmission.

Ilcom Headset

Sets to use the optional Icom VS-3 Bluetooth
headset.

Power Save OFF or ON Sets the Power save function to prolong the
headset battery life.

One-Touch PTT OFF or ON Sets the One-Touch PTT function to change
between transmission and reception by
pushing [PTT].

PTT Beep OFF or ON Sets to sound a beep when you push [PTT].

Custom Key Beep OFF or ON Sets to sound a beep when you push custom

key ([PLAY])/[FWD]/[RWD]).

Custom Key

[PLAY]:---, [FWD]:UP,
[RWD]: DOWN

Selects the key function of custom key
([PLAY]/[FWD]/[RWD]).

Data Device Set

Sets the data device options.

Serialport Function

CI-V (Echo Back OFF),

CI-V(Echo Back ON), or DV Data

Selects to transmit or receive CI-V commands
or DV data.

Bluetooth Device Information

Displays the optional UT-137 Bluetooth UNIT
information.

Initialize Bluetooth Device

Resets the optional UT-137 Bluetooth UNIT.
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Menu items and Default settings (Continued)

NOTE: The default settings shown in bold letters below are for the USA version.
The default settings may differ, depending on your transceiver version.

Others Set other options.
Information
Voltage Displays the power source voltage.
Version Displays the transceiver’s firmware version
number.
Clone
Clone Mode Reads or writes the CS-4100 data from or to
the PC.
Reset
Partial Reset Returns all settings to their defaults, without

clearing the memory contents, call sign
memories or repeater lists.

All Reset Clears all entries and memories, and returns
all settings to their defaults.
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DUP/TONE items

Offset frequency (Default: 0.600.00%)

DTCS Code (Default: 023)

DUP/TONE... > Offset Freq

Set the frequency offset for duplex (repeater)

operation to between 0.000.00 and 59.99500 MHz.

® The duplex shift direction (DUP—/DUP+) is set in
the duplex setting window.

® When the DR function is ON, editing is restricted.

*The default value may differ, depending on the frequency
band and the transceiver version.

Repeater Tone
DUP/TONE... > Repeater Tone

Select a CTCSS tone frequency for repeater access
and other functions.
50 tone frequencies (67.0 ~ 254.1 Hz) are selectable.

(Default: 88.5)

TSQL Freq
DUP/TONE... > TSQL Freq

Select a CTCSS tone frequency for the tone squelch
or the Pocket beep function.
50 frequencies (67.0 ~ 254.1 Hz) are selectable.

(Default: 88.5)

» Selectable repeater tone/tone squelch
frequencies (Unit: Hz)

67.0 | 85.4|107.2(136.5/165.5|186.2(210.7 |254.1
69.3 | 88.5/110.9(141.3|167.9|189.9(218.1

71.9 | 91.5|114.8(146.2{171.3|192.8|225.7

744 | 94.8|/118.8(151.4|173.8|196.6(229.1

77.0 | 97.4|123.0(156.7(177.3|199.5|233.6

79.7 1{100.0|127.3(159.8(179.9|203.5|241.8

82.5 1103.5|131.8(162.2|183.5|206.5|250.3

Tone Burst (Default: OFF)

DUP/TONE... > Tone Burst

Turn the Tone Burst function ON or OFF in the FM
mode when using tone squelch.

* OFF: When you transmit a signal that superimposes
the CTCSS tone, the other station may hear

a short burst of noise from their receiver, just
after you stop transmitting.

When you transmit a signal that superimposes
the CTCSS tone, the function mutes the noise
from being heard in the other station’s receiver.

* ON:

9-16

DUP/TONE... > DTCS Code

Select a DTCS (both encoder/decoder) code for the
DTCS squelch.
Atotal of 104 codes (023 ~ 754) are selectable.

 Selectable DTCS codes

023 | 072 152 | 244 | 3N 412 | 466 | 631
025 | 073 | 155 | 245 | 315 | 413 | 503 | 632
026 | 074 | 156 | 246 | 325 | 423 | 506 | 654
031 114 162 | 251 331 431 516 | 662
032 115 165 | 252 | 332 | 432 | 523 | 664
036 116 172 | 255 | 343 | 445 | 526 | 703
043 | 122 174 | 261 346 | 446 | 532 | 712
047 | 125 | 205 | 263 | 351 452 | 546 | 723
051 131 212 | 265 | 356 | 454 | 565 | 731
053 | 132 | 223 | 266 | 364 | 455 | 606 | 732
054 | 134 | 225 | 271 365 | 462 | 612 | 734
065 | 143 | 226 | 274 | 371 464 | 624 | 743
071 145 | 243 | 306 | 411 465 | 627 | 754

DTCS Polarity
DUP/TONE... > DTCS Polarity

Select the DTCS polarity to use for transmitting and

receiving.

* Both N: Normal polarity is used for both TX and RX.

* TN-RR: Normal polarity is used for TX; Reverse
polarity for RX.

* TR-RN: Reverse polarity is used for TX; Normal
polarity for RX.

* Both R: Reverse polarity is used for both TX and RX.

(Default: Both N)

DTCS code’s polarity for transmitting or receiving can
be independently set with this item.

Digital Code
DUP/TONE... > Digital Code

Select the digital code for digital code squelch.
A total of 100 codes (00 ~ 99) are selectable.

(Default: 00)
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Manage Memory items

Memory CH Call CH
Manage Memory > Memory CH Manage Memory > Call CH
You can delete, copy and edit your memory data. You can delete, copy or edit your Call channel data.
Up to 1000 Memory channels can be saved. The Call channel can be assigned to 2 different
Also, 26 memory banks, Ato Z, can be used to save channels (CO and C1) in the 144 MHz and 430 MHz
groups of operating channels, and so on. bands.
Up to 100 channels can be assigned to a bank. The default setting is differ, depending on the
* ALL: All Memory channels are listed. transceiver version.
* A-Z: Memory channels that is saved in the bank

are listed.
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Pause Timer (Default: 10sec)

Scan > Pause Timer

Select the scan Pause time. When receiving a signal,

the scan pauses for the scan Pause Timer time.

» 2sec ~ 20sec : When a signal is received, the scan
pauses for 2 ~ 20 seconds (set in 2
second steps).

: The scan pauses on a received
signal until the signal disappears.

* HOLD

Resume Timer (Default: 2sec)

Scan > Resume Timer

Select the scan Resume Timer time.

When a received signal disappears, the scan resumes
according to the scan Resume Timer setting.

* Osec: The scan resumes immediately after
the signal disappears.

The scan resumes 1 ~ 5 seconds after
the signal disappears.

The scan remains paused for the
Pause Timer setting, even if the signal
disappears.

* 1sec ~ 5sec:

« HOLD:

NOTE: Rotate [DIAL] to resume the scan. The
Resume Timer must be set shorter than the Pause
Timer, otherwise this timer does not work properly.

Temporary Skip Timer (Default: 5min)

Scan > Temporary Skip Timer

Set the Temporary Skip Timer to 5, 10 or 15 minutes.
When the time is set, the unwanted frequencies are
skipped for this set period during a scan.

This timer is activated for the VFO scan, Memory scan
and DR scan.

Program Skip (Default: ON)

Scan > Program Skip

Turn the Program Skip Scan function ON or OFF for a

VFO mode scan.

This function enables the transceiver to skip the

unwanted frequencies or channels that inconveniently

stop scanning.

Set the unwanted frequencies or channels to “PSKIP”

in the Memory Channel screen.

* OFF: The transceiver scans all frequencies.

* ON: The transceiver does not scan frequencies set
as “PSKIP” frequencies.
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Bank Link
Scan > Bank Link

Select banks to be scanned during a Bank Link Scan.
The Bank Link function scans all channels in the
selected banks.

Select a bank, A~ Z, then push [J] to turn the Link
function ON or OFF.

* Displays “v"” when the function is set to ON.

(Default: AlvV]~ Z:)

Program Scan Edge

Scan > Program Scan Edge

You can delete, copy or edit the lower and higher
frequencies for programmed scans.

The transceiver has a total of up to 25 frequency
ranges (00 ~ 24), and you can set scan nhame, tuning
step, and the receive mode for each scan edge.

The default setting is differ, depending on the
transceiver version.

See page 2-9 for Entering scan edges.
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Scan items (Continued)

Program Link (Default: Refer to the table below)

Scan > Program Link

This item sets the link function for two or more
program scan edge ranges to be sequentially scanned
during the Program Link Scan.

The link function scans all frequencies in the scan
range.

Default settings of the Program Link
The Program Scan Edge channels “01” and “02” are
set in the Program Link No. 0 as the default.

0:
Edit Name

( Program Link 01: 144.000-148.000 |

02: 430.000-450.000 |

Program Link number (0 to 9) Program Scan Edge channel

® The Program Link No. screen displays the
frequency range. (The default scan edge frequency
may differ, depending on the transceiver version.)

® You can add a link setting by pushing [QUICK]
when two or more pairs of Program Scan Edge
channels are entered.

® When only one Program Scan Edge channel is
entered, or there is no Programmed Scan Edge (00
to 24) is left, “Add” is not displayed after pushing
[QUICK].
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Adding a Scan Edge channel to the Program Link

1. Select a Program Link number between 0 and 9,
then push [J].

2. Push [QUICK].

3. Select “Add,” then push [J].

= Progra Aodd ‘

-

4. Select a programmed scan number you want to
add to the selected link channel.
(Example: 00: 118.000-550.000)
£ Prograllon: 115, 000 - 550. 000 ()| 141 5]
B

I 124 000 - 146, 000

02: 430. 000 - 450, 000

5. Push [MENUI.
* Returns to the standby screen.

Deleting the link channel

1. Select a Program Link number between 0 and 9,
then push [J].

2. Select the programmed scan number you want to
delete. (Example: 02: 430.000-450.000)

=E Program Link Mo.0
0z 144, 000

- 148. 000
- 450, 000

3. Push [QUICK].

4. Select “Delete,” then push [J].

£ Prog ra | IR
|]

01+ 144, (|[Fe
20 430,

5. Push [MENUI.
* Returns to the standby screen.
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Scan items (Continued)

Editing a Program Scan Link name
1. Select a Program Link number between 0 and 9,
then push [QUICK].

E Program Link

* Enters the Program Link Name edit mode.
3. Enter a Program Scan Link name of up to 16
characters.

E Program Link Mame

lapan_

— — CLR ab
(Example: Japan)

Selectable characters and symbols
AtoZ,atoz,0t0 9, !"#$%& ()*+
-l <=>?2@ VN {1} (space)

® See “Entering and editing text” for details. (p. iv)
4. After entering, push [J].

E Program Link

5. Push [MENU]I.
* Returns to the standby screen.
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Voice Memo items (For Record/Playback)

<<REC Start>>

REC Mode (Default: TX&RX)

Voice Memo > QSO Recorder > <<REC Start>>

After selecting “<<REC Start>>,” push [J] to start
voice recording.
* “Recording started.” is displayed.

® Information

* Be sure a microSD card is in the card slot.

* While recording, “<<REC Stop>>" is displayed on the QSO
RECORDER screen. To stop recording, select “<<REC
Stop>>.”

» Once recording has started, the recording will continue,
even if the transceiver is turned OFF and then later turned
ON again.

Play Files

Voice Memo > QSO Recorder > Play Files

Performs the following steps to play back the recorded
audio on the microSD card.

TIP: Be sure a microSD card is in the card slot.

Playing back
1. Select “Play Files,” then push [J].
+ Displays the folders on the microSD card
® These folders contain the recorded audio files.
2. Select the folder that includes the audio file to play
back, then push [J].
3. Select the file to play back, then push [J].
» The VOICE PLAYER screen is displayed and the
selected file is played back.
® See “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 7-3)
4. Push [MENU]I.
* Returns to the standby screen.

NOTE:
* The folder name is automatically created, as shown
below:
Recording date: 1st April 2017
Folder name: 20170401
* The file name is automatically created, as shown
below:
Recording date and time: 1st April 2017 15:30:00
File name: 20170401_153000
* The voice audio is recorded onto a microSD
card, and saved in the “wav” format. (“.wav” is not
displayed on the transceiver’s screen.)
» The recorded voice audio can also be played back
with a PC.
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Voice Memo > QSO Recorder > Recorder Set >
REC Mode

Records both the transmitted and received audio as

the default setting.

* TX&RX: Records both the transmitted and received
voice audio.

* RX Only: Records only the received voice audio.

When transmitted while recording

When “File Split” is set to “OFF,” the recording is
paused. After you finish transmitting, the recording
resumes.

When “File Split” is set to “ON,” a new file is
automatically created, and the transmitted voice audio
is recorded into the new one.

RX REC Condition (Default: Squelch Auto)

Voice Memo > QSO Recorder > Recorder Set >
RX REC Condition

Select whether or not the squelch status affects the
RX voice audio recording.

* Always: The transceiver always records the
RX voice audio regardless of the
squelch status.

The transceiver records the RX voice
audio only when a signal is received
(the squelch is opened).

When the squelch closes while
recording, the recording will continue
for 2 seconds, and then pause.

» Squelch Auto:

File Split (Default: ON)

Voice Memo > QSO Recorder > Recorder Set >
File Split

Turn the File Split function ON or OFF.

* OFF: When the recording starts, a new file is
automatically created in the folder on the
microSD card. The voice audio is continuously
recorded into the file, even if transmission and
reception, or the squelch status (open and
close) is switched.

If the file size exceeds 2 GB, a new file is
automatically created in the same folder, and
the voice audio is recorded there.

When the recording starts, a new file is
automatically created in the folder of the
microSD card. During recording, and if
transmission and reception, or squelch status
(open and close) is switched, a new file is
automatically created in the same folder, and
the voice audio is saved into the new one.

* ON:
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Voice Memo items (Continued)

PTT Auto REC (Default: OFF)

Voice Memo > QSO Recorder > Recorder Set >
PTT Auto REC

Turn the PTT Automatic Recording function ON or

OFF.

® Transmitting from a Bluetooth VOX device, or
sending a CI-V command also starts recording.

® When "REC Mode" is set to "RX Only," the
transmitted voice audio is not recorded.

* OFF: Turns OFF the function.
* ON: The recording automatically starts when [PTT]
is pushed.

The recording will stop when:

* No signal is transmitted for 10 seconds after
releasing [PTT].

* No signal is received for 10 seconds after
releasing [PTT].

- When transceiver receives a signal 10
seconds after releasing [PTT], the recording
automatically starts.

* Frequency or operating mode is changed
after releasing [PTT].

Skip Time (Default: 10sec)
Voice Memo > QSO Recorder > Player Set >
Skip Time

Select the Skip timer to 3, 5, 10 or 30 seconds to

rewind or skip forward for this set period when you

push the fast-rewind or fast-forward key while playing

the recorded voice audio.

® See “The VOICE PLAYER screen description” for
forwarding or rewinding. (p. 7-3)

DV Auto Reply
Voice Memo > DV Auto Reply

Up to 10 seconds of audio can be recorded for the
automatic reply function.

|TIP: Be sure a microSD card is in the card slot. |

® See “Automatic Reply function” for details. (p. 4-24)
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Voice TX items

Record <<TX>>
Voice TX > Record Voice TX > <<TX>>
Up to one minute of audio can be recorded onto a The transceiver transmits the recorded voice audio.
microSD card for voice transmission. (p. 10-5) If the memory T1 ~ T4 with “Repeat TX” is selected,
Four independent voice audios can be memorized into the recorded voice audio is repeatedly transmitted for
each memory T1 ~ T4. up to 10 minutes, at the “Repeat Time” interval.
While recording a QSO voice audio, this function is (p. 10-6)
disabled.

NOTE:
TIP: Be sure a microSD card is in the card slot. | » If 10 minutes passes while transmitting, the

transceiver continues to transmit until the complete
voice audio transmission is finished.

Repeat Time (Default: Ssec) « Any one of the following action will cancel the
Voice TX > TX Set > Repeat Time transmission.
- Push [PTT].

Set the repeat period of time to between 1 and 15 - Turn OFF the transceiver, then turn it ON again.

seconds (in 1 second steps). _ - Push any key (except for [VOL] and [(]).
The transceiver repeatedly transmits the recorded

voice audio for this set period of time.

NOTE: The recorded voice audio is repeatedly
transmitted for up to 10 minutes. If 10 minutes
passes while transmitting, the transceiver
continues to transmit until the complete voice audio
transmission is finished.

TX Monitor (Default: ON)
Voice TX > TX Set > TX Monitor

Turn the TX Monitor function ON or OFF.

* OFF: The TX voice audio is not heard from the
speaker.

* ON: The TX voice audio is heard from the speaker.

9-23



Previous view

9

MENU SCREEN

GPS Select (Default: Internal GPS)

Unproto Address (Default: AP1410,DSTAR*)

GPS > GPS Set > GPS Select

Select either the internal or external GPS receiver that

the transceiver receives its position data from, or to

manually enter your current position data.

* OFF: A GPS receiver is not used.

« Internal GPS: Position data of the internal GPS data

is used for the GPS functions.

Position data of an external GPS

receiver is used for the GPS

functions.

Manually enter the current Latitude,

Longitude and Altitude in Manual

Position.

® Data communication is disabled when “External
GPS” is selected. (p. 4-27)

® When “External GPS” is set, but if the external
GPS receiver is not connected, the internal GPS
receiver is temporarily turned ON if you use the
Automatic Position Reply function.

* External GPS:

* Manual:

Manual Position (Default: LATITUDE : 0°00.00°N,
LONGITUDE : 0°00.00°E
ALTITUDE : ------ ft)

GPS > GPS Set > Manual Position

Manually enter the latitude, longitude and Altitude of

your current position.

® You can capture the position from the GPS receiver
if “Capture From GPS” is selected. (p. 5-18)

GPS Out (To DATA jack) (Default: OFF)

GPS > GPS Set > GPS Out (To DATA Jack)

Select whether or not the position data of the internal
GPS receiver is output to the [DATA] jack.

TIP:

* When “GPS Select” is set to “OFF,” “External GPS,”
or “Manual,” GPS position data is not output from
the [DATA] jack.

* When you want to operate data communication in

the DV mode, set to “OFF.”

GPS TX Mode (Default: OFF)

GPS > GPS TX Mode

Select a GPS transmission mode to send a GPS
position data while in the DV mode.

* OFF: Does not transmit a GPS data.

* D-PRS: Transmits GPS data in the D-PRS format.
* NMEA: Transmits a GPS data in the NMEA format.
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GPS > GPS TX Mode > D-PRS > Unproto Address

Displays an unproto address of up to 56 alphanumeric
characters.

NOTE: You should use the default address, and
editing is not recommended.

TX Format (Default: Position)
GPS > GPS TX Mode > D-PRS > TX Format

Select the format to transmit the position data in the

D-PRS mode.

 Position: The caller station is the mobile or base
station.

* Object: Transmits a certain location’s information,
such as an event, earthquake, and so on.
(time stamp data is included.)

* ltem: Transmits repeater or antenna information

that needs no time information.
(time stamp data is not included.)

» Weather: Transmits weather information received
from a weather device.

Symbol (Default: Car)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Symbol

Select the symbol that indicates your operating
situation. The selected symbol channel’s symbols
(1~4) are transmitted along with the position data.

Editing a symbol
Select the symbol channel, then push [QUICK].
Select “Edit Symbol,” then push [J].
Push [QUICK].
Select “Direct Input,” then push [J].
Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first digit.
Rotate [DIAL] to select a character or symbol to
the selected digit.

Selectable characters and symbols
<For the first digit>/,\,0t0 9, Ato Z
<For the second digit>Ato Z, atoz, 0to 9, !"#
$R& O+, - /<=>2@[\]"_"{I}"

7. After selecting, push [J].
+ Sets the Symbol into the channel selected in step 1.

aobrwnN =

o

Selecting a preset symbol
1. Select the symbol channel, then push [QUICK].
2. Select “Edit Symbol,” then push [J].
3. Select the symbol, then push [J].
® 1:Car, 2: Van, 3: Truck, and 4:House QTH (VHF) are
set as defaults.
4. Select the symbol channel, then push [J].
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GPS items (Continued)

Symbol list

i [/] Large Aircraft H - W] Sunny 1

E5 W bal Ma.1

[/_1 WX Station

& [/ Dish Antenna

= Symbol Mol

[fa] Ambulance
&% [/b] Bicycle

Symbal Mol

[f]1 Fire Truck H

v [Fa] Glider

= Symbol Mol

[/h] Hospital H

b [£]] leep

Symbol Mo

5 ol Mo 0/38 Symbal Mol

&l

_ - E]["-.Ei] Circle -

A [%] Park/Picnic Area

= [/#] Helicopter
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GPS items (Continued)

SSID (Default: ---)

Comment

GPS > GPS TX Mode > D-PRS > TX Format >
Position > SSID

Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.

The space in call sign is converted to “-.
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”
Example: JA3SYUA — JA3YUA
JA3YUA A — JA3YUA-A
No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.
Example: JASYUA — JA3YUA
JABYUA A — JA3YUA
* -1~-15: Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”
JA3YUA — JA3YUA-9
JA3YUA A — JA3YUA-9
* -A~-Z: Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”
JA3YUA — JA3YUA-Z
JA3YUA A — JA3YUA-Z

About the SSID

To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (or APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.
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GPS > GPS TX Mode > D-PRS > TX Format >
Position > Comment

Enter a comment to transmit it with the D-PRS
position data.

You can enter up to four comments.

The number of characters you can enter differs,
depending on the Data Extension and Altitude
settings.

Data Extension Altitude erﬁ:::c(tﬁ;i_)
OFF OFF 43 (Default)
OFF ON 35
Course/Speed OFF 36
Course/Speed ON 28
Power/Height/Gain/Directivity OFF 36
Power/Height/Gain/Directivity ON 28

The symbol “1” displays the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.

E Comment

— —

CLR 4B

Transmittable comment range display
(In case of up to 28 characters)

Time Stamp (Default: OFF)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Time Stamp

Sets the transmitting time stamp type to DHM, HMS or
OFF.

The time stamp is transmitted along with the position
data in the D-PRS mode, and UTC (Universal Time
Coordinated) time is used.

* OFF: Does not transmit the time information.

* DHM: Transmits the time stamp in the Day, Hour,
and Minute format.

Transmits the time stamp in the Hour, Minute,
and Second format.

* HMS:

When your location is manually set, time stamp data
cannot be transmitted.
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GPS items (Continued)

Altitude (Default: OFF)

Power (Default: 0W)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Altitude

Select whether or not to transmit altitude data along

with the position data in the D-PRS mode.

* OFF: No altitude data is transmitted.

* ON: Transmits altitude data along with the position
data.

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data

Extension” and “Altitude” settings.

Data Extension (Default: OFF)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Data Extension

Select whether or not to transmit course/speed data

or Power/Height/Gain/Directivity data along with the

position data in the D-PRS mode.

* OFF: Does not transmit any information.

» Course/Speed: Transmits course and speed data
along with the position data.
The Course and Speed data is not
transmitted when your location is
manually set.
When transmitting with this setting,
your station is regarded as a mobile
station.

» Power/Height/Gain/Directivity:
Transmits the TX power level, height,
antenna gain and antenna direction,
along with the position data.
The Power, Height, Gain and
Directivity data is transmitted even if
your location is manually set.
Only the Icom transceivers, ID-
51A/E PLUS, ID-51A/E PLUS2,
ID-5100A/E, and ID-4100A/E, can
receive Power, Height, Gain and
Directivity data. (As of April 2017)

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.
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GPS > GPS TX Mode > D-PRS > TX Format >
Position > Power

Select the TX power level of the base station, to
transmit along with the position data.
Options: Set to between 0, 1, 4, 9, 16, 25, 36, 49, 64,
and 81W.
® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Height (Default: 10ft)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Height

Select the height of the base station’s antenna, to

transmit along with the position data.

Options: Set to between 10, 20, 40, 80, 160, 320, 640,

1280, 2560, and 5120 feet.”

*If the Altitude/Distance unit is set to “m,” select between 3,

6, 12, 24, 49, 98, 195, 390, 780, and 1561 meters. (p. 9-64)

® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Gain (Default: 0dB)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Gain

Select the gain of the base station’s antenna, to

transmit along with the position data.

Options: Set to between 0 and 9 dB.

® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Directivity (Default: Omni)

GPS > GPS TX Mode > D-PRS > TX Format >
Position > Directivity

Select the direction the base station’s antenna was
pointing, to transmit along with the position data.
Options: Set to between Omni, 45°NE, 90°E, 135°SE,
180°S, 225°SW, 270°W, 315°NW and 360°N.
® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”
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GPS items (Continued)

Object Name

Comment

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Object Name

Enter an Object name of up to 9 characters.

Data Type (Default: Live Object)
GPS > GPS TX Mode > D-PRS > TX Format > Object

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Comment

Enter a comment.

The number of characters you can enter differs,
depending on the Data Extension and Altitude data
entry.

DT LT Characters
Set the Object’s status. Data Extension Altitude entered
* Live Object: The Object is valid. (maximum)
* Killed Object: The Obiject is invalid. OFF — 43 (Default)
OFF Entered 35
Symbol (Default: Radio) Course/Speed — 36
GPS > GPS TX Mode > D-PRS > TX Format > Object Course/Speed ___| Entered 28
> Symbol Power/Height/Gain/Directivity| — 36
Power/Height/Gain/Directivity| Entered 28

The symbol is an icon which represents Object’s
means of transportation or location. The saved symbol
is transmitted along with the position data while in the
D-PRS mode.

See page 9-25 for the symbol list.

Editing a symbol

1. Push [QUICK].

2. Rotate [DIAL] to select “Direct Input,” then push
[J].

3. Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first
digit.

4. Rotate [DIAL] to select a character or symbol to
the selected digit.

Selectable characters and symbols

<For the first digit>
/,\,0t09,Ato Z

<For the second digit>
AtoZ,atoz, 0to 9, !"#$%& ()*+
o ln<=>2@ N\ N {1}

5. Push [J] to set the symbol.

Selecting a preset symbol

1. On the “Symbol” screen, rotate [DIAL] to select
the symbol.

2. Push [J] to set the symbol.

9-28

The symbol “1” shows the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.

£ Comment

— —

CLR AB

Transmittable comment range display
(In case of up to 28 characters)
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GPS items (Continued)

Position

GPS > GPS TX Mode > D-PRS > TX Format > Object

> Position

Displays the position information of the Object.
Push [QUICK] to open the window shown below.

Lﬂ\T|TU Capture From GPS
LOMGIT Set Fram GPS Memar
ALTITU Default

TIP: When you select “Capture From GPS” or “Set
From GPS Memory,” you can capture the position
from the GPS, or set the Object’s position from the
GPS memory. (p. 5-18)

Entering the latitude
1. Rotate [DIAL] to select “Edit,” then push [J].
* Displays the POSITION EDIT screen.
2. Select “LATITUDE,” then push [J].
* Displays the LATITUDE screen.
3. Rotate [DIAL] to enter the latitude.
® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
® To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”
4. After entering, push [J].

Entering the longitude
5. Select “LONGITUDE,” then push [J].
* Displays the LONGITUDE screen.
6. Rotate [DIAL] to enter the longitude.
® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
® To enter an east latitude longitude, select “E,” and to
enter a west longitude, select “W.”
7. After entering, push [J].

Entering the altitude
8. Select “ALTITUDE,” then push [J].
* Displays the ALTITUDE screen.
9. Rotate [DIAL] to select between plus and minus.
10. Push [MW] to move the cursor forwards.
11. Rotate [DIAL] to enter the altitude.
® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
After entering, push [J].
Select “<<Write>>,” then push [J].
* The confirmation dialog “Write?” is displayed.
Select <YES>, then push [J].
» Writes the entered position data.
Push [9].

12.
13.

14.

15.

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.

9-29

EPOSITION EDIT

LATITUDE : 35°45.00'N 3
LONGITUDE 135"36.00'E 3
ALTITUDE 3

After entering the position data

Data Extension (Default: OFF)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Data Extension

Select whether or not to transmit the Course/Speed
data or Power/Height/Gain/Directivity data along with
the position data in the D-PRS mode.
* OFF: Does not transmit any information.
» Course/Speed: Transmits the Course and Speed
data along with the position data.
» Power/Height/Gain/Directivity:
Transmits the Power, Height, Gain
and Directivity data, along with the
position data.
Only the Icom transceivers, ID-
51A/E PLUS, ID-51A/E PLUS2,
ID-5100A/E, and ID-4100A/E, can
receive Power, Height, Gain and
Directivity data. (As of April 2017)

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.

Course (Default: 0°)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Course

Set the Object’s course to between 0° and 360°.
® This item is displayed when “Data Extension” is set
to “Course/Speed.”

Speed (Default: 0Omph)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Speed

Set the Object’s speed to between 0 and 1150 mph.*

*If the Speed unit is set to “km/h,” select between 0 to 1850

km/h, or set to “knots,” select between 0 and 999 knot.

(p. 9-64)

® This item is displayed when “Data Extension” is set
to “Course/Speed.”
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GPS items (Continued)

Power (Default: 0W)

SSID (Default: ---)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Power

Select the TX power level of the Object, to transmit
along with the position data.
Options: Set to between 0, 1, 4, 9, 16, 25, 36, 49, 64,
and 81W.
® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Height (Default: 10ft)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Height

Select the height of the Object’s antenna, to transmit

along with the position data.

Options: Set to between 10, 20, 40, 80, 160, 320, 640,

1280, 2560, and 5120 feet.”

*If the Altitude/Distance unit is set to “m,” select between 3,

6, 12, 24, 49, 98, 195, 390, 780, and 1561 meters. (p. 9-64)

® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Gain (Default: 0dB)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Gain

Select the gain of the Object’s antenna, to transmit

along with the position data.

Options: Set to between 0 and 9 dB.

® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Directivity (Default: Omni)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Directivity

Select the direction the Object’s antenna was pointing,
to transmit along with the position data.
Options: Set to between Omni, 45°NE, 90°E, 135°SE,
180°S, 225°SW, 270°W, 315°NW and 360°N.
® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

9-30

GPS > GPS TX Mode > D-PRS > TX Format > Object
> SSID

Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.
o - The space in call sign is converted to “-.”
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”
Example: JA3YUA — JA3YUA

JA3YUA A — JA3YUA-A
No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.
Example: JA3SYUA — JA3YUA

JABYUA A — JA3YUA
Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”

JA3YUA — JA3YUA-9

JA3YUA A — JA3YUA-9
Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”

JA3YUA — JA3YUA-Z

JA3YUA A — JA3YUA-Z

. -1~-15:

e -A~-Z:

About the SSID

To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (or APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

Time Stamp (Default: DHM)

GPS > GPS TX Mode > D-PRS > TX Format > Object
> Time Stamp

Sets the transmitting time stamp type to DHM or HMS.

The time stamp is transmitted along with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

* DHM: Transmits the time stamp in the Day, Hour,
and Minute format.

* HMS: Transmits the time stamp in the Hour, Minute,
and Second format.
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GPS items (Continued)

Item Name

Comment

GPS > GPS TX Mode > D-PRS > TX Format > ltem >
Item Name

Enter an Item name of up to 9 characters.

Data Type (Default: Live Item)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Data Type

GPS > GPS TX Mode > D-PRS > TX Format > Iltem >
Comment

Enter a comment.

The number of characters you can enter differs,
depending on the Data Extension and Altitude data
entry.

Characters
Set the Item’s status. Data Extension Altitude entered

e Live Item: The ltem is valid. (maximum)

* Killed Item: The Item is invalid. OFF — 43 (Default)
OFF Entered 35
Symbol (Default: Radio) Course/Speed — 36
GPS > GPS TX Mode > D-PRS > TX Format > Item > Course/Speed ___| Entered 28
Symbol Power/Height/Gain/Directivity — 36
Power/Height/Gain/Directivity| Entered 28

The symbol is an icon which represents Item’s means
of transportation or location. The saved symbol is
transmitted along with the position data while in the
D-PRS mode.

See page 9-25 for the symbol list.

Editing a symbol

1. Push [QUICK].

2. Rotate [DIAL] to select “Direct Input,” then push
[J].

3. Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first
digit.

4. Rotate [DIAL] to select a character or symbol to
the selected digit.

Selectable characters and symbols

<For the first digit>
/,\,0t09,Ato Z

<For the second digit>
AtoZ,atoz, 0to 9, !"#$%& ()*+
o ln<=>2@ N\ N {1}

5. Push [J] to set the symbol.

Selecting a preset symbol

1. On the “Symbol” screen, rotate [DIAL] to select
the symbol.

2. Push [J] to set the symbol.

9-31

The symbol “1” shows the transmittable comment
range. Please note that the characters that exceed the
range will not be transmitted.

£ Comment

— —

CLR AB

Transmittable comment range display
(In case of up to 28 characters)
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GPS items (Continued)

EPOSITION EDIT

Position

GPS > GPS TX Mode > D-PRS > TX Format > ltem >

Position

Displays the position information of the Item.
Push [QUICK] to open the window shown below.

Lﬂ\T|TU Capture From GPS
LOMGIT Set Fram GPS Memar
ALTITU Default

TIP: When you select “Capture From GPS” or “Set
From GPS Memory,” you can capture the position
from the GPS, or set the ltem’s position from the
GPS memory. (p. 5-18)

Entering the latitude
1. Rotate [DIAL] to select “Edit,” then push [J].
* Displays the POSITION EDIT screen.
2. Select “LATITUDE,” then push [J].
* Displays the LATITUDE screen.
3. Rotate [DIAL] to enter the latitude.
® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
® To enter a north latitude, select “N,” and to enter a
south latitude, select “S.”
4. After entering, push [J].

Entering the longitude
5. Select “LONGITUDE,” then push [J].
* Displays the LONGITUDE screen.
6. Rotate [DIAL] to enter the longitude.
® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
® To enter an east latitude longitude, select “E,” and to
enter a west longitude, select “W.”
7. After entering, push [J].

Entering the altitude
8. Select “ALTITUDE,” then push [J].
* Displays the ALTITUDE screen.
9. Rotate [DIAL] to select between plus and minus.
10. Push [MW] to move the cursor forwards.
11. Rotate [DIAL] to enter the altitude.
® Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.
After entering, push [J].
Select “<<Write>>,” then push [J].
* The confirmation dialog “Write?” is displayed.
Select <YES>, then push [J].
» Writes the entered position data.
Push [9].

12.
13.

14.

15.

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.

9-32

LATITUDE : 35"45.00'N »
LOMGITUUDE: 135" 26.00'E »
ALTITUDE :55ft »

After entering the position data

Data Extension (Default: OFF)

GPS > GPS TX Mode > D-PRS > TX Format > Iltem >
Data Extension

Select whether or not to transmit the Course/Speed
data or Power/Height/Gain/Directivity data along with
the position data in the D-PRS mode.
* OFF: Does not transmit any information.
» Course/Speed: Transmits the Course and Speed
data along with the position data.
» Power/Height/Gain/Directivity:
Transmits the Power, Height, Gain
and Directivity data, along with the
position data.
Only the Icom transceivers, ID-
51A/E PLUS, ID-51A/E PLUS2,
ID-5100A/E, and ID-4100A/E, can
receive Power, Height, Gain and
Directivity data. (As of April 2017)

TIP: The number of characters you can enter
in “Comment” differs, depending on the “Data
Extension” and “Altitude” settings.

Course (Default: 0°)

GPS > GPS TX Mode > D-PRS > TX Format > ltem >
Course

Set the ltem’s course to between 0° and 360°.
® This item is displayed when “Data Extension” is set
to “Course/Speed.”

Speed (Default: Omph)

GPS > GPS TX Mode > D-PRS > TX Format > Iltem >
Speed

Set the ltem’s speed to between 0 and 1150 mph.*

*If the Speed unit is set to “km/h,” select between 0 to 1850

km/h, or set to “knots,” select between 0 and 999 knot.

(p. 9-64)

® This item is displayed when “Data Extension” is set
to “Course/Speed.”
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GPS items (Continued)

Power (Default: 0W)

SSID (Default: ---)

GPS > GPS TX Mode > D-PRS > TX Format > Item
> Power

Select the TX power level of the Item, to transmit
along with the position data.
Options: Set to between 0, 1, 4, 9, 16, 25, 36, 49, 64,
and 81W.
® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Height (Default: 10ft)

GPS > GPS TX Mode > D-PRS > TX Format > Item
> Height

Select the height of the ltem’s antenna, to transmit

along with the position data.

Options: Set to between 10, 20, 40, 80, 160, 320, 640,

1280, 2560, and 5120 feet.”

*If the Altitude/Distance unit is set to “m,” select between 3,

6, 12, 24, 49, 98, 195, 390, 780, and 1561 meters. (p. 9-64)

® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Gain (Default: 0dB)

GPS > GPS TX Mode > D-PRS > TX Format > Item
> Gain

Select the gain of the Item’s antenna, to transmit

along with the position data.

Options: Set to between 0 and 9 dB.

® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

Directivity (Default: Omni)

GPS > GPS TX Mode > D-PRS > TX Format > Item >
Directivity

Select the direction the ltem’s antenna was pointing,
to transmit along with the position data.
Options: Set to between Omni, 45°NE, 90°E, 135°SE,
180°S, 225°SW, 270°W, 315°NW and 360°N.
® This item is displayed when “Data Extension” is set
to “Power/Height/Gain/Directivity.”

9-33

GPS > GPS TX Mode > D-PRS > TX Format > Item
> SSID

Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.
o - The space in call sign is converted to “-.”
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”
Example: JA3YUA — JA3YUA

JA3YUA A — JA3YUA-A
No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.
Example: JA3SYUA — JA3YUA

JABYUA A — JA3YUA
Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”

JA3YUA — JA3YUA-9

JA3YUA A — JA3YUA-9
Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”

JA3YUA — JA3YUA-Z

JA3YUA A — JA3YUA-Z

. -1~-15:

e -A~-Z:

About the SSID

To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (or APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.
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GPS items (Continued)

Symbol (Default: WX Station)

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > Symbol

The symbol is an icon which represents weather
station’s means of transportation or location. The
saved symbol is transmitted along with the position
data while in the D-PRS mode.

See page 9-25 for the symbol list.

Editing a symbol

1. Push [QUICK].

2. Rotate [DIAL] to select “Direct Input,” then push
[J].

3. Push [MW] to move the cursor to the second digit,
or push [MODE] to move the cursor to the first
digit.

4. Rotate [DIAL] to select a character or symbol to
the selected digit.

Selectable characters and symbols

<For the first digit>
/,\,0t09,Ato Z

<For the second digit>
AtoZ,atoz, 0to 9, "#$%& ()*+
<= 2@ N\ {1}

5. Push [J] to set the symbol.

Selecting a preset symbol

1. On the “Symbol” screen, rotate [DIAL] to select
the symbol.

2. Push [J] to set the symbol.

SSID (Default: ---)

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > SSID

Select an SSID based on APRS® to add to your call
sign, to show your operating style to other stations.
The addition methods of the SSID may differ,
depending on whether the call sign includes a space
or not.

L The space in call sign is converted to “-.”
If no text is entered after the space, the
space will be deleted, and the space is not
converted to “-.”

Example: JABYUA — JA3YUA
JA3YUA A — JA3YUA-A

*(-0):  No SSID is added. If a call sign includes a
space, any text or digit after the space will be
deleted.

Example: JASYUA — JA3YUA
JA3YUA A — JA3YUA

* -1~-15; Adds an SSID of -1 to -15 to your call sign.
Example: SSID is “-9.”
JA3YUA — JA3YUA-9
JA3YUA A — JA3YUA-9
*-A~-Z: Adds an SSID of -A to -Z to your call sign.
Example: SSID is “-Z.”
JA3YUA — JA3YUA-Z
JA3YUA A — JA3YUA-Z

About the SSID

To assist in identifying a station’s type, designated
call sign SSIDs are used in D-PRS (APRS®),
according to a common guideline. The guideline may
be changed when the infrastructure environment,
such as a product or network, is changed. Please
check the latest guideline in the web site related to
D-PRS and APRS®, and correctly set.

Comment

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > Comment

Enter a comment of up to 43 characters.

Time Stamp (Default: DHM)

GPS > GPS TX Mode > D-PRS > TX Format >
Weather > Time Stamp

Sets the transmitting time stamp type to DHM, HMS or

OFF.

The time stamp is transmitted along with the position

data in the D-PRS mode, and UTC (Universal Time

Coordinated) time is used.

* OFF: Does not transmit the time information.

* DHM: Transmits the time stamp in the Day, Hour,
and Minute format.

* HMS: Transmits the time stamp in the Hour, Minute,
and Second format.
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GPS items (Continued)

GPS Sentence (Default: GGA)

GPS Message

GPS > GPS TX Mode > NMEA > GPS Sentence

Select sentences to be transmitted in the GPS mode

to transmit position data.

Options: Set to between RMC, GGA, GLL, VTG, GSA
and GSV.

® Information

* A maximum of four GPS sentences can be set at a
time.

* Displays “v” when the sentence is set to ON.

* Even if the GPS Auto TX Timer is set to “5 sec.,”
when 4 sentences are selected, the time the GPS
Auto TX Timer is automatically changed to “10 sec.”

< “VTG,” “GSA” and “GSV” sentences will not be
transmitted when your position has been manually
set.

NOTE: Set the GSV sentence to OFF when

sending the GPS message to conventional digital
transceivers (IC-2820H, |IC-E2820, ID-800H, IC-
91AD, IC-E91, IC-V82, IC-U82, IC-2200H).

The GSV sentence is incompatible with them. Those
transceivers will not display GPS messages properly
if sent as a GSV sentence from the ID-4100A/E.

GPS > GPS TX Mode > NMEA > GPS Message
Enter a GPS message of up to 20 alphanumeric
characters. (p. 5-26)

NOTE: When you do not want to send a message,
delete the entered message.

TIP: Contents of GPS sentence

The Time Stamp is shown based on the UTC (Universal Time Coordinated) time.

GPS Time | Date COG | SOG
Sentence | Lat/Lon | Alt Stamp (UTC)|(UTC) Status | 2D/3D (True) | (knot)
RMC | v v v | v v | v
GGA v v v v
GLL v v v
VTG v v
GSA v v
GSV
Sentence Others

RMC Magnetic Variation, Mode Indicator

GGA Differential reference station 1D

Number of used satellites, HDOP, Geoidal separation, Age of Differential GPS data,

GLL Mode Indicator

VTG COG (Magnetic north), SOG (km/h), Mode Indicator

GSA PRN number of satellites, PDOP, HDOP, VDOP

GsvV

Total number of sentences, Sentence number, Total number of satellites in view,
Satellite information (ID, Altitude, Azimuth, S/N)

9-35
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GPS items (Continued)

GPS Information

GPS > GPS Information

Displays the GPS satellite direction, altitude, satellite
number and receiving status. (p. 5-11)

EGPS INFORMATION

[l

] {1 Tl | Y
071 25 16 01 18 22 26 30 -- == == ==
SR SAT: 4
e/ S 135" 3017 E

RX screen (Received position of the other station)
Depending on the caller’'s TX mode or TX format, the
displayed items and these meanings are differ.

The following lists describe the items for each

category.

No data is displayed when no position data is received
on your transceiver.

20537, 73N <1. When the caller’s TX mode is NMEA>
. Displays the caller’s direction
i i Compass "
(Example: Tracking 4 satellites) from your position.
Latitude Displays the caller’s latitude
Longitude Displays the caller’s longitude
©) Untracking satellite Displays the grid locator based
Regular characters Tracking satellites (weak signal) GL on the latitude and longitude of
(Example: 01) 9 9 the caller’s position.
Reversed ALT Displays the caller’s altitude
characters Tracking satellites (strong signal) Displays the caller’s distance
DST "
(Example: () from your position
SAT Number of tracking satellite Displays the caller’s direction
- . COURSE
The altitude of your station. over ground
The altitude is only displayed SPEED Displays the caller’s speed
Altitude when 4 or more satellites are ' Displays the time that the caller
GPST St . ”
tracked. When 3 or less satellites 'me >tamp acquired the position data.
are tracked, “------ ft” is displayed. Call sign Displays the caller’s call sign
Latitude —L— :['_t-“d_ (Nfon—p03|tt|(:.n|ng)/
allude °N your s ? lon. ; <2. When the caller’s TX format is D-PRS Position
Longitude "=~ (Non-positioning) (Mobile station)>
Longitude of your station. - PTIY
. Displays the caller’s direction from
Compass -,
your position
GPS Position Latitude Displays the caller’s latitude
GPS > GPS Position Longitude D!splays the ca]ler s longitude
Displays the grid locator based on
Your current position, received position or GPS GL the latitude and longitude of the
memory alarm position information is displayed. caller’s position.
(p. 5-3) ALT Displays the caller’s altitude
Rotating [DIAL] selects the MY, RX, MEM, and ALM Displays the caller’s distance from
DST -
screens. your position
Displays the caller’s direction over
MY screen (MY Position) COURSE ground
Compass* Displays your direction SPEED Displays the caller’s speed
Latitude Displays your latitude Symbol Displays the caller’s D-PRS symbol
Longitude Displays your longitude GPS Time Displays the time that the caller
Displays the grid locator based Stamp acquired the position data. .
GL on the latitude and longitude of : Displays the caller’s call sign (with
" Call sign
your position. SSID)
ALT Displays your own altitude
SPEED Displays your speed over ground
Displays current time received
TIME from the GPS
COURSE Displays your direction heading

® When “GPS Select’ is set to “Manual,” the screen
displays only latitude, longitude, altitude, GL (Grid
locator), and time (internal clock).

*The display type can be changed. (p. 5-10)
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<3. When the caller’s TX format is D-PRS Position <5. When the caller’s TX format is D-PRS Weather>

(Base station)> . Displays the caller’s direction
. PSTERT Compass I,
Compass* Dlsplays_the caller’s direction from : fr(_)m your position : .
your position Latitude Displays the caller’s latitude
Latitude Displays the caller’s latitude Longitude Displays the caller’s longitude
Longitude Displays the caller’s longitude Displays the grid locator based
Displays the grid locator based on GL on the latitude and longitude of
GL the latitude and longitude of the the caller station’s position
caller’s position. DST Displays the caller’s distance
ALT Displays the caller’s altitude from your position
DST Displays the caller’s distance from TEMP Displays the temperature of the
your position caller station’s area
POWER Displays the caller’s TX power level RAIN Displays the rainfall of the caller
HEIGHT Displays the caller’s antenna height station'sarea
GAIN Displays the caller’s antenna gain WIND DIR c[:);lzlragtsa:igi'szgrdeglrecnon of the
Displays the direction of caller’s - .
DIRECT antenna was pointing WIND SPD Displays t_he ,wmd speed of the
Symbol Displays the caller’s D-PRS symbol cDglleIr Stat'ﬁ ns ared
GPS Time Displays the time that the caller BARO fI?E aysl;t © ta{.om,etrlc pressure
Stamp acquired the position data. B. Ie ca tﬁr sha 'o.g.s arfe?h
. Displays the caller’s call sign (with HUMI 'Splays e, umidity of the
Call sign SSID) cl:;)e_allelr staf[lr?n s e|1|rea "
isplays the caller station’s
<4. When the caller’s TX format is D-PRS Object/ Symbol D.PRS symbol
Item> ' Displays the time that the caller
Compass* Displays the Object/Item’s direction GPS Time Stamp ac_:quired the weatr)er data_.
from your position Call sign Dls_splays the caller’s call sign
Latitude Displays the Object/Item’s latitude (with SSID)
Longitude Displays the Object/ltem’s longitude
Displays the grid locator based on MEM screen (GPS memory alarm position)
GL thellat|tude and Iqqg|tude of the . Displays GPS Memory channel’s
Object/Item’s position. Compass direction from your position
ALT Displays the Object/ltem’s altitude ] Displays GPS Memory channel’s
DST Displays the Object/Item’s distance Latitude latitude
fr(_)m your position — Lonaitud Displays GPS Memory channel’s
COURSE Displays the Object/Item’s direction ongitude longitude
over ground Displays the grid locator based
SPEED Displays the Object/ltem’s speed GL on the latitude and longitude of
POWER Displays the Object/ltem’s TX power GPS Memory channel’s.
level : DST Displays GPS Memory channel’s
HEIGHT D|§plays the Object/Item’s antenna distance from your position
height : GPS memory Displays the selected GPS
GAIN Dlgplays the Object/ltem’s antenna name* memory name
gain
Displays the direction that the
DIRECT Object/lItem’s antenna was pointing
Symbol Displays the Object/ltem’s D-PRS
symbol
GPS Time Displays the time that the caller sent
Stamp the Object’s data.
. Displays the caller’s call sign (with
Call sign SSID)

® When the object or Item is disabled, “KILLED” is

displayed.
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ALM screen (GPS alarm position) GPS Memory

Compass* Djsple_nys GPS Alarm argg's GPS > GPS Memory

direction from your position
: Displays GPS Alarm area’s The transceiver has 300 GPS Memory channels to

Latitude latitude save the received position data, or often-used position

Longitude Displays GPS Alarm area’s data, along with an alphanumeric channel name.
longitude The channels can be divided into the “(No Group)”
Displays the grid locator based group and each memory group (A to Z) for easy

GL on the latitude and longitude of memory management.
GPS Alarm area’s.

DST Displays GPS Alarm area’s The display of the GPS memory
distance from your position GPS memories not assigned to
Displays “RX,” GPS memory (No Group) any group.

GPS Alarm* group name or GPS memory A~ Z: Group GPS memories assigned to the
name specified for the GPS Name selected group.
alarm function.

GPS memory groups (A~ Z)

GPS memory group name
(Up to 16 alphanumeric
characters)

GROUP NAME

® You can edit the GPS memory group name.
(p. 5-30)

GPS memory channels

GPS memory channel name
NAME (Up to 16 alphanumeric
characters)
DATE Saved date
TIME Saved time
LATITUDE Saved location (latitude)
LONGITUDE Saved location (longitude)
ALTITUDE Saved altitude
GROUP The group letter and the name of
the group

® When you save the received position data on the
GPS POSITION screen, the received station’s call
sign is used as the GPS memory name.

® You can edit the GPS memory contents, such as
the GPS memory name. (p. 5-27)
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Alarm Select (Default: OFF)

Alarm Area (RX/Memory) (Default: Both)

GPS > GPS Alarm> Alarm Select

Select the target position(s) for the GPS alarm
function.
* OFF:

* RX:

Turns OFF the function.

The GPS alarm sounds when a target (the
last received position) enters in your active
alarm range, .

The GPS alarm sounds when a target
(positions in the GPS memory, or in the
selected GPS memory group) enters in
your active alarm range.

The GPS alarm sounds when a target (the
specified position in the GPS memory)
enters in the active alarm range.

» Group:

* Memory:

Alarm Area (Group) (Default: 0.25')

GPS > GPS Alarm> Alarm Area (Group)

Set the GPS active alarm range.

When a target enters in the specified active alarm

range, the GPS alarm sounds and the GPS alarm icon

blinks.

® When “Alarm Select” is set to “Group,” this setting is
enabled.

Ranges differs, depending on the “Position Format”
setting.
® Position Format = ddd°mm.mm’
Ranges: 00.08' to 59.99' (0.01" steps)
® Position Format = ddd°mm’'ss"
Ranges: 00'05" to 59'59" (0’01" steps)

Example:
When a target enters in the active alarm range, the
GPS alarm sounds and the GPS alarm icon blinks.

Point (A/S ;025 0.25°
N |
|
Your 1
position ———*-——-
/
Point B T

Point C  Beeps three times
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GPS > GPS Alarm> Alarm Area (RX/Memory)

Select the GPS active alarm range.

When a target enters in the active alarm range, the

GPS alarm sounds and the GPS alarm icon blinks.

® When “Alarm Select” is set to “RX” or “Memory,” this
setting is enabled.

* Limited: The transceiver sounds 3 beeps and the

GPS alarm icon blinks when the target

enters the 500 meter range.

The transceiver sounds 3 beeps and the

GPS alarm icon blinks when the target

enters the 1 kilometer range.

The transceiver sounds a beep and the

GPS alarm icon blinks when the target

enters the 1 kilometer range, and sounds

3 beeps and the icon blinks when it enters

the 500 meter range.

When the target exits the 500 meter

range, but is still in the 1 kilometer range,

the icon continues to blink, but no beeps

sound.

* Extended:

* Both:

Example:

When a target enters in the active alarm range (500
meter or 1 kilometer range, depending on the setting),
the GPS alarm sounds and the GPS alarm icon blinks.

|
/ /_Extended range
’4(Approximate 1 km,

m 1094 Y)
?/ (Approximate 500 m,

[ 547 Y)

Beeps one tlmes Beeps three times

Your
posmon

L|m|ted range
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GPS Logger (Default: OFF)

GPS Auto TX (Default: OFF)

GPS > GPS Logger > GPS Logger

Turn the GPS Logger function ON or OFF.

This function logs the position, altitude, course, speed

and number of satellites being used.

* OFF: Turns OFF the function.

* ON: The transceiver automatically logs GPS data.
Once this function is turned ON, the GPS data
will be continuously logged until turning it OFF,
even if the transceiver power is turned OFF,
then ON again.

® This function requires a microSD card (User
supplied).

® When “GPS select” is set to “OFF” or “Manual,” this
function does not save the log.

TIP: The log data is saved on the microSD card. The
file name is automatically created, as shown below:
* Log start date and time: 1st April 2017 15:30:00

* File name: 20170401_153000.log

Record Interval (Default: 5sec)

GPS > GPS Logger > Record Interval

Select the GPS Logger function record interval of 1, 5,
10, 30, or 60 seconds.

Record Sentence

(Default: [VIRMC/V|GGA/IVIVTGIVIGSA)
GPS > GPS Logger > Record Sentence

Set the GPS Logger function record sentence to
RMC, GGA, VTG, or GSA.
* Displays “v” when the sentence is set to ON.

NOTE: Select at least one sentence, otherwise an
error beep will sound.
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GPS > GPS Auto TX

Select an option for the GPS automatic transmission
function.

This function automatically transmits the current
position data received from a GPS receiver, as well as
any entered GPS message, at the selected interval.

* OFF: Does not automatically transmit
the position data. (When you push
[PTT], the transceiver transmits the
position data.)

Transmits the current position data
at the selected interval (5%, 10, or
30 seconds, or 1, 3, 5, 10, or 30
minutes).

*Not displayed when you set four GPS
sentences in “GPS Sentence.”

* 5 sec to 30 min:

NOTE: When the GPS transmit mode is “NMEA,” set
the “GPS Select” item to “Internal GPS” or “External
GPS.” If you set to “Manual” or “OFF,” the current
position data will not be automatically transmitted.
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Call Sign

Call Sign

Sets or views the “UR,” “R1,” “R2,” and “MY” call signs
to use in the DV mode.

When not using the DR function, sets the call signs on
this screen.

For Simplex operation (DV mode)
You can set the “UR” and “MY” call signs.

For Duplex (repeater) operation

(DV mode/DR function)

You can set only “MY” call sign when the DR function
is ON.

<To manually set the Duplex (repeater) operation>

Example: Making a gateway CQ call to Hamacho
repeater (JP1YIU A) from the Hirano
repeater (JP3YHH A), in the DV mode.

® Before starting to set the call sign, set the
frequency of your access repeater and duplex
direction on the standby screen. (Section 4)

TIP: When the DR function is ON, the repeater call

sign is automatically set. (p. 9-49)

Step 1. Setting the call sign “R1”

1. Rotate [DIAL] to select “R1.”

2. Push [QUICK]

3. Select “Edit,” then push [J].

4. Rotate [DIAL] to enter the first character.
® Selectable characters are Alphanumeric characters

and symbol (/")

5. Push [MW] to move the cursor forwards, or push
[MODE] to move the cursor backwards.

6. Repeat steps 4 and 5 to enter the repeater call
sign of up to 8 characters, including a space.

(Example: JP3YHH A)
7. After entering, push [J].
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Step 2. Gateway “R2” setting

1. Select “R2,” then push [J].
® To manually enter the call sign, push [QUICK], then
select “Edit.”
2. Select “GW,” then push [J].

About the RPT2 SELECT screen

NOT USED* |For local area call

To select the gateway call sign from
GW ;

the repeater list.
Repeater To select the repeater that has the
name same gateway as the “R1” repeater.

Step 3. Destination “UR” setting

1. Select “UR,” then push [J].
® To manually enter the call sign, push [QUICK], then
select “Edit.”
2. Select “Gateway CQ,” then push [J].
3. Select repeater group where your destination
repeater is listed, then push [J].
(Example: 11:Japan)
4. Select the repeater, then push [J].
(Example: Hamacho)

About the YOUR SELECT screen

cacaca To se_lect CQC_QCQ to make a non-
call sign specific call.
. | To select “Gateway CQ” to make a
Gateway CQ call using the repeater list.
Your Call Sian To select the destination “UR” call sign
9 using the Your Call Sign memory.

. To select the destination “UR” call sign
RX History using the RX History.

; To select the destination “UR” call sign
TX History using the TX History.

*Not displayed in the Simplex mode.
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RX History

RX History

When a call is received in the DV mode, the call

information such as the caller station’s call sign, the

repeater’s call sign, and so on, are saved on this

screen. Up to 50 records can be saved.

® Even if the transceiver is OFF, the saved records
are not deleted.

TIP: To display the RX record contents
On the RX HISTORY screen, rotate [DIAL] to display
the RX record contents (RX01 ~ RX50).

Contents of the RX History Top screen

Contents of the detail screen

The contents of the detail screen differ, whether the

position data is included in the received data or not.

The position data that is included in the received data

can be divided into five categories. Depending on the

caller’s TX mode or TX format, the displayed items

and these meanings differ.

The following lists show the items for each category.

® No data is displayed when no position data is
received.

TIP: On the RX HISTORY screen, push [J] to
display the detail screen.

RX01 ~ RX50 |[RX history number Common items
CALLER*" Displays the caller station’s name*2. CALLER*" Displays the caller station’s name*2.
CALLED* Displays the called station’s name*2. CALLED*" Displays the called station’s name*2.
MESSAGE Displays any message included in Displays the name of the repeater
the received call, if entered. that was accessed by the caller
RX TIME Displays the date and time the call station.
was received. RXRPT1*".*3  |If it was a call through a gateway
W) Displays when a call is received and the internet, this item displays
cw) through the internet. the gateway repeater name of your
Displays when position data is local area repeater.
GPS included. (NMEA or Mobile/Base «1 »3 |Displays the name of the repeater
X RXRPT2*: .
station) you received the call from.
Displays when the Object’s data is Displays any message included in
included. RX MESSAGE the received call, if entered.
Displays when the Item’s data is Displays the date and time the call
LLEM included. RX TIME was received.
cI?lipllay_s \Allhgndthe weather station’s
aals holded. <1. When the caller’s TX mode is NMEA>
Displays when an uplink signal is : TR
(UP) : 4 Displays the caller’s direction from
received. Compass o
your position
Latitude Displays the caller’s latitude
Longitude Displays the caller’s longitude
GL Displays the grid locator based on
the caller’s latitude and longitude
ALT Displays the caller’s altitude
DIST* Dlsplays.t.he caller’s distance from
your position
COURSE Displays the caller’s direction over
ground
SPEED Displays the caller’s speed
*1 These items can be changed to the call sign display. In GPS Time Displays the time that the caller
that case, the call sign and a note that is entered after the Stamp acquired the position data.
call sign are displayed. Call sign Displays the caller’s call sign

*2 |f the name is not entered, the call sign and a note that is
entered after the call sign are displayed.

*3“FREQUENCY” is displayed instead of these items when
the call was not through a repeater (Simplex call), to show
the frequency that was used.

*4 |f you have no position data, these items are not
displayed.
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Displays the GPS message included

GPS MESSAGE |in the position data of the received

call.
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<2. When the caller’s TX format is D-PRS Position <4. When the caller’s TX format is D-PRS Object/

(Mobile station)> Item>
. Displays the caller’s direction from . Displays the Object/Item’s direction

Compass - Compass "

your position from your position
Latitude Displays the caller’s latitude Latitude Displays the Object/ltem’s latitude
Longitude Displays the caller’s longitude Longitude Displays the Object/Item’s longitude
GL Displays the grid locator based on Displays the grid locator based

the caller’s latitude and longitude GL on the Object/Item’s latitude and
ALT Displays the caller’s altitude longitude : :

. Displays the caller’s distance from ALT Displays the Object/Item’s altitude

DIST it Displays the Object/ltem’s dist
your position DIST* isplays the Object/ltem’s distance
COURSE Displays the caller’s direction over from your position
ground COURSE Displays the Object/Item’s direction
SPEED Displays the caller’s speed over ground :
GPS Time Displays the time that the caller SPEED Displays the Object/ltem’s speed
Stamp acquired the position data. POWER Displays the Object/ltem’s TX power
. Displays the caller’s call sign (with level
Call sign ssID) HEIGHT Displays the height of Object/ltem’s
- ; tenna
Symbol Displays the caller's D-PRS symbol an , : ,
Displays the GPS message included GAIN Dljplays the gain of Object/ltem’s
GPS MESSAGE|in the position data of the received antenna —
call DIRECT Displays the direction that the
- Object/ltem’s antenna was pointing
GPS Time Displays the time that the caller sent
<3. When the caller’s TX format is D-PRS Position Stamp the Obiject’s data.
(Base station)> Call sian Displays the caller’s call sign (with
Compass* Displays the caller’s direction from 9 SSID)

P your position Svmbol Displays the Object/ltem’s D-PRS
Latitude Displays the caller’s latitude y S\(mb0| :
Longitude Displays the caller’s longitude Status Displays "KILLED" when the object
GL Displays the grid locator based on or Item station is disabled. _

the caller’s latitude and longitude GPS MESSAG Displays the GPS me];ssage included
ALT Displays the caller's altitude PS MESSAGE|in ;tlhe position data of the received
" Displays the caller’s distance from cal.
DIST .
your position
POWER Displays the caller’s TX power level *If you have no position data, these items are not displayed.
HEIGHT Displays the height of caller’s
antenna
GAIN Displays the gain of caller’s antenna
DIRECT Dlspla}ys the direction th'at'the
caller’s antenna was pointing
GPS Time Displays the time that the caller
Stamp acquired the position data.
. Displays the caller’s call sign (with
Call sign ssID)
Symbol Displays the caller’s D-PRS symbol
Shows the GPS message included
GPS MESSAGE |in the position data of the received
call.
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<5. When the caller’s TX format is D-PRS Weather>

" Displays the caller’s direction from
Compass -
your position
Latitude Displays the caller’s latitude
Longitude Displays the caller’s longitude
GL Displays the grid locator based on
the caller’s latitude and longitude
DIST* Dlsplayslt.he caller’s distance from
your position
TEMP Displays the temperature of the caller’s
area
RAIN Displays the rainfall of the caller’s
area
WIND DIR Dlspl,ays the wind direction of the
caller’s area
WIND SPD Dlsplfays the wind speed of the
caller’s area
BARO Displays ’the barometric pressure of
the caller’s area
HUMI Displays the humidity of the caller’s
area
Symbol Displays the caller’s D-PRS symbol
GPS Time Displays the time that the caller
Stamp acquired the position data.
Shows the D-PRS comment
GPS MESSAGE |included in the position data of the
received call.
. Displays the caller’s call sign (with
Call sign SSID)

*If you have no position data, these items are not displayed.

9-44



Previous view

9  MENU SCREEN

DV Memory items

Your Call Sign

DV Memory > Your Call Sign

The transceiver has a total of 300 memories to save

an individual station call sign.

The saved call sign and name are displayed on the

YOUR CALL SIGN or RX HISTORY screen.

® You can enter the Your (UR) Call Sign into the
Memory using the RX History. (p. 4-10)

® To add, edit or move the Your Call Sign in the
memory, see pages 4-43 ~ 4-45 for details.

Repeater List

DV Memory > Repeater List

You can save repeater information for quick and
simple communication when using repeaters.

The transceiver has a total of 1500 repeater memory
channels, storable in 50 groups (01 to 50).

NOTE: For easy operation, a repeater list is
preloaded into your transceiver. However, if the
CPU clears all entered contents (All Reset), the
repeater list is also cleared. We recommend that
memory data be backed up using a microSD card,
or be saved to a PC using the CS-4100 CLONING
SOFTWARE.

TIP: About the repeater list

The repeater list can be downloaded from the Icom
website.
http://www.icom.co.jp/world/support/download/firm/
index.html

Repeater Group (01 ~ 50)

Repeater group name of up to 16
alphanumeric characters

Group name

You can set the Skip setting. (p. 4-40)
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Repeater List
<DV Repeater>

TYPE

DV Repeater

Repeater name of up to 16

NAME .
alphanumeric characters
SUB NAME Repeater su_b name of up to 8
alphanumeric characters
CALL SIGN Repeater call sign
GW CALL SIGN [Gateway call sign
GROUP Repegter group where the repeater
is assigned
Select whether or not to use the
USE(FROM) repeater as an access repeater
(FROM) in the DR screen
FREQUENCY Operating frequency of the access
repeater
DUP Duplex setting to use the access
repeater
OFFSET FREQ Frequency offset to use the access
repeater
Position data accuracy level
POSITION (“None,” “Approximate” or “Exact”)
LATITUDE* Latitude position of the repeater
LONGITUDE* |Longitude position of the repeater
Time difference between UTC
UTC OFFSET  |(Universal Time Coordinated) and

the local time

NOTE: When the repeater is used for a simplex
communication, refer to the list below to set the

settings.
<DV Simplex>
TYPE DV Simplex
NAME Enter the name of up to 16
alphanumeric characters
SUB NAME Enter the su_b name of up to 8
alphanumeric characters
GROUP Set the repeater group
Select whether or not to set in the
USE(FROM) “FROM?’ field on the DR screen
FREQUENCY |Frequency to operate simplex
Position data accuracy level
POSITION (“None,” “Approximate,” or “Exact”)
LATITUDE* Latitude position of the access point
LONGITUDE* Iggir:gnude position of the access
Time difference between UTC
UTC OFFSET  |(Universal Time Coordinated) and

the local time

* Displayed when “POSITION” is set to “Approximate” or

“Exact.”
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<FM Repeater> <FM Simplex>
TYPE FM repeater .
NAME FM repeater name of up to 16 TYPE FM Simplex
alphanumeric characters NAME Enter the name of up to 16
SUB NAME FM repeater sub name of up to 8 alphanumeric characters
alphanumeric characters Enter the sub name of up to 8
CALL SIGN FM repeater call sign SUB NAME alphanumeric characters
GROUP il:;eapsz?;i;grou‘) where the repeater GROUP Set the repeater group
Select whether or not to use the USE(FROM) ?Fell?e(gzkﬂwgz’fgegnotrhréoltjg :s:elgr;[he
USE(FROM) l(:FMRE)eI\SI?e:)tr?rt:es ggi%?:: repeater FREQUENCY |Frequency to operate simplex
Operating frequency of the FM MODE Receiving mode for simplex FM
FREQUENCY repeater TONE Tone function setting for simplex
- FM
Dupl tting t the FM
DUP re%%::(e?e Ing fo use the REPEATER FM simplex tone frequency (Tone
Frequency offset to use the FM TONE Encoder) setting of the access
OFFSET FREQ repeater
repeater P P ition dat level
MODE Receiving mode of the FM repeater POSITION (“Esolr:zr}’ “z:p?g;l:r::fey,, (?IY?Exact”)
Tone functi tti f the FM ;
TONE r:;:atlérsc lon setting ot the LATITUDE* Latitude position of the station
FM repeater tone frequency (Tone LONGITUDE* Lpngitgde position of the station
REPEATER Encoder) setting of the access Time difference between UTC
TONE repeater. UTC OFFSET  |(Universal Time Coordinated) and
POSITION Position data accuracy level the local time
(“None,” “Approximate” or “Exact”)
LATITUDE* Latitude position of the FM repeater * Displayed when “POSITION" is set to “Approximate” or
i iti “Exact.”
LONGITUDE* Longitude position of the FM
repeater
Time difference between UTC
UTC OFFSET |(Universal Time Coordinated) and
the local time

9-46




Previous view

9  MENU SCREEN

My Station items

My Call Sign
My Station > My Call Sign

The transceiver has a total of 6 memories to save

your own call signs.

You can enter a call sign of up to 8 digits. Also, a note

of up to 4 characters, for operating radio type, area,

and so on, can be entered.

® See the D-STAR guide for MY call sign entry.

® To select other My Call Sign, rotate [DIAL] to select,
then push [J] on the MY CALL SIGN screen.

TX Message

My Station > TX Message

The transceiver has a total of 5 memories to save

short messages for simultaneous transmission in the

DV mode.

Enter a message of up to 20 alphanumeric characters

for each memory.

® See page 4-17 for TX message entry.

® To select other TX message, rotate [DIAL] to select,
then push [J] on the TX MESSAGE screen.

|TIP: To transmit no message, select “OFF.”
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RX Bass (Default: Normal)

Auto Reply (Default: OFF)

DV Set > Tone Control > RX Bass

Set the received audio bass filter level to Cut, Normal
or Boost.

* Cut; Reduces the low frequencies

* Normal: Normal tone balance

* Boost: Increases the low frequencies

RX Treble (Default: Normal)

DV Set > Tone Control > RX Treble

Set the received audio treble filter level to Cut, Normal
or Boost.

* Cut: Reduces the high frequencies

* Normal: Normal tone balance

* Boost: Increases the high frequencies

RX Bass Boost (Default: OFF)

DV Set > Tone Control > RX Bass Boost

Turn the received audio Bass Boost function ON or
OFF.

This function is separate from the “Boost” setting of
the RX Bass.

* OFF: Turns OFF the function.

* ON: This function boosts the received audio bass.

TX Bass
DV Set > Tone Control > TX Bass

(Default: Normal)

Set the transmit audio bass filter level to Cut, Normal
or Boost.

* Cut; Reduces the low frequencies

» Normal: Normal tone balance

* Boost: Increases the low frequencies

TX Treble
DV Set > Tone Control > TX Treble

Set the transmit audio treble filter level to Cut, Normal
or Boost.

* Cut: Reduces the high frequencies

* Normal: Normal tone balance

* Boost: Increases the high frequencies

(Default: Normal)
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DV Set > Auto Reply

Set the Automatic Reply function to ON, OFF, Voice,
Position. This function automatically replies to a call
addressed to your own call sign, even if you are away
from the transceiver.

* OFF: Turns OFF the function.

* ON: Replies with your own call sign. (No audio
reply is sent)

Replies with your call sign and any Auto
Reply message recorded on the SD (up to
10 seconds).

If no microSD card is inserted, or no
message is recorded, only your call sign is
transmitted. The transmitted audio can be
monitored.

Replies with your own call sign and
transmits your position data using the
internal or external GPS receiver.

« \oice:

* Position*:

*When “GPS Select” is set to “OFF” or “Manual,” the internal
GPS receiver is temporarily turned ON.

When “GPS Select” is set to “External GPS,” but if the
external GPS receiver is not connected, the internal GPS
receiver is temporarily turned ON.

® When “ON” or “Voice” is selected, the Automatic
reply function is automatically turned OFF when
you push [PTT].
When “Position” is selected, the Automatic reply
function is not turned OFF, even if you push [PTT].

DV Data TX (Default: Auto)

DV Set > DV Data TX

Select whether to manually or automatically transmit

data in the DV mode.

* PTT: Push [PTT] to manually transmit data.

* Auto: When data is input from a PC through the
[DATA] jack, the transceiver automatically
transmits it.
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DV Set items (Continued)

Fast Data (Default: OFF)

DV Set > DV Fast Data > Fast Data

Select whether or not to use the DV Fast Data function

for data communication in the DV mode.

The DV Fast Data function uses the data and the

audio frames to send data approximately 3.5 times

faster than the normal speed. So, no audio can be

sent.

* OFF: Sends data at the slow speed (approximately
950 bps).

* ON: Sends data at the fast speed (approximately
3480 bps).

® Even if “ON” is selected, while holding down [PTT],
the data is sent at the slow speed, because the
audio frame is used for the microphone audio
transmission and the audio transmission has
priority.
The GPS data speed is set in “GPS Data Speed.”

GPS Data Speed (Default: Slow)

DV Set > DV Fast Data > GPS Data Speed

Set the GPS data speed when the data is sent using
the DV Fast Data function.
® When you send the GPS data to other transceivers
that can receive only slow speed data, set to
“Slow.”
» Slow: Sends GPS data in the slow speed
(approximately 950 bps).
» Fast: Sends GPS data in the fast speed
(approximately 3480 bps).

TX Delay (PTT) (Default: 2sec)
DV Set > DV Fast Data > TX Delay (PTT)
Set the TX delay time.

In the data communication mode and after releasing
[PTT], the transceiver automatically sends the data
using the DV Fast Data function for this set period.

* OFF: After releasing [PTT], the transceiver
returns to receive.
* 1 ~ 10sec: After releasing [PTT], the transceiver

sends data by using the DV Fast Data
function for this set period.

The transceiver automatically returns to
receive when the TX data is completely
sent, or when this set period ends,
whichever is sooner.

NOTE: This function is usable only when “DV Data
TX" is set to “PTT.”
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Digital Monitor
DV Set > Digital Monitor

Select a receive mode when [MONI] is pushed in the
DV mode.
* Auto:

(Default: Auto)

Receives in the DV mode or the FM mode,
depending on the received signal.

« Digital: Receives in the DV mode.

* Analog: Receives in the FM mode.

Digital Repeater Set
DV Set > Digital Repeater Set

Turn the Digital Repeater Setting function ON or OFF.
In any DV mode except when using the DR function,
and when accessing a repeater that has a call sign
that is different than the transceiver’s setting, this
function reads the repeater’s signal and automatically
sets the repeater call sign in R1 and R2.

* OFF: Turns OFF the function.

* ON: Automatically sets the repeater call sign.

(Default: ON)

DV Auto Detect
DV Set > DV Auto Detect

(Default: OFF)

Turn the DV mode automatic detect function ON or
OFF. If you receive an FM signal in the DV mode, this
function temporarily switches to the FM mode.

* OFF: Turns OFF the function. The operating mode
is fixed to the DV mode.

Automatically selects the FM mode for
temporary operation.

* ON:

RX Record (RPT)
DV Set > RX Record (RPT)

The transceiver can record the data of up to 50
individual calls. When the received signal includes a
status message (“UR?” or “RPT?”) that is sent back
from the access repeater, you can record up to 50
messages, or only the last call, in the Received Call
Record.

* ALL: Records up to 50 calls.

» Latest Only: Records only the last call.

(Default: ALL)
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DV Set items (Continued)

BK (Default: OFF)
DV Set > BK

The Break-in (BK) function enables you to break
into a conversation, where the two other stations are
communicating with call sign squelch enabled.

* OFF: Turns OFF the function.

* ON: Turns ON the function.

® The BK function is automatically turned OFF when
transceiver is turned OFF.

EMR (Default: OFF)
DV Set > EMR

The Enhanced Monitor Request (EMR) function
enables all transceivers that receive an EMR signal
automatically open their squelch to receive the signal.
* OFF: Turns OFF the function.

* ON: Turns ON the function.

® The EMR function is automatically turned OFF
when transceiver is turned OFF.

EMR AF Level (Default: 19)
DV Set > EMR AF Level

Set the audio output level to between 0 and 32 for
when an EMR communication signal is received.
When an EMR signal is received, the audio will be
heard at the set level, or the [VOL] control level,
whichever is higher.

To disable the setting, set to “0.”

NOTE: After an EMR signal disappears, the audio
level will remain at the EMR level. In this case, rotate
[VOL] to adjust the audio level.
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SPEECH items

RX Call Sign SPEECH  (Default: ON (Kerchunk))

DIAL SPEECH (Default: OFF)

SPEECH > RX Call Sign SPEECH

Turn the RX call sign speech function ON or OFF for
calls received in the DV mode.

* OFF: The caller station’s call sign is not
announced, even when a call is
received.

The caller station’s call sign is
announced only when they make a
short transmission.

The caller station’s call sign is
always announced.

* ON (Kerchunk):

« ON (All):

® Information

* When the digital squelch function is used, the calling
station’s call sign is not announced if the received
signal is not addressed to your call sign, or does not
include a matched digital code.

* When you receive a signal from a repeater (“UR?”
or “RPT?”), the caller station’s call sign is not
announced.

» While scanning, the transceiver resumes the scan
during an announcement.

* Even if a note is entered after the call sign, it is not
announced.

* When you receive a signal during an announcement,
the transceiver cancels announcement, and you can
hear the received audio.

RX>CS SPEECH (Default: ON)

SPEECH > RX>CS SPEECH

Turn the RX>CS Speech function ON or OFF.

The RX>CS Speech function announces the station
call sign that is selected from a Received Call Record
by pushing [RX—CS].

* OFF: The station call sign is not announced.

* ON: The station call sign is announced.

® If a call is received during an announcement, the
received audio is muted, and audio is not recorded
onto the microSD card.
If the call sign is announced while recording,
the recorded contents are silent during the
announcement.
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SPEECH > DIAL SPEECH

Turn the Dial Speech function ON or OFF.

The Dial Speech function announces the frequency or
repeater call sign that is selected by rotating [DIAL].

* OFF: The frequency or repeater call sign is not
announced.

The frequency or repeater call sign is
announced, 1 second after rotating [DIAL].

In the VFO, Memory, or Call channel mode,
the frequency is announced.

When using the DR function, the repeater call
sign is announced.

* ON:

® When using the DR function, the frequency is
announced if Simplex is selected or the FM
repeater does not have a call sign.

® When you receive a signal during an
announcement, the transceiver cancels
announcement, and you can hear the received
audio.

MODE SPEECH
SPEECH > MODE SPEECH

Turn the Operating Mode Speech function ON or OFF.

When this function is ON, the selected operating

mode is announced.

* OFF: The selected operating mode is not
announced.

* ON: The selected operating mode is announced.

(Default: ON)

® While the VFO scanning, the operating mode is
announced when you change the mode.

SPEECH Language

SPEECH > SPEECH Language

Set the speech language to English or Japanese.

(Default: English)

Alphabet
SPEECH > Alphabet

Select either “Normal” or “Phonetic Code” to
announce the alphabet characters.
* Normal: Normal code is used.
(Example: A as eh, B as bee)
» Phonetic Code: Phonetic code is used.
(Example: A as Alfa, B as Bravo)

(Default: Normal)
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SPEECH items (Continued)

SPEECH Speed (Default: Fast)
SPEECH > SPEECH Speed

Set the speech speed to Slow or Fast.

SPEECH Level (Default: 7)
SPEECH > SPEECH Level

Adjust the voice synthesizer volume level to between
0 (OFF), 1 (minimum) and 9 (maximum).

The voice synthesizer audio output level is linked with
the [VOL] setting from the minimum audio volume up
to the set level.
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DTMF items

You can set the DTMF tone code and DTMF memory
channel for DTMF tone operation.
See pages 10-8 ~ 10-10 for details.

DTMF Memory (Default: d0)

DTMF > DTMF Memory

Shows a list of the DTMF memory channels.
+» d0 to d#: DTMF memory channel list

DTMF Speed (Default: 100ms)
DTMF > DTMF Speed

Select the DTMF transmit speed.

* 100ms: Transmits the DTMF codes at about 100
milliseconds per code.
5 characters per second.

* 200ms: Transmits the DTMF codes at about 200
milliseconds per code.
2.5 characters per second.

* 300ms: Transmits the DTMF codes at about 300
milliseconds per code.
1.6 characters per second.

* 500ms: Transmits the DTMF codes at about 500
milliseconds per code.
1 character per second.
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QSO/RX Log items

QSO Log

(Default: OFF)

Separator/Decimal (Default: Sep [,] Dec [.]¥)

QSO/RX Log > QSO Log

Select whether or not to make a communication log

on a microSD card.

The communication log is made on a microSD card,

and saved in the “csv” format.

® This function requires a microSD card (User
supplied).

* OFF: The QSO Log function is OFF.

* ON: The transceiver makes a log on the microSD
card.
The transceiver starts making a log when you
begin talking.

TIP:

* The folder name is automatically created, as
[ID-4100\QsoLog].

* The file name is automatically created, as shown
below:
Log start date and time: 1st April 2017 15:30:00
File name: 20170401_153000.csv

» The log contents is not displayed on the
transceiver.

* You can display the log contents on a PC.

RX History Log

(Default: OFF)

QSO/RX Log > RX History Log

Select whether or not to make a DV mode’s receive

history log on a microSD card.

The receive history log is made on a microSD card,

and saved in the “csv” format.

® This function requires a microSD card (User
supplied).

* OFF: The RX History Log function is OFF.

* ON: The transceiver makes a DV mode’s receive
history log on the microSD card.
The transceiver starts making a receive
history log when you finish talking.

TIP:

* The folder name is automatically created, as
[ID-4100\RxLog].

* The file name is automatically created, as shown in
the example below:
Log start date and time: 1st April 2017 15:30:00
File name: 20170401_153000.csv

» The log contents is not displayed on the
transceiver.

* You can display the log contents on a PC.
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QSO/RX Log > CSV Format > Separator/Decimal

Select the separator and the decimal character for the
CSV format.
» Sep [,] Dec [.]: Separator is “,” and Decimal is “.”

» Sep [;] Dec [.]: Separator is

and Decimal is “.
* Sep [;] Dec [,]: Separator is “;” and Decimal is “,”
*The default value may differ, depending on the transceiver

version.

Date (Default: mm/dd/yyyy*)
QSO/RX Log > CSV Format > Date

Select the date format between “yyyy/mm/dd,” “mm/
dd/yyyy” and “dd/mm/yyyy.” (y: year, m: month, d: day)
*The default value may differ, depending on the transceiver
version.
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QSO/RX Log items (Continued)

The call log contents are shown below:

Contents Example Descriptions
TX/RX X RX Transmission and reception
Date 4/1/2017 4/1/2017 Date and time the call was started.
13:51:48 13:51:48
Frequency 438.010000 [438.010000 | Operating frequencies
(When Duplex is set, the RX frequency is displayed.)
Mode DV DV Operating mode (AM/AM-N/FM/FM-N/DV)
My Latitude 34.764667 |34.764667 |Your latitude (unit: degree) (+: North latitude, —: South latitude)
My Longitude |135.375333 |135.375333 | Your longitude (unit: degree) (+: East longitude, —: West longitude)
My Altitude 50.5 50.5 Your altitude (unit: m) Records to one decimal place.
RF Power Low (Blank) TX output power level
S-meter (Blank) SO The relative signal strength of the receive signal (in twelve levels)
RPT Call Sign |JP3YHJA |JP3YHJA |Repeater call sign (DV mode only)
TX Call Sign  |CQCQCQ |[(Blank) TX Call sign (DV mode only)
RX Call Sign | (Blank) JA3YUAA/ |RX Call sign (DV mode only)
4100
RX Latitude (Blank) 34.764667 |Caller’s latitude, if sent. (unit: degree)
(+: North latitude, —: South latitude)
Records only when you receive in the DV mode.
RX Longitude |(Blank) 135.375333 | Caller’s longitude, if sent. (unit: degree)
(+: East longitude, —: West longitude)
Records only when you receive in the DV mode.
RX Altitude (Blank) 30.5 Caller’s altitude, if sent. (unit: m)
Records only when you receive in the DV mode.
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QSO/RX Log items (Continued)

The RX log contents are shown below:

Contents Example Descriptions
Frequency 438.010000 RX Frequency
Mode DV Operating mode (DV mode is fixed)
Caller JASYUAA Call sign of the caller station (up to 8 characters)
/ 4100 Note after the call sign (up to 4 characters)
Called cQcaQcQ Call sign of the called station
Rx RPT1 JP3YHH G Access repeater call sign of the caller station or the gateway repeater call sign
of your local area repeater.
Rx RPT2 JP3YHJ A Access repeater call sign of the called station
Message Hello CQ D-STAR! | Message included in the received call (up to 20 characters)
Status (Blank) Normal: blank, Uplink: “RPT UP”, Access repeater reply: “UR?” or “RPT?”
Received date | 4/1/2017 Date and time the call was received
13:51:48 Depending on the setting, the format may differ.
BK * BK call: “*”, Normal call: Blank
EMR * EMR call: “*”, Normal call: Blank
Latitude 34.764667 Caller’s latitude, if sent. (unit: degree) (+: North latitude, —: South latitude)
Longitude 135.375333 Caller’s longitude, if sent. (unit: degree) (+: East longitude, — West longitude)
Altitude 30.5 Caller’s altitude, if sent. (unit: m) Records to one decimal place.
SSID -A Caller’s SSID, if sent. (0, -1 to -15, -Ato -Z)
D-PRS Symbol |Car Icon: Converts to text, None: Code
Course 123 Caller’s course (unit: degree)
Speed 23.5 Caller’s speed (unit: km/h) Records to one decimal place.
Power 49 TX power (unit: W)
Height 24 Antenna height (unit: m)
Gain 6 Antenna gain (unit: dB)
Directivity Omni Antenna directivity
(Omni, 45, 90, 135, 180, 225, 270, 315 or 360)
Object/Item HAM FES Object name or Iltem name (up to 9 characters)
Name
Data Type Live Object Data type of Object or Item (Live or Kill)
Temperature 20.5 Temperature (unit: ‘C) Records to two decimal places.
Rainfall 253.75 Rainfall (unit: mm) Records to two decimal places.
Rainfall (24 253.75 Rainfall (24 Hours) (unit: mm) Records to two decimal places.
Hours)
Rainfall 253.75 Rainfall (Midnight) (unit: mm) Records to two decimal places.
(Midnight)
Wind Direction |315 Wind Direction (unit: degree)
Wind Speed 10.0 Wind Speed (unit: m/s) Records to one decimal place.
Gust Speed 10.0 Gust Speed (unit: m/s) Records to one decimal place.
Barometric 1013.0 Barometric (unit: hPa) Records to one decimal place.
Humidity 85 Humidity (unit: %)
GPS Time Stamp | 12:00:00 Time data that the caller station acquires the position data
GPS Message |Osaka City/ Caller is “NMEA”: Records the GPS message
ID-4100 Caller is “D-PRS: Records the D-PRS comment

9-56




Previous view

9

MENU SCREEN

Squelch/ATT Select (Default: S-Meter Squelch)

Auto Repeater (Default: ON (DUP))

Function > Squelch/ATT Select

Select the function that varies according to the [SQL]
control position.
* OFF: Both the S-Meter Squelch and
Attenuator are disabled.

The S-Meter Squelch activates
and adjusts the squelch level
when [SQL] is set between 12
o’clock and the fully clockwise
position.

The Attenuator is enabled and
adjusts the attenuator level when
[SQL] is set between 12 o’clock
and the fully clockwise position.

» S-Meter Squelch:

*ATT:

Squelch Delay (Default: Short)

Function > Squelch Delay

Set the squelch delay to short or long to prevent
repeated opening and closing of the squelch when
receiving the same signal.

* Short: Shortens the time until the squelch opens.
* Long: Lengthens the time until the squelch opens.

Fan Control (Default: Auto)

Function > Fan Control

Select the cooling fan control between Slow, Mid, Fast
and Auto.
* Slow: The fan rotates slow.

* Mid: The fan rotates at mid speed.

* Fast: The fan rotates fast.

* Auto: The fan automatically turns ON during
transmission or when the internal temperature
of the transceiver exceeds the preset value. It
remains ON until the temperature drops below
the value.

Dial Speed-UP (Default: ON)

Function > Dial Speed-UP

Turn the dial speed acceleration ON or OFF.

The acceleration automatically speeds up the tuning
dial speed when you rapidly rotate [DIAL].

* OFF: Turns OFF the function.

* ON: Turns ON the function.
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Function > Auto Repeater

The Auto repeater function automatically turns the

duplex operation and tone encoder* ON or OFF. The

offset and repeater tone* are not changed by the

auto repeater function. Reset these setting values, if

necessary.

® This item is displayed only in the USA version
transceiver.

* OFF:

* ON (DUP):

Turns OFF the function.

Turns ON the duplex operation

only. (Default)

* ON (DUP, TONE): Turns ON the duplex operation
and tone encoder®.

* The tone encoder will not be turned ON in the DV mode.

Remote MIC Key

Function > Remote MIC Key

The function assignments for [F-1] and [F-2] keys on
the supplied HM-207S HAND MICROPHONE (REMOTE-
CONTROL) can be changed.

See pages 9-58 ~ 9-59 for the assignable key
functions.

» During RX/Standby: The assigned key function is
enabled while receiving or in
standby.

The assigned key function is
enabled during transmission.

* During TX:

Up/Down MIC Key

Function > Up/Down MIC Key

The function assignments for the [UP] and [DN] keys
on the optional HM-154 HAND MICROPHONE or HM-232
HAND MICROPHONE (SIMPLE) can be changed.

See pages 9-58 ~ 9-59 for the assignable key
functions.

* During RX/Standby: The assigned key function is
enabled while receiving or in
standby.

The assigned key function is
enabled during transmission.

* During TX:
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Function items (Continued)

* During RX/Standby:
@®: Default setting O: Available N/A: Not available

Up/Down MIC
Function Description Emel2 1S 6y Key
[F-1] [F-2] [UP] [DN]

- No function O O O O
UP Push t_o increase the frequency, Memory channel, repeater N/A N/A ° o

or station call sign.
DOWN Push t_o decrea_se the frequency, Memory channel, repeater N/A N/A o °

or station call sign.
VOL UP Push to increase the volume level. N/A N/A O O
VOL DOWN |Push to decrease the volume level. N/A N/A O O
SQL UP Push to increase the squelch level. N/A N/A O O
SQL DOWN | Push to decrease the squelch level. N/A N/A O O
Monitor Push to open or close the squelch. O o O O
CALL Push to select a call channel. N/A N/A O O
MR (000 CH)|In the Memory mode, push to select Memory channel 000. O O O O
MR (001 CH)| In the Memory mode, push to select Memory channel 001. O O O O
VFO/MR Z%Zr;to select between the VFO mode and the Memory N/A N/A o o
DR Push to turn the DR function ON or OFF. O O O O
FROM/TO On the DR screen, push to select between “FROM” and

W O O O O
(DR) TO.

Push to directly select the Home CH that is set to the

selected mode (VFO/Memory) or DR screen.
Home CH While in the CALL CH or Weather channel mode, or when N/A N/A © ©

no Home CH is set, an error beep sounds.

Push to select an operating band.

In the VFO mode, push to change the operating band, and
BAND/BANK |in the Memory Bank mode, push to select Bank A~ Z, or N/A N/A O O

OFF.

® Only the entered bank is selectable.

* Push to start a scan.
SCAN » While scanning, push to stop the scan. © © © ©
Termpora Push to set the frequency to be skipped during scanning.
SKi POray | The selected frequencies are temporarily skipped for faster O O O O

P scanning.

RX>CS Hold do“wn Ior 1 s_eco_nd to set the last calling station’s call o o o o

sign to “TO” (destination).

Push to announce the frequency, operating mode or call

sign.
SPEECH ® In the VFO, Memory or Call channel mode, the frequency and o) o o) o

the operating mode are announced.
@ In the DR screen, the call sign is announced. If Simplex is
selected, the frequency is announced.

MODE Push to change the operating mode. o O O O
LOW Push to change the transmit power level. O O O O

Push to turn the Duplex mode ON or OFF, and the shift
bUP direction to DUP+ or DUP-. © © © o
PRIO Push to turn the Priority watch ON or OFF. O O O O
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= Continued on the next page
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* During RX/Standby (Continued):
@®: Default setting O: Available N/A: Not available

Remote MIC Key UplD;\év: e

[F-1] [F-2] [UP] [DN]

Function Description

Push to select between tone types.

<<MODE>> FM/FM-N

TONE: Repeater Tone

TSQL ((»): Pocket Beep with Tone Squelch

TSQL: (Tone Squelch)

DTCS ((+) : Pocket Beep with DTCS Code Squelch

DTCS: DTCS Code Squelch

TSQL-R: Reverse Tone Squelch

DTCS-R: Reverse DTCS Code Squelch

DTCS (T) (“DTCS” blinks):
TX:DTCS, RX:OFF

TONE (T)/DTCS (R) (“T-DTCS” is displayed, “T” blinks.):
TX:TONE, RX:DTCS

DTCS (T)/TSQL (R) (“D-TSQL" is displayed, “D” blinks.):
TX:DTCS, RX:CTCSS

TONE (T)/TSQL (R) (“T-TSQL" is displayed, “T” blinks.):
TX:TONE, RX:CTCSS

TONE/DSQL

<<MODE>> DV

® You can set this setting on the DR screen.

DSQL ((+)) : Pocket Beep with Digital Call sign Squelch

DSAQL: Digital Call sign Squelch

CSQL (t+)) : Pocket Beep with Digital Code Squelch

CSQL: Digital Code Squelch

MW In the VFO mode or on the DR screen, hold down to save
the displayed frequency into a Memory blank channel.

MUTE Push to turn the Mute function ON or OFF. )] @) O O

* Push to transmit the voice audio recorded on the microSD

card once.

Voice TX * Hold down for 1 second to repeatedly transmit the voice

(T1) audio. O O O O
® This key function can also be used on the DR screen.

@ If the voice audio is not saved in the [T1] (Voice memory number

for TX) on the Voice TX record screen, this function is disabled.

O
O
O
O

DTMF
DIRECT TX N/A N/A
T-CALL Push to transmit a 1750 Hz tone. O O O O

O
O

Push to display the DTMF code direct entry mode screen.

* During TX:
@®: Default setting O: Available N/A: Not available

Remote MIC Key Up/D;wn olle
ey
[F-1] [F-2] [UP] [DN]
- No function O [ ] [ ] [ ]
LOW Push to change the transmit power level. O O O O
Push to transmit the voice audio recorded on the microSD
Voice TX card once.
(T1) Hold down for 1 second to repeatedly transmit the voice audio.
- To make a repeat transmission, [PTT] must be released.
T-CALL Push to transmit a 1750 Hz tone. [ O O O

Function Description

O O O ©)
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Function items (Continued)

One-Touch PTT (Remote MIC) (Default: OFF)

Active band (Default: All)

Function > One-Touch PTT (Remote MIC)

Set the On-Touch PTT function for the HM-207S.

The function enables you to transmit without
sequentially holding down the [PTT] button.

* OFF: Push [PTT] to transmit and release to receive.

* ON: Push [PTT] to transmit, then push again to
receive.
PTT Lock (Default: OFF)

Function > PTT Lock

Turn the PTT lock function ON or OFF.

To prevent accidental transmissions, this function
disables [PTT].

* OFF: Turns OFF the function.

* ON: Turns ON the function.

Busy Lockout (Default: OFF)

Function > Busy Lockout

Turn the busy lockout function ON or OFF.

This function inhibits transmission while receiving a
signal, or when the squelch is open.

* OFF: Turns OFF the function.

* ON: Turns ON the function.

Time-Out Timer (Default: OFF)

Function > Time-Out Timer

To prevent accidental prolonged transmission, the

transceiver has a time-out timer.

The function inhibits continuous transmissions longer

than the set period of time.

* OFF: Turns OFF the function.

* 1 to 30 min: The transmission is cut OFF after the
set period of time ends (1, 3, 5, 10, 15 or
30 minutes).
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Function > Active Band

Enables continuous frequency selection of the
operating frequency across all bands using [DIAL].

« Single: When you rotate [DIAL] on the band edge,
the top or bottom frequency in the displayed
band is selected.

When you rotate [DIAL], the next band is
displayed.

* ALL:

® To select another band when “Single” is selected,
push [QUICK], then select “Band Select.”

® This setting is for the [DIAL] operation, so all
frequencies are scanned, even if “Single” is
selected.

MIC Gain
Function > MIC Gain

(Default: 2¥)

Set the microphone gain to between 1 (minimum) and
4 (maximum), to suit your preference.

Higher values make the microphone more sensitive to
your voice.

*The default settings may differ, depending on your
transceiver version.

Data Speed

Function > Data Speed

(Default: 9600bps)

Select the data speed for outputting a GPS
information, inputting a weather information, or data
communication in the DV mode to 4800 bps or 9600
bps.

CI-V Address
Function > CI-V > CI-V Address

(Default: 9Ah)

To distinguish equipment, each CI-V transceiver has
its own Icom standard address in hexadecimal code.
The ID-4100A/E’s default address is 9Ah.

When 2 or more ID-4100A/Es are simultaneously
controlled by a PC, set a different address for each
transceiver between 02h and DFh (hexadecimal).

CI-V Baud Rate
Function > CI-V > CI-V Baud Rate

Set the CI-V data transfer speed to 4800, 9600, 19200

bps or Auto.

® When “Auto” is selected, the baud rate is automatically
set, according to the data rate of the controller.

(Default: Auto)
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Function items (Continued)

CI-V Transceive (Default: OFF)
Function > CI-V > CI-V Transceive

Turn the CI-V Transceive function ON or OFF.

* OFF: Turns OFF the function.

* ON:  When you change a setting on one
transceiver, the same settings is automatically
changed on other connected transceivers or
receivers.

CI-V Bluetooth—/REMOTE Transceive Address
(Default: 00h)

Function > CI-V >
CI-V Bluetooth—REMOTE Transceive Address

If you remotely operate your transceiver using
Bluetooth when “CI-V Transceive” is set to ON,

the devices in the same system are also externally
controlled through the external speaker (REMOTE)
jack.

To prohibit the external control of an lcom transceiver,
set this value to other than “00h.”

The control signal is output from the external speaker
(REMOTE) jack.

Select an address between 00h and DFh.

Power OFF (With No Controller) (Default: ON)
Function > Power OFF (With No Controller)

Select whether or not to automatically turn OFF the
transceiver when the controller is disconnected from
the transceiver.
* OFF: The transceiver power is not turned OFF.
To turn OFF the transceiver, turn OFF the DC
supply, or disconnect the power cable.
When you connect the controller again, the
controller may perform incorrectly. This is not
the controller’'s malfunction.
* ON: The transceiver is automatically turned OFF.
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Display items

LCD Backlight Brightness (Default: 4)

Auto Dimmer (Default: OFF)

Display > LCD Backlight Brightness
Set the LCD backlight brightness level to between 1
(Dark) and 4 (Bright).

LCD Backlight Color (Default: White)

Display > LCD Backlight Color

Set the LCD backlight color to between White, Amber,
Green, and Blue.

Key Backlight Brightness (Default: 4)

Display > Key Backlight Brightness
Selects the key backlight brightness level to between
1 (Dark) and 4 (Bright).

Key Backlight Color (Default: White)

Display > Key Backlight Color

Selects the key backlight color to between White,
Amber, Green, and Blue.

Night Time Setting (Default: OFF)

Display > Backlight Night Time Setting >
Night Time Setting

Select whether or not to reduce the backlight
brightness for the nighttime operation.

You can set the nighttime operation start or stop time
with “Night Time Start” or “Night Time End.”

* OFF: Does not reduce the backlight brightness.

* ON: Reduces the backlight brightness.

Brightness (Default: 2)

Display > Backlight Night Time Setting > Brightness

Select the backlight brightness level for the nighttime
operation between 1 (Dark) and 4 (Bright).

Night Time Start (Default: 18:00)

Display > Backlight Night Time Setting >
Night Time Start

Set the start time for the nighttime operation to
between 0:00 and 23:59.

Night Time End (Default: 6:00)

Display > Backlight Night Time Setting >
Night Time End

Set the end time for the nighttime operation to
between 0:00 and 23:59.
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Display > Auto Dimmer Setting > Auto Dimmer

This function sets the Auto Dimmer operation for the
display backlight.
* OFF: Auto Dimmer function is turned OFF.
The display backlight is turned ON continuously
while the transceiver is turned ON.
* Auto-OFF:
The display backlight is automatically turned
ON when operating the transceiver. The
backlight is automatically turned OFF after the
set time of inactivity in the Auto Dimmer Timer.
* Auto-1 to Auto-3:
The display backlight is automatically turned ON
when operating the transceiver. The backlight
automatically returns to the 1 ~ 3 set level after
the Auto Dimmer Timer set time ends.

Auto Dimmer Timer (Default: 5sec)

Display > Auto Dimmer Setting >
Auto Dimmer Timer

Set the backlight lighting period of time to between 5

and 10 seconds.

* 5sec: The Auto dimmer function automatically
activates after 5 seconds of inactivity.

* 10sec:The Auto dimmer function automatically
activates after 10 seconds of inactivity.

Auto Dimmer Cancel (PTT)

Display > Auto Dimmer Setting >
Auto Dimmer Cancel (PTT)

Select the transceiver operation when [PTT] is pushed
while the Auto Dimmer is activated.

* OFF: Pushing [PTT] transmits a signal without
turning OFF the Auto Dimmer when the Auto
Dimmer is activated.

Pushing [PTT] turns OFF the Auto Dimmer
and then transmits a signal when the Auto
Dimmer is activated.

(Default: OFF)

* ON:

Auto Dimmer Cancel (DV RX)

Display > Auto Dimmer Setting >
Auto Dimmer Cancel (DV RX)

Select the transceiver operation when receiving a DV
signal while the Auto Dimmer is activated.

* OFF: Receiving a DV signal displays the RX screen
without turning OFF the Auto Dimmer when
the Auto Dimmer is activated.

Receiving a DV signal turns OFF the Auto
Dimmer and then displays the RX screen
when the Auto Dimmer is activated.

(Default: OFF)

* ON:
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Display items (Continued)

LCD Contrast (Default: 8)

RX Position Display (Default: ON)

Display > LCD Contrast

Set the LCD contrast level to between 1 (lowest
contrast) and 16 (highest contrast).

RX Call Sign (Default: Normal)

Display > RX Call Sign

Select whether or not to display the call sign and the
message of the caller station, when a call is received.

* OFF: Does not display the caller station’s call
sign and message.

* Normal: The caller station’s call sign and message
scroll only once across the display.

* RX Hold: The caller station’s call sign and message
scroll once, and then only the call sign is
displayed until the signal disappears.

* Hold: The caller station’s call sign and message

scroll only once, and then only the call sign
is displayed until the signal disappears.
When the signal disappears, the call sign
and the message are alternately displayed,
each for 2 seconds.

® When this item is set to “Normal,” “RX Hold” or
“Hold,” and if you enter the caller station’s call sign
and name in Your Call Sign screen, the entered
name is displayed with “()” after the call sign.

RX Position Indicator (Default: ON)

Display > RX Position Indicator

Select whether or not to display “B" (RX position
indicator) when the signal received in the DV mode
contains position data.

* OFF : Displays no indicator even though the
received signal contains position data.
* ON : Displays the indicator when the received

signal contains position data.

® When the “RX Call Sign” is set to “OFF,” the
indicator is not displayed when the received signal
contains position data, even if this item is set to
ON.
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Display > RX Position Display

Select whether or not to display the caller’s position
in a dialog when the signal received in the DV mode
contains a caller station’s position.

* OFF: Does not display the caller’s position.

* ON: Displays the caller’s position.

® You can set the display period of time in the “RX
Position Display Timer” item.

RX Position Display Timer (Default: 10sec)

Display > RX Position Display Timer

Set the display period of time for the caller’s position.
» 5/10/15/30sec:Displays the caller’s position for this
set period of time.
* Hold: Displays the caller’s position until you operate
the transceiver.

Reply Position Display (Default: ON)

Display > Reply Position Display

Select whether or not to display the caller's position in
a dialog when the Auto Reply signal contains a caller
station’s position.

* OFF: Does not display the caller's position.

* ON: Displays the caller's position.

TX Call Sign
Display > TX Call Sign

Select whether or not to display your own or the
destination call sign while transmitting in the DV mode.
* OFF: Does not display any call sign.

* Your Call Sign: Displays and scrolls the destination’s
call sign. When the destination’s call
sigh and name are entered in your
memory, the transceiver displays
the name after the call sign in any
DV mode except when using the DR

(Default: Your Call Sign)

function.

* My Call Sign: Displays and scrolls your own call
sign.

Scroll Speed (Default: Fast)

Display > Scroll Speed

Set the scrolling speed of the message, call sign, or
other text, that is displayed on the screen.

* Slow: The scroll speed is slow.

* Fast: The scroll speed is fast.
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Display items (Continued)

Opening Message (Default: ON)

Barometric (Default: inHg*)

Display > Opening Message

Select whether or not to display the opening message

at power ON.

* OFF: Opening message is not displayed.

* ON: Icom logo, MY call sign, the product model
(“ID-4100A” or “ID-4100E”)* are displayed.
*Depending on the version.

Voltage (Power ON) (Default: ON)

Display > Voltage (Power ON)

Select whether or not to display the power source

voltage at power ON.

* OFF: Does not display the voltage of the external
DC power source at power ON.

* ON: Displays the voltage of the external DC power
source at power ON.

NOTE: When the voltage of the external DC power
source is over 17.0 V, “Over Voltage” is displayed.
In that case, immediately disconnect the DC power
source.

Latitude/Longitude (Default: ddd °mm.mm")

Display > Display Unit > Latitude/Longitude
Select either the ddd °mm.mm’ or ddd °mm’'ss" format
to display the position.

Altitude/Distance (Default: feet/mile*)

Display > Display Unit > Altitude/Distance

Select either the meter or feet/mile format to display
the distance and altitude.

Speed (Default: mph*)

Display > Display Unit > Speed

Select either the km/h, mph or knots format to display
the speed.

Temperature (Default: °F*)

Display > Display Unit > Temperature

Select either the degrees °C or °F format to display
the temperature.

*The default value may differ, depending on the transceiver
version.

Display > Display Unit > Barometric

Select between the hPa, mb, mmHg and inHg format
to display the barometric pressure.

Rainfall (Default: inch*)

Display > Display Unit > Rainfall

Select either the mm or inch format to display the
amount of rainfall.

Wind Speed

Display > Display Unit > Wind Speed

(Default: mph*)

Select between the m/s, mph and knots format to
display the wind speed.

Display Language (Default: English)

Display > Display Language

Set the screen display language type in the DR screen
or MENU screen to English or Japanese.

® This item is displayed only when the “System
Language” is set to “Japanese.” See page 9-65
“Choose your language carefully” about setting
cautions.

System Language (Default: English)

Display > System Language

Set the system language of the transceiver.

* English:  The system language of the transceiver is
English.
Only alphabetical characters (Ato Z, a to
z,0to9)and symbols (! "#$ % &' ()* +
-l <=>?2@[\]1M_"{|}~) canbe
displayed. If Japanese characters (Kanji,
Hiragana and Katakana) are included,
the display shows “=" or “_” instead of
that character. In that case, you can only
delete “=" or “_” in the transceiver's edit
mode.

» Japanese: The system language of the transceiver is
Japanese.
Kaniji, Hiragana and Katakana characters,
and the 2-bytes symbols can be
displayed. To display such characters
in the DR screen or Menu mode, set
“Display Language” to “Japanese.”

® When this item is set to “English,” “Display
Language” is not displayed.
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Display items (Continued)

Choose your language carefully

When the system language of the transceiver

is set to Japanese, the transceiver has the
capability to display both English and Japanese
characters. HOWEVER, if you select Japanese as
the display language, all menu items throughout
the transceiver system will be displayed in only
Japanese characters. There will be no English item
names. Unless you are fluent in reading Japanese
characters, use this feature with extreme caution.

If you change the transceiver’s language to
Japanese, and cannot understand the menu system
in the new setting, you will have to change the
language back to English in “Display Language” or
“System Language,” or by doing a partial reset of the
transceiver CPU. A partial reset will not clear your
call sign databases.

To do a partial reset of the CPU, do the following
steps:

1. Push [MENU].

2. Rotate [DIAL] to select the 8th page, then push

3. Select the bottom item, then push [J].

= = 0ifh

= ey -
A=l ﬂ

@ Do not select the lower item. The lower item is
for the All reset function, and the All reset clears
all entries and returns all settings to their factory
defaults.

5. The dialog is displayed.
Select the left option, then push [J].

Bl —— v iUty FLETN?
=

» When the partial reset is completed, “PARTIAL
RESET” is displayed, then the display automatically
returns to the default screen.
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Beep Level (Default: 9)

Sounds > Beep Level

Set the beep audio output level to between 0 (OFF), 1
(minimum) and 9 (maximum).

Key-Touch Beep (Default: ON)

Sounds > Key-Touch Beep

Turn the confirmation beep tones ON or OFF.
* OFF: No beep sounds.
* ON: A beep sounds when you push a key.

Home CH Beep (Default: ON)

Sounds > Home CH Beep

Turn the Home CH Beep ON or OFF.

* OFF: No beep sounds.

* ON: Sounds a beep when you select the Home CH
by rotating [DIAL].

® You can set a Home CH for the VFO mode,
Memory mode and the DR function. (p. 10-7)

Band Edge Beep (Default: OFF)

Sounds > Band Edge Beep

Turn the Band edge beep ON or OFF.

* OFF: No beep sounds.

* ON: Abeep sounds when you tune into or out of
the AIR, 144 MHz, 230 MHz, 300 MHz, or
430 MHz band’s frequency range by rotating
[DIAL].

Scan Stop Beep (Default: OFF)

Sounds > Scan Stop Beep

Turn the scan stop beep ON or OFF.

* OFF: No beep sounds.

* ON: A beep sounds when a scan stops by receiving
a signal.
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Standby Beep
(Default: ON (to me:Alarm/High Tone))

Sounds > Standby Beep

Turn the Standby Beep function ON or OFF.

This function sounds a beep after a received signal

disappears, in the DV mode.

* OFF: Does not sound a beep after a received signal
disappears.

* ON: Sounds a beep after a received signal
disappears.

* ON (to me: High Tone):

Sounds a high pitched beep when a received

signal that is addressed to your call sign (MY)

disappears.

When any other received signal disappears, a

regular beep sounds.

* ON (to me: Alarm/High Tone):

Sounds alarm (PiRoPiRoPiRo) when a

received signal that is addressed to your call

sign (MY) disappears.

- If you release [PTT] and/or a signal is
received within 5 seconds, the alarm sound
changes to a high pitch beep sound when the
received signal disappears.

- If no signal is received for 5 seconds after
you release PTT, the next signal addressed
to your call sign will again sound the alarm
sound.

When any other received signal disappears, a

regular beep sounds.

® The standby beep sounds even when “Key-Touch
Beep” is set to “OFF.”

® The standby beep output level is depending on the
Beep level setting.

Scope AF Output
Sounds > Scope AF Output

(Default: ON)

Select the audio output option during a sweep by the
Band Scope function.

* OFF: No audio is heard during the sweep.

* ON: Audio is heard during the sweep.
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Time Set items

DATE
Time Set > Date/Time > DATE

Manually set the date to between 2000/01/01 and
2099/12/31.

TIME
Time Set > Date/Time > TIME

Manually set the time that is displayed at the top of
the screen to between 0:00 and 23:59. The time is
displayed in the 24 hour format.

® When “GPS Time Correct” is set to “Auto,” the GPS
receiver automatically sets the time by calculating
the received Universal Time of Coordinated (UTC)
time and the “UTC Offset” setting. (p. 9-67)

GPS Time Correct (Default: Auto)
Time Set > GPS Time Correct

This function corrects the time by using the time
information that a GPS sentence contains.

It is corrected by calculating the received UTC time
and the “UTC Offset” setting.

* OFF: Does not correct the time.

« Auto: Automatically corrects the time.

UTC Offset (Default: +£0:00)
Time Set > UTC Offset

Set the time difference between UTC time and the
local time to between —14:00 and +14:00 in 00:05
steps.

Auto Power OFF (Default: OFF)
Time Set > Auto Power OFF

Select whether or not to automatically turn OFF the

transceiver after inactivity for this set period of time.

* OFF: Does not turn OFF the transceiver.

+ 30/60/90/120min: Turns OFF the transceiver after
inactivity for this set period of time.

® “AUTO POWER OFF” is displayed and beeps
sound 5 seconds before turning OFF the
transceiver. If you operate the transceiver during
this period of time, the Auto Power OFF timer is
reset.
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DV Gateway items

Enters the Terminal mode or Access Point mode.

See “About the DV Gateway function” for details.

® “About the DV Gateway function” can be
downloaded from the Icom website.

<<Terminal Mode>>

DV Gateway > <<Terminal Mode>>

The Terminal mode enables you to make a direct
Gateway call through the Internet using the optional
OPC-2350LU and a Windows PC or Android device.
In the Terminal mode, “<<Normal Mode>>" is
displayed on the DV GATEWAY screen. To cancel the
Terminal mode, push [J].
® You can cancel the Terminal mode in the Quick
Menu window.

<<Access Point Mode>>

DV Gateway > <<Access Point Mode>>

The Access Point mode enables the D-STAR

transceiver to make a Gateway call through an

ID-4100A/E using the optional OPC-2350LU to a

Windows PC or Android device.

In the Access Point mode, “<<Normal Mode>>" is

displayed in the DV GATEWAY screen. To cancel the

Access Point mode, push [J].

® You can cancel the Access Point mode in the Quick
Menu window.



Previous view

9  MENU SCREEN

SD Card items

Load Setting

Separator/Decimal (Default: Sep [,] Dec [.]¥)

SD Card > Load Setting

Select from the list when you load the setting file.

Save Setting

SD Card > Save Setting

Save the setting file.

Import

SD Card > Import/Export > Import

Import the UR call sign, repeater list or GPS memory
data in the CSV format file.

Export

SD Card > Import/Export > Export

Export the UR call sign, repeater list or GPS memory
data in the CSV format file.
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SD Card > Import/Export > CSV Format >
Separator/Decimal

Select the separator and the decimal character for the
CSV format.

» Sep [,] Dec [.]: Separator is “,” and Decimal is “.”

» Sep [;] Dec [.]: Separator is “;” and Decimal is “.”

» Sep [;] Dec [,]: Separator is “;” and Decimal is *,

*The default value may differ, depending on the transceiver
version.

Date (Default: mm/dd/yyyy*)
SD Card > Import/Export > CSV Format > Date

Select the date format between “yyyy/mm/dd,” “mm/
dd/yyyy” and “dd/mm/yyyy.” (y: year, m: month, d: day)

*The default value may differ, depending on the transceiver
version.

SD Card Info

SD Card > SD Card Info

Displays the microSD card’s free space and its
remaining recording time.

Firmware Update

SD Card > Firmware Update

Displays the Firmware Update mode.

® See “Updating the firmware” (p. 13-3) for details.
Format

SD Card > Format

Formats the microSD card, deleting all data.

Unmount
SD Card > Unmount

Electrically unmounts the microSD card while the
transceiver is ON.
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Bluetooth® Set items

The optional UT-137 Bluetooth UNIT is required.

Bluetooth (Default: OFF)

Bluetooth Set > Bluetooth

Turns the Bluetooth function ON or OFF.
® To use the Bluetooth function, the optional UT-137
Bluetooth UNIT is required.

¢ OFF: Turns OFF the function.
¢« ON: Turns ON the function.

Auto Connect (Default: ON)

Bluetooth Set > Auto Connect

Select whether or not to automatically connect to the

paired Bluetooth device when its power is turned ON.

» OFF: Does not connect to the paired device.

* ON: Automatically connects to the last connected
device.

Paring/Connect

Bluetooth Set > Paring/Connect

Searches for the Bluetooth device to connect, or
display the paired Bluetooth devices in the list.
See page 12-3 for details.

<<Paring Reception>>

Bluetooth Set > <<Paring Reception>>

Enters the pairing reception mode.
See page 12-10 for details.

AF Output (Default: Headset Only)
Bluetooth Set > Headset Set > AF Output

Select the AF Output device when a Bluetooth
headset is connected.
* Headset Only:

Outputs audio to only the
connected Bluetooth headset.
» Headset & Speaker: Outputs audio to both the
connected Bluetooth headset
and the transceiver’s speaker.
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Headset Function Select

Bluetooth Set > Headset Set >
Headset Function Select

(Default: Normal)

Select the PTT and microphone combination when

both the Bluetooth headset and the transceiver

microphone are used.

® To use the Bluetooth function, the optional UT-137
Bluetooth UNIT is required.

Transmits the audio from the Bluetooth
headset or the transceiver microphone
whichever [PTT] is pushed.

Transmits the audio from the Bluetooth
headset.

Transmission is enabled by pushing
either the [PTT] on the Bluetooth
headset, or the transceiver microphone.
The transceiver microphone is only
used for the PTT control.

Transmits the audio from the
transceiver microphone.

Transmission is enabled by pushing
either the [PTT] on the Bluetooth
headset, or the transceiver microphone.
The Bluetooth headset is only used for
the PTT control.

*« Normal:

* Microphone:

- PTT:

NOTE:

» When you select “PTT,” turn OFF the VOX function.

* DO NOT select “PTT” when the microphone is not
connected to the transceiver, and you use only the
Bluetooth headset.

® The Bluetooth headset operation for each option is
listed below.

Option TX control TX audio
Normal Enabled Enabled
Microphone Enabled Enabled
Disabled
PTT Enabled |(Audio from the microphone
is transmitted.)
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Bluetooth® Set items (Continued)

VOX (Default: OFF)

Power Save (Default: OFF)

Bluetooth Set > Headset Set > VOX > VOX

The Voice Operated Transmission (VOX) function

starts transmitting without pushing [PTT] when you

speak into the microphone, then automatically returns

to receive when you stop speaking.

® To use the VOX function, the optional VS-3 headset
is required.

* OFF: Turns OFF the function.
*« ON: Turns ON the function.

VOX Level (Default: 5)
Bluetooth Set > Headset Set > VOX > VOX Level

Set the VOX gain level to between OFF, 1 (minimum
sensitivity) and 10 (maximum sensitivity).

Higher values make the VOX function more sensitive
to your voice.

When “OFF” is selected, the transmission does not
start when you speak into the microphone. (The VOX
function is OFF.)

NOTE: Before setting the VOX gain level, it is
recommended that you set the microphone gain
level in “Function” of the Menu screen or the
Bluetooth headset.

VOX Delay (Default: 0.5sec)
Bluetooth Set > Headset Set > VOX > VOX Delay

Set the VOX Delay time to 0.5, 1.0, 1.5, 2.0, 2.5 or 3.0
seconds.

The VOX Delay is the amount of time the transmitter
stays ON after you stop speaking, before the VOX
switches to receive.

VOX Time-Out Timer

Bluetooth Set > Headset Set > VOX >
VOX Time-Out Timer

Set the VOX Time-Out Timer to between OFF, 1, 2,
3,4, 5, 10, or 15 minutes to prevent an accidental
prolonged transmission.

If a continuous transmission exceeds the set period of
time, the transmission will be cut off.

When “OFF” is selected, the continuous transmission
is not cut off.

(Default: 3min)
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Bluetooth Set > Headset Set > Icom Headset >
Power Save

Select whether or not to operate with the Power Save

mode while the optional VS-3 headset is connected.

® When a headset (user supplied) or a data device is
connected, the Power Save mode is automatically
turned OFF, regardless of this setting.

* OFF: Turns OFF the function.

* ON: The Power Save mode is enabled when no
communication or operation is performed for
120 seconds.

One-Touch PTT (Default: OFF)

Bluetooth Set > Headset Set > Icom Headset >
One-Touch PTT

Set the One-Touch PTT function when the optional

VS-3 headset is connected.

This function enables you to transmit without

continuously holding down [PTT].

® When a headset (user supplied) is connected, this
function is automatically turned ON, regardless of
this setting.

* OFF: Transmits while holding down [PTT].
* ON: Pushing [PTT] changes transmission and
reception.

PTT Beep (Default: OFF)

Bluetooth Set > Headset Set > lcom Headset >
PTT Beep

Set the beep sound when you push [PTT] on the
optional VS-3 headset.

* OFF: No beep sounds.

* ON: Abeep sounds.

Custom Key Beep (Default: OFF)

Bluetooth Set > Headset Set > Icom Headset >
Custom Key Beep

Set the beep sound when you push the Custom Key
([PLAY]/[FWDJ/[RWD]) on the optional VS-3 headset.
* OFF: No beep sounds.

* ON: Abeep sounds.

= Continued on the next page.
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Bluetooth® Set items (Continued)

Custom Key

(Default: [PLAY]: ---, [FWD]: UP, [RWD]: DOWN)

Bluetooth Set > Headset Set > lcom Headset >

Custom Key

Assigns the following key functions to the Custom Key
([PLAY]/[FWD]/[RWD]) on the optional VS-3 headset.

Function Description

— No function
Push to increase the frequency,

upP Memory channel, repeater or select the
next station call sign.

Push to decrease the frequency,

DOWN Memory channel, repeater or select the
previous station call sign.

VOL UP Push to increase the volume level.

VOL DOWN |Push to decrease the volume level.

SQL UP Push to increase the squelch level.

SQL DOWN |Push to decrease the squelch level.

Monitor Push to open or close the squelch.

CALL Push to select a call channel.

In the Memory mode, push to select

MR (000 CH) Memory channel 000.

In the Memory mode, push to select

MR (001 CH) Memory channel 001.

VEO/MR Push to select between the VFO mode
and the Memory mode.

DR Push to turn the DR function ON or
OFF.

FROM/TO On the DR screen, push to select

(DR) between “FROM” and “TO.”

Push to directly select the Home CH
that is set to the selected mode (VFO/
Memory) or DR screen.

HOME CH While in the CALL CH or Weather
channel mode, or when no Home CH
is set, an error beep sounds.

Push to select an operating band.
In the VFO mode, push to change the
operating band, and in the Memory

BAND/BANK Bank mode, push to select Bank A~ Z,
or OFF.
® Only the entered bank is selectable.
Push to start a scan.

SCAN While scanning, push to stop the scan.
Push to set the frequency to be

Temporary |skipped during scanning.

Skip The selected frequencies are
temporarily skipped for faster scanning.
Hold down for 1 second to set the

RX>CS last calling station’s call sign to “TO”

(destination).
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Function

Description

SPEECH

Push to announce the frequency,

operating mode or call sign.

® In the VFO, Memory and Call channel
mode, the frequency and the operating
mode are announced.

® In the DR screen, the call sign is
announced. If Simplex is selected, the
frequency is announced.

MODE

Push to change the operating mode.

LOwW

Push to change the transmit power
level.

DUP

Push to turn the Duplex mode ON or
OFF, and the shift direction to DUP+ or
DUP-.

PRIO

Push to turn the Priority watch ON or
OFF.

TONE/DSQL

Push to select between tone types.

<<MODE>> FM/FM-N

TONE: Repeater Tone

TSQL((+) : Pocket Beep with Tone

Squelch

(Tone Squelch)

Pocket Beep with DTCS

Code Squelch

DTCS Code Squelch

Reverse Tone Squelch

Reverse DTCS Code

Squelch

DTCS (T) (“DTCS” blinks):
TX:DTCS, RX:OFF

TONE (T)/DTCS (R)

(“T-DTCS” is displayed, “T” blinks.):
TX:TONE, RX:DTCS

DTCS (T)/TSQL (R)

(“D-TSQL" is displayed, “D” blinks.):
TX:DTCS, RX:CTCSS

TONE (T)/TSQL (R)

(“T-TSQL” is displayed, “T” blinks.):
TX:TONE, RX:CTCSS

TSQL:
DTCS((9):

DTCS:
TSQL-R:
DTCS-R:

<<MODE>> DV
® You can set this setting on the DR
screen.

DSQL ((») : Pocket Beep with Digital
Call sign Squelch

DSAQL: Digital Call sign Squelch

CSQL ((») : Pocket Beep with Digital
Code Squelch

CsQL: Digital Code Squelch

MW

In the VFO mode or on the DR screen,
hold down to save the displayed
frequency into a Memory blank
channel.

MUTE

Push to turn the Mute function ON or
OFF.
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Bluetooth® Set items (Continued)

Custom Key (Continued)

Function Description

* Push to transmit the voice audio

recorded on the microSD card once.

* Hold down for 1 second to repeatedly

] transmit the voice audio.

Voice TX ® This key function can also be used on

(T1) the DR screen.

@ If the voice audio is not saved in the [T1]
(Voice memory number for TX) on the
Voice TX record screen, this function is
disabled.

T-CALL Push to transmit a 1750 Hz tone.

Serialport Function
(Default: CI-V (Echo Back OFF))

Bluetooth Set > Data Device Set >
Serialport Function

Set the serial port function for the Bluetooth SPP

(Serial Port Profile) connection to a data device, PC

and so on.

* CI-V (Echo Back OFF):
Transmits or receives a Cl-V command.
Does not send back the serial data
received from the SPP connection.

* CI-V (Echo Back ON):
Transmits or receives a Cl-V command.
Sends back the serial data received from
the SPP connection.

* DV Data: Transmits or receives data in the DV
mode.
Does not input the cloning or weather
data entries, or output the GPS data.

Bluetooth Device Information

Bluetooth Set > Bluetooth Device Information

Displays the Bluetooth device information.

Initialize Bluetooth Device

Bluetooth Set > Initialize Bluetooth Device

Initializes the installed Bluetooth unit.
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Voltage

Others > Information > Voltage

Displays the voltage of the external power supply.

Version

Others > Information > Version

Displays the transceiver firmware’s version number.

® When the optional UT-137 Bluetooth UNIT is
installed, the unit’'s version number is also
displayed.

Clone Mode

Others > Clone > Clone Mode

Select to enter the clone mode to read or write the
CS-4100 data from or to the PC.
See page 10-14 for details.

Partial Reset

Others > Reset > Partial Reset

Select to reset the operating settings to their default
values (VFO frequency, VFO settings, menu contents)
without clearing the items below.

* Memory channel content

» Scan Edge content

* Call channel content

+ Call sign memories

* Message content

* DTMF memory content

* GPS Memory content

* Repeater list content

See page 10-18 for details.

All Reset
Others > Reset > All Reset

Select to clear all content and return all settings to
their factory defaults.
See page 10-18 for details.
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Selecting a Squelch delay

You can select a squelch delay in the MENU screen to
prevent repeated opening and closing of the squelch
while receiving the same signal.

Function > Squelch Delay

1. Push [MENU].
Rotate [DIAL] to select “Function,” then push [J].

T DTIMF '

EFUMNCTION

Sqquelch/ATT Select »
Sguelch Delay 4
Fan Control »

3. Select" Squelch Delay,” then push [J].

4. Select an option.
* Short: Short squelch delay.
. Long' Long squelch delay.

5. Push [MENUI.
* Returns to the standby screen.

10-2

Transmit power levels and RF meter

The transmit power level and the RF meter displays
are shown below.

LOW MID HIGH
Lo ER | mMID
RF meter
(TX dlsplay) FEKIF J PSKIPﬁ PSKIP%
841 BA1 ad1
Power level "
(at TX) 5W 15W |25/50W

*Depending on the transceiver version.

TIP: To change the transmit power level
Push [QUICK], then select “TX Power.”

Al Band Select >|—|
1 ﬂ D U P b FEKIF
TOME vl p6B
AL L
1 ﬂ MID
H | G H FEKIF
BEA
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Attenuator function Microphone gain level setting

The transceiver has an RF attenuator related to Set the microphone gain level in the MENU screen.
the squelch control setting. You can add up to
approximately 20 dB of attenuation at its maximum Function > MIC Gain
setting.
You can set the Attenuator to [SQL] in the MENU 1.~ Push [MENU].
screen. 2. Rotate [DIAL] to select “Function,” then push [J].
. i DTMF 3
Function > Squelch/ATT Select QS0/RX Lag ,H
1. Push [MENU]. # Function
Rotate [DIAL] to select “Function,” then push [J]. 3. Select “MIC Gain,” then push [d]
EMEML EFUMNCTION
i DTMF > Time-Out Timer 3
[ QS0 /RE Log » Active Band »
3 Function MIC Gain d
3. Select “Squelch/ATT Select,” then push [J]. 4. Rotate [DIAL] to set the microphone gain level.
/5 ® Set higher values to make the microphone more
Sqquelch/ATT Select > sensitive to your voice.
Sguelch Delay » EMIC Gain
Fan Control »

—

4. Select “ATT,” then push [J].

E Squelch/ATT Select
OFF 5. Push [MENU].

S-Meter Squelch * Returns to the standby screen.

5. Push [MENUI.
* Returns to the standby screen.

< Operating the Attenuator function
Rotate [SQL] clockwise past the 12 o’clock position
to turn ON the Attenuator and adjust the attenuation
level up to approximately 20 dB.

You can adjust the
Attenuation level between
12 o’clock and the fully
clockwise position.

Noise squelch

Displayed

146010 |
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Band Scope function

Use the Band Scope function to visually search for

a specified frequency range around the displayed

frequency.

You can use this function to search for a signal, and

see the received signal strength level.

The Band Scope function has two sweep types,

Single sweep and Continuous sweep:

* A Single sweep searches the specified frequency
range only once.

» A Continuous sweep repeatedly searches the
specified frequency range.

The transceiver sweeps in “+25 x Tuning step” steps
centered on the displayed frequency.
® ‘25’ is fixed.

For example, if the display frequency is 146.010 MHz
and its tuning step is 20 kHz, the sweep range is
between 145.510 MHz (lower frequency) and 146.510
MHz (higher frequency). (146.010 MHz £0.5 MHz)
See the calculation below.
+25 x 20 kHz = +500 kHz (0.5 MHz)
—25 x 20 kHz = =500 kHz (-0.5 MHz)
Upper frequency: 146.510 MHz
(146.010 MHz + 0.5 MHz)
Lower frequency: 145.510 MHz
(146.010 MHz — 0.5 MHz)

Example: A strong signal is received on 146.030 MHz.
(Tuning step: 5 kHz)

Strong level

3 ik

Weak level

The signal on 146.030 MHz
Band Scope display
[ T3

| Dl ﬁ
/ P
l ||

Center frequency —T

(Example: 146.010 MHz)

T— Sweep marker

TIP:

* The specified tuning step is used during a sweep.
If the tuning step is set too wide, the signals in the
sweep range may not be displayed (they may be
skipped), even if they are strong signals. Thus we
recommend that you set the tuning step to 20 kHz
or less to use the Band Scope function.

See Basic manual section 3 for details.

* You can hear the displayed frequency’s audio
during a sweep.

* You can turn OFF the audio output during a sweep
in the MENU screen. (p. 9-66)

(Sounds > Scope AF Output)

10-4

< Sweep operation

Example: Continuous sweeps centered on 146.010 MHz

1. Push [V/M] several times until you enter the VFO
mode.

2. Rotate [DIAL] to set 146.010 MHz.

146.010

BEB 1
3. Push [QUICK].
4. Rotate [DIAL] to select “Band Scope,” then push

[J].
AL Home CH Zet r
1 4 Clock
Yaltage
5. Select “Continuous Sweep,” then push [J].

14

Single Sweep

Continuous Sweep

FEEIF

146010

|

* Returns to the frequency display and starts continuous
sweeping.
6. Push[J].
« Stops the continuous sweeping.
7. When the sweeping stops, rotate [DIAL] to move
the sweep marker to a detected signal.

146.030
()

® You can hear the signal audio.
8. Push [QUICK].
9. Rotate [DIAL] to select “Band Scope,” then push
[J].
. Select “Scope OFF,” then push [J].

FERIF
Ban

* Turns OFF the Band Scope function.

Single Sweep
Continuous Sweep
Center Recall

Scn e COFF

TIP: In the Band scope setting window, select
“Center Recall” to set the sweep marker to the

center frequency.
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Voice TX function

The Voice TX function transmits the audio that is on
the microSD card, one time or repeatedly, for up to 10
minutes at the specified interval.

Up to 4 memories can be used for repeatedly calling
CQ or for other events.

When the key function [Voice TX (T1)] is assigned to
a microphone key, push the key to transmit the saved
audio in the “T1” (Voice memory number for TX).

(p. 9-59)

NOTE: Be sure to insert a microSD card into the
transceiver.

< Recording the voice audio
Voice TX > Record

1.

Push [MENU].

Rotate [DIAL] to select “Voice TX,” then push [J].
Select “Record,” then push [J].

* Displays the VOICE TX RECORD screen.

Select the memory number, “T1” ~ “T4.”

T Woice  —
REC N
Leyvel - ' . . . L. -
MIC SEL  GAIM * > ]

* The “VOICE TX RECORD (T1)” screen is displayed
when “T1” memory is selected.
Push [MW] to start recording.

Displayed
Audio  while Recording
level recording time
T Yoice
FREC 1 l_ 0:05/ 1:00
MIC SEL GAIN @ - n

® Hold the microphone 5 to 10 cm (2 to 4 inches) from
your mouth, then speak at a normal voice level.

® The maximum record time is 1 minute.

Push [MONI] to stop recording.

Push [RX—CS] to playback the recorded audio.

TH Voice | N —

REC . .
Lewel - - - . . . . |:|.|:I!§I,f 0:37
MIC SEL  oAIM L] > ]

@ If you push [MW], the recording starts again. In this
case, the previous recorded audio will be overwritten.

® Push [MODE] to display the microphone gain setting
screen. Rotate [DIAL] to set the gain level.

10-5

8. Push [9].

* Returns to the VOICE TX RECORD screen.
EVOICE TH RECORD

TIP: On the VOICE TX RECORD screen, push
[QUICK], then select “Clear” to clear the recorded
audio.

BANDIBANK
S | O em

[b]/ |
Cancels [QUICK]
[MODE] Deletes the file
Sets the mic gain [MONI] .
Stops recording
[RX—CS]
Playback

[MW]
Starts to record
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Voice TX function (Continued)

< Transmitting the recorded voice audio

NOTE: Be sure to insert a microSD card into the
transceiver.

Voice TX > <<TX>>

Push [MENU].

Rotate [DIAL] to select “Voice TX,” then push [J].
Select “<<TX>>" then push [J].

Select the memory number, “T1” ~ “T4,” then push

[J].

PO

Recard . »
T Set 3
EXIEIIE:
Recard (T2 »
TH Set [T

146.030 3

* The recorded voice audio is transmitted once.

® Information

» While transmitting, the SD card icon blinks.

* When you select “T1 (Repeat TX)” ~ “T4 (Repeat
TX)” in step 4, the transceiver repeatedly transmits
the recorded voice audio for up to 10 minutes at the
interval specified in “Repeat Time.”

* Push [PTT] to cancel a recorded voice transmission.

TIP: To send the recorded voice audio in the Quick
Menu window, push [QUICK], then select “Voice TX.”
FIa

MH=z
1 4TS y
DTMF T¥ ,

FZEIF

10-6

< Changing the voice TX settings
You can change the voice TX settings on the MENU
screen. (p. 9-23)

Setting the Repeat Time

Set the repeat interval for the voice repeat
transmission.

The transceiver repeatedly transmits the recorded
voice audio at 5 second intervals as the default.

Voice TX > TX Set > Repeat Time

E Repeat Time

Using the TX Monitor function
The TX voice audio is output from the speaker as the
default. (Default: ON)

Voice TX > TX Set > TX Monitor

E T Monitor
OFF
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Home channel function

Home channels are often-used frequencies you can
preset in the transceiver’s VFO mode, Memory mode
and DR function. Select the Home channel by just
pushing [HOME] in each mode.

< Home channel setting

1. Select a mode (VFO or Memory) or the DR screen
in which you want to set the Home channel.

2. Select a frequency to be set as the Home
channel.
® On the DR screen, select “FROM.”

3. Push [QUICK].

4. Rotate [DIAL] to select “Home CH Set,” then push

[J].
FM

1 4 866

5. Select an option, then push [J].
Fi

® In the VFO mode, select “Set Frequency,” in the
Memory mode, select “Set Channel.” or on the DR
screen, select “Set Repeater.”

Home CH Set

Clock

Vaoltage

Band Scope r

Set Frequency

FEEIF

866

TIP: Selecting “Clear” in step 4 clears the Home
channel setting.

14

Set Frequency
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< Home channel operation

1. Select a mode (VFO or Memory) or the DR
screen in which you want to select the Home
channel.

146.010 |

FEKIF

5155}
2. Push [HOME] on the microphone.

146.030 y

* Selects the Home channel of the selected mode or DR
screen.

< Home CH Beep function
When the specified Home CH is selected by rotating
[DIAL], a beep sounds.
You will know the Home CH selection without looking
at the display.
® You can turn OFF the Home CH Beep function on
the MENU screen.
(Sounds > Home CH Beep)
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Using the DTMF memory

The transceiver can save up to 16 memories of
24-digit DTMF code.

< Entering DTMF code
DTMF > DTMF Memory

1. Push [MENU].
Rotate [DIAL] to select “DTMF,” then push [J].

5/3

tog] 2SO0/ Log »
# Function 3

3. Select “DTMF Memory,” then push [J].
E0TMF I

DTMF Memary '
DTMF Speed 3

* Displays the DTMF memory list (dO to d#).
4. Select the DTMF memory, then push [J].
(Example: d0)

= DTMF MEMORY (d0)

= — CLR

5. Enter the DTMF code, then push [J].
(Example: 12345A)

EDTMF MEMORY (d0)
122484

— — CLR
EDTMF MEMORY JE
di: »
dz: »

» Saves the channel, and returns to the DTMF
MEMORY screen.
® See “Entering and editing text” for details. (p. iv)
6. Push [MENU].
* Returns to the standby screen.

TIP: To clear the entered DTMF code, push [QUICK]
on the DTMF MEMORY screen, then select “Clear.”

10-8
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Using the DTMF memory (Continued)

< Transmitting DTMF code

1.

Push [QUICK].

2. Rotate [DIAL] to select “DTMF TX,” then push [].

il MHz
1 4 TS ,
DTRF T3 e
Woice T 3

3. Select the DTMF memory channel to transmit,

then push [J].

FM Direct Input
1 dIII: 12345 4
d1: 678908 e
[5]
v
Fivl | L3
146.010

* Transmits the selected DTMF code.
® The DTMF code scrolls during transmission.

10-9

< Transmitting DTMF code (Direct Input)

1.
2.
3.

Push [QUICK].
Rotate [DIAL] to select “DTMF TX,” then push [J].
Select “Direct Input.”

i Direct Input
1 4 d0: 12345 4
d1: 672908 —
5 8]E]

Enter the DTMF code, then push [J].
(Example: 123A)

EDTMF DIRECT INPUT

1234
— — CLR
4
Fi [ T2
146.010 %

* Transmits the entered DTMF code.
® The DTMF code scrolls during transmission.
® See “Entering and editing text” for details. (p. iv)



Previous view

10 OTHER FUNCTIONS

Using the DTMF memory (Continued)

<¢ Selecting the DTMF transmit speed

You can select the DTMF transmit speed.

DTMF > DTMF Speed

1. Push [MENU]I.
Rotate [DIAL] to select “DTMF,” then push [J].

/e s

QS50/RH Log 3
# Function 3
3. Select “DTMF Speed,” then push [J].

ED0TMF

4. Select a transmit speed.

* 100ms: Transmits the DTMF tones at about 100
milliseconds per code.
5 characters per second.

» 200ms: Transmits the DTMF tones at about 200
milliseconds per code.
2.5 characters per second.

* 300ms: Transmits the DTMF tones at about 300
milliseconds per code.
1.6 characters per second.

* 500ms: Transmits the DTMF tones at about 500
milliseconds per code.
1 character per second.

200ms

5. Push [MENU]I.
* Returns to the standby screen.

Image of the DTMF transmit speed

Pi-, Po-, Pa—

/

When “100ms” is set, When “500ms” is set,
the DTMF transmit the DTMF transmit
speed is fast. speed is slow.

10-10
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Tone squelch operation

The tone squelch opens only when you receive a
signal containing a matching subaudible tone in the
FM or FM narrow mode. You can silently wait for calls
from others using the same tone.

Also, the reversed tone squelch function will mute

the squelch when a signal containing a matched
subaudible tone.

< Tone squelch frequency setting and operation

Step 1. Setting the tone squelch frequency

DUP/TONE... > TSQL Freq

1. Push [V/M] several times until you enter the VFO
mode.

2. Push [MODE] several times until you select the
FM or FM-N (FM narrow) mode.

3. Rotate [DIAL] to set an operating frequency.

146.010

FEEIF

866

&

Push [MENU].

5. Rotate [DIAL] to select “DUP/TONE...,” then push
[J].

6. Select “TSQL Freq,” then push [J].

7. Rotate [DIAL] to set a tone squelch frequency,

then push [J].

E TS0L Frec

® Set to between 67.0 and 254.1 Hz.
8. Push [MENU].
* Returns to the standby screen.

Step 2. Using the tone squelch

1. Push [QUICK].
2. Select “TONE,” then push [J].
3. Select the tone squelch type. (Example: TSQL)

14

CIFF
TOMNE
TS0 L

FERIF

TS0
FSEIF

146010 _

4. Holding down [PTT] and call a station.
Operate normally.
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About the tone squelch type:
« TSQL ((»)) : Enables the Tone Squelch with the Pocket
Beep function.

« TSQL: Enables the Tone Squelch function.
+ TSQL-R: Enables the Reverse Tone Squelch function.
* TONE(T)/DTCS(R)

(“T-DTCS” is displayed, “T” blinks.):
When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)

* DTCS(T)/TSQL(R)

(“D-TSQL” is displayed, “D” blinks.):
When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching
tone frequency. (Audio is heard)

* TONE(T)/TSQL(R)

(“T-TSQL” is displayed, “T” blinks.):
When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching
tone frequency. (Audio is heard)

To sound beeps when a call is received.

If “TSQL ((+)) " is selected, beeps sound for 30
seconds and “((+)) ” blinks when a call with the
matched tone signal is received.

W
TS0 0 Z
FIEIP

145010 _

® Within 30 seconds, push [PTT] to stop the beeps.
(“((») " disappears) After that, the transceiver selects
the regular tone squelch operation. If you make no
operation for 30 seconds, the beeps automatically
stop, but “((+))” continues to blink to indicate that you
received a call.
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DTCS squelch operation

The tone squelch opens only when you receive a
signal containing a matching DTCS code in the FM
or FM narrow mode. You can silently wait for calls
from others using the same tone. Also, a reversed
tone squelch function will mute the squelch when you
receive a signal containing a matched DTCS code.

<& DTCS code setting and operation

Step 1. Setting the DTCS code

DUP/TONE... > DTCS Code

1. Push [V/M] several times until you enter the VFO
mode.

2. Push [MODE] several times until you select the
FM or FM-N (FM narrow) mode.

3. Rotate [DIAL] to set an operating frequency.

146.010

FSKIF

866

4. Push [MENUI.

5. Rotate [DIAL] to select “DUP/TONE...,” then push
[J].

6. Select “DTCS Code,” then push [J].

7. Rotate [DIAL] to set a DTCS code, then push [J].
EDTCS Coc

® Set to between 023 and 754.
8. Push [MENU]I.
* Returns to the standby screen.

< The DTCS code operation

1. Push [QUICK].

2. Select “TONE,” then push [J].

3. Select the DTCS code type. (Example: DTCS)

AL DT C5
1 4 TsaL-R e
OTC5-R BER
FM (T3
146.010 _
BER

4. Holding down [PTT] and call a station.
Operate normally.
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About the DTCS code type:

« DTCS (()) : Enables the DTCS squelch with the Pocket

Beep function.

Enables the DTCS Squelch function.

Enables the Reverse DTCS Squelch

function.

* DTCS(T) ("“DTCS” blinks):
When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the function is OFF.

* TONE(T)/DTCS(R)

(“T-DTCS” is displayed, “T” blinks.):

When you transmit, the selected subaudible
tone is superimposed on your normal signal.
When you receive, the DTCS squelch opens
only for a signal that includes a matching
DTCS code and polarity. (Audio is heard)

* DTCS(T)/TSQL(R)

(“D-TSQL” is displayed, “D” blinks.):

When you transmit, the selected DTCS code
is superimposed on your normal signal.
When you receive, the tone squelch opens
only for a signal that includes a matching
tone frequency. (Audio is heard)

* DTCS:
* DTCS-R:

To sound beeps when a call is received.
If “DTCS ((+)) " is selected, beeps sound for 30
seconds and “((+)) " blinks when a call with the
matching tone signal is received.
DT(}}@]I: [ T3
FZEIF

146.01 "

® Within 30 seconds, push [PTT] to stop the beeps.
(“((2)) " disappears) After that, the transceiver selects
the regular tone squelch operation. If you make no
operation for 30 seconds, the beeps automatically
stop, but “((+)) ” continues to blink to indicate that you
received a call.
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Weather channel operation (USA version only)

There are 10 weather channels for monitoring
the National Oceanographic and Atmospheric
Administration (NOAA) weather broadcasts.

< Selecting a Weather channel
1. Push [QUICK].
2. Rotate [DIAL] to select “Weather CH,” then push

[J1.
it 1

GP3 Information
GPS Pozition

14

* Enters the Weather channel mode.
3. Rotate [DIAL] to select a weather channel.

WX-01

* Displays the selected weather channel number (“WX-
01" ~ “WX-10”).

PRID WMatch »

TIP: To return to the previous frequency or Memory
channel, push [QUICK], then select “Weather CH
OFF.”
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< Weather alert function

NOAA broadcast stations transmit weather alert tones
before important weather announcements.

When the weather alert function is turned ON, the
selected weather channel is monitored every 5
seconds for an announcement.

When an alert signal is detected, the “ALT” and the
WX channel are alternately displayed, and a beep
sounds until you change the operating mode or
weather channel, turn OFF the Weather Alert function,
or turn OFF the transceiver.

The previously selected (used) weather channel

is checked periodically during standby, or while
scanning.

1. Push [QUICK].
Rotate [DIAL] to select “Weather Alert,” then push
[].

FiA

GPS Information
GPS Pozition

Weather CH OFF 1
WX
3. Select “ON.”
B OFF
E—
Wx
v
EM W) B+
WX-0
WX

* Turns ON the Weather Alert function, and “W” is
displayed.
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Cloning function

The ID-4100A/E has a data cloning capability. This
function is useful when you want to copy all of the

entered contents from one ID-4100A/E to another.
Cloning can also be done with a PC.

Transceiver-to-Transceiver cloning using a

Cloning from a PC using a microSD card (p. 10-17,
CS-4100 Instruction manual)

To the memory "\
card slot

To the memory
card reader

® If your PC does not have a microSD card slot,
connect a memory card reader (user supplied) to
use the microSD card.

10-14

Cloning from a PC using an optional cloning cable
(CS-4100 Instruction manual)

By using the CS-4100 CLONING SOFTWARE and an
optional cloning cable, cloning can be done with a PC.
See the CS-4100 instruction manual that can be
downloaded from the Icom website.
http://www.icom.co.jp/world/support/

OPC-478UC To the
M (Option) VS8 por
e <~ ===
N
To the speaker jack .
[DATA] jack

OPC-2350LU
(Option)

To the
USB port

IMPORTANT: When using the OPC-2350LU, set
the “DV Data TX” setting of the transceiver to “PTT,”
before reading or writing setting data. Otherwise,
when a PC input data through the [DATA] jack, the
transceiver automatically transmits it.

(MENU > DV Set > DV Data TX)
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Cloning function (Continued)

< Transceiver-to-Transceiver cloning using a microSD card

This section describes the cloning method using a

microSD card. Memory channel contents, MENU

item settings and repeater lists can be saved onto the

microSD card.

® Recorded voice memories are not included in the
cloning data. To play back the master transceiver’s voice
memory, insert the microSD card into a sub transceiver,
or make a copy onto the sub transceiver’s microSD card
using a PC.

® Assumes that the microSD card has already been
inserted into the transceiver.

Step 1. Saving the master transceiver’s setting
data onto the microSD card.

SD Card > Save Setting

Push [MENU].
Rotate [DIAL] to select “SD Card,” then push [J].
Select “Save Setting,” then push [J].

PON=

* Displays the FILE NAME screen.

® The file name is automatically named in the following
manner: Setyyyymmdd_xx (yyyy: Year, mm: month,
dd: day, xx: serial number)
Example: If a second file is saved on April 1, 2017,

the file is named “Set20170401_02."

® To change the file name, see “Save with a different
file name.” (p. 6-4)

Push [J].

= FILE MAME

Setz@ 179491 _@1

— —

CLR 4B

 The confirmation dialog “Save file?” is displayed.
Select <YES>, then push [J].

Set

Save file?

+ Saves the data settings.

® While saving, a progress bar is displayed, then
returns to the SD CARD screen after the saving is
completed.

Push [MENUI.

* Returns to the standby screen.

10-15

Step 2. Remove the microSD card from the master
transceiver, then insert it into the sub
transceiver.

1. Hold down the master transceiver’s [()] to turn
OFF the power.

2. Remove the microSD card from the master
transceiver.
3. Insert the microSD card into the sub transceiver,

then hold down the sub transceiver’s [(M] to turn
ON the power.

NOTE: Before inserting, be sure to check the card
direction. If the card is forcibly or inversely inserted,
it will damage the card and/or the slot.

Master 7 T

TIP: The setting data are saved in the “icf” file format
that is used in the CS-4100 CLONING SOFTWARE.
When the saved data on a card is copied to a PC,

you can edit it with the cloning software.
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Cloning function

< Transceiver-to-Transceiver cloning using a microSD card (Continued)

Step 3. Loading the setting data into the sub
transceiver.

SD Card > Load Setting 7. Select <YES>, then push [J].

1. Push [MENUJ. Load file? F
2. Rotate [DIAL] to select “SD Card,” then push [J]. e

3. Select “Load Setting,” then push [J]. Rz |]
4. Select a file to load.

» Starts the file check.
® While checking the file, displays “CHECKING FILE”
and a progress bar.

CHECKING FILE EE
Please wait... .
* Displays the LOAD SETTING screen. Eas
5. Select the loading option, then push [J]. Rep| — 1
* ALL: Loads all memory channels, Menu screen
item settings and the repeater list into the 8. After checking, settings data loading begins.
transceiver. ® While loading, “LOADING” and a progress bar are
+ Except My Station: displayed.
!_oads al! memory channels, Mgnu screen LOADING
item settings and the repeater list except Please wait... [ ]
MY call signs and TX message into the Exie
transceiver. Rep| - '
* Repeater List Only:
Loads on|y the repeater list into the 9. After |Oading endS, “COMPLETED!” is dISpIayed
transceiver. ® To complete the loading, restart the transceiver.
COMPLETED! /1]
Reboot the 10-416@. B
Except My Station Exce
Repeater Lizt Oinly Rer

* The confirmation dialog “Keep 'SKIP' settings in the
Repeater List?” is displayed.
6. Select <YES>, <NO> or <Cancel>, then push [J].

* YES: Retains the skip settings of the repeater
list. (p. 4-40)

* NO: Does not retain the skip settings of the
repeater list.

* Cancel: Returns to the LOAD FILE screen.

Keep 'SKIP' settings in the
Repeater List? H
Exre

Rek MO CAMNCEL

* When you select <YES> or <NO>, the confirmation
dialog “Load file?” is displayed.

10-16
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Cloning function (Continued)

< Cloning from a PC using a microSD card

You can clone transceivers from a PC using a microSD

card.

Set memory content, Menu item settings and repeater
list in the CS-4100 CLONING SOFTWARE, and save them
in an “icf” file format. Copy the “icf” file to the “Setting”

folder in the “ID-4100” folder of the microSD card.

microSD card configuration
Insert the microSD card that includes the “icf” file, then
load it to complete the cloning.

—|Csv GpsMemory |

— Gps | | [RetList |
D100 | {Rxog ]

—ISetting I

—|Voice yyyymlmdd |

yyyymmdd

Connections

To the memory
card slot

To the memory
card reader

10-17

Removable Disk (H:)

Choose what to do with remavable drives

' Configure this drive for backup
£ i History

Configure storage settings
Settings

<——Click

Take no action

Open folder to view files
File Explorer

Home Share View

T == » Removable Disk (H:) »

# Quick access Name

ID-4100

f@ OneDrive

= e

v

Drive Tools

Removable Disk (H:

Manage

<«———— Double-click

I & [ =1 p-#00
Home Share View

» Removable Disk (H:) » ID-4100

~

<«— Double-click

« - 1
# Quick access Mame
Cow
¢@ OneDrive
Gps
[ This PC Qsolog
[ Desktop Reply
[ Documents —
Setti
& Downloads "9
Toice
M
b Music VoiceTx
I + | Setting
Home Share View

PR

s
7 Quick access Name

¢@ OneDrive

= R

» Removable Disk (H:) » 1D-4100 » Setting

[ Copy the i

file.
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Resetting the CPU

Occasionally, erroneous information will be displayed
when, for example, first applying power. This may

be caused externally by static electricity or by

other factors. If this problem occurs, turn OFF the
transceiver. After waiting a few seconds, turn ON the
transceiver again. If the problem is still there, perform
a Partial reset or an All reset.

< Partial Reset
Others > Reset > Partial Reset

1. Push [MENU].
Rotate [DIAL] to select “Others,”

3.
4,
1415

Fartial Reset

All Reszet

 The confirmation dialog “Partial Reset?” is displayed.
5. Select <YES>, then push [J].

Partial Reset? 15

FPar

Al

» When the partial reset is completed, “PARTIAL
RESET” is displayed, then the display automatically
returns to the default screen.

® A Partial reset resets the operating settings to their
default values (VFO frequency, VFO settings, menu
contents) without clearing the items below:
* Memory channel contents
» Scan Edge contents
+ Call channel contents
» Call sign memories
* Message data
* DTMF memory contents
* GPS Memory contents
* Repeater list

10-18

NOTE for the All reset:

After you perform an All reset, you cannot use the
DR function because the repeater list will be cleared.
So we recommend you save the setting data onto

a microSD card, or to your PC using the CS-4100
cloning software before performing an All reset.
After the All reset is finished, load or write the saved
data into your transceiver.

< All Reset
Others > Reset > All Reset

Push [MENU].
Rotate [DIAL] to select “Others,” then push [J].
Select “Reset,” then push [J].

Select “All Reset,” then push [J].

N

Partial Reset

.

* The confirmation dialog “All Reset?” is displayed.
Select <NEXT>, then push [J].

All Reset?
Par|Carefully read the next

caution.

CAMNCEL

* The confirmation dialog as shown below is displayed.
Select <YES>, then push [J].

Clearz all settingz and

Par|memories.
Dizablez the DR function.

« After the All reset is finished, the default screen is
displayed.

® An All reset clears all setting, and returns all
settings to their factory defaults. Therefore, the
repeater list, Memory channel contents, filter
settings and so on will be cleared, so you will
need to reenter your memories, list and operating
settings.
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Remote control (Cl-V) information

< CI-V connection example

The transceiver's operating frequency, mode, VFO
and memory selection, can be remotely controlled
using a PC.

The Icom Communications Interface V (CI-V) is used
for remote control.

< Preparing

To control the transceiver, first set its address, data

communication speed, and transceive function.

These settings are set on the MENU screen. (p. 9-60)

(Function > CI-V)

® When the OPC-478UC is connected, the received
audio cannot be heard. To hear the received audio,
use the cable as shown to the right.

< Data format

The CI-V system can be written using the following
data formats. Data formats differ according to
command numbers. A data area or sub command is
added for some commands.

Controller to ID-4100A/E

o o @ ® &6 6

(Option) USB port

“CD"—'MG«—

~

ID-4100A/E

To the
Speaker jack \

(Vg inch)

OK message to controller
@

IFE[FE| 9a | E0 | Cn | sc |

Data area | FD |

m
O

|FE|FE| EO | 9A | FB |

—_—
5
5

(see the data content description)

—_ ‘_A 2}

,©® 83 ©

o8 =235 e}

] 9 o® ES RS
— L8 w3 E =] So
[ORe) L0 Lo ° c3T R-E=
23 © S < = ET
o % >0 Lo c® T © S«(D
[SES o2 6'5 € c E T >
& o o® £® TBeg & ovlsp
03 o T o E£o9o PR
L c’S =1 3] o c

a9 g3 Q&8 E£¢o Eo ©T3
o e O% o QTS
o ) €< o= oO0dC

© T Qo qo Qs

Oeo So =

%ﬁ ) ) (O]

(fixed) — >
B e

Preamble
code (fixed)
Controller's

default address
Transceiver’s
default address
End of message
code (fixed)

End of message
code (fixed)
NG code OK code

" (fixed)
-~

|FE|FE| Eo| 9A | Cn | Sc |

Data area |

FD | |FE|FE| Eo| 9A | FA | FD|

o @ e ® &6 6

ID-4100A/E to controller

10-19

@
NG message to controller
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Remote jack (Cl-V) information (Continued)

¢ Command table

Cmd. fr:g Data Description Cmd. 3:2 Data Description
00 see p. 10-21 | Send operating frequency for 18 00 Turning OFF the transceiver
transceive 01 Turning ON the transceiver*?
01 see p. 10-21 | Send operating mode for transceive 19 00 Read transceiver ID
03 see p. 10-21 | Read operating frequency 1B 00 |[see p. 10-22 | Send/read Repeater tone frequency
04 see p. 10-21 | Read operating mode 01 |[see p. 10-22 | Send/read Tone squelch frequency
05 see p. 10-21 | Send operating frequency 02 |see p. 10-22 |Send/read DTCS code and polarity
06 see p. 10-21 | Send operating mode 07 |[see p. 10-22 | Send/read CSQL code (DV mode)
07 Select VFO mode 1C 00 (00 Send/read Transceiver’s status (RX)
0cC see p. 10-21 |Read frequency offset*! 01 Send/read Transceiver’s status (TX)
0D see p. 10-21 | Send frequency offset 1F 00 |[see p. 10-22 |Send/read DV MY call sign
OF Read duplex setting 01 |see p. 10-22|Send/read DV TX call signs
(10=simplex, 11=DUP—, 12=DUP+) 02 |see p. 10-22 | Send/read DV TX message
10 Set simplex operation 20(00| 00 |00*3 Send/read Auto DV RX Call signs
11 Set DUP- operation output OFF
12 Set DUP+ operation 01*3 Send/read Auto DV RX Call signs
14 01 {0000 to Send/read audio output level output ON
0255 (000=Minimum, 0128=Center, 01 |see p. 10-23 | Output DV RX Call signs for transceive
0255=Maximum) 02 |[see p. 10-23 |Read DV RX Call signs for transceive
03 {0000 to Send/read squelch level 01| oo [|o00*3 Send/read Auto DV RX message
0255 (000=Minimum, 0128=Center, output OFF
0255=Maximum) 01*3 Send/read Auto DV RX message
0A [see p. 10-21 |Send/read RF power setting output ON
0B |see p. 10-21 | Send/read external microphone gain. 01 |see p. 10-23 | Output DV RX message for transceive
16 |see p. 10-22 | Send/read VOX gain. 02 |[see p. 10-23 | Read DV RX message for transceive
15 01 (00 Read noise/S-meter squelch status 02| oo |o00*3 Send/read Auto DV RX status output
(squelch close) OFF
01 Read noise/S-meter squelch status 01*3 Send/read Auto DV RX status output
(squelch open) ON
02 10000 to Read S-meter level 01 |see p. 10-23 | Output DV RX status for transceive
0255 (0000=80, 0170=59) 02 |see p. 10-23 |Read DV RX status for transceive
05 100 Read tone squelch and RF squelch 03| 00 |oo Sendiread Auto DV RX GPS/D-PRS
status (squelch close) data output OFF
01 Read tone squelch and RF squelch 01 Send/read Auto DV RX GPS/D-PRS
status (squelch open) data output ON
11 /0000 to Read RF power meter
0255 (0026=LOW, 0077=MID, 0255=HIGH) 01 |seep.10-24 t?::‘zzgsz RX GPS/D-PRS data for
16 | 42 |00 Sendiread Repeater tone OFF 02 |see p. 10-24 |Read DV RX GPS/D-PRS data for
01 Send/read Repeater tone ON transceive
43 |00 Send/read Tone squelch OFF 04| 00 |00 Send/read Auto DV RX GPS/D-PRS
01 Send/read Tone squelch ON message output OFF
02 Send/read Reversed Tone squelch ON 01 Send/read Auto DV RX GPS/D-PRS
46 |00 Send/read VOX function OFF message output ON
01 Send/read VOX function ON 01 |see p. 10-26 | Output DV RX GPS/D-PRS message
4B |00 Send/read DTCS OFF for transceive
01 Send/read DTCS ON 02 |see p. 10-26 |Read DV RX GPS/D-PRS message for
02 Send/read Reversed DTCS ON transceive
5B |00 Send/read DSQL/CSQL OFF (DV
mode only)
01 Send/read DSQL ON (DV mode only)
02 Send/read CSQL ON (DV mode only)
5C |00, 01, 02 Send/read GPS TX mode
(00=OFF, 01=D-PRS, 02=NMEA)
5D |00 to 09 Tone setting
00=OFF, 01=TONE, 02=TSQL,
03=DTCS, 04=TSQL-R, 05=DTCS-R,
06=DTCS (T), 07=TONE (T) /DTCS
(R), 08=DTCS (T)/TSQL (R), 09=TONE
(T)/TSQL (R)

10-20
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Remote jack (Cl-V) information (Continued)

Cmd. csnn:g. Data e [ Receive fr.equency setting
Command: 00, 03, 05
22|00 see p. 10-26 | Send/read DV TX data (Up to 30 byte)
01| 00 |00 Send/read Auto DV RX data output @ @ ® ® ®
OFF [(x To[xix[xix[xix]oix]
01 Send/read Auto DV RX data output ON f:,, T T T
01 |see p. 10-26 | Send/read DV RX data (Up to 30 byte) N O: ; v
02 00, 01 Send/read DV data TX setting © g i’; ) :
(00=PTT, 01=Auto) um'{; 2 : ° & ® &5 o o
Send/read DV fast data setting s - e L
08 00, 01 (00=OFF, 01=ON) 2o S £ B 2 5 oD
04 00. 01 Send/read GPS Data Speed setting 5 5 %’,\ 5 T N 3 E s I_ %
' (00=Slow, 01=Fast) Ig&ngy I 2 % S I g82
05 00~10 Send/read TX Delay (PTT) setting 8L 2 2 2 e Z gre
(00=0OFF, 01=1 sec. ~ 10=10 sec.)
23|00 see p. 10-26 | Read the position 100 Hz dlglt 10 Hz digit
01 00 Send/read the GPS receiver OFF 0 0
01 Send/read the internal GPS ON 2 5
02 Send/read the external GPS ON 3 3
03 Sen.d./read the manually entered 5 0
position
02 see p. 10-26 | Send/read manually entered position 6 6
24|00 00 (00 Send/read TX output power setting ’ o
OFF
01 Send/read TX output power setting ON Operating mode
01 |00 > output power setting OFF for Command: 01, 04, 06
transceive @ @
01 TX output power setting ON for
transceive | X i X | X i X |
*! Below 100 Hz is omitted. Operating | 3 \i14e | @ Filter setting
*2 When sending the power ON command (18 01), the mode
command “FE” must be sent before the basic format. AM 02 0f
« 19200bps: 25 AM-N 02 02
- 9600bps: 13 FM 05 01
- 4800bps: 7 FM-N 05 02
Example: When sending with 4800 bps bv 17 01

[©)] @ ® @

i 8‘0‘1‘[5

o

o]

e

®
|F|E|HEIHE‘9
x7

Duplex Frequency offset setting

Command: 0C, 0D
(D Preamble code (fixed) D @ ®

(@ Transceiver’s default address

(3 Controller’s default address | X X | X X | X X |
@ Command number T A X i} N T
® Sub command number 1 2 5 - = L
@ End of message code (fixed) g E N S 'E 2
*3 Qutput setting is automatically turned OFF after turning 3 g E ﬁ = T
OFF the transceiver, then turn it ON again. - S S o o =
RF power level setting
Command: 14 0A
LOW MID HIGH
0~84 85~ 170 171 ~ 255

External microphone gain setting
Command: 14 0B

1 2 3 4
0000 ~ 0063|0064 ~ 01270128 ~ 0191|0192 ~ 0255

10-21
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Remote jack (Cl-V) information (Continued)

VOX gain setting

Command:

1416

OFF

1

2

3

4

0000 ~ 0022

0023 ~ 0046

0047 ~ 0069

0070 ~ 0092

0093 ~ 0115

5

6

7

8

9

0016 ~ 0139

0140 ~ 0162

0163 ~ 0185

0186 ~ 0208

0209 ~ 0232

10

0233 ~ 0255

Repeater tone/tone squelch frequency setting
Command: 1B 00, 1B 01

®*

@

®

Fixed: 0 ——| ©

Fixed: 0 ——| ©

100 Hz digit —| X
10 Hz digit —>| X

1 Hz digit ——>| X

0.1 Hz digit—>| X

*Not necessary when setting a frequency.
® See page 9-16 for the tone frequency list.

DTCS code and polarity setting

Command:
@®

X1X|[0, .

1B 02
@

x
x

Second digit: 0 ~ 7 —>

First digit: 0 ~7 —>
Third digit: 0

0 (fixed)

~7—| X

Receive polarity: 0: Normal

1: Reverse

Transmit polarity: 0: Normal

1: Reverse

® See page 9-16 for the DTCS code list.

Digital code squelch setting

Command:

1B 07

X
e
X

First digit: 0 ~9 ——>
Second digit: 0 ~9—>

10-22

DV MY call sign setting
Command: 1F 00
Set your own call sign and note of up to 12 characters.

XX

(@ ~ ®: Your own call sign setting (8 characters)
(@ ~ (2: Note setting (4 characters)

DV TX call signs setting (24 characters)
Command: 1F 01

Set “UR,” “R1” and “R2” call signs of 8 characters
(fixed).

OO —O-®——D-8—
[X:x X X|XiX X X[ XX X:X|

LN LN ] LN ]

@ ~ ®: UR (Destination) call sign setting (8
characters)

@ ~ (6: R1 (Access/Area repeater) call sign setting (8
characters)

@ ~ @: R2 (Link/Gateway repeater) call sign setting
(8 characters)

Character’s code of the call sign

Character ASCII code
0~9 30~39
A~Z 41 ~5A

(Space) 20
/ 2F

DV TX message setting

Command: 1F 02

Set the transmit message of up to 20 characters.
“FF” stops sending or reading messages.

Character | ASCIl code | Character | ASCIl code
A~Z 41 ~ 5A a~z 61 ~7A
0~9 30~ 39 Space 20

! 21 # 23
$ 24 % 25
& 26 \ 5C
? 3F " 22
' 27 ) 60
A 5E + 2B
- 2D * 2A
/ 2F . 2E
, 2C : 3A
; 3B = 3D
< 3C > 3E
( 28 ) 29
[ 5B ] 5D
{ 7B } 7D
: 7C _ 5F
B 7E @ 40
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Remote jack (Cl-V) information (Continued)

DV RX call sign data
Command: 20 0001, 20 0002

(DHeader flag data (First byte)

Data Description
bit7 | (0: Fixed) —
bit6 | (0: Fixed) —
bit5 | (0: Fixed) —
bit4 0/1 0=Voice, 1=Data
bit3 0/1 0=Direct, 1=Through repeater
bit2 0N 0=No Break-in, 1=Break-in
bit1 0/1 0=Data, 1=Control
bit0 0/1 0=Normal, 1=EMR

(2 Header flag data (Second byte)

Data Description
bit2 | bit1 | bit0
1 1 1 |Repeater control
1 1 0 [Send auto acknowledge
1 0 1 [(Not used)
1 0 0 |Request to re-transmit
0 1 1 [Send acknowledge
0 1 0 |Receive no reply
0 0 1 |[Repeater disabled
0 0 0 |NULL
(® ~ (0: Call sign of the caller station
(8 characters, fixed)
@ ~ (9: Note of the caller station (4 characters, fixed)

@5 ~ @2: Call sign of the called station
(8 characters, fixed)
@3 ~ 30: Call sign of the access/area repeater (R1)
(8 characters, fixed)
@D ~ @8: Call sign of the link/gateway repeater (R2)
(8 characters, fixed)
® “FF” stands for no call sign receiving after turning ON the
transceiver.
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DV RX message
Command: 20 0101, 20 0102

OB B~ @

(D ~ @0: Message (20 characters)

@D ~ @3: Call sign of the caller station (8 characters)

@9 ~ 32: Note of the caller station (4 characters)

® FF: When no call sign is received since the transceiver
power ON.

Example: When a Gateway call is received

(RERPTD) o,

(YOUR STATION)

CALLER:
CALLED:
RXRPT1:

Caller’s call sign

Called station call sign

Call sign of the repeater that was accessed

by the caller station

@ If it was a call through a gateway and the
internet, this item displays the gateway call
sign of the repeater you received the call from.

Call sign of the repeater you received the

call from

RXRPT2:

DV RX Status setting
Command: 20 0201, 20 0202

Data Function Description

bit7 | 0 |(Fixed)

Receiving a
voice call

While receiving a digital voice
signal, select “1.” (Regardless
of DSQL and CSQL setting)

bit6 | 0/1

Last call
finisher

When the last call was

bit5 finished by you, select “1.”

0/1

When the audio tone can be
heard, select “1.”

Receiving a

bit4 .
signal

0/1

Receiving a
BK call

While receiving a BK call,

bit3 select “1.”

0/1

Receiving a
EMR call

While receiving a EMR call,

bit2 select “1.”

0/1

When “DV” and “FM” are
blinking, select “1.”

Receiving a
signal other
than DV

bit1 | 0/1

Packet loss |While displaying packet loss

bit0 | 0/1

status
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Remote jack (Cl-V) information (Continued)

GPS/D-PRS data— Position
Command: 20 03 01, 20 03 02

~D-@ @ O R~C— D -B— BB D B —B~O——R~B— D @

Data number

@ ~ @: Call sign/SSID Power Height Gain | Directivity
*9 ASCII characters (A-Z, 0-9, /, -, space) Data (W) (mlft) (dB) (deq)

0, @: Symbol 0 0 3/10 0 |Omni-direction
*2 ASCII characters (00h—EFh) 1 1 6/20 1 45° NE

@2 ~ (8: Latitude (dd°mm.mmm format) 2 4 12/40 2 90° E

@ ~ @: Longitude (ddd°mm.mmm format) 3 9 24/80 3 135° SE

@ ~ 9: Altitude (0.1 meter steps) 4 16 49/160 4 180° S

@), @: Course (1 degree steps) 5 25 98/320 5 225° SW

@ ~ 3D: Speed (0.1 km/h steps) 6 36 195/640 6 270° W

32 ~ (38: Date (UTC: yyyymmddHHMMSS) 7 49 390/1280 7 315° NW
*y: Year, m: Month, d: Day, H: Hour, M: Minute, 8 64 780/2560 8 360° N

S: Second 9 81 1561/5120 9 —

39: Power (see the table to the right)

@o: Height (see the table to the right)

an: Gain (see the table to the right)

@: Directivity (see the table to the right)

GPS/D-PRS data— Object
Command: 20 03 01, 20 03 02

—D~@— @ O @~~~ BB~ B D B B~ — @ ~B— D

@ B~ &
XXX oo [XEX]X0X]
@ ~ @ Call sign/SSID Power Height Gain | Directivity
*9 ASCII characters (A-Z, 0-9, /, -, space) Data "\ (m/ft) (dB) (deq)
10, @: Symbol 0 0 3/10 0 |Omni-direction
*2 ASCII characters (00h—EFh) 1 1 6/20 1 45° NE
@2 ~ (6: Latitude (dd°mm.mmm format) 2 4 12/40 2 90° E
@ ~ @ Longitude (ddd°mm.mmm format) 3 9 24/80 3 135° SE
@3 ~ @0: Altitude (0.1 meter steps) 4 16 49/160 4 180° S
22, @9: Course (1 degree steps) 5 25 98/320 5 225° SW
@ ~ 3D: Speed (0.1 km/h steps) 6 36 195/640 6 270° W
32 ~ 38: Date (UTC: yyyymmddHHMMSS) 7 49 390/1280 7 315° NW
*y: Year, m: Month, d: Day, H: Hour, M: Minute, 8 64 780/2560 8 360° N
S: Second 9 81 1561/5120 9 —
39: Power (see the table to the right)
@o: Height (see the table to the right)
an: Gain (see the table to the right)
@: Directivity (see the table to the right)
~ 6D: Name
*9 ASCII characters (00h—EFh)
62: Type (1=Live, 0=Killed)
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Remote jack (Cl-V) information (Continued)

GPS/D-PRS data— Item
Command: 20 03 01, 20 03 02

~D-~@\ @ O R~C——D-B— BB D B —B-O— R D @

B B~ 86
IXXIXIX| « e e [XiXX0X]
@ ~ @ Call sign/SSID Power | Height Gain | Directivity
*9 ASCII characters (A-Z, 0-9, /, -, space) Data (W) (m/ft) (dB) (deq)
@, @: Symbol 0 0 3/10 0 [Omni-direction
*2 ASCII characters (00h—EFh) 1 1 6/20 1 45° NE
@2 ~ (6: Latitude (dd°mm.mmm format) 2 4 12/40 2 90°E
@ ~ @: Longitude (ddd°mm.mmm format) 3 9 24/80 3 135° SE
@3 ~ @0: Altitude (0.1 meter steps) 4 16 49/160 4 180° S
@), @9: Course (1 degree steps) 5 25 98/320 5 225° SW
@ ~ G): Speed (0.1 km/h steps) 6 | 36 195/640 6 270° W
: Power (see the table to the right) 7 49 390/1280 7 315° NW
Height (see the table to the right) 8 64 780/2560 8 360° N
Gain (see the table to the right) 9 81 1561/5120 9 —

Directivity (see the table to the right)
: Name

*9 ASCII characters (00h—EFh)

Type (1=Live, 0=Killed)

® 808X
l
®

GPS/D-PRS data— Weather
Command: 20 03 01, 20 03 02

~D-~@\ 0 O R~ DB B-B— D 6 R B DB, BB\ ®

@ ~ @: Call sign/SSID
*9 ASCII characters (A—Z, 0-9, /, -, space)
~ {D: Symbol
*2 ASCII characters (00h—EFh)
@2 ~ (0: Latitude (dd°mm.mmm format)
@2 ~ @: Longitude (ddd°mm.mmm format)
@ ~ @: Date (UTC: yyyymmddHHMMSS)
*y: Year, m: Month, d: Day, H: Hour, M: Minute,
S: Second

80, @D: Wind direction (1 degree steps)

32, 33: Wind speed (0.1 m/s steps)

34, 35: Gust speed (0.1 m/s steps)

~ B2: Temperature (0.1°C steps)

. Temperature (0=+ degree, 1=— degree)
39, @0: Rainfall (0.1 mm steps)

@), @: Rainfall (24 hours) (0.1 mm steps)

@), @: Rainfall (Midnight) (0.1 mm steps)

@, @: Humidity (1% steps)

@) ~ @9: Barometric pressure (0.1 hPa steps)
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Remote jack (Cl-V) information (Continued)

GPS/D-PRS message DV TX data, DV RX data (transceive)
Command: 20 04 01, 20 04 02 Command: 22 00, 22 01 01
~O~-®— —0~2— T . o
XX] +e e Pixxix] - [xix serereeeeeeeaens
Variable Variable
@ ~ @: Call sign/SSID (D ~ B0: Tx, data Rx data (Up to 30 Byte)
*9 ASCII characters (A~Z,0~9, /, -, space) **FA” to “FF” are entered after converted to “FF 0A”
~ 62: Message to “FF OF” automatically. Up to 60 Byte data can
*Up to 43 ASCII characters (00h—-EFh) be entered in this case.

MY position data
Command: 23 00

D~ OO~ 2~ B 1 O B~ D~ D

XX|XX XEX[XiX XX|XEX|XX[XX XEX|X X

: Latitude (dd°mm.mmm format)

: Longitude (ddd°mm.mmm format)

: Altitude (0.1 meter steps)

Course (1 degree steps)

: Speed (0.1 km/h steps)

: Date (UTC: yyyymmddHHMMSS)

*y: Year, m: Month, d: Day, H: Hour, M: Minute,
S: Second

CEEELEE
@®@@®@

Manually entered position data
Command: 23 02

[Xix

X:X

@ ~ ®: Latitude (dd°mm.mmm format)
® ~ @: Longitude (ddd°mm.mmm format)
@2 ~ (5: Altitude (0.1 meter steps)

©®2O6ee6e 6 06 @ OO oG @ G

VXPXVXPO“XbXVXhXVXhOthXVXhXbX

AA*\ AI\* A A
- -
Il JIx
3 °
S =]
= =
5 2
mcn g m@ _o\—c»
1 -~ l 1
(o)} [} =
mmmmlxo g lmmmmzlo 801?9 o
t l o =z | ol 1 o .. o L O
ololoegs £| olotlox S2.° o
Lo Lo uEeD S 2" o oy 52 S ox .o
282925 1 ox - 2, 52% IS o2. " o
D2 oiE DT g O | T OEDE DT L0598 %5
TO9O5 92T ¢ & o TO5 20T ¢ & S O o O.2%FE 5
T oo o 2 21 3o g00=E 2 2506 .-.020
Q [0} 2 3 c = S Q = 3 c Q= 5 T =
BoLoS2EEm2808y52EEaa 5 o 5=
25 L2EET oD 2S5 L2EETOEERFE 2T
o2 5EE Q0 Qo2 ESEE QOO EQgoDQY
PO EEESE XXEXOVOO=EEEEXX_8sEL2HE X
SO0 EZE-OfLSLoOOEESE-OTIT® 1S irs
To E-0d ST E-od 02888 5E-L
o o OO0 —-—-0“—-35 o o O O —<— SO o ]
‘—\—\—\—OOOOD(/)O\—\—‘—‘—\—OOOOOE\—‘—F\—\—OO+
Latitude Longitude Altitude

*“FF” in all 4-byte characters stands for no altitude data
sending or receiving.
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Microphone/Speaker

HM-154 HAND MICROPHONE

HM-207S HAND MICROPHONE (REMOTE-CONTROL)
HM-209 NOISE CANCELING MICROPHONE
HM-232 HAND MICROPHONE (SIMPLE)

OPC-440 MIC EXTENSION CABLE: 5 m (16.4 ft)*
OPC-647 MIC EXTENSION CABLE: 2.5 m (8.2 ft)*
SP-30 EXTERNAL SPEAKER: 2.8 m (9.1 ft)*
SP-35 EXTERNAL SPEAKER: 2 m (6.5 ft)*
SP-35L EXTERNAL SPEAKER: 6 m (19.6 ft)*

*Approximate

Software

CS-4100 CLONING SOFTWARE

RS-MS1A Android™ APPLICATION

RS-MS1I iOS™ APPLICATION

RS-MS3W TERMINAL MODE/ACCESS POINT MODE
SOFTWARE: For Windows

RS-MS3A TERMINAL MODE/ACCESS POINT MODE
APPLICATION: For Android™ devices

OPC-2350LU DATA CABLE: USB type

OPC-478UC CLONING CABLE: USB type

Bluetooth

UT-137 Bluetooth® UNIT

VS-3 Bluetooth® HEADSET

Others

MBA-8 CONTROLLER BRACKET

MBF-1 MOUNTING BASE: MBA-8 is required

MBF-4 MOBILE BRACKET

OPC-345 DC POWER CABLE

OPC-589 MIC ADAPTOR CABLE

OPC-1156 CONTROLLER EXTENSION CABLE:

3.5m (1.4 ft)

Icom is not responsible for the destruction, damage
to, or performance of any Icom or non-lcom
equipment, if the malfunction is because of:

* Force majeure, including, but not limited to, fires,
earthquakes, storms, floods, lightning, other
natural disasters, disturbances, riots, war, or
radioactive contamination.

* The use of Icom transceivers with any equipment
that is not manufactured or approved by Icom.

About the free download software

You can download each manual and guide from the
Icom website.

http://www.icom.co.jp/world/support/

Before using, read each manual and guide, and use
it according to the instructions.

® Information
* To use to the software, the following items are
required.

CS-4100 microSD card
OPC-2350LU
OPC-478UC
RS-MS1A UT-137
RS-MS1I UT-137
RS-MS3A OPC-2350LU
RS-MS3W OPC-2350LU

* To add or expand a function, or to improve
the performance, the software version may be
upgraded. Before you update your software
version, see the instructions and cautions
described on the lcom website.

* To use the RS-MS3W or RS-MS3A, see “About
the DV Gateway function” that can be downloaded
from the Icom website.
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12 Bluetooth® OPERATION

Bluetooth® operations

If you install the optional UT-137 Bluetooth® UNIT in
the transceiver, you can connect to other Bluetooth
devices.

In this section, the ID-4100A/E with the UT-137 is
described as simply the “transceiver.”

You can connect other devices to the transceiver.

Ilcom Headset

When you connect the VS-3 Bluetooth® HEADSET to the
transceiver, you can wirelessly transmit and receive.
The VS-3 has a [PTT] switch, so you can transmit in
the same way as using the transceiver’s [PTT] switch.
The VOX function can also be used, so you can select
transmit and receive by using your voice through the
headset to switch between TX and RX.

You can assign a function to the keys on the side
panel of the VS-3 to remotely operate the transceiver.

Android™ device

When you connect an Android device to the
transceiver, you can use the extended D-STAR
functions with the RS-MS1A (freeware Android
application).

iOS™ device

When you connect an iOS device to the transceiver,
you can use the extended D-STAR functions with the
RS-MS1I (freeware iOS application).

® The communication range of Bluetooth is approximately
10 meters (32.8 feet).

Headset device

’:"-\‘.‘I.‘ Optional VS-3
Q il (Bluetooth Headset)

Android device,
iOS device, or
Bluetooth Low
Energy device
(third party)

Data device

Transceiver with
the Bluetooth unit

12-2

Turning ON the Bluetooth®

function

Bluetooth Set > Bluetooth

1. Push [MENU].
2. Rotate [DIAL] to select “Bluetooth Set,” then push
[J].

L Gateway - u

B SO Card »
) Eluetooth Set

EBLUETOOTH SET

Bluetooth 4
Auto Connect »
Pairing/Connect 3

4. Select “ON,” then push [J].
= Bluetooth

OFF

5. Push [MENU]I.
* Returns to the standby screen.

IMPORTANT: The Bluetooth communication range
may vary, depending on the environment in which
the device operates. Microwave ovens or Wireless
LAN may cause an interference.

In that case, stop using those devices or increase
the space between the Bluetooth device and the
other devices.

This Bluetooth device has a range of use. If the
communication is unstable, use the device within the
range.
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Connecting to a Bluetooth® headset

You can connect the optional Bluetooth headset to the
transceiver.

Step 1. Selecting the pairing mode of the headset.

See the instruction manual of the headset to select
the pairing mode.

Step 2. Searching for the headset (Transceiver)

Bluetooth Set > Pairing/Connect

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push

[J].

< DY Gateway 3
B SO Card b
£ Bluetooth Set
3.
Bluetooth 4
Auto Connect 4
3
4.
5.

= DEVICE SEARCH

Search Headset

Search Data Device 4 |r

* Displays the usable headsets in the pairing list.
(Example: ICOM BT-002)

6. Select “ICOM BT 002,” then push [d]

* The confirmation dialog “Connect?” is displayed.
7. Select <YES>, then push [J].

ﬂ Connect?

+ Connects to the headset.
« After the connecting to the headset, “»” is displayed
in the pairing list.

12-3

Pairing List
OMMECT

Device Search 4

L4~ COM BT-002

f

Device name
(“ICOM” indicate the Icom headset.)

Displayed while connecting
Headset icon

8. Push [MENUI].

* Returns to the standby screen.
@® While connected to a Bluetooth device, the Bluetooth
icon is displayed.

Displayed

- o
146.010

TIP:

* When you turn ON the transceiver with “Auto
Connect” set to ON, the transceiver automatically
connects to the last paired device. (Default: ON)
(Bluetooth Set > Auto Connect)

After connecting, the following dialog is displayed.

1

|COM BT-092
Connected.

* When the transceiver cannot find a connectable
headset, and “No Device Found” is displayed on
the screen, push [QUICK], then select “Re-search”
to search again for a headset.

FZEIF
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VOX function

The Voice Operated eXchange (VOX) function toggles
the transceiver between transmit and receive by your
voice. This function provides hands-free operation.
You can use the VOX function with the optional VS-3
or a third party’s Bluetooth headset.

Depending on the headset, the VOX function may be
disabled because of the differences in microphones.

< Using the VOX function
Bluetooth Set > Headset Set > VOX > VOX

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push
[J].

& DV Gateway »
B S0 Card »
3 Bluetooth Set

3. 1.
Data Device et PH

4. Select “VOX,” then push [J].
EHEADSET SET iz
AF QOutput 4
Headzet Function Select 4

5. Select “VOX,” then push [J].

WO Level 4
WOX Delay 4

6. Select “ON,” then push [J].

OFF

7. Push [MENU].
* Returns to the standby screen.
* Displays “V.”
Y W

146010

o

SR

=

NOTE: While receiving a signal or sounding a beep,
the transceiver does not switch to transmit by your
voice.
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If the transceiver does not connect to a Bluetooth
headset, you cannot use the VOX function, even if
the “VOX” item is set to ON.

Be sure to check the Bluetooth connection between
the transceiver and the headset before using the
VOX function.

<© Setting the VOX level
Bluetooth Set > Headset Set > VOX > VOX Level

1. Push [MENU].

Rotate [DIAL] to select “Bluetooth Set,” then push
[J].

3. Select “Headset Set,” then push [J].

4. Select “VOX,” then push [J].

5. Select “VOX Level,” then push [J].

n

VOX Delay

6. While speaking into the headset microphone,
rotate [DIAL] to adjust the VOX level.

* Displays “VOX” when the TX level audio is input.

® The VOX level can be adjusted between 1
(minimum) and 10 (maximum), or turned OFF.
(Default: 5)

® Higher values make the VOX function more sensitive
to your voice.

7. Push [MENU]I.
* Returns to the standby screen.

® Information

« If the S-meter does not display the output power level,
and the transceiver does not transmit, adjust the VOX
delay time in the Menu screen.

(Bluetooth Set > Headset Set > VOX > VOX Delay)

* When the VOX function is ON, you can adjust the
VOX level by pushing [+] or [-] on the VS-3 while
transmitting.

* When the VOX function is ON, you can adjust the
VOX level by rotating [DIAL] while transmitting.

NOTE: We recommend that you set the microphone
gain on the MENU screen or the headset, before
setting the VOX level.

(Function > MIC Gain)
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VOX function (Continued)

<& VOX-related settings
You can set the “VOX Delay” and “VOX Time-Out
Timer” on the MENU screen.

VOX Delay
Delay

1.Bzec

Bluetooth Set > Headset Set > VOX > VOX Delay

The VOX delay is the amount of time the transmitter
stays ON after you stop speaking. It enables for
normal pauses in speaking. (p. 9-70)

Bluetooth Set > Headset Set > VO
VOX Time-Out Timer

>

The VOX Time-Out Timer prevents accidental
prolonged transmission. (p. 9-70)
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Other settings of the headset

< AF Output < Headset Function Select

Select the AF Output device Select the PTT and microphone combination

If “AF Output” is set to “Headset & Speaker,” you can when either a Bluetooth headset or the transceiver
hear audio from both a connected Bluetooth headset microphone are used.

and the transceiver’s speaker.
Bluetooth Set > Headset Set >

Bluetooth Set > Headset Set > AF Output Headset Function Select
1. Push [MENU]. 1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push 2. Rotate [DIAL] to select “Bluetooth Set,” then push

s DY Gateway »

s OV Gateway -
B S0 Card 3 B S0 Card »
3. 1- 3.
Data Dawce Set PH Data Dawce Set PH
4. Select “AF Output,” then push [J]. 4. Select “Headset Function Select,” then push [J].
5 HEHD ET SET SEHEADSET SET '
5.
EAF Output ME
Headszet Cinly I'l-_-rrual
Headszet & Speaker Microphone
FTT
6. Push [MENU]I. 6. Push [MENU]I.
* Returns to the standby screen. * Returns to the standby screen.
® Audio is heard from both the connected Bluetooth
headset and the transceiver’s speaker. NOTE:

* When you select “PTT,” turn OFF the VOX function.
* DO NOT select “PTT” when you use only the
Bluetooth headset.

Using the Bluetooth headset Using the Bluetooth headset
as a microphone asaPTT
(Select “Microphone”) (Select “PTT”)

Voice from
the Bluetooth
headset

Voice from the
microphone

)

=
Transmitting from the
Transmitting from the Blustooth headset
microphone
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Other settings of the headset (Continued)

< About the Icom headset (VS-3)

You can set the detailed settings of the optional VS-3
Bluetooth HEADSET.

Also, you can assign a key function to [PLAY], [FWD],
and [RWD] on the VS-3’s “Custom Key” screen.

Power Save screen

The Power Save function temporarily disconnects the
Bluetooth connection if no communication or operation
is performed for 120 seconds. (p. 9-70)

The Power Save function is disabled when the VOX
function is ON.

One-Touch PTT screen
The One-Touch PTT function enables you to select
transmission and reception by pushing [PTT].

PTT Beep screen
Set the beep to sound when you push [PTT] on the
VS-3. (p. 9-70)

Custom Key Beep screen
Set the beep to sound when you push [PLAY], [FWD]
or [RWD] on the VS-3. (p. 9-70)

Custom key screen
You can assign a key function to [PLAY], [FWD] and
[RWD] on the VS-3. (p. 9-71)

12-7

Optional VS-3
Bluetooth HEADSET

5

7 [FWD]
— [PLAY]
— [RWD]




Previous view

12 Bluetooth® OPERATION

Downloading the RS-MS1A from the Google Play store

The RS-MS1Ais a freeware application for Android
devices.

With the RS-MS1A, you can use the extended
D-STAR functions to exchange pictures or messages,
or display the received D-PRS station data on a map
application.

To use the RS-MS1A, download it from the Google™
Play store installed in your Android device.

< Required items

Android™ device

You can use the RS-MS1A with devices that have
Android 4.0 or later installed.

The RS-MS1A has been tested with the Android
4.x.X, 5.x.x, and 6.x.x. (As of April 2017)

® Information

» Some function may not work correctly, depending
on the application installed in your Android device or
memory capability, even if you use one of the above
products.

+ See the instruction manual for details of the
operation or account setting of the Android device.

* The screen shot in this manual may differ, depending
on your device’s OS or its version.

12-8

< Download procedures

1. Turn ON your Android device.

2. Tap “Play Store.”

3. Enter “RS-MS1A” in the “Search Google Play”
field.

4. Tap "~

* Displays “RS-MS1A” in the application list.
5. Tap “RS-MS1A.
* Displays the introduction screen of the RS-MS1A.
6. Tap <INSTALL>.
7. Tap <ACCEPT=> in the “App permissions” window.
* Installation starts.
« After finishing the installation, the RS-MS1A icon is
displayed on the screen.

ICOM

<«— RS-MS1Aicon
RS-MS1A
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Downloading the RS-MS1Il from the Apple App store

The RS-MS11 is a freeware application for iOS
devices.

With the RS-MS1I, you can use the extended D-STAR
functions to exchange pictures or messages, or
display the received D-PRS station data on a map
application.

To use the RS-MS1I, download it from the Apple App
store installed in your iOS device.

< Required items

iOS device

You can use the RS-MS11 with the iPhone or iPad that
have iOS 8.0.1 or later installed.

® Information

» Some function may not work correctly, depending
on the application installed in your iOS device or
memory capability, even if you use one of the above
products.

+ See the instruction manual for details of the
operation or account setting of the iOS device.

* The screen shot in this manual may differ, depending
on your device’s OS or its version.

< Download procedures
1. Turn ON your iOS device.
2. Tap “App Store.”
3. Tap “Q”
4. Enter “RS-MS1I” in the search field.
« Displays “RS-MS11” in the application list.

5. Tap “RS-MS1I”

* Displays the introduction screen of the RS-MS1I.
6. Tap <GET>.
7. Tap <INSTALL>.

* Installation starts.
+ After finishing the installation, the RS-MS11 icon is
displayed on the screen.

fef®) Yk < RS-MS1l icon

s

- RS-MS 51
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Connecting to an Android™ device

Before connecting to an Android™ device, you must
pair with it.

* How to pair (see below)

* How to connect (p. 12-11)

< Pairing with an Android™ device
This section describes how to pair with an Android
device.

NOTE: Depending on the device, you may not be
able to pair with the Bluetooth device.

Step 1. Entering the pairing reception mode
(Transceiver)

Step 3. Sending a pairing request to the
transceiver (Android device)

Bluetooth Set > <<Pairing Reception>>

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push
[J].

s OV Gateway -
B SO Card b
€3 Bluetooth Set

<<Pairing Feception==
Headset Set »
Data Device Set »

v

Waiting for the Pairing
request with releazing statusz .
tn the evternal devices. F

Hea|
Dat| Time left:1:55 b

Turn ON Bluetooth with your Android device
within the displayed period of time.

When the time runs out, the transceiver exits
the Pairing reception mode.

Step 2. Turning ON Bluetooth (Android device)

Turn ON Bluetooth with your Android device.
« The Android device displays the UT-137 Bluetooth® UNIT
name.

® See the instruction manual of the Android device for
details.

® You can confirm the UT-137’s name on the BLUETOOTH
DEVICE INFORMATION screen.
(Default: ICOM BT-003) (p. 9-72)

12-10

Select the displayed UT-137’s name to send a pairing

request.

» The Android device starts to send a pairing request.

» The Android device displays the “To pair with: ICOM BT-
003. Make sure it is showing this passkey: * * * * *”
dialog.

Step 4. Receiving a pairing request (Transceiver)

1. When the transceiver receives a pairing request,
confirm the displayed passkey is the same as
yours, and then, push [J].

Caonnection request received E
from A | .
Hea|Confirm the following 3
Dat|Basskey iz shown. »
A 4
Pazzkey: E
|
Hea | k
Dat 3

* Pairing starts.
Select “Pairing/Connect,” then push [J].

EBLUETOOTH SET

Bluetooth
Auto Connect
Fairing/ Connect

|]:|— Pairing list

After the pairing is complete, the Android
device name is displayed on the pairing list.

NOTE: When you pair with the third party’s data
device, entering a PIN code or passkey may be
required. See the instruction manual of the data
device for details to enter a PIN code or passkey.
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Connecting to an Android™ device (Continued)

< Connection
This section describes how to connect to the
transceiver from an Android device.

Step 1. Preparing for the connection (Transceiver)

Function > CI-V > CI-V Transceive

Set “Cl-V Transceive” to ON to control the transceiver
and the RS-MS1A with Cl-V commands.

Step 2. Starting the RS-MS1A (Android device)

Tap the RS-MS1A to start.
® See page 12-8 for details on downloading the RS-MS1A.

ICOM
<— RS-MS1Aicon

RS-MSTA

Step 3. Connecting to the transceiver
(Android device)

Tap the UT-137 Bluetooth® UNIT name displayed on the

RS-MS1A.

» Starts to connect.

® When your call sign has not been entered in the
transceiver, you should enter in before you connect.

® After the connection has succeeded, the transceiver
displays “* * ¥ Connected,” and the Bluetooth icon is
displayed.

Displayed

Gm

{ [COM
Connected.

Fhi

® On the PAIRING/CONNECT screen, “@” is displayed to
the left of the Android device name.

P&IRIMNG/COMMECT

Device Search . b

1~ [ CO

T Device name
Displayed while connecting

Data device icon
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TIP: To connect to the Android device from the
transceiver:

When the RS-MS1A is started on the Android

device, you can connect to the device from the

transceiver.

Bluetooth Set > Pairing/Connect

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then
push [J].
3. Select “Pairing/Connect,” then push [J].
4. Select the Android device name displayed in the
pairing list, then push [J].
5. Select <YES>, then push [J].
* Displays “* * ¥ Connecting...”
(“* * %” is the Bluetooth name of the Android
device.)
® “w” is displayed to the left of the Android device
name.

NOTE: If you cannot connect, check that the same
CI-V address is set between the transceiver and the
RS-MS1A.

You can see the CI-V setting as described below:
Transceiver

“Cl-V Address” in the Menu screen.

(Function > CI-V > CI-V Address) (Default: 9A)
RS-MS1A:

“Application Setting” - “CI-V setting”

(Default: Transceiver[9A])
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Connecting to an iOS™ device

Before connecting to an iOS device, you must pair
with it.

* How to pair (see below)

® See page 12-13 to connect to the paired device.

< Pairing with an iOS™ device

NOTE: Depending on the device, you may not be
able to pair with the Bluetooth device.

Step 1. Starting the RS-MS1I

(iOS device)

1.

Turn ON Bluetooth with your iOS device.
® See the instruction manual of the iOS device for
details.

Tap the RS-MS1l icon to start.
® See page 12-9 for details on downloading the RS-MS1A.

[6{®]\%§ < RS-MS1l icon

RS-MS1

* Displays the pairing device list.

Step 2. Entering the pairing reception mode

(Transceiver)

Bluetooth Set > <<Pairing Reception>>

1.

Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push [J].

EMEMLI =
s DY Gateway

B S0 Card

3 Bluetooth Set

Select “<<Pairing Reception>>," then push [J].

EBLUETOOTH 5 E
Hea » H

<Pairing Fe
Data Device Set r

set Set
. 4

'.-"-.'aiting for the Pairing E
request with releasing status .
Healtn the evternal devices.

! 3
Dat| Time left:1:55 ;H

Turn ON Bluetooth with your iOS device within the
displayed period of time. When the time runs out,
the transceiver exits the Pairing reception mode.
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NOTE: Before connecting, check the following items
are correctly set.
* Set “Cl-V Transceive” to “ON.”
(Function > CI-V > CI-V Transceive)
« Set “Serialport Function” to “CI-V (Echo Back OFF).”
(Bluetooth Set > Data Device Set > Serialport Function)
» Set the same CI-V address between the transceiver
and the RS-MS11.
Transceiver:
“Cl-V Address” in the MENU screen
(Function > CI-V > CI-V Address) (Default: 9A)
RS-MS1I:
“Application Setting” —» “Cl-V address”
(Default: Transceiver[9A])

Step 3. Sending a pairing request to the
transceiver (iOS device)

1. On the RS-MS1l, tap “Scan.”
* The device displays the UT-137 Bluetooth® UNIT name.
® You can confirm the UT-137’s name on the
BLUETOOTH DEVICE INFORMATION screen.
(Default: ICOM BT-003) (p. 9-72)

2. Tap the displayed UT-137’s name to send a

pairing request.

» The iOS device starts to send a pairing request.

® When your call sign has not been entered in the
transceiver, you should enter in before you connect.

® After the connection has succeeded, the iOS device
displays “Bluetooth connected to ICOM BT-003.”

® About the transceiver’s display

After the connection has succeeded, the transceiver
displays “* * * Connected.” and the Bluetooth icon
is displayed.

(“* * *” is the Bluetooth name of the iOS device.)

Displayed

F (=3

{ [COmr
Connected.

BEB
On the PAIRING/CONNECT screen, “#” is displayed
to the left of the iOS device name.

(Bluetooth Set > Pairing/Connect)

OMMECT

Device Search

m C ' i .I '

Device name
Displayed while connecting

Data device icon
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Connecting to an iOS™ device (Continued)

< Connection

This section describes how to connect to the paired
transceiver from an iOS device.

1. Tap the RS-MS1l icon to start.

[6{®]\"F < RS-MS1l icon

RS-MS1

- -

Tap “Other.”

Tap “Bluetooth Connection.”

Tap the displayed UT-137’s name to connect.

* The iOS device starts to connect to the transceiver.

® When your call sign has not been entered in the
transceiver, you should enter in before you connect.

® After the connection has succeeded, the iOS device
displays “Bluetooth connected to ICOM BT-003.”

PODN

® About the transceiver’s display

After the connection has succeeded, the transceiver
displays “* * * Connected.” and the Bluetooth icon
is displayed.

(“* * *” is the Bluetooth name of the iOS device.)

Displayed

Gm#

{ [COM
Connected.

AR
On the PAIRING/CONNECT screen, “#” is displayed
to the left of the iOS device name.

(Bluetooth Set > Pairing/Connect)

EPAIRING/COMNMECT

Device Search

¥ 1

Device name
Displayed while connecting

Data device icon
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TIP: To connect to the iOS device from the
transceiver:

When the RS-MS11 is started on the iOS device,

you can connect to the device from the transceiver.

Bluetooth Set > Pairing/Connect

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then
push [J].
3. Select “Pairing/Connect,” then push [J].
4. Select the iOS device name displayed in the
pairing list, then push [J].
5. Select <YES>, then push [J].
* Displays “* * * Connecting...”
(“* * *” is the Bluetooth name of the iOS

device.)
® “w” is displayed to the left of the iOS device name.

NOTE: If you cannot connect, check that the same
CI-V address is set between the transceiver and the
RS-MS1l.

You can see the CI-V setting as described below:
Transceiver

“Cl-V Address” in the Menu screen.

(Function > CI-V > CI-V Address) (Default: 9A)
RS-MS1l:

“Application Setting” - “CI-V address”

(Default: Transceiver[9A])
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Disconnecting from a Bluetooth® device

There are 3 ways to disconnect from a Bluetooth

device (headset device or data device).

* Turn OFF a headset

* Turn OFF the Bluetooth on a data device

® See the instruction manual of the headset or a data
device for details.

Or, you can disconnect from a Bluetooth device
without canceling the pairing, as described below.

Bluetooth Set > Pairing/Connect

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push

[J].
< DY Gateway 3
B SO Card »
£3 Bluetooth Set

3. Select “Pairing/Connect,” then push [J].
EELUETOOTH SET 1/5E
Bluetaoth H
Auto Connect »
Pairing/ Connect

4,
EPAIRIMNG/COMNMNECT ,
Device Search »
La [ COM BT-002
B~ COM

* The confirmation dialog “Disconnect?” is displayed.
5. Select <YES>, then push [J].

Crew

3]
EN

Disconnect?

EPAIRIMNG/COMNMNECT i E
Device Search »
B~ COM

“»” disappears

* The transceiver disconnects from the Bluetooth
device, and “#” disappears from the list. However, the
transceiver is still paired with the device.

® When you select the unconnected device

displayed in the pairing list, the transceiver displays
“Connect?.” To connect to the device, select <YES>.

12-14
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Deleting a Bluetooth® device from the pairing list

You can delete a Bluetooth device from the pairing list.
Before deleting a connected Bluetooth device,
disconnect it.

Bluetooth Set > Pairing/Connect

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push

[J].
< DY Gateway 4
B S0 Card »

83 Bluetooth Set

Auto Connect 4

Eluetuuth PF

4. Select the Bluetooth device, then push [QUICK].

E1+~ICOmM

Device Search 4 |r

SR Connect

Devic: < [ {

El~ICOl BD Address Display

* The confirmation dialog “Delete?” is displayed.
6. Select <YES>, then push [J].

TE

Diew »

- |
) | l

* Deletes the selected device from the pairing list.

TIP: To connect to the deleted device again, you
must first pair with it again.

Pairing with a headset: p. 12
Pairing with an Android device: p. 1
Pairing with an iOS device: p. 1

12-15
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Editing the installed Bluetooth® unit name

You can edit the Bluetooth unit name. After initializing
the unit, the edited name remains.

Bluetooth Set > Bluetooth Device Information

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push

[J].

EMEML 7/8
< DY Gateway 4
B S0 Card »

83 Bluetooth Set

3. Select “Bluetooth Device Information,” then push
[J].
EBLUETOOTH SET
Bluetooth Device Information
Initialize Bluetooth Device

* Displays the BLUETOOTH DEVICE INFO screen.
Push [QUICK].

Select “Edit Name,” then push [J].

Edit Name '

Device M
BD Acd
Frofile

o &

= DEVICE MAME
ICOM BT-203
= — CLR 4B

* Enters the unit name entry mode.
6. Enter a name of up to 8 characters™.
(Example: ICOM BT-003 A)

= DEVICE MAME
ICOM BT-283 A_
= — CLR AB

Selectable characters and symbols
AtoZ,atoz, 0to 9, !"#$%& ()*+
-l <=>?2@ [V {]} (space)
® See “Entering and editing text” for details. (p. iv)
*Except for “ICOM BT-.”

7. After entering, push [J].
* Sets the edited name.
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Initializing the installed Bluetooth® unit

You can initialize the installed UT-137 Bluetooth® UNIT.
You should initialize the unit if you have trouble during
Bluetooth operation.

When you do a partial reset or all reset, the Bluetooth
settings returns to their factory defaults. However,

the device name and pairing/connection information
remain.

Bluetooth Set > Initialize Bluetooth Device

1. Push [MENU].
Rotate [DIAL] to select “Bluetooth Set,” then push

[J].
< DY Gateway 4
B S0 Card »

83 Bluetooth Set

Initialize Bluetooth Device

* The confirmation dialog “Initialize Bluetooth Device?”
is displayed.
4. Select <YES>, then push [J].
Initialize Bluetooth Dewice? /3 |
BElus
Init

* Resets the installed UT-137’s settings to their factory
defaults, and returns to the standby display.
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The maximum number of paired devices

You can pair 3 types of the Bluetooth devices:
Headset, Data device, and Low Energy device.

Up to 7 Bluetooth devices can be paired with the UT-

137. However, you cannot pair with 7 headsets only, 7

data devices only, or 7 Low Energy devices only.*

* Either headsets or Android devices are maximum 4
devices, and the combination is 5 devices in total.

* Bluetooth Low Energy devices are maximum 2 devices.

L~ COM ET-002
Fl~ICOmM

Displays the paired Bluetooth device
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< About updating the firmware

You can update the ID-4100A/E’s firmware using a
microSD card. Updating the firmware can add new
functions or improve performance parameters.

You can download the latest firmware from the lcom
website.
http://www.icom.co.jp/world/index.html

< Cautions

* CAUTION: NEVER turn OFF the transceiver
while updating the firmware. If you turn OFF the
transceiver, or if a power failure occurs while
updating, the transceiver firmware may be damaged
and you may have to send the transceiver back
to the nearest Icom distributor for repair. This type
of repair is out of warranty, even if the transceiver
warranty period is still valid.

* We recommend that you backup all the transceiver’s
data to a microSD card or to a PC before starting the
firmware update. Settings and/or memory contents
may be lost or returned to their default settings when
the firmware is updated.

* You are responsible for the the results after updating
the firmware.

< Item requirement

*PC

* microSD card

» microSD card slot or a memory card reader

NOTE: Before using a microSD card, format it with

the transceiver.

® Formatting a card erases all its data. Before formatting
any used card, back up its data onto your PC.

® See the Basic manual for details.

13-2

< Checking the firmware version
You can check the firmware version on the MENU
screen.

Others > Information > Version

1. Push [MENU].
Rotate [DIAL] to select “Others,” then push [J].

3.
= OTHERS £
Information
Clone »
Reset »
4. Select “Version,” then push [J].
EINFORMATION ME
Yaoltage
Werzion
EVERSION BE
CPU M ~ DsP .
g .
C ~  BTUnit

* The firmware version is displayed.
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Updating the firmware

These instructions are based on Microsoft® Windows® 8. Right-click the downloaded firmware folder (zip
10. format).
9. Click “Extract All...”

Step 1. Downloading the firmware file
1. Access the following URL.

Open

http://www.icom.co.jp/world/index.html E—— |7C"Ck
2. Click <Support>. Bin to Start
?  lcom Inc Global site X Openylth...
Chare wwith S

& S5 O | comom

ICOM Giotal

10. Select the location where you want to create the
unzipped folder, then click <Extract>.

3. Click the “Firmware Updates/Software (Example: Desktop)

Downloads” link. B i Comprct i ol

9 supportlicomme X |+ - o x Select a Destination and Extract Files

Files willbe extracted to tis older

€ 5 O | concop

ICOM Giopa /Show extaced s when complte

Home Products About Us Investor Relations Support

B

ISupport

Click
[ Firmware Updates / Software Downioads _| Click * After unzipping, a folder is created in the specified
: location.
4. Click the firmware file link in the 1D-4100A/E @Inthe #1008 xx™folder, 41008 _xx".dat'is

group. * “x %” represents the release number.
5. Read “Regarding this Download Service” P ’

fully, and th lick <A >, . . .
careiuly, and then click =Rigree= Step 2: Inserting the microSD card into a PC

mw NOTE: To use the microSD card with the transceiver,
format the card, even preformatted microSD cards
[e# |————7—Click for PCs or other uses. See Basic manual section 7
P . for details.
6. Click <Save as>. 1. Turn OFF the transceiver, then remove the
R — . microSD card.
L e == Click 2. Insert it into the microSD card drive or a memory

card reader* on your PC.

7. Select the location where you want to save the 4
*User supplied.

firmware, and then click <Save>.
(Example: Desktop) PC

ave A x

Transceiver

< < 4 EE > ThizPC 5 Desktop v [ scorchDesktop »

Oy i s e

4 OneDiive New folder

[ This PC

!

& ot microSD To the memory
& b card card reader

File name: [ #100E101.2ip

Saveastype: | Compressed (zipped) Folder ("zip)

[C=}=—""Click

* The file starts downloading.
® The firmware and the firm utility are compressed in a
“zip” format folder.

1= Continued on the next page.
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Updating the firmware (Continued)

Step 3. Copy the downloaded firmware data

1. Double-click the created folder.
(Example: 4100E101).

2. Copy the downloaded firmware data into the
ID-4100 folder on a microSD card.
(Example: 4100E101.dat).

———Click

Step 4: Removing the microSD card

Turn OFF the transceiver, then remove the microSD
card from your PC, and insert it into the transceiver’s
slot.

Transceiver

From the memory
card reader

microSD
card

Step 5: Updating the firmware

CAUTION: NEVER turn OFF the transceiver while
updating the firmware.

If you turn OFF the transceiver, or if a power failure
occurs while updating, the transceiver firmware
may be damaged and you may have to send the
transceiver back to the nearest Icom distributor for
repair. This type of repair is out of warranty, even if
the transceiver warranty period is still valid.

SD Card > Firmware Update

1. Push [MENU].
Rotate [DIAL] to select “SD Card ? then push [J].

< DY Gateway 4

S0 Card

€3 Bluetooth Set 3
3.

=50 CARD )

S0 Card Info k

Firmmware Update

Farmat

* The firmware update agreement screen is displayed.

13-4

4. Carefully read all the displayed precautions.
After you read and agree with all the precautions,
select <YES>, then push [J].

Firmwware updating has risks, and wou
do zo at your own risk and
responzibility.

If wou make a mistake updating, the

h 4

ID-41@@ may not wark properly ar
the data will become corrupted.

In that casze you must send it to an
lcom distributor for repair.

v

Refer to the instruction manual for
the correct updating procedures.
Depending an the updating versian,
all previous settings and memory

v

contents may be |ost. |l

Before updating, make a hackup file
of the zsettings and memary contents
onto an 3D Card.

A 4

Do you agree to all of the above?

® Rotate [DIAL] to scroll the screen.
® To cancel the updating, select <NO>.
5. Select the Firmware, then push [J].
(Example: 4100E101).
AWARE LIPDATE

* The final confirmation screen is displayed.

& Continued on the next page.
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Updating the firmware (Continued)

6. Carefully read all the displayed precautions.
After you read and agree with all them, select
<YES>, then push [J].

Firmware updating takes
approximately 4 minutes.

After updating, the [D-41@@ will
automatically restart.

v

Until the frequency screen is
dizplayed, NEVER turn OFF the
ID-41@ or remove the SD Card.

v

Do you want to start updating?

* The updating starts.

® Information

* To cancel the updating, select <NO>.

* The transceiver reads the firmware file from the
microSD card and writes it to the main CPU, sub CPU,
DSP, and the controller CPU.

* Downloading and loading status are displayed in the
dialogs.

7. The firmware updating has completed, the
transceiver will automatically restart. And then,
returns to the standby screen.

TIP:

* To check the firmware version after the updating,
see “Checking the firmware version” for details.
(p. 13-2)

* To delete the firmware file on the microSD
card, push [QUICK], then select “Delete” on the
FIRMWARE UPDATE screen.
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